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Preface

This guide describes how to use the Thermo TraceFinder™ 3.3 application with compatible 
Thermo Scientific™ GC/MS and LC/MS analytical instruments.

Related Documentation
The TraceFinder application includes complete documentation. In addition to this guide, you 
can also access the following documents as PDF files from the data system computer:

• TraceFinder User Guide

• TraceFinder Administrator Console User Guide

• TraceFinder Acquisition Quick Reference Guide

• TraceFinder Analysis Quick Reference Guide

• TraceFinder Shortcut Menus Quick Reference Guide

 To view TraceFinder documents using the Start menu

From the Microsoft™ Windows™ taskbar, choose Start > All Programs > Thermo 
TraceFinder > Manuals.

Contents

• Related Documentation

• License Activation

• Special Notices

• Contacting Us
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 To open TraceFinder Help and access related documents from the application

1. Open the TraceFinder application and choose Help > TraceFinder Help. 

• To find a particular topic, use the Contents, Index, or Search panes.

• To create your own bookmarks, use the Favorites pane.

2. To view the operator manual, user guide, or one of the quick reference guides, choose 
Help > Manuals > PDF file.

Figure 1. PDF files available from the Help menu

The PDF file of the selected document opens in a new window.
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License Activation 
When you first start the TraceFinder application, a dialog box displays the number of days 
remaining in your 120-day free evaluation license. If your evaluation license has expired, the 
License Activation wizard opens. 

Two types of licenses are available:

• 120-Day Evaluation Version (free of charge)

• Full Version Single License 

The evaluation version is full-featured and automatically expires 120 days after activation. 
Any attempt to set back the system date automatically terminates this version. You can 
purchase and then activate the full version of the application at any time, during or after the 
free evaluation, without reinstalling the software. 

Each activation key is valid only for a single license. Any additional installation generates a 
different license and requires a different activation key.

For software download and licensing questions, contact support at 
ThermoMSLicensing@thermo.com.

Note  You can open the License Activation wizard at any time during your evaluation 
period by choosing Help > About TraceFinder and Licensing from the TraceFinder menu 
and then clicking Activate. If you already have a permanent license, a message tells you 
that your product is fully licensed.

IMPORTANT  The 120-day evaluation license includes both the basic TraceFinder 3.3 
features and the unknown screening features. When you purchase a permanent license, 
you have the option of purchasing the unknown screening features. Your permanent 
license might not include the unknown screening features.

mailto:ThermoMSLicensing@thermo.com
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Use the License Activation wizard to activate or deactivate the license for the application. To 
activate the license, you must have an activation code from Thermo Fisher Scientific. You 
must deactivate the license before you transfer it to another computer.

 To start the license activation or deactivation process

1. Open the application.

2. Choose Help > About TraceFinder and Licensing to display the License Activation 
wizard.

3. Click Activate (Deactivate) to start the activation or deactivation process, as applicable.

The License Activation wizard opens.

4. Follow the instructions in the License Activation wizard.

For additional instructions, click Help in the wizard.
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Special Notices
Make sure you follow the special notices that appear in boxes.

This guide uses the following types of special notices.

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. You 
can use your smartphone to scan a QR code, which opens your email application or browser. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

Contact us Customer Service and Sales Technical Support

(U.S.) 1 (800) 532-4752 (U.S.) 1 (800) 532-4752

(U.S.) 1 (561) 688-8731 (U.S.) 1 (561) 688-8736

us.customer-support.analyze
@thermofisher.com 

us.techsupport.analyze
@thermofisher.com 

mailto:us.customer-support.analyze@thermofisher.com
mailto:us.customer-support.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
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 To find global contact information or customize your request

1. Go to Thermoscientific.com. 

2. Click Contact Us, select the Using/Servicing a Product option, and then 
type the product name. 

3. Use the phone number, email address, or online form. 

 To find product support, knowledge bases, and resources

Go to www.thermoscientific.com/support. 

 To find product information

Go to www.thermoscientific.com/lc-ms. 

Note  To provide feedback for this document: 

• Send an email message to Technical Publications (techpubs-lcms@thermofisher.com).

• Complete a survey at www.surveymonkey.com/s/PQM6P62. 

Contact us Customer Service and Sales Technical Support

http://www.thermoscientific.com
http://www.thermoscientific.com/lc-ms
mailto:techpubs-lcms@thermofisher.com
http://www.surveymonkey.com/s/PQM6P62
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Introduction

This chapter describes general features of the TraceFinder application.

About the TraceFinder Application
The TraceFinder application targets the general quantitation market. It supports a focused 
quantification workflow for specific nonbioanalytical laboratory use, instrument control, and 
method development functionality. TraceFinder is the primary application for the TSQ 
Quantum™ XLS triple quadrupole mass spectrometers.

The application can export mass data in the Acquisition List to XML format so that other 
systems’ applications, such as for the TSQ 8000, TSQ Quantum™, ISQ, and Q Exactive™, 
can import the files into their databases.

The application can import the following file types:

• Sample lists in .csv or .xml format

See “Defining a Sample List” on page 360.

• Processing (.pmd) and instrument (.meth) method files from the Xcalibur™ data system 

For detailed information about creating quantitative processing methods, see Chapter 5, 
“Using the Method Development Mode for Quantitation Methods.” 

For detailed information about creating target screening processing methods, see 
Chapter 6, “Using the Method Development Mode for Target Screening Methods.” 

For detailed information about creating unknown screening processing methods, see 
Chapter 7, “Using the Method Development Mode for Unknown Screening Methods.” 

For detailed information about creating instrument methods, see “Working with 
Instrument Methods” on page 108.

Contents

• About the TraceFinder Application

• TraceFinder Summary of Features

• TraceFinder Workflow

• Reporting Features
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• Compounds from files that use the database (.xml or .cdb) format

See “Working with the Compound Database” on page 74.

• Batches, methods, or templates from the TraceFinder 2.0, 2.1, 3.0, 3.1, or 3.2 
applications.

See “Converting Legacy Data” on page 20.

The application checks the accuracy and precision of data against systems that have previously 
been certified against a standard processing program, such as the Statistical Analysis System 
(SAS). 

Supported File Types 

The application supports the following file types:

• Comma-separated values (.csv): A set of file formats used to store tabular data in which 
numbers and text are stored in plain textual form that can be read in a text editor. Lines in 
the text file represent rows of a table, and commas in a line separate fields in the tables 
row.

• Extensible Markup Language (.xml): A generic framework for storing any amount of text 
or any data whose structure can be represented as a tree. The only indispensable 
syntactical requirement is that the document has exactly one root element (also called the 
document element). This means that the text must be enclosed between a root start-tag 
and a corresponding end-tag.

• Instrument method (.meth): A proprietary file format for the Xcalibur data system suite 
with specific instructions that enable scientific instruments to perform data acquisition.

• Processing method (.pmd): A proprietary file format for the Xcalibur data system suite 
with specific instructions on processing data that was acquired through the instruments 
attached to the system.

• Raw data (.raw): The file type for acquired samples on the system.

• Compound database (.cdb): The file type for TraceFinder or ExactFinder™ compound 
database data.

• Library (.db): A library used for target screening.
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TraceFinder Directory Structure

The application creates folders for batches, methods, and templates in the 
…\TraceFinderData directory. Within each batch folder, the application creates folders for 
data, methods, and reports.

You can create batches in the TraceFinderData\3.3\Projects folder, or you can create 
subfolders within the Projects folder for your batches. You can create as many subfolders as 
you want for your batches, but you cannot create a batch within another batch folder.

Figure 2. Example batch directory structure

TraceFinder Summary of Features
The TraceFinder system provides a workflow-oriented approach to high-throughput 
quantitation, using tools that automate and speed up the processes of method creation, 
loading samples, automatically generating data, manually reviewing and editing results, and 
finalizing the data review and reporting process. 

The TraceFinder software package includes data acquisition, processing, reviewing, and 
reporting capabilities designed to assist analysts in general quantitation applications. The 
application has a fully automated acquisition mode and a manual data analysis mode. You can 
use the data acquisition system to create and submit batches and monitor real-time review of 
results. 

The application uses a comprehensive processing method to provide improved handling of 
ion ratio calculations, reviewing, and reporting. In addition, it can compare the mass spectra 
and integrate the processes of data review and reporting. 

Key features include the following: 

• Role-based authorization for Security, LabDirector, ITAdmin, Supervisor, Technician, 
and QAQC (quality assurance) roles

IMPORTANT  You cannot rename or move the folders created by the TraceFinder 
application.
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• Administrator Console for user security, role-based permissions, and data repositories

• Configuration console for report configuration, detection and acquisition defaults, 
adduct definitions, screening library selection, and customized columns and flags

• Method Development mode for editing instrument methods, setting processing and error 
flag parameters, and setting reporting options

• Acquisition mode that guides you in creating batches and running samples

• Analysis mode with batch views, data review, local method views, and reporting views

• Database-capable method development

• Quantification workflows

• Target screening workflows

• Unknown screening workflows

• Spreadsheet-based report designer

Features of the common workflow core include the following:

• Acquisition and processing

• Peak detection

• Quantification to include calibration

• Error analysis and flag setting

• Reporting

• Data persistence

• Raw data file handling
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TraceFinder Workflow
The application is structured with a typical laboratory workflow in mind. You create a batch, 
and the system injects samples into the instrument, runs the samples, analyzes the data, and 
generates a report. You can set up a master method for specific compound groups or assays 
that you expect to run in your laboratory. When you are ready to run a particular type of 
sample, select the appropriate method and begin. 

When using the application, follow these basic steps:

1. Create and save a master method in the Method Development mode. 

A master method combines the instrument method and processing method that define 
the following:

• How the raw data is acquired and processed

• How the error checking information evaluates the results

• How the results appear in reports

2. Create and submit a batch using the Acquisition wizard. 

A batch lists samples for processing and reporting using a specified method. Each row of a 
batch represents a unique sample. 

3. Monitor the status of the batch in the Real Time Status view. 

The real-time display is visible from all the TraceFinder modes. You can begin another 
batch while you watch the real-time display of the currently acquiring batch.

4. Evaluate the data in the Analysis mode. 

The Analysis mode includes views where you can review batches, batch data, reports, and 
local methods.

5. View and print reports in the Report View of the Analysis mode. 

Use the Report View to view or print the reports for the current batch.

Note  At any time, you can quickly view the system status by looking in the upper 
right corner of the TraceFinder window. This area displays a green, yellow, or red 
status light and a description of any activity in the queues, as in this example:

The status light (in any color) might include an exclamation mark. 

• An exclamation mark on a green status light, , might indicate that the 
instrument method contains the wrong source (for example, APCI instead of 
HESI). 

• An exclamation mark on a red status light, , might indicate that a vial is 
missing and the batch was forced to stop. 

Click the status light to display details of the error.
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Reporting Features
The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The following types of reports meet the requirements of various methods and global 
regulatory agencies, helping to track the performance of LC and GC systems and methods. 

Standard Report Types

• Ad Hoc Tune Report

• Batch Report 

• Blank Report 

• Breakdown Report

• Calibration Report

• Check Standard Report 

• Chromatogram Report 

• Compound Calibration Report 

• Compound Calibration Report - Alternate

• Confirmation Report 

• Confirmation Report 2

• High Density Calibration Report 

• High Density Internal Standard Report Long

• High Density Sample Report 1 Long

• Intelligent Sequencing Report

• Internal Standard Summary Report

• Ion Ratio Failure Report 

• LCSLCSD Report 

• Manual Integration Report 

• Method Detection Limit Report 

• Method Report

• Method Validation Report 

• MSMSD Report

• QC Summary Report
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• Quantitation Report 

• Quantitation Report - 2

• Sample Report

• Solvent Blank Report

• Standard Addition Report

• Surrogate Recovery Report

• Target Screening Height Density Sample Report

• Target Screening Height Density Sample Report 2

• Target Screening Summary Report

• TIC Report

• TIC Summary Report

• Tune Report

• Unknown Screening Summary Report

Use the features in the Report Designer to create custom report types. See Chapter 12, “Using 
the Report Designer.” 
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Getting Started

This chapter includes the procedures for getting started with the TraceFinder application.

Installing the TraceFinder Application
To initially install the TraceFinder 3.3 application, follow the instructions in the TraceFinder 
Installation Guide. Later, you might need to reinstall the application or other features using 
the InstallShield Wizard.

Follow these instructions to reinstall, start, and log in to the application.

 To reinstall the TraceFinder application

1. From the Thermo Foundation Instrument Configuration window, remove all 
instruments.

2. From the Windows Control Panel, uninstall the application and then uninstall all 
Thermo instrument drivers.

3. Insert the TraceFinder CD, and install both the TraceFinder 3.3 application and the 
NIST™ library as follows:

a. Open the TraceFinder launcher and click Next.

Contents

• Installing the TraceFinder Application

• Installing the NIST and QED Libraries

• Launching the NIST Library Browser

• Launching a Qualitative Explorer

• Converting Legacy Data

• Choosing a Mode or Console
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The InstallShield Wizard opens.

b. Click TraceFinder 3.3, and follow the instructions in the InstallShield Wizard.

The installer verifies that you have the appropriate versions of the Thermo 
Foundation™ platform and Xcalibur data system and updates them if necessary. 

c. At the prompt, click Yes to completely remove any previously installed applications.

d. Open the TraceFinder launcher again and click Next.

e. Click TraceFinder 3.3, and follow the instructions in the InstallShield Wizard.

f. When prompted, choose to install either the GC or LC version of the software.

g. When the installation is complete, open the TraceFinder launcher again and click 
Next.

h. When prompted to restart your computer, select the Yes option and click Finish.

IMPORTANT  For the application to properly install, you might be prompted to 
uninstall Foundation platform. Do the following:

1. Click Yes, and then when prompted to restart your computer, click OK. 

The wizard continues the TraceFinder installation.

2. When prompted to install Thermo Foundation, click Yes, and then when 
prompted to restart your computer, click OK. 

The wizard continues the installation.



 2 Getting Started
Installing the TraceFinder Application

Thermo Scientific TraceFinder User Guide 11

3. (Optional) After your system restarts, open the TraceFinder launcher again, click Next, 
and install any of the following: 

a. Click NIST Library and follow the instructions to install it.

b. Click Example Data.

The application installs example compound databases, instrument methods, and 
batch data.

c. Click Library Manager 2.0 and follow the instructions to install the Thermo Library 
Manager application.

4. Install the appropriate device drivers, and configure the instruments in the Thermo 
Foundation Instrument Configuration window.

You can now start the TraceFinder application.

 To start the TraceFinder application

1. Configure your instruments.

You must close the TraceFinder application before you can configure your instruments.

2. Double-click the TraceFinder icon on your desktop, or choose Start > All Programs > 
Thermo TraceFinder 3.3 > TraceFinder 3.3 General Quan. 

By default, user security is not activated and the application does not require a password. 
To activate user security, refer to the TraceFinder Administrator Console User Guide. 

 To log in to the TraceFinder application (when user security is activated)

1. Enter your user name in the TraceFinder login window. See “TraceFinder login window” 
on page 13.

2. Enter your password. 

If your user name or password does not match, the system reports this error:

Correct the user name or password, or contact your system administrator.

3. Click Login.

The TraceFinder login window opens. See TraceFinder main window.

Note  Before you can log in to the application when user security is activated, a system 
administrator must set up a user account for you. 
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Figure 3. TraceFinder main window, showing the Analysis mode for a quantitation batch

Table 1. TraceFinder main window features  (Sheet 1 of 2)

Parameter Description

Modes

Acquisition See Chapter 8, “Using the Acquisition Mode.” 
Analysis See Chapter 9, “Using the Analysis Mode for Quantitation Batches.” 

See Chapter 10, “Using the Analysis Mode for Target Screening Batches.” 

See Chapter 11, “Using the Analysis Mode for Unknown Screening Batches.” 
Method Development See Chapter 4, “Using the Common Features of the Method Development Mode.” 

See Chapter 5, “Using the Method Development Mode for Quantitation Methods.” 

See Chapter 6, “Using the Method Development Mode for Target Screening Methods.” 

See Chapter 7, “Using the Method Development Mode for Unknown Screening Methods.” 
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Figure 4. TraceFinder login window 

Additional Features

A TraceFinder window with user security for a user in the default LabDirector role has these 
functions.

Real Time Status Opens the Real Time Status pane for the current acquisition. The acquisition progress is 
displayed within the current mode window. 

CurrentUserName Displays the name of the current user. 
Log Off Logs off the current user and displays the login screen. This function is available only when 

user security is activated. 
Help Opens the TraceFinder Help. 
Application 
Configuration 

Opens the Configuration console where you can configure several options for using the 
application. See Chapter 3, “Using the Configuration Console.” 

Table 1. TraceFinder main window features  (Sheet 2 of 2)

Parameter Description

Table 2. Login window parameters

Parameter Description

Domain The authentication method.
Username The user’s assigned user name.
Password The assigned password for the user name.
Login Verifies the user name and password, and opens the application.
Exit Closes the TraceFinder login window.



2 Getting Started
Installing the NIST and QED Libraries

14 TraceFinder User Guide Thermo Scientific

Installing the NIST and QED Libraries
When you are using triple quadrupole instruments, such as the TSQ Quantum XLS, follow 
these instructions to install the NIST and QED libraries. 

 To install the NIST library

1. Open the TraceFinder launcher, and click Next.

2. Click NIST Library.

The NIST 08 MS Search and AMDIS Setup wizard opens.

3. Follow the instructions in the setup wizard.

4. When the wizard prompts you to select a destination folder, select 
C:\Program Files\NISTMS.

5. Continue to follow the instructions in the wizard until the setup is complete.

 To install the QED library

1. On your desktop, double-click the Xcalibur icon, .

The Thermo Xcalibur Roadmap opens.

Note  The application installs the NIST 2008 library; however, it also supports the 
NIST 2011 and NIST 2014 libraries.
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2. Choose Tools > Library Manager from the main menu. 

The Thermo Library Manager dialog box opens, showing the NIST Libraries list.

3. Click Add.

The Add Library dialog box opens.

4. Click Browse, and locate your QED library in the C:\Thermo folder.

5. Click OK.

The Xcalibur data system reports that it has added the library to the NIST application.

6. Click Dismiss to close the message box.

The Xcalibur data system adds the QED library to the NIST Libraries list in the Library 
Manager dialog box.
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7. Click Exit in the Thermo Library Manager dialog box.

8. To confirm the library installation, do the following:

a. Start the application.

b. Click Method Development in the navigation pane.

c. Click Method View in the Method Development navigation pane.

d. Choose File > New > Method Template from the main menu.

The Method Template Editor displays the QED NIST Library in the Use These 
Libraries list.
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Launching the NIST Library Browser
Use the NIST MS Search tool to search the NIST library.

 To open the NIST library browser

Choose Tools > Launch Library Browser from the TraceFinder main menu.

The NIST MS Search window opens.

For detailed instructions about using the library browser, refer to the Help in the NIST MS 
Search window.
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Launching a Qualitative Explorer
Use a qualitative explorer application to display chromatograms and spectra, detect 
chromatogram peaks, search libraries, simulate spectra, subtract background spectra, apply 
filters, add text and graphics, create and save layouts, and view instrument parameters as they 
changed during the acquisition.

Your TraceFinder application is configured to use one of the following applications:

• Thermo Scientific FreeStyle

• Thermo Xcalibur Qual Browser

Thermo Scientific FreeStyle

 To open the FreeStyle window

Choose Tools > Launch Qual Explorer from the TraceFinder main menu.

The Thermo Scientific FreeStyle application opens.

Figure 5. FreeStyle main window

For detailed instructions about using the FreeStyle application, click the Help icon, , in 
the FreeStyle window.

IMPORTANT   The FreeStyle™ application is available only when you configure it as your 
default qualitative explorer in the Configuration Console. See Chapter 3, “Using the 
Configuration Console.” 
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Thermo Xcalibur Qual Browser 

 To open the Qual Browser window

Choose Tools > Launch Qual Explorer from the TraceFinder main menu.

The Thermo Xcalibur Qual Browser application opens.

Figure 6. Qual Browser main window

For detailed instructions about using the Qual Browser application, refer to the Help in the 
Qual Browser window.

IMPORTANT   The Qual Browser application is available only when you configure it as 
your default qualitative explorer in the Configuration Console. Chapter 3, “Using the 
Configuration Console.” 
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Converting Legacy Data
Use the TraceFinder Legacy Data Converter to convert methods, batches, method templates, 
batch templates, or compound databases (CDBs) from the source versions to compatible 
TraceFinder 3.3 target configurations. 

• You can convert legacy methods, batches, or method templates from TraceFinder versions 
2.1, 3.0, 3.1, or 3.2.

• You can convert legacy batch templates from TraceFinder versions 3.0, 3.1, or 3.2.

• You can convert legacy compound databases from Thermo ToxFinder™ version 1.0 or 
from TraceFinder versions 3.0, 3.1, or 3.2.

• You can convert data from TraceFinder version 3.3 for general quantitation to another 
installed configuration of TraceFinder 3.3.

Version Compatibility

This table shows which source versions of methods, batches, method templates, batch 
templates, or compound databases are compatible with TraceFinder 3.3 target configurations. 

Table 3. Version compatibility 

Source  TraceFinder 3.3 target 

General EFSa

a Environmental and Food Safety

 Clinical 
Research

 Forensic 
Toxicology

TraceFinder 3.3 General   

TraceFinder 3.2 General   

TraceFinder 3.2 EFS 

TraceFinder 3.2 Clinical Research  

TraceFinder 3.2 Forensic Toxicology  

TraceFinder 3.1 General   

TraceFinder 3.1 EFS 

TraceFinder 3.1 Clinical Research  

TraceFinder 3.1 Forensic Toxicology  

TraceFinder 3.0 General    

TraceFinder 3.0 EFS 

TraceFinder 3.0 Clinical Research  

TraceFinder 3.0 Forensic Toxicology  

TraceFinder 2.1 General    

TraceFinder 2.1 EFS 

TraceFinder 2.1 Clinical Research  

TraceFinder 2.1 Forensic Toxicology  
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See the following topics:

• Converting Methods 

• Converting Batches

• Converting Method Templates

• Converting Batch Templates

• Converting Compound Databases

 To open the TraceFinder Legacy Data Converter

Choose Tools > Launch Legacy Data Converter from the TraceFinder main menu.

The TraceFinder Legacy Data Converter window opens.

Note  When you open the application, the system checks for any legacy data and 
prompts you to open the Legacy Data Converter.
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Converting Methods

Use the data converter to convert legacy methods to TraceFinder 3.3 methods. 

 To convert a method 

1. In the Data Type list, select Method.

The TraceFinder Legacy Data Converter displays the interface for converting methods. 

The following example shows that you can convert methods from the TraceFinder 3.2 
General configuration to the current General configuration. For a complete list of version 
compatibilities, see “Version Compatibility” on page 20.

2. In the Source Version list, select the version of the method that you will convert.

The conversion table displays the methods in the Methods folder for the selected source 
version. The application verifies that the method file is in the .mmx file format.

3. To convert a method that is not in the default list, do the following:

a. Click Browse and locate a different source method folder.

You can select a specific method folder or a folder that contains multiple methods. 

b. Click OK in the Browse for Folder dialog box.

The application displays the selected method folder in the conversion table. 

When you select a folder that contains multiple method folders, the application displays 
all the methods.

4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
Compatibility” on page 20.

5. (Optional) In the Target Name column, change the default new name for each method 
that you want converted.

Note  When you select Any Legacy, the Legacy Data Converter examines all possible 
methods in the source folder, regardless of version.
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When you populate the conversion table, the application checks each method to see if a 
method with this name exists in the target repository. 

• If the method name already exists in the target repository, the default new name 
appends “_1” to the original name. 

• If the method name does not exist in the target repository, the application keeps the 
original method name.

6. Select the Convert check box for each method that you will convert, and click 
.

The application confirms that all methods to be converted use the .mmx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the method that is currently 
converting.

When the Status column reports that a method is successfully converted, the application 
writes the converted file to the specified target repository.

7. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Microsoft Notepad text 
editor window.

Figure 7. Sample log file for converting a method

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing method file, the conversion will not work. When you 
manually enter a new name, you must verify that the name does not already exist.

Note   If a method conversion is unsuccessful, the Status column displays “Conversion 
failed.” The log file contains details about the failed conversion.
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Converting Batches

Use the data converter to convert legacy batches to TraceFinder 3.3 batches.

 To convert a batch

1. In the Data Type list, select Batch.

The following example shows that you can convert batches from the TraceFinder 3.2 
General configuration to the current General configuration. For a complete list of version 
compatibilities, see “Version Compatibility” on page 20.

2. In the Source Version list, select the version of the batch that you will convert.

The conversion table displays all batches in the Projects folder for the selected source 
version.

3. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
Compatibility” on page 20.

4. In the Target Default Project and Subproject boxes, type the name of a project and 
subproject, or select the Replicate Original Project/Subproject check box.

5. (Optional) In the New Name column, change the default new name for each batch that 
you want converted.

When you populate the conversion table, the application checks each batch to see if a 
batch with this name exists in the target repository. 

• If the batch name already exists in the target repository, the default new name 
appends “_1” to the original name. 

• If the batch name does not exist in the target repository, the application keeps the 
original batch name.

Note  When you select Any Legacy, the Legacy Data Converter examines all possible 
batches in the source folder, regardless of version.

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing batch folder, the conversion will not work. When you 
manually enter a new name, you must verify that the name does not already exist.
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6. Select the Convert check box for each batch that you will convert, and click 
.

The application confirms that all batches to be converted use the .btx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the batch that is currently 
converting.

When the Status column reports that a batch is successfully converted, the application 
writes the converted batch to the …\TraceFinderData\3.3\Projects folder and uses either 
the original project and subproject names or the new names that you entered.

7. To view a log of the conversion, click View Log.

Figure 8. Sample log file for converting a batch

Note   If a batch conversion is unsuccessful, the Status column displays “Conversion 
failed.” The log file contains details about the failed conversion.
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Converting Method Templates

Use the data converter to convert legacy method templates to TraceFinder 3.3 method 
templates.

 To convert a method template

1. In the Data Type list, select Method Template.

The following example shows that you can convert method templates from the 
TraceFinder 3.2 General configuration to the current General configuration. For a 
complete list of version compatibilities, see “Version Compatibility” on page 20.

2. In the Source Version list, select the version of the method template that you will convert.

The conversion table displays the method templates in the Templates folder for the 
selected source version. The application verifies that the method template file is in 
the .pmtx file format.

3. To convert a method template that is not in the default list, do the following:

a. Click Browse and locate a template folder.

You can select a specific template folder or a folder that contains multiple templates. 

b. Click OK in the Browse for Folder dialog box.

The application displays the selected folder in the conversion table. 

When you select a folder that contains multiple method template folders, the application 
displays all the method templates.

4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
Compatibility” on page 20.

5. (Optional) In the Target Name column, change the default name for each method 
template that you want converted.

Note  When you select Any Legacy, the Legacy Data Converter examines all possible 
method templates in the source folder, regardless of version.
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When you populate the conversion table, the application checks each method template to 
see if a method template with this name exists in the target repository. 

• If the method template name already exists in the target repository, the default new 
name appends “_1” to the original name. 

• If the method template name does not exist in the target repository, the application 
keeps the original method template name.

6. Select the Convert check box for each method template that you will convert, and click 
.

The application confirms that all method templates to be converted use the .pmtx file 
format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.

When the Status column reports that the template is successfully converted, the 
application writes the converted template to the specified target repository.

7. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Notepad text editor 
window.

Figure 9. Sample log file for converting a method template

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing method template file, the conversion will fail. When you 
manually enter a new name, you must verify that the name does not already exist.

Note   If a template conversion fails, the Status column displays “Conversion failed.” 
The log file contains details about the failed conversion.
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Converting Batch Templates

Use the data converter to convert legacy batch templates to TraceFinder 3.3 batch templates.

 To convert a batch template

1. In the Data Type list, select Batch Template.

The following example shows that you can convert batch templates from the TraceFinder 
3.2 General configuration to the current General configuration. For a complete list of 
version compatibilities, see “Version Compatibility” on page 20.

2. In the Source Version list, select the version of the batch template that you will convert.

The conversion table displays the batch templates in the Templates folder for the selected 
source version.

3. To convert a batch template that is not in the default list, do the following:

a. Click Browse and locate a template folder.

You can select a specific batch template folder or a folder that contains multiple batch 
templates. 

b. Click OK in the Browse for Folder dialog box.

The application displays the selected folder in the conversion table. 

When you select a folder that contains multiple batch template folders, the application 
displays all the batch templates.

4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
Compatibility” on page 20.

5. (Optional) In the New Name column, change the default new name for each batch 
template that you want converted.

When you populate the conversion table, the application checks each batch template to 
see if a batch template with this name exists in the target repository. 

• If the batch template name already exists in the target repository, the default new 
name appends “_1” to the original name. 

Note  When you select Any Legacy, the Legacy Data Converter examines all possible 
batch templates in the source folder, regardless of version.
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• If the batch template name does not exist in the target repository, the application 
keeps the original batch template name.

6. Select the Convert check box for each batch template that you will convert, and click 
.

The application confirms that all batch templates to be converted use the .btx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.

When the Status column reports that the template is successfully converted, 
the application writes the converted template folder to the 
…\TraceFinderData\3.3\Templates\Batches folder. 

7. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Notepad text editor 
window.

Figure 10. Sample log file for a failed batch template conversion

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing batch template file, the conversion will fail. When you 
manually enter a new name, you must verify that the name does not already exist.

Note   If a template conversion fails, the Status column displays “Conversion failed.” 
The log file contains details about the failed conversion.
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Converting Compound Databases

Use the data converter to convert legacy compound databases to TraceFinder 3.3 compound 
databases.

 To convert compound databases

1. Click Convert CDBs (in the upper right corner of the window).

The Confirm dialog lists all databases that will be converted to TraceFinder 3.3.

2. Click Yes.

The Confirm dialog lists all databases that are converted to TraceFinder 3.3.

3. Click OK.

The converted compound databases are now available in the TraceFinder 3.3 application.

Note   If your window is too narrow, you might not see the Convert CDBs button. 
Widen the window to expose the button in the upper right corner.
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Choosing a Mode or Console
When user security is activated, the navigation pane displays the modes and consoles available 
to the current user’s assigned roles and permissions. The following table shows the available 
modes and consoles for each user role.
 

Follow these procedures:

• To choose a mode

• To open the Configuration console

• To open the Administrator Console

• To display a log of instrument errors

• To monitor instrument status

• To watch acquisition and processing in real time

Table 4. User roles and default access

User role Method 
Development Acquisition Analysis  Configuration 

Console
 Administrator 

Console

Security Security only

LabDirector     

ITAdmin 

Supervisor     

Technician  

QAQC 

Note  When user security is not activated, all modes and consoles are available to all users.
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 To choose a mode 

In the navigation pane, click the mode where you want to work.

The navigation pane shows only the modes that you have permission to use. 

 To open the Configuration console

Click the Application Configuration icon, , in the upper right corner of the 
TraceFinder window.

When user security is activated, you must have Configuration permissions to access the 
Configuration Console. See Chapter 3, “Using the Configuration Console.” 

Mode Description

Acquisition Opens the Acquisition mode where you can create and review batches, 
batch data, reports, and local methods. 

See Chapter 8, “Using the Acquisition Mode.” 

Analysis Opens the Analysis mode where you can review batches, batch data, 
reports, and local methods. 

See Chapter 9, “Using the Analysis Mode for Quantitation Batches.” 

See Chapter 10, “Using the Analysis Mode for Target Screening 
Batches.” 

See Chapter 11, “Using the Analysis Mode for Unknown Screening 
Batches.” 

Method 
Development

Opens the Method Development mode where you can create a master 
method or an instrument method. 

See Chapter 4, “Using the Common Features of the Method 
Development Mode.” 

See Chapter 5, “Using the Method Development Mode for 
Quantitation Methods.” 

See Chapter 6, “Using the Method Development Mode for Target 
Screening Methods.” 

See Chapter 7, “Using the Method Development Mode for Unknown 
Screening Methods.” 
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 To open the Administrator Console

Choose Tools > Administrator Console from the TraceFinder main menu.

When user security is activated, you must have Administrator permissions to access the 
Administrator Console. Refer to the TraceFinder Administrator Console User Guide.

 To display a log of instrument errors 

1. Click the status light in the upper right corner of the TraceFinder window.

The Instrument Log dialog box opens.

The Instrument Log displays all instrument errors that have occurred since the 
application started or since the last time that you cleared the message log.

2. Do any of the following:

• Click Refresh to display errors that occur after you open the Instrument Log dialog 
box.

• Click Clear Messages to remove messages from the Instrument Log display.

The application clears messages only from the Instrument Log display. These 
messages remain in the following log file:

C:\Thermo\TraceFinder\3.3\General\Logs\TraceFinder.log 

• Click OK to dismiss the Instrument Log dialog box.

 To monitor instrument status

Look at the status light in the upper right corner of the TraceFinder window.

 Green indicates that the instrument is ready.

 Yellow indicates that the instrument is in standby mode, waiting for contact 
closure, or warming up the lamp.

 Red indicates that the instrument is not ready because it is turned off, not
configured or connected, currently initializing, or otherwise busy. 

Status light
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The status light (in any color) might include an exclamation mark. 

• An exclamation mark on a green status light, , might indicate that the 
instrument method contains the wrong source (for example, APCI instead of HESI). 

• An exclamation mark on a red status light, , might indicate that a vial is missing 
and the batch was forced to stop. 

Click the status light to display details of the error.

 To watch acquisition and processing in real time

Click Real Time Status in the upper right corner of the TraceFinder window.

The application displays the Real Time Status pane at the bottom of the window.

For descriptions of all the features of the Real Time Status pane, see “Real Time Status 
Pane” on page 388. 
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3

Using the Configuration Console

This chapter discusses the features of the Configuration console. When user security is 
activated, you must have Configuration permissions to access the features in the 
Configuration console. 

If you are a member of the local administrator’s group and are launching the TraceFinder 
application for the first time, by default, you have LabDirector permissions. For information 
about groups and permissions, refer to the TraceFinder Administrator Console User Guide.

Using the features in the Configuration console, you can do any of the following:

• Activate features, such as multiplexing, intelligent sequencing, qualitative browsers, and 
screening libraries.

• Select the reports that are available to users, the detector types, and the algorithms used 
for peak detection. 

• Customize adduct definitions, additional sample grid columns, and flags.

Contents

• Specifying Application Defaults

• Specifying Default Peak Detection Parameters

• Specifying Adducts

• Activating Optional Features

• Creating Custom Columns

• Creating Custom Flags

• Specifying the Reports
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 To access the Configuration console 

Click the Application Configuration icon, , in the upper right corner of any 
window.

The TraceFinder Configuration console opens.

Table 5. Navigation pane functions in the Configuration console 

Function Description

Defaults Use the Defaults view to specify the default laboratory and 
instrument names, the displayed mass precision, and the intensity 
scale to use for reporting. See “Specifying Application Defaults” on 
page 37.

Peak Detection 
Defaults 

Use the Peak Detection Defaults view to specify a peak detection 
algorithm and its options and to determine the area under a curve. 
See “Specifying Default Peak Detection Parameters” on page 39.

Adducts Use the Adducts view to specify the adducts that will be available for 
use in method development. See “Specifying Adducts” on page 53.

Optional 
Features

Use the Optional Features view to enable features, such as quick 
acquisition, multiplexing, intelligent sequencing, and screening 
libraries. See “Activating Optional Features” on page 56.

Custom 
Columns

Use the Custom Columns view to add six additional columns to the 
samples list in batches. See “Creating Custom Columns” on 
page 63.

Flag 
Customization

Use the Flag Customization view to customize error flags and 
conditions to indicate compound errors in Data Review for 
quantitation batches. See “Creating Custom Flags” on page 65.

Reports Use the Reports view to configure which reports are available to 
users. See “Specifying the Reports” on page 71.
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Specifying Application Defaults
Use the Application – Defaults view of the Configuration console to specify the default 
laboratory and instrument names, the displayed mass precision, and the chromatogram 
intensity scale to use for reporting. When user security is activated, you must have 
Configuration – Defaults permission to access these features.

Follow these procedures:

• To open the Defaults view

• To specify a default laboratory name and instrument name

• To specify default mass precision and the intensity scale

 To open the Defaults view

In the navigation pane for the Configuration console, click Defaults.

The Application – Defaults view opens.

 To specify a default laboratory name and instrument name

1. Type the name of your laboratory in the Lab Name box.

When you create a method, the application uses this default laboratory name for the 
Laboratory Name value on the Processing page of the Method View. The application uses 
this laboratory name in the report headings. 

The application does not apply this default laboratory name to previously created 
methods. By default, the laboratory name is Default Laboratory.

2. Type the name of your instrument in the Instrument Name box.

When you create a batch, the application uses this default instrument name for the 
Instrument Name value. The application uses this instrument name in the report 
headings.

3. To save your changes, click Apply.

The application does not apply this default instrument name to previously created 
batches. By default, the instrument name is Thermo Scientific Instrument.
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 To specify default mass precision and the intensity scale

1. In the Display Mass Precision box, set the decimal value for the mass precision to an 
integer from 2 to 6, inclusive.

The default number of digits to display is 2. The application uses this mass precision 
value to display mass values in the following locations: 

• Reports:
– Blank Report
– Confirmation Report (data spectra, library spectra, quantitation ion display, and 

qualitative ion display)
– All High Density reports (m/z values)
– Ion Ratio Failure Report (quantitation ion and qualitative ion)
– Manual Integration Report (m/z value)
– Quantitation Report (QIon)

• All peaks on the Detection pages in the Method Development mode
• The spectrum display in Data Review in the Analysis mode
• The spectrum display in the Method Forge dialog box

2. Select either the Relative or Absolute option for the Chromatogram Intensity Scale.

This sets the default display type for both quantitation and qualitative chromatograms 
displayed in data review and reports. 

3. To save your changes, click Apply.

IMPORTANT  When you create a method using a raw data file, the application reads 
the filter precision value from the raw data file to create scan filters; however, the 
application uses the Display Mass Precision value when showing masses that are not 
embedded within filter strings and masses that are displayed on spectral plots.
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Specifying Default Peak Detection Parameters
When user security is activated, you must have Configuration – Peak Detection Defaults 
permission to access default peak detection parameters for the Genesis, ICIS, or Avalon 
detection algorithms.

Use the Peak Detection Defaults view to specify a peak detection algorithm and its options 
and to determine the area under a curve. These parameters are available for quantitation 
methods only.

The following topics include procedures for specifying common peak detection parameters 
and the parameters used for each of the following detection algorithms:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method

 To open the Peak Detection Defaults view

In the navigation pane for the Configuration console, click Peak Detection Defaults.

The Application – Peak Detection Defaults view opens. 

• For parameter information about all detection algorithms, see “Common Peak 
Detection Parameters” on page 41.

• For parameter information about the Genesis detection algorithm, see “Genesis 
Detection Method” on page 43.

• For parameter information about the ICIS detection algorithm, see “ICIS Detection 
Method” on page 46.

• For parameter information about the Avalon detection algorithm, see “Avalon 
Detection Method” on page 49.

 To specify common detection parameters

1. In the Detector Type list, select a detector type.

For detailed descriptions of the available detector types, see “Common Peak Detection 
Parameters” on page 41.

2. In the Mass Tolerance area, do the following:

a. Select the unit of measure that you want to use (MMU or PPM). 

b. In the Value box, specify the number of millimass units or parts per million to use as 
the upper limit.

The application applies this mass tolerance to the extracted chromatograms. The default 
is 500 MMU.
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3. In the Retention Time area, do the following:

a. In the Window box, specify the width of the window (in seconds) to indicate how far 
around the expected retention time the system will look for a peak apex. 

b. In the View Width box, specify the viewable size (in minutes) of the ion 
chromatogram display. 

4. In the Ion Ratio Parameters area, do the following:

a. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

b. In the Window box, select the acceptable ion ratio range. 

c. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

5. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

6. Specify the parameters for the selected detection algorithm.

For detailed parameter descriptions, see one of the following:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method
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Common Peak Detection Parameters

All of the detection algorithms use the Detector Type, Mass Tolerance, Retention Time, and 
Ion Ratio detection parameters.

Figure 11. Common peak detection areas

Table 6. Common peak detection parameters  (Sheet 1 of 2)

Parameter Description

Detector Type MS: Mass spectrometer that ionizes sample molecules and then 
separates the ions according to their mass-to-charge ratio (m/z).

PDA: Photodiode array detector providing a linear array of discrete 
photodiodes on an integrated circuit chip. It is placed at the image 
plane of a spectrometer so that a range of wavelengths can be 
simultaneously detected.

Analog: Supplemental detectors (for example, FID, ECD). When 
you select this detector, any reports that display a QIon value show 
the value as Analog and any reports that display spectra show the 
spectra as Not Available.

A/D card: If your detector is not under data system control, you can 
capture the analog signal and convert it to digital using an interface 
box (for example, SS420X) for storage in the raw data file.

UV: A UV spectrophotometer (for variable-wavelength detection) or 
photometer (for single-wavelength detection) equipped with a 
low-volume flow cell. This detector detects analytes that readily 
absorb light at a selected wavelength.
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Mass Tolerance

Units • (Default) MMU (millimass units) 
MMU is a static calculation to the extracted mass.

• PPM (parts per million) 
PPM is a variable calculation dependent on the actual mass. The 
smaller the mass, the narrower the tolerance range. The larger the 
mass, the wider the tolerance range.

Value Upper limit of MMU or PPM.

Valid range: 0.1 through 50 000
Default: 500

Retention Time

Window (sec) Width of the window (in seconds) to indicate how far around the 
expected retention time the system will look for a peak apex. 

View Width (min) Viewable size (in minutes) of the ion chromatogram display. 
Changing the view width does not affect the process of peak 
detection; the application uses it only for graphical display. 

Ion Ratio 
Parameters

Window Type The absolute or relative calculation approach for determining the 
acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion Coelution (min) The maximum difference in retention time between a confirming ion 
peak and the quantification ion peak.

Table 6. Common peak detection parameters  (Sheet 2 of 2)

Parameter Description
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Genesis Detection Method

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur 1.0 studies. 

Figure 12. Genesis peak detection

Table 7. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the Genesis peak detection algorithm.

Detection Method Specifies the detection method used for component identification.

Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.
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Smoothing Specifies the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1

S/N threshold Specifies the current signal-to-noise threshold for peak integration. 
Peaks with signal-to-noise values less than this value are not 
integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 

Valid range: 0.0 through 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected Width (sec) Specifies the expected peak width parameter (in seconds). This 
parameter controls the minimum width that a peak is expected to 
have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the application 
terminates the peak at that point. The application always 
terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
threshold and a tailing factor. Selecting the Constrain Peak Width 
check box activates the Peak Height (%) and Tailing Factor 
options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Table 7. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description



 3 Using the Configuration Console
Specifying Default Peak Detection Parameters

Thermo Scientific TraceFinder User Guide 45

Tailing Factor Specifies the tailing factor that controls how the application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This 
text box is active only when you select the Constrain the Peak 
Width check box. 

Valid range: 0.5 through 9.0

Peak S/N Cutoff Sets the peak edge to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the application defines the right and left edges of the peak 
when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) Specifies that the peak trace can rise above the baseline by this 
percentage after passing through a minimum (before or after the 
peak). This criteria is useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the application applies 
valley detection peak integration criteria. This test is applied to 
both the left and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Specifies the number of background scans performed by the 
application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 7. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 13. ICIS peak detection 

Table 8. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Detection Method Specifies the detection method used for component identification.

Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.
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Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1 

Area Noise Factor Specifies the noise level multiplier used to determine the peak edge 
after the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5

Peak Noise Factor Specifies the noise level multiplier used to determine the potential 
peak signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window Specifies that the application looks for a local minima over this 
number of scans. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) Specifies that the signal must be above the baseline percentage of 
the total peak height (100%) before integration is turned on or 
off. This text box is active only when you select the Constrain Peak 
Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor Specifies the tailing factor that controls how the application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This 
text box is active only when you select the Constrain the Peak 
Width check box. 

Valid range: 0.5 through 9.0

Table 8. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Noise Method Specifies the noise method as INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Min Peak Width Specifies the minimum number of scans required in a peak. The 
ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution Specifies the minimum separation in scans between the apexes of 
two potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension Specifies the number of scans past the peak endpoint to use in 
averaging the intensity. The ICIS peak detection algorithm uses 
this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window Specifies the number of allowable scans on each side of the peak 
apex. A zero value defines all scans (peak-start to peak-end) to be 
included in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculate noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 8. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 14. Avalon peak detection 

Table 9. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Detection Method Specifies the detection method used for component identification.
Highest peak: Uses the highest peak in the chromatogram for 
component identification. 
Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters. See Avalon Event List.
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 15. Avalon Event List dialog box

Table 10. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types.” 

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 16. Event types

Table 11. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold Specifies the peak-to-peak resolution threshold controls how much 
peak overlap must be present before two or more adjacent peaks 
create a peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off



3 Using the Configuration Console
Specifying Default Peak Detection Parameters

52 TraceFinder User Guide Thermo Scientific

Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Specifies that you can tangent skim any peak clusters. By default, it 
chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Forces the following peaks to be treated as a cluster (single peak).

Force Cluster Off Ends the forced clustering of peaks.

Disable Cluster On Prevents any peaks from being clustered.

Disable Cluster Off Permits clusters to occur again.

Table 11. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Specifying Adducts
An adduct ion is formed from a precursor ion and contains all of the constituent atoms of that 
ion and additional atoms or molecules. Adduct ions are often formed in the mass 
spectrometer ion source. Adducts can be either positive or negative.

Use the Application – Adducts view to specify the adducts that will be available for you to use 
in method development. When user security is activated, you must have 
Configuration – Adducts permission to access these features.

Follow these procedures:

• To open the Adducts view

• To add an adduct

• To remove an adduct

 To open the Adducts view

In the navigation pane for the Configuration console, click Adducts.

The Application – Adducts view opens, displaying the default positive and negative 
adducts.

 To add an adduct

1. In the Positive Adducts or Negative Adducts pane, click the Add New Adduct icon, .

The application adds a new, editable row at the bottom of the Adducts list.
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2. Type the formula for the new adduct ion.

The formula syntax is alphanumeric and case sensitive. It can include parentheses and 
brackets.

The formula specifies the difference between the neutral molecule and the charged ion 
that you expect to see in the results.

For example, a sodium adduct has [M+Na]+ as the expected charged ion (where M is the 
neutral molecule), so you would type “Na” for the formula. A water adduct has 
[M+H+H2O]+ as the expected charged ion, so you would type “H3O” for the formula.

The application displays a type and neutral mass for the adduct formula you entered.

3. Select the default name (New Adduct) and type a name for the adduct.

You cannot change the type or neutral mass, but the application will correctly calculate 
these values later.

4. Press ENTER.

The application adds the adduct to the adducts list and calculates the correct type (Gain 
or Loss) and the neutral mass.

These adducts are available for you to select in the Compound Database view of the 
Method Development mode when you specify parameter values for target peaks. 

IMPORTANT  When you create an adduct formula, you can type both uppercase and 
lowercase letters; however, the application interprets all uppercase input as 
single-letter elements and all lowercase input as two-letter elements. 

For example, it interprets the string “inau” as In Au and “COSI” as C O S I.
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 To remove an adduct

1. In the Positive Adducts or Negative Adducts pane, select the adduct that you want to 
remove.

2. Press DELETE and confirm that you want to delete the selected adduct.

You can delete only adducts that you added to the adducts list. You cannot delete default 
adducts defined by the TraceFinder installation.
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Activating Optional Features 
When user security is activated, you must have Configuration – Optional Features permission 
to access these features.

Use the Application – Optional Features view to activate the following features:

• Quick Acquisition

• Delay Calibration

• User Peak Detection Settings

• Autosampler Tray Configuration

• Acquisition Submission Options

• Qualitative Explorer

• Screening Libraries

• Multiplexing

• Intelligent Sequencing

• Processing Options

 To open the Optional Features page

In the navigation pane for the Configuration console, click Optional Features.

The Application – Optional Features page opens. 
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Quick Acquisition

The quick acquisition option activates the Quick Acquisition feature in the Acquisition, 
Analysis, or Method Development mode.

 To activate quick acquisition

1. Select the Quick Acquisition Allowed check box.

2. To save your changes, click Apply.

The application immediately applies this feature change.

For a description of the Quick Acquisition features, see Appendix A, “Using Quick 
Acquisition.” 

Delay Calibration 

You can determine when the application calculates the calibration curve, using the Delay 
Calibration option. Delaying the recalibration until the application processes the last 
calibration sample in a batch is faster but less responsive than recalibration after each 
calibration sample.

 To delay calculation of a calibration curve

1. Select the Delay Calibration check box.

2. To save your changes, click Apply.

The application immediately applies this feature change.

User Peak Detection Settings 

Use the User Peak Detection Settings Allowed option to let users modify the method 
integration settings for specific compounds in Data Review. 

 To allow users to modify peak detection settings

1. Select the User Peak Detection Settings Allowed check box.

2. To save your changes, click Apply.

The application immediately applies this feature change.

Autosampler Tray Configuration

By default, the TraceFinder application lets the autosampler automatically determine the tray 
configuration. When you are using a Waters™ Acquity™ system, you must make this feature 
unavailable and explicitly specify the tray configuration when you create a batch.
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 To disallow automatic tray configuration

1. Select the Allow Auto Sampler to Automatically Determine … check box.

2. To save your changes, click Apply.

The application immediately applies this feature change.

Acquisition Submission Options 

To control acquisitions, you can activate either submission option: full-sequence or 
single-sample. When you submit batches from the Acquisition mode or Quick Acquisition 
batches from any mode, they run in first-in-last-out order. The last batch submitted is the first 
batch to run, unless you submit a batch as a priority batch in Acquisition mode.

• When you use Full Sequence Submission, priority batches always run immediately after 
the currently acquiring batch is completed.

• When you use Single Sample Submission, priority batches always run immediately after 
the currently acquiring sample is completed.

 To specify acquisition submission features

1. Select either the Full Sequence Submission or the Single Sample Submission option:

• Full Sequence Submission: Supports look-ahead features of the autosampler. When 
the instrument method specifies the look-ahead feature, the application functions like 
a multiplex driver and feeds the autosampler the next vial position.

When you submit a batch, the autosampler begins preparing for all sample injections 
when the pre-run condition begins. All samples in the batch must be completed 
before other batches (even higher priority batches) can begin.

• Single Sample Submission: Supports intelligent-sequencing features. When you 
submit a batch, the autosampler begins preparing for one sample injection at a time. 
Higher priority batches can interrupt the sample sequence in the currently acquiring 
batch.

2. To save your changes, click Apply.

You must restart the application to apply this feature change.

Note  The Full Sequence Submission feature is not available when you activate 
Intelligent Sequencing. 

Note  The Single Sample Submission feature is not available when you activate 
Multiplexing. See “Multiplexing” on page 61.
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Qualitative Explorer

You can use either the FreeStyle application or Qual Browser to display chromatograms and 
spectra, detect chromatogram peaks, search libraries, simulate spectra, subtract background 
spectra, apply filters, add text and graphics, create and save layouts, and view instrument 
parameters as they changed during the acquisition. 

 To specify a qualitative explorer 

Select either the Thermo FreeStyle or the Thermo Xcalibur Qual Browser option.

Screening Libraries

Use the specified screening libraries for both quantitation methods and target screening 
methods. For more information about how you can use screening libraries in a quantitation 
method, see “Screening Libraries in a Quantitation Method” on page 60. For more 
information about how you can use screening libraries in a target screening method, see 
“Screening Libraries in a Target Screening Method” on page 61. 

When you specify the Library Search Type on the Processing page for a target screening 
method, you choose either the Library Manager search type or the NIST search type. See 
“Editing the Acquisition Page” on page 261.

• When you choose Library Manager as the Library Search Type for a quantitation or target 
screening method, the application uses the Library Manager library file (.db) specified in 
the Configuration console. You can search only one spectral library when you process a 
sample.

• When you choose NIST as the Library Search Type for the method, the application uses 
the NIST libraries specified in the Configuration console. You can choose to search 
multiple NIST libraries when you process a sample.

 To specify a Library Manager screening library

Click Browse and locate the library that you want to use for screening.

Note  You can access the explorer by choosing Tools > Launch Qual Explorer in the 
main TraceFinder menu. See “Launching a Qualitative Explorer” on page 18.

Note  You can use only one search type when you process a sample. When you select 
NIST as the Library Search Type in your method, the application does not use the 
screening library that you specify here.
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 To specify a NIST screening library

1. Click Select.

The Select NIST Libraries dialog box opens, listing the libraries you installed for the 
application.

2. Select the check box for each NIST library that you want to use for screening and click 
OK.

3. To save your changes, click Apply.

The application immediately applies this feature change.

The application searches the specified screening library to identify or confirm a sample 
compound, matches the fragment ion spectrum in the library to the compound’s ion 
spectrum, and returns the highest score (best match).

The application performs either a forward library search or a reverse library search. A forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry, whereas a reverse search compares a library entry to an unknown compound.

Screening Libraries in a Quantitation Method

In a quantitation master method, you can enable library matching and set a score threshold to 
minimize poor matches. See “Library” on page 196. To match a compound, the resulting 
score from a library search must be higher than the specified threshold value.

Note  You can use only one search type when you process a sample. When you select 
Library Manager as the Library Search Type in your method, the application does not 
use the NIST libraries that you specify here.
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Screening Libraries in a Target Screening Method

In a target screening master method, you can specify the library search to either identify or 
confirm library matches and set a score threshold to minimize poor matches. See “Editing the 
Processing Page” on page 264.

• Identify or Confirm: The application identifies or confirms the sample compound by 
searching the specified search library and returning the highest score (as a percentage 
value) for the fragment ion spectrum in that library that matches the compound’s ion 
spectrum. 

• Score Threshold: To identify or confirm the presence of a compound, the resulting score 
from a library search must be higher than the specified threshold value. 

Screening Libraries in an Unknown Screening Method

Unknown screening methods do not use screening libraries.

Multiplexing

The application uses multiplexing features in the Acquisition mode when you specify 
channels for a sample in a batch (see “Defining a Sample List” on page 360) or monitor an 
acquisition (see “Devices Page” on page 391).

 To specify multiplexing features

1. Select the Multiplexing check box.

2. Select the check box for each channel that you want to use for acquisition.

3. To save your changes, click Apply.

The application immediately applies this feature change.

IMPORTANT  To use a library search for identification or confirmation, the application 
requires meeting these conditions:

• The raw data file must contain higher energy collision-induced dissociation (HCD), 
source collision-induced dissociation (CID), or all ions fragmentation (AIF) ion 
spectra.

• The spectra must exist at a time point within the compound’s elution time range.

Note   Multiplexing is not available when you activate Intelligent Sequencing. See 
Intelligent Sequencing.

Note  When you activate multiplexing, the Single Sample Submission option is not 
available.
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Intelligent Sequencing
Use Intelligent Sequencing for single-sample submission. When you submit a batch, the 
autosampler begins preparing for one sample injection at a time. Higher priority batches can 
interrupt the sample sequence in the currently acquiring batch.

 To activate the intelligent sequencing feature

1. Select the Intelligent Sequencing check box.

The Acquisition Submission Options default to Single Sample Submission. The Full 
Sequence Submission option is not available when you select the Intelligent Sequencing 
option.

2. To save your changes, click Apply.

The application immediately applies this feature change. 

Processing Options 
Use these options to enable auto-batch processing or to allow unknown screening.

 To allow auto-reprocessing

1. Select the Auto Reprocess check box.

• When you select this option, the Auto Reprocess option is selected by default in the 
banner of all application views.

• When you clear this option, the Auto Reprocess option is cleared by default in the 
banner of all application views.

2. To save your changes, click Apply.

The application immediately applies this feature change.

 To allow unknown screening 

1. Select the Allow Unknown Screening check box.

• When this option is selected, Unknown Screening features are displayed in the 
application.

• When this option is cleared, Unknown Screening features are not displayed in the 
application.

2. To save your changes, click Apply.

The application immediately applies this feature change. 

Note   Intelligent Sequencing is not available when you activate Multiplexing. See 
“Multiplexing” on page 61.

Note   When you use auto-reprocessing, it can slow batch processing.
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Creating Custom Columns
Use the Custom Columns page to add six additional columns to the samples list in batches. 
The application treats these custom columns the same as other columns when you export data 
to a Microsoft Excel™ spreadsheet or to a CSV file. 

When user security is activated, you must have Configuration – Custom Columns permission 
to access these features.

You can use the Modify Columns dialog box to display and change the order of these columns 
in the sample list (see the Column Display topic in the appropriate Analysis chapter for your 
quantitation, target screening, or unknown screening batch).

You can use the Field Chooser to display and change the order of these columns in the Data 
Review Samples pane (see the Samples Pane topic in the appropriate Analysis chapter for your 
quantitation, target screening, or unknown screening batch).

You can use the information in these columns (for example) for temperature control when 
you use Aria™ MX for multiplexing or for injector and multiple column module ports when 
you use the TurboFlow™ method with the Prelude™ or TLX data systems. 

Follow these procedures:

• To open the Custom Columns page

• To add custom columns to new batches

• To create new batches without custom columns

• To control the display of custom columns

 To open the Custom Columns page

Click Custom Columns in the navigation pane. 

The Application – Custom Columns page opens.

 To add custom columns to new batches 

1. Select the Enable Custom Columns check box.
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The application adds six additional columns to the samples list in all new batches that you 
create. 

The Enable Custom Columns check box controls both the creation of custom columns 
on new batches and the display of custom columns in the Modify Columns dialog box in 
the Batch View and the Field Chooser in the Data Review Samples pane.

2. For each custom column, select the default column name and type your custom name, as 
in this example:

3. Click Apply.

The application adds the six custom columns to all new batches that you create.

 To create new batches without custom columns

Clear the Enable Custom Columns check box and click Apply.

When you create new batches, they will not include custom columns, and the application 
hides the display of the custom columns for any previous batches that you created with 
custom columns enabled.

 To control the display of custom columns

Do one of the following:

• To make custom columns available for all batches, select the Enable Custom 
Columns check box and click Apply.

• To make custom columns not available for batches, clear the Enable Custom 
Columns check box and click Apply.

Note  Only new batches include these custom columns. The application does not add 
custom columns to previously created batches.

Note  If you return to this page and change the custom column names, the 
application uses the new names only for future batches. 
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Creating Custom Flags
Use the Flag Customization view to customize error flags and conditions that indicate 
compound errors in Data Review for quantitation batches. You can edit the priority assigned 
to an error condition (flag rule) and the shape and color of the icon used to indicate the error. 
You can also delete an error condition or create a new one. When user security is activated, 
you must have Configuration – Custom Flags permission to access these features.

 To open the Flag Customization view 

Click Flag Customization in the navigation pane. 

The Application – Flag Customization view opens.
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Follow these procedures:

• To edit priority groups

• To create a new priority group

• To edit flag rules

• To create a new flag rule

• To remove all customization

In the Priority Groups area, you can edit the priority, shape, or color of a flag. You can also 
delete a flag or create a new one. You cannot change the name of a flag.

 To edit priority groups 

1. Do any of the following:

• Select the default Priority value and type a new value.

A priority of 1 is the highest priority. The higher the Priority number, the lower the 
priority. 

• Double-click the Shape value and select a new shape from the list.

• Click the Color arrow and select a new color from the color palette.

2. When you have completed all your changes, click Apply to save your changes. 
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 To create a new priority group

1. In the Priority box, type a value.

You can enter positive or negative numbers. The lower the number, the higher the 
priority.

2. In the Name box, type a name for the new priority group.

3. Select a flag shape from the Shape list: Circle, Square, or Flag.

4. Click the Color list and select a color from the color palette.

5. (Optional) Click Advanced and select a color based on RGB, HSL, or CMYK color 
palettes. See “Advanced Dialog Box” on page 69.

6. Click Create.

The application adds the new flag to the Priority Groups list, as in this example:
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 To edit flag rules

1. Do any of the following:

• In the Description column, select the current text and type a new description.

• Double-click the PriorityGroup value and select a new group from the list.

• Click Delete.

The application immediately removes the flag rule. To restore the deleted rule, click 
Undo.

2. When you have completed all your changes, click Apply to save your changes. 

 To create a new flag rule 

1. In the Name box, type a name for the new rule.

Keep the name short and make it intuitive.

2. In the Description box, type a description for the new flag rule.

This description can be anything that you want and use as many characters as you want.

3. From the Flags list, select an error condition.

4. From the PriorityGroup list, select a priority group.

This list includes both the default priority groups and any priority groups that you 
created. See “To create a new priority group” on page 67.

5. Click Create.

The application adds your new flag rule to the end of the Flag Rules list.

 To remove all customization

Click Reset to Factory Defaults.

The application removes all new priority groups, new flag rules, and any edits to the 
groups or rules.

Note  You can edit the description and priority group for a flag rule, and you can 
delete a rule. You cannot edit the name or flag type for a rule. 
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Advanced Dialog Box

Use the features in the Advanced dialog box to select custom colors for your flags, using RGB, 
HSL, or CMYK color standards.

Figure 17. Advanced RGB colors

With the Red/Green/Blue (RGB) color palette, you can select a color with a specific RGB 
value, as displayed on a computer monitor.

Figure 18. Advanced HSL colors

With the Hue/Saturation/Lightness (HSL) color palette, you can select a color with a specific 
HSL value, as is commonly used in computer graphics.
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Figure 19. Advanced CMYK Colors

With the Cyan/Magenta/Yellow/Key (CMYK) color palette, you can select a color with a 
specific CMYK value, as you might specify in a color printer. The key (K) color used on 
printers is always black.
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Specifying the Reports
When user security is activated, you must have Configuration – Reports permission to 
configure a list of reports that are available to all users when they generate reports from the 
Method Development, Analysis, or Acquisition modes.

 To open the Application – Reporting view

In the Configuration console navigation pane, click Reports.

The Application – Reporting view opens. 

The application displays the Excel template files in the following folder:

…\TraceFinderData\3.3\Templates\ReportTemplates

Each template has an XLS file and a metadata file to support report generation. 

 To specify which reports are available

Select the check box for each report that you want to make available.

• To return the report selections to their original state (when you first opened this 
view), click Undo.

• To save your changes, click Apply.

Your report settings are immediately available in the application.
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Reports
The application can generate any of the following reports. 

Figure 20. Reports
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4

Using the Common Features of the Method 
Development Mode

This chapter includes method development tasks common to quantitation, target screening, 
and unknown screening methods. 

For information about creating either a quantitation method, a target screening method, or an 
unknown screening method, see the appropriate chapter:

• Chapter 5, “Using the Method Development Mode for Quantitation Methods.” 

• Chapter 6, “Using the Method Development Mode for Target Screening Methods.” 

• Chapter 7, “Using the Method Development Mode for Unknown Screening Methods.” 

 To access the Method Development mode

Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

See descriptions of all the features in the Method Development navigation pane by 
method:

For a quantitation method, see “Opening a Master Method” on page 115 (Chapter 5).

For a target screening method, see “Opening a Master Method” on page 257 (Chapter 6).

For an unknown screening method, see “Opening a Master Method” on page 303 
(Chapter 7).

Contents

• Working with the Compound Database

• Working with Instrument Methods
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Working with the Compound Database
When user security is activated, you must have Method Development permission to manage 
compound definitions in the current database from either the Compound Detail Page or the 
Grid Page in the Compound Database view. From either of these pages, you can export 
compounds to a CSV file or mass list, or you can import compounds from an XML, a CSV, 
or a CDB file. 

Follow these procedures:

• To export compounds to a CSV file

• To export compounds to a mass list

• To import compounds

In addition to procedures for importing and exporting compound data, see the following 
topics:

• Compound Database Names Mapped to CSV Column Names

• Data Columns with Default Values

 To export compounds to a CSV file

1. Choose Compound Database > Export All Compounds to CSV File from the main 
menu. 

The Export Compounds dialog box opens.

2. (Optional) Click Browse and locate a different folder or file name where you want to 
write the exported compound database.

Each parameter in the compound database editor is represented by a column of data in 
the spreadsheet. When you export compound data to a CSV file, each parameter is 
assigned to a column and each compound is assigned to a row.

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the export procedure.
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3. Select one of these options:

• Export Only Columns with Data: Writes only columns that contain nondefault 
data for at least one compound. This option does not export columns that contain 
only default data. See “Data Columns with Default Values” on page 107.

• Export All Columns: Writes all columns to the CSV file, including columns that 
contain no data for any compound.

4. Click Export.

The application stores the database as

…\Thermo\TraceFinder\3.3\General\Databases\databaseName.csv

An Excel window opens with the compound data in spreadsheet format.

Figure 21. Compound data in an Excel spreadsheet

Column names in an exported Excel spreadsheet do not always match the parameter names in 
the compound database editor. See “Compound Database Names Mapped to CSV Column 
Names” on page 104.

You can use the tools in the spreadsheet to edit the data in the compound database and then 
import the data in the CSV file back into the TraceFinder application. If you delete a column 
from the spreadsheet and then import the CSV file, the application replaces the data in that 
column with default values. For a list of default values, see “Data Columns with Default 
Values” on page 107. 

 To export compounds to a mass list

1. Select the compounds that you want to export.

You can export any experiment type to any instrument format. The application writes the 
data to the XML file in a format that is compatible with the specified instrument, 
regardless of the original experiment type.
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2. Choose Compound Database > Export Selected Compounds to Mass List from the 
main menu. 

The application writes the mass data for the selected compounds to the following folder, 
using a format compatible with your configured instrument:

…\TraceFinderData\3.3\Methods\Methodname\*.xml

For examples of exported mass lists, “Mass Data Formats” on page 79.

 To import compounds 

1. Choose Compound Database > Import Compounds from the main menu.

The Select File to Import into the Current Compound Database dialog box opens.

You can import compounds from the following file types:

• ToxID™ Exactive CSV

• ToxID MS2 CSV

• TraceFinder CSV

• TraceFinder Mass List XML

• TraceFinder 3.2 Legacy CDB

• ExactFinder™ 2.0 CDB

• .include-masses

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the export procedure.

Note   If your configured is other than a TSQ, an ISQ, a Q Exactive, a TSQ Endura™, 
or a TSQ Quantiva™ mass spectrometer, a message asks which format you want to 
export: Triple Quadrupole, Q Exactive, TSQ Quantiva/Endura SIM, or TSQ 
Quantiva/Endura SRM.

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the import procedure.
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2. Locate the CDB, CSV, or XML compound database file that you want to import and 
click Open.

The Import Compounds to CDB dialog box opens.

3. To select a different compound database, click Browse, locate an XML, a CSV, or a CDB 
compounds file, and click Open.

4. To select a different target database, do one of the following:

a. Click Browse.

b. Locate an XML, a CSV, or a CDB compounds file.

c. Click Open.

IMPORTANT  Before you import data from a CSV file, verify that the following 
required columns have data for each compound. These columns have no default 
values and must have a value before you can import CSV data into the TraceFinder 
compound database:

• CompoundName
• ExperimentType
• ProductMass (target peak)
• Confirm Product (confirming peak)
• Fragment

If you delete any of these columns from the spreadsheet and attempt to import the 
CSV data into the TraceFinder application, the application warns that it is unable to 
parse the file and identifies the missing column.

Note  If the import file is missing required compound information, the application 
warns that it is unable to parse the file and identifies the missing columns. For a list of 
required columns, see “Compound Detail Page” on page 80.
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–or–

a. Click Create.

b. Type a name for a new compound database.

c. Click OK.

5. Confirm that the import file and the target database are correct.

The dialog box reports the total number of compounds in the import file, the number of 
compounds with validation errors, and the number of compounds that already exist in 
the target database.

6. (Optional) Select one of these options:

• Skip: Imports only those compounds that do not already exist in the target database.

• Overwrite: Replaces compounds that already exist in the target database with the 
imported compounds.

7. Click Import.

The application imports the compounds from the imported file, adds them to any 
compounds already in the database, and alphabetically sorts them.

The application reports the number of imported compounds.

8. Click OK.
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Mass Data Formats

In the TraceFinder application, you can export the mass data list from the Compound 
Database to an XML file that can be read by the TSQ, ISQ, Q Exactive, TSQ Endura, or 
TSQ Quantiva applications. 

Triple Quadrupole Format

The application writes the mass data to the following file:

…\TraceFinderData\3.3\Methods\Methodname\*.xml

The data in this file matches the TSQ XML data, which you can use in the instrument 
method editor of a TSQ application.

Q Exactive Format

The application writes the mass data to the following file:

…\TraceFinderData\3.3\Methods\Methodname\Methodname.xml.include-masses

The data in this file matches the Exactive XML data, which you can use in the instrument 
method editor of a Q Exactive application.

TSQ Quantiva/Endura SIM Format

The application writes the mass data to the following file:

…\TraceFinderData\3.3\Methods\Methodname\Methodname.xml

The data in this file matches the TSQ Endura, TSQ Quantiva, and Xcalibur XML data, 
which you can use in the instrument method editors of the associated applications. The 
application exports only the following compound parameters to the XML file:

• Compound (as Name in the XML file)

• Product Mass (as Mass in the XML file)

• RT range (as StartTime and StopTime in the XML file)

• Polarity

• Lens (as TubeLens or S-Lens in the XML file)

IMPORTANT  You can export only SRM or SIM data types to the Triple Quadrupole 
format.

IMPORTANT  You can export only XIC data types to the Q Exactive format.

IMPORTANT  You can export only SIM data types to the TSQ Quantiva/Endura SIM 
format.
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TSQ Quantiva/Endura SRM Format

The application writes the mass data to the following file:

…\TraceFinderData\3.3\Methods\Methodname\Methodname.xml

The data in this file matches the TSQ Endura, TSQ Quantiva, and Xcalibur XML data, 
which you can use in the instrument method editors of the associated applications. The 
application exports only the following compound parameters to the XML file:

• Compound (as Name in the XML file)

• Precursor Mass

• Product Mass 

• RT range (as StartTime and StopTime in the XML file)

• Polarity

• Lens (as TubeLens or S-Lens in the XML file)

• Collision Energy

Compound Detail Page

When you open the Compound Database view, the Compound Detail page is the default.

The compound details are different depending on which experiment type the selected 
compound uses. 

• Compound Detail page for SRM experiments

• Compound Detail page for SIM experiments

• Compound Detail page for XIC experiments

See the following topics:

• Sorting Compounds in the Database

• Editing Compounds in the Database

Note  You can export only SRM data types to the TSQ Quantiva/Endura SRM format.
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Figure 22. Compound Detail page for SRM experiments 
 

Figure 23. Compound Detail page for SIM experiments
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Figure 24. Compound Detail page for XIC experiments 
 

Sorting Compounds in the Database

On the Compound Detail page, you can sort the list of compounds that you want to display.
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Follow these procedures:

• To search for compounds by name

• To display compounds by experiment type

• To display truncated compound names

 To search for compounds by name

In the Search box, begin typing any part of a compound name.

As you type, the list of displayed compounds narrows to match the typed text.

For example, you can use this feature in combination with the experiment type list to 
display only SIM compounds that begin with the letter “a”.

 To display compounds by experiment type

Select an experiment type from the  list.

The list displays experiment types that each use a different structure for the mass filter. 

• SRM: Selected Reaction Monitoring

• XIC: Extracted Ion Chromatogram

• SIM: Single Ion Monitoring

For detailed descriptions of each experiment type, see “Experiment Types” on page 101.

For example, you can use this feature in combination with the text search to display only 
SRM compounds that begin with the letter “f ”.

 To display truncated compound names

Hold your cursor over long, truncated names to display a ToolTip with the entire name.
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Editing Compounds in the Database

On the Compound Detail page of the Compound Database view, you can import compounds 
into the database, add or remove compounds from the database, add target or confirming 
peaks to a compound, or remove target or confirming peaks from a compound.

Follow these procedures:

• To add a compound to the database

• To remove compounds

• To make a compound editable

• To add a target peak to a compound

• To add a confirming peak to a target peak

• To copy target peaks from one compound to another

• To copy window values from one peak to another

• To add a fragment to a target peak

 To add a compound to the database 

1. Click the Add Compound icon, .

The application adds a new, empty compound page and highlights the required 
parameters in red.

2. Click the Compound box, and type the required Compound name.

3. Select the Experiment type: SRM, SIM, or XIC.

The required parameters are different for each experiment type. See “Experiment Types” 
on page 101.

4. In the Target Peaks area, do the following:

• For SRM experiments, enter values for Precursor Mass and Product Mass.

• For SIM or XIC experiments, enter a value for Extracted Mass.

5. In the Confirming Peaks area, do the following:

• For SRM experiments, enter values for Precursor and Product Mass.

• For SIM or XIC experiments, enter a value for Precursor and Extracted Mass.

6. Enter or edit any of the other optional parameters described in the “Compound 
Parameters” on page 95.

7. When you have finished your changes, click the Complete Edit icon, .
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 To remove compounds

1. In the Compound list, select the compounds that you want to delete.

The application supports the following methods to delete multiple compounds:

• CTRL+A to select all compounds

• CTRL+click to select noncontiguous compounds

• SHIFT+click to select contiguous compounds

2. Click the Delete Selected Compounds icon, .

3. To confirm that you want to delete the selected compounds, at the prompt click OK.

The application removes the selected compounds and all their peak information. 

 To make a compound editable

1. In the Compound list, select the compound that you want to edit.

Tip  You cannot add another new compound or access the menu commands until you 

complete the edit, , or cancel the edit, .

IMPORTANT  After you complete the edits for the compounds, the header in the 
Compound Database page marks the database name with an asterisk, indicating that 
the database is not saved. To save the database with your compound changes, choose 
File > Save Compound Database from the main menu.
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2. Click the Edit Compound icon, . 

The application makes the compound parameters editable and displays the 

Add icon, , so that you can add target peaks, confirming peaks, and fragments to the 
compound details.

 To add a target peak to a compound

1. In the Target Peaks header, click the Add Target Peak icon.

The application adds a new target peak to the compound. A target peak includes 
quantitative values for the compound. 

2. Enter all required parameters. 

The required target peak values differ for each experiment type. See “Experiment Types” 
on page 101.

For a list of required and optional parameters, see the list of “Compound Parameters” on 
page 95.

3. Repeat these steps to add as many as six target peaks to the compound. 

Note  If you are adding a new compound, it is editable by default.

Tip  You cannot add another new target peak or save the compound until you enter all 

required peak parameters or delete  the new target peak.

Add Target Peak icon

Delete Target Peak icon
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 To add a confirming peak to a target peak 

1. In the Confirming Peaks header, click the Add Confirming Peak icon.

The application adds a new confirming peak to the target peak. 

2. Type the required values for the confirming peak. 

The required confirming peak values differ for each experiment type. See “Experiment 
Types” on page 101.

For a list of required and optional parameters, see “Compound Parameters” on page 95.

3. Repeat these steps to add as many as 10 confirming peaks to the target peak.

 To copy target peaks from one compound to another 

1. In the compounds list, select the compound whose target peak you want to copy.

2. When the target peak includes more than one peak, in the Target Peaks area for the 
selected compound, scroll to the peak that you want to copy.

Tip  You cannot add another new confirming peak or save the compound until you 

enter all required peak parameters or delete  the new confirming peak.

Add Confirming Peak icon

Delete Confirming Peak icon

Source compound
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3. In the compounds list, keep the source compound selected and use the SHIFT or CTRL 
keys to select the compounds that you want to copy the target peak to.

4. In the Target Peaks area for the selected compound, right-click the target peak area and 
choose Add Peak 1 to N Selected Compounds from the shortcut menu.

The application reports that the peak was copied to the specified number of compounds.

The application copies the peak information to the selected compounds, adding this peak 
to the peaks already defined for the compounds.

5. Click OK.

 To copy window values from one peak to another 

1. In the compounds list, select the compound with the window value that you want to 
copy.

IMPORTANT  Be careful to keep the source compound selected.

Source compound 

Right-click the target peak area.

Source compound 
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2. In the Target Peaks area for the selected compound, identify the peak whose window you 
want to copy.

3. In the compounds list, keep the source compound selected and use the CTRL key to 
select the compounds that you want to copy the window to.

4. In the Target Peaks area for the selected compound, right-click the target peak area and 
choose Set the Window for All Peaks of selectedCompounds to windowValue from the 
shortcut menu.

The application reports that the retention time and window were copied to the specified 
number of compounds, including the source compound when it has multiple peaks.

The application copies the retention time and window information to all peaks in the 
selected compounds and all additional peaks in the source compound, overwriting the 
values for these parameters.

5. Click OK.

IMPORTANT  Be careful to keep the source compound selected.

Source compound 

Right-click the target peak area.
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 To add a fragment to a target peak

1. In the Fragments header, click the Add Fragment icon.

The application adds a new fragment to the target peak. 

2. Click the Extracted Mass box, and type a value between 10 and 2999.999.

3. Repeat these steps to add as many fragments as you want.

Tip  You cannot save the compound until you enter all required fragment parameters 

or delete  the new fragment.

Add Fragment icon

Delete Fragment icon
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Grid Page

The Grid page of the Compound Database view displays the data in the compound database 
as a grid similar to a spreadsheet. The data on the Grid page reflects all populated values on 
the Compound Detail page. 

• There must be at least one compound in the compound database to view the Grid page.

• There are no empty columns on the Grid page. There must be at least one value for a 
parameter in the compound database or that parameter column is not displayed. 

On the Grid page, you can import compounds into the database, add compounds to or 
remove compounds from the database, add target or confirming peaks to a compound, or 
remove target or confirming peaks from a compound.

 To display the compound database on the Grid page

Click Grid in the Compound Database navigation pane.

The current database opens on the Grid page.

The parameters displayed in the compound database depend on which experiment type the 
selected compound uses. For detailed descriptions of all parameters used in the compound 
database, see “Compound Parameters” on page 95. 

Note  If a column of interest is not displayed on the Grid page, return to the 
Compound Detail page, edit at least one compound to have a value for that 
parameter, and then return to the Grid page.
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Follow these procedures:

• To add a compound

• To remove a compound

• To edit values in the compound database grid

• To edit Experiment Type values in the compound database

• To sort the grid on column data

• To organize compounds by column data

 To add a compound

1. Scroll to the bottom of the compound database grid.

There is always one blank row in the grid.

2. In the blank row, type or paste values into the columns.

3. Press ENTER to add another blank row to the grid.

 To remove a compound

1. Click anywhere in a row to select the compound.

2. Press the DELETE key.

3. At the prompt to confirm that you want to delete the compound, click Yes.

The application removes the compound from the database grid.

 To edit values in the compound database grid

Do either of the following:

• Select the current column value and type a new value.

–or–

• Select single cells or entire columns whose values you want to copy, using a 
copy-and-paste operation.

You can use this method to replicate entire columns. Click the column header to 
select the entire column, and then use CTRL+C and CTRL+V to replicate the 
column values.

Note  Some columns have dropdown lists from which you can select values.

Note  Do not use CTRL+X to delete a compound. CTRL+X deletes only the 
parameter values in the selected cells.
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When you edit a value in the Formula column, the application calculates the m/z for the 
precursor and product masses.

When you change the charge state, adduct, or polarity for a compound, the application 
recalculates the m/z for the precursor and product masses.

 To edit Experiment Type values in the compound database

1. Select a new experiment type for one compound from the Experiment Type list.

2. Double-click the new type in the cell, and press CTRL+C.

3. Select all Experiment Type cells in all the compounds in the database.

4. Press CTRL+V.

The application pastes the copied experiment to all compounds in the database.

 To sort the grid on column data

1. Click the header of a column.

The application sorts the grid by ascending column values (alphabetically or numerically).

2. Click the header a second time to sort by descending column values.

Note  Do not use CTRL+X to delete a compound. CTRL+X deletes only the 
parameter values in the selected cells.

IMPORTANT  If you change one experiment type, you must change the experiment 
type for all compounds. The Grid page cannot display a database unless all 
compounds use the same experiment type.

Note   Columns with alphanumeric values sort from 1 to n and then A to Z.
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 To organize compounds by column data

1. In the banner at the top of the column, click the filter icon.

2. Select one of the filtering options, for example, Starts With.

3. Click the down arrow and choose one of the column values in the list, for example, EI.

The grid displays only compounds that match the selected filter and data.

 Filter icon

Down arrow

The down arrow 
changes to a list box.
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Compound Parameters

The Compound Detail page and the Grid page occasionally use different names for the same 
parameter. The Parameter column in Table 12 indicates if the parameter name is different, for 
example, “Compound” for the Compound Detail page and “Compound Name” for the Grid 
page.

The parameters that are displayed in a compound database on either the Compound Detail 
page or the Grid page depend on which experiment type the selected compound uses. The 
Description column in the table includes the applicable experiment types. 

Table 12. Compound parameters  (Sheet 1 of 6)

Parameter Description

(Compound Detail page) 
Compound

(Grid page)
Compound Name

Alphanumeric name assigned to the compound.

(Compound Detail page) 
Formula

(Grid page)
Chemical Formula

Chemical formula for the compound. Used to calculate the neutral mass for the 
compound.

(Compound Detail page)
Experiment

(Grid page)
Experiment Type

Experiment type: SRM, XIC, or SIM. For details about the differences, see “Experiment 
Types” on page 101.

Compound Type Specifies the compound type as Analyte or Internal Standard.

(Compound Detail page)
ISTD Concentration

(Grid page)
Internal Standard 
Concentration

Specifies the concentration for the internal standard. Available only when the Compound 
Type is Internal Standard. Used when you enable semi-quan features in the method. 

Valid range: 0 through 10 000 000 (1e7)

Concentration Units Specifies the user-defined units of measure that you entered in the database.

Ionization Alphanumeric identifier. 

Valid values: None, ESI, APCI, EI, CI, or APPI
Default: None

Category (Optional) Alphanumeric identifier, such as Class 1, Class 2, Opiates, and so forth.

CAS The Chemical Abstract Service (CAS) number that the application matched with the 
compound. The Grid display shows the CAS column only when at least one compound 
has a CAS value.
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Response Threshold The threshold used to integrate only peaks with a response greater than this value. The 
response threshold is a minimum response that must be met to allow peak confirmation. 
Used only for target screening methods and XIC experiments.

Valid range: 1000 or greater
Default: 5000

Neutral Mass Mass calculated from the chemical formula. The neutral mass is the sum of all AMU 
elements in the compound. This parameter is informational only; it is not used for peak 
detection.

Target Peaks

(Compound Detail page)
Precursor Mass

(Grid page)
Peak n Precursor Mass

The mass-to-charge ratio (m/z) of a target peak. The location of the center of a target 
precursor ion peak in mass-to-charge ratio units. 
In confirming peaks, the precursor mass is the same as the target peak precursor mass.

Valid range: 10.000 through 6000.000
Default: 0.0

Available for all SRM experiments and for XIC experiments with the MS Order set to 
MS2.

For mass values in XIC experiments when the MS Order is set to MS1, see Extracted 
Mass.

(Compound Detail page)
Product Mass

(Grid page)
Peak n 

The mass-to-charge ratio of the confirming peak. The location of the center of a target 
quan ion peak in mass-to-charge ratio (m/z) units. 

Valid range: 10.000 through 6000.000
Default: 0.0

Available for all SRM experiments and for XIC experiments with the MS Order set to 
MS2. 

For mass values in XIC experiments when the MS Order is set to MS1, see Extracted 
Mass.

Table 12. Compound parameters  (Sheet 2 of 6)

Parameter Description
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(Compound Detail page) 
Mass

(Grid page)
Peak n Mass

The mass-to-charge ratio of the confirming peak. The location of the center of a target 
quan ion peak in mass-to-charge ratio (m/z) units. 
Available only for SIM experiments.

(Compound Detail page)
Extracted Mass

(Grid page)
Peak n Extracted Mass

The mass-to-charge ratio of the target peak. The location of the center of a target quan ion 
peak in mass-to-charge ratio (m/z) units. 
You can enter a value for the Extracted Mass, but when you change the values for Formula, 
Adduct, Polarity, or Charge State, the application recalculates the Extracted Mass value, 
overwriting the value you entered.

Valid range: 10.000 through 2999.999
Default: 0.0

Available only for XIC experiments with the MS Order set to MS1.

For mass values in XIC experiments when the MS Order is set to MS2, see Precursor Mass 
or Product Mass.

(Compound Detail page)
Polarity

(Grid page)
Peak n Polarity

Positive or Negative

(Compound Detail page)
Adduct

(Grid page)
Peak n Adduct

The adducts specified in the configuration file. To add or remove adducts from the default 
lists, see “Specifying Adducts” on page 53. 

Adducts affect the calculated amount of the extracted mass by adding to or subtracting 
from the neutral mass.

Adducts are polarity sensitive. Select the Polarity parameter before selecting the Adduct 
value.

Default Positive valid values: Neutral, NH4, H, Na, K
Default Negative valid values: Neutral, H, H3C2O2, HCO2
Default: Neutral

(Compound Detail page) 
Charge State

(Grid page)
Peak n Charge State

The charge state of the ion (the z value in m/z). For example, a charge state of 2 with a 
negative polarity means that the compound has 2 more electrons than protons.

Valid range: 1 through 10
Default: 1

Table 12. Compound parameters  (Sheet 3 of 6)

Parameter Description
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MS Order The confirming peaks come from the same scan (MS) or are fragments from an adjacent 
scan (MS2). 
Available only for XIC experiments. 

Time Range Peak The acquisition time specified as either a window around a specified RT value or as a 
retention time range in minutes.

This parameter is visible only when you are editing a compound.

Window (sec) The Window value used to determine the start and stop time for the acquisition. Available 
only when the Time Range Peak option is not selected.

Valid range: 0.00 through 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 through 999.00

(Compound Detail page)
RT (min)

(Grid page)
Peak n RT 

Retention time. The application uses RT and Window values to determine the start and 
stop time for the acquisition. When the Time Range Peak option is selected, the RT value 
is specified as a range.

Valid range: 0.00 through 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 through 999.00

(Compound Detail page)
Lens

(Grid page)
Peak n Lens

Valid range: –400 through 400

(Compound Detail page)
Collision Energy

(Grid page)
Peak n Collision Energy

The energy used when ions collide with the collision gas.
Available only for SRM experiments.

Valid range: –250.00 through 250.00

(Compound Detail page)
Energy Ramp

(Grid page)
Peak n Energy Ramp

Valid range: 0.00 through 200.00

Table 12. Compound parameters  (Sheet 4 of 6)

Parameter Description
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Confirming Peaks Use confirming peak parameters in quantitation methods only.

(Compound Detail page)
Precursor

(Grid page)
Peak n Confirming n 
Precursor

The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments or XIC experiments with the MS Order set to MS2.

Valid range: 10.000 through 2999.999
Default: 0.0

(Compound Detail page)
Product Mass

(Grid page)
Peak n Confirming n

The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.

Valid range: 10.000 through 2999.999
Default: 0.0

(Compound Detail page)
Mass

(Grid page)
Peak n Confirming n 
Extracted Mass

The mass-to-charge ratio of the confirming peak. The location of the center of a target 
quan ion peak in mass-to-charge ratio (m/z) units. 
Available only for SIM experiments.

(Compound Detail page)
Extracted Mass

(Grid page)
Peak n Confirming n 
Extracted Mass

The mass-to-charge ratio of the target peak. The location of the center of a target quan ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC experiments.

Valid range: 10.000 through 2999.999
Default: 0.0

(Compound Detail page)
Collision Energy

(Grid page)
Peak n Confirming n 
Collision Energy

The energy used when ions collide with the collision gas. 
Available only for SRM experiments.

Valid range: –250.00 through 250.00

Target Ratio (%) Specifies the theoretical ratio of the confirming ion’s response to the quantification ion’s 
response.

Valid range: 1 through 100

Window Type Specifies an Absolute or a Relative calculation approach for determining the acceptable ion 
ratio range.

Window (+/-%) Specifies the acceptable ion ratio range.

Valid range: 1 through 100

Table 12. Compound parameters  (Sheet 5 of 6)

Parameter Description
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Ion Coelution (min) Specifies the maximum difference in retention time between a confirming ion peak and 
the quantification ion peak.

Valid range: 0.025 through 0.1

(Compound Detail page)
MS Order

(Grid page)
Peak n Confirming n 
MS Order

Specifies whether the confirming peaks or fragments come from the same scan (MS) or an 
adjacent scan (MS2).
Available only for XIC experiments. 

Fragments
Fragment parameters are used for XIC experiment types in target screening methods. The 
application uses fragments to define masses that are present in an adjacent scan (MS2).

(Compound Detail page)
Extracted Mass

The mass-to-charge ratio of the target peak. The location of the center of a target quan ion 
peak in mass-to-charge ratio (m/z) units. 
Available only for XIC experiments.

Valid range: 10.000 through 2999.999
Default: 0.0

Table 12. Compound parameters  (Sheet 6 of 6)

Parameter Description
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Experiment Types

The TraceFinder application uses three experiment types: SRM, SIM, and XIC.

Each of these experiment types uses a different structure for the mass filter. The target peak 
and confirming peak parameters for each experiment type are defined in the “Compound 
Parameters” on page 95.

A compound database can include multiple experiment types for a single compound; 
however, each compound name and experiment type combination must be unique.

SRM: Selected Reaction Monitoring 

The SRM experiment type supports triple quadrupole LC/MS. The mass filter includes 
precursor mass and narrow mass ranges to identify product masses. Imported compounds 
with no experiment type are treated as SRM data.

Confirming peaks include values for precursor mass, product mass, and collision energy.
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SIM: Single Ion Monitoring

The SIM experiment type supports single quadrupole LC/MS, GC/MS, and Exactive 
systems. The mass filter includes narrow mass ranges to identify product masses.

Confirming peaks include an extracted mass value.
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XIC: Extracted Ion Chromatogram

The mass filter is a single, full scan which is post-processed to extract a peak for the ions of 
interest.

Confirming peaks include an extracted mass value and a choice of mass order: MS1 or MS2.
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Compound Database Names Mapped to CSV Column Names

Column names in an Excel spreadsheet do not always match the parameter names in the 
compound database editor. The following table maps the parameter names for both the 
Compound Detail page and the Grid page to the column headings in a CSV spreadsheet. 

Table 13.  CSV column names for compound parameters  (Sheet 1 of 3)

Compound database parameter CSV column heading

(Compound Detail page) 
Compound

(Grid page)
Compound Name

CompoundName

(Compound Detail page) 
Experiment

(Grid page)
Experiment Type

ExperimentType

Category Category
CAS CAS
Formula ChemicalFormula
Ionization Ionization
Response Threshold ResponseThreshold 

(XIC only)
Target Peaks

(Compound Detail page) 
Precursor Mass

(Grid page)
Peak n Precursor Mass 

PrecursorMass 
(SRM only)

 (Compound Detail page) 
Product Mass 

(Grid page)
Peak n 

ProductMass 
(SRM only)

(Compound Detail page) 
Mass

(Grid page)
Peak n Mass

ProductMass
(SIM only)

(Compound Detail page) 
Extracted Mass

(Grid page)
Peak n Extracted Mass

Extracted Mass
(XIC only)
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(Compound Detail page)
Product Mass
Mass
Extracted Mass

Extracted Mass
(when the Compound Detail page of a compound 
database contains any combination of SRM, XIC, and 
SIM experiments)

(Compound Detail page) 
Adduct

(Grid page)
Peak n Adduct

Adduct

Polarity Polarity
(Compound Detail page) 
Charge State

(Grid page)
Peak n Charge State

ChargeState

Window Window
(Compound Detail page) 
RT (min)

(Grid page)
Peak n RT

RT

(Compound Detail page) 
Collision Energy

(Grid page)
Peak n Collision Energy

CollisionEnergy
(SRM only)

(Compound Detail page) 
Lens

(Grid page)
Peak n Lens

Lens

Energy Ramp EnergyRamp
Confirming Peaks

(Compound Detail page) 
Precursor

(Grid page)
Peak n Confirming n Precursor

Confirm Precursor
(SRM and XIC only)

Table 13.  CSV column names for compound parameters  (Sheet 2 of 3)

Compound database parameter CSV column heading
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(Compound Detail page) 
Product Mass

(Grid page)
Peak n Confirming n

Confirm Product
(SRM only)

(Compound Detail page) 
Mass

(Grid page)
Peak n Confirming n Extracted 
Mass

Confirm Product
(SIM only)

(Compound Detail page) 
Extracted Mass

(Grid page)
Peak n Confirming n Extracted 
Mass

Confirm Extracted
(XIC only)

(Compound Detail page)
Product Mass
Mass
Extracted Mass

Confirm Extracted
(when the Compound Detail page of a compound 
database contains any combination of SRM, XIC, and 
SIM experiments)

(Compound Detail page)
Collision Energy

(Grid page)
Peak n Confirming n Collision 
Energy

Confirm Energy
(SRM only)

Fragments

Extracted Mass Fragment
(XIC only)

Table 13.  CSV column names for compound parameters  (Sheet 3 of 3)

Compound database parameter CSV column heading
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Data Columns with Default Values

When you export compounds to a CSV file with the Export Only Columns with Data 
option, the application writes only columns that contain nondefault data for at least one 
compound. This option does not export columns that contain only default data. 

When you import compounds from a CSV data file that has missing columns, the application 
replaces the missing columns and uses default values for all compounds. 

Table 14. Default values for compound parameters 

CDB parameter Default value

Compound Detail  
Formula Blank
CAS Blank
Category Blank
Ionization None
Response Threshold
(XIC only)

5000

Target Peaks

Precursor Mass Blank
Collision Energy 0
Adduct Neutral
Lens 0
Energy Ramp 0
Confirming Peaks

Precursor 0
Collision Energy Blank
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Working with Instrument Methods 
An instrument method is a set of experiment parameters that define the operating settings for 
an autosampler, mass spectrometer, and so on. Instrument methods are saved as file 
type .meth.

Follow these procedures:

• To open the Instrument View

• To create a new instrument method

• To create a new multiplexing instrument method

• To open an instrument method

 To open the Instrument View

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens.

2. Click Instrument View.

The Instrument View opens.

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration window 
while the TraceFinder application is running.
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 To create a new instrument method

1. Choose File > New Instrument Method from the main menu. 

The Thermo Xcalibur Instrument Setup window opens.

Figure 25. Example instrument setup showing multiple configured instruments

2. Click the icon for the instrument that you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu in the Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.



4 Using the Common Features of the Method Development Mode
Working with Instrument Methods

110 TraceFinder User Guide Thermo Scientific

5. Select an instrument method name to overwrite, or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

6. (Optional) Type a comment about the new instrument method.

7. Click OK.

The application saves the new instrument method in the following folder:

…\Xcalibur\methods

 To create a new multiplexing instrument method

1. Choose File > New Instrument Method from the main menu. 

The Thermo Xcalibur Instrument Setup window opens.

Figure 26. Example instrument setup showing a configured multiplexed instrument

2. Click the icon for the instrument that you want to use for the method.
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3. Edit the values for the instrument method.

For information about specifying multiplexing values, refer to the documentation for 
your multiplexed instrument.

4. Specify the channels that you want to use for acquisition, as in this example: 

5. From the main menu in the Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.

6. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

7. (Optional) Type a comment about the new instrument method.

8. Click OK.

The application saves the new instrument method in the following folder:

…\Xcalibur\methods 

 To open an instrument method

1. From the File menu, choose Open Instrument Method.

An instrument method browser opens.

2. Select an instrument method from the list and click Open.

The selected method opens in the Thermo Xcalibur Instrument Setup window. You can 
edit this method and save the changes, or you can save this method with another name.

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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5

Using the Method Development Mode for 
Quantitation Methods

This chapter includes method development tasks for creating and editing a quantitation 
method. (See Method Development navigation pane.) When user security is activated, you 
must have Method Development Access permission to use these features. 

The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for your 
application. A quantitation master method contains a list of compounds and the settings for 
detecting, processing, and reporting those compounds. 

When you create a master method, the application uses the method to determine how the 
application works with a set of samples to provide a set of meaningful results. The application 
uses an instrument method to define how raw data is acquired. The rest of the master method 
defines how the raw data is processed, how the flags information displays the results, and how 
the reporting functionality defines the output for your data and results. 

The application applies your master method to a batch, which is a list of one or more samples 
to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the data processing and information reporting for batches of 
samples. 

To speed up the creation of master methods, you can create a method template. Using a 
method template helps you to develop methods faster because the application saves all of your 
commonly used method settings in a template, such as the number of confirming ions or the 
use of data-dependent scans. 

Contents

• Opening a Master Method

• Starting a New Quantitation Master Method

• Editing a Master Method

• Saving a Master Method to a New Name

• Creating a Method Template

• Exporting Mass Data
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Figure 27. Method Development navigation pane 

Table 15. Method Development navigation pane commands 

Command Description

Method View Displays the Method View for the master method. 

Acquisition Displays the Acquisition page of the Method View. See “Editing the Acquisition Page” on 
page 137.

Quantitation

Processing Displays the Processing page of the Method View. See “Editing the Processing Page” on 
page 141.

Compounds Displays the Compounds page of the Method View. See “Editing the Compounds Page” on 
page 150.

QAQC Displays the QAQC page of the Method View. See “Editing the QAQC Page” on page 217.

Groups Displays the Groups page of the Method View. See “Editing the Groups Page” on page 226.

Intel Seq Displays the Intelligent Sequencing page of the Method View. See “Editing the Intelligent 
Sequencing Page” on page 228. Available only when you activate the Intelligent Sequencing 
option in the Configuration console.

Reports Displays the Reports page of the Method View. See “Editing the Reports Page” on page 236.

Compound Database See “Working with the Compound Database” on page 74.

Instrument View See “Working with Instrument Methods” on page 108.

Available only when you activate the Intelligent Sequencing 
option in the Configuration console
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Opening a Master Method
Use the TraceFinder application to open a master method that was created and saved in the 
current application or converted from previous versions of TraceFinder. To convert legacy 
methods, see “Converting Legacy Data” on page 20.

 To open a quantitation method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

For descriptions of all the features in the Method Development navigation pane, see 
“Starting a New Quantitation Master Method” on page 117.

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods. See Open 
Master Method dialog box.

3. Select Quan in the Type list.

The method list displays all quantitation methods.

4. Select a quantitation master method and click Open.

The Acquisition page for the selected method opens. For detailed descriptions of all the 
features on the Acquisition page, see “Acquisition Page for a Quantitation Method” on 
page 140.

Tip  You can also open one of your most recently used master method files. Choose 
Files > Recent Files > Method.
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Figure 28. Open Master Method dialog box

Table 16. Open Master Method dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.

Type Type of method: Quan, Screening, or Unknown Only. 

Date Changed Date the method was last updated.

Size Size of the method in megabytes.

Domain TraceFinder domain for which the method was created.

Type Type of method to display: Quan, Screening, Unknown 
Only, or Any.

Path Path to the selected method in the 
TraceFinderData\3.3\Methods folder.
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Starting a New Quantitation Master Method
To create or start a specific method, select as applicable from one of the four different 
quantitation method procedures (or techniques) in the Create Master Method dialog box:

• Creating a New Method with Method Forge

• Importing an Xcalibur Master Method

• Creating a Blank Method

• Selecting Compounds from the Compound Database

Then, use the features of the Method View to complete and save the master method.

To open the Create Master Method dialog box, choose File > New > Master Method from 
the main menu. 

Figure 29. Create Master Method dialog box

IMPORTANT   The Unknown Screening Method - Only technique is displayed only when 
you select the Allow Unknown Screening option in the application configuration console. 
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Creating a New Method with Method Forge

With Method Forge, you can create a new quantitation master method by manually selecting 
peaks, selecting multiple compounds, renaming peaks, or comparing mass spectra from the 
library searches. You can also choose to let the application automatically create a master 
method for you. For detailed descriptions of all the Method Forge parameters, see “Method 
Forge Dialog Box” on page 125.

When the application automatically creates a master method for you, it performs the 
following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign compound names and CAS numbers.

• Uses mass spectral information to select potential quantification and confirming ions and 
a reference mass spectrum for the compound. 

Follow these procedures:

• To automatically select compounds to create a new method

• To manually select compounds to create a new method

 To automatically select compounds to create a new method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens. To view all available ways to create a master 
method, see “Create Master Method dialog box” on page 117.

2. Select the Quan Using Method Forge option and click OK.

The Method Forge dialog box opens. For detailed descriptions of all the features in the 
Method Forge dialog box, see “Method Forge Dialog Box” on page 125.

Use Method Forge to create a master method from an existing raw data file or to create a 
new raw data file to use for the master method. 

Each method requires a processing method template. The application displays all saved 
method templates in the template list.

Note  When the identified peak is from an analog trace, the application does not perform 
a library search and does not identify any confirming ions.
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3. To select a processing method template, do one of the following:

• Click Open Method Template Editor to create and save a new method template.

See “Creating a Method Template” on page 243.

• Select a method template from the template list, and click Open Method Template 
Editor to edit and save the method template. 

• Select a method template from the template list.

The selected template is now selected by default each time you open the Method Forge 
dialog box until you restart the application. To view the parameters for each available 
method template, hold your cursor over the template name, as in this example: 

4. Select the Name the Master Method check box and type a name for your master method.

You can enter a new method name, or you can enter an existing method name to 
overwrite when you create the method. If you do not select this option, the method is 
named for the raw data file used to create the method.

5. Select the Automatically Create the Master Method check box.

6. Specify a raw data file by doing one of the following:

a. In the Raw File Selection area, select the Use an Existing Raw Data File option.

b. Click the browse button and locate a raw data file to use for the method.

c. Go to step 8.

–or–

a. In the Raw File Selection area, select the Acquire a New Raw Data File option.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

Note  When the Name the Master Method check box is selected, you must enter a 
method name. To let the application name the method with the raw data file name, 
clear the Name the Master Method check box.
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c. In the Raw Filename box, type the name of the file where the application will write 
the raw data file.

d. In the Path box, type a path or click the browse button and locate a folder where the 
application will save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

7. To acquire a new raw data file, do one of the following:

Select the Manual Injection option.

–or–

Specify the autosampler settings:

a. Select the Use Autosampler option.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

Valid range: 0.1 through 2000 μL

8. To automatically create the master method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status bars:

• For analog peaks, the Method Forge displays the detected peak as Peak@(RT)Analog. 
The Method Forge does not perform a library search for peaks found in analog traces.

• For mass spectral peaks, the Method Forge process searches the associated libraries 
and displays the identified compound names instead of the peak times.

When the acquisition is completed, Method Forge performs peak detection, library 
searching (except for analog peaks), and identification of characteristic ion and reference 
spectra. Method Forge then loads this information into a new master method. This 
process occurs immediately if you selected a previously acquired raw data file.

9. From the Instrument Method list, select an instrument method.

10. From the Qualitative Peak Processing Template list, select a method template for 
performing peak detection on quantitation samples following target compound analysis.

11. (Optional) From the Background Subtraction Range Option list, select how you want the 
background subtraction range determined from one of these options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.
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• After Peak: Subtracts a specified number of scans following the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

When you create a reference spectrum with background subtraction, the application uses 
the selected method to conduct background subtraction of peak spectra during 
quantitative processing and reports the background-subtracted reference spectrum 
(indicated with BS in the scan heading) as the last scan for each compound in the 
Quantitation Report - 2 report. The application does not use background subtraction 
with qualitative processing. 

12. In the Stepoff Value box, enter a number.

The application uses this offset value to average and subtract scans that are not adjacent to 
the apex of the peak. For example:

If you entered 3 in the Number of Scans To Subtract box and the stepoff value is 5, the 
application ignores the first 5 scans to the left of the peak and applies the averaging and 
subtraction to the 6th, 7th, and 8th scans to the left of the peak.

13. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify all the parameters in a master method, see 
“Editing a Master Method” on page 135.

 To manually select compounds to create a new method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens. See “Create Master Method dialog box” on 
page 117.

2. Select the Quan Using Method Forge option and click OK.

The Method Forge dialog box opens. For detailed descriptions of all the features in the 
Method Forge dialog box, see “Importing an Xcalibur Master Method” on page 127.

Each method requires a qualitative peak processing template. The application displays all 
saved method templates in the template list.
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3. To select a qualitative peak processing template, do one of the following:

• Click Open Method Template Editor to create and save a new method template.

See “Creating a Method Template” on page 243.

• Select a method template from the template list, and click Open Method Template 
Editor to edit and save the method template. The application saves the methods to 
the following folder:

…\TraceFinderData\3.3\Templates\Methods\General 

• Select a method template from the template list.

The selected template is now selected by default each time you open the Method Forge 
dialog box until you restart the application. 

To view the parameters for each available method template, hold your cursor over the 
template name, as in this example:

4. Select the Name the Master Method check box and type a name for your master method.

You can enter a new method name, or you can enter an existing method name and 
overwrite it when you create the method. If you do not select this option, the method is 
named for the raw data file used to create the method.

5. Ensure that the Automatically Create the Master Method check box is cleared.

6. To select a raw data file, browse to the file location.

IMPORTANT  When the Name the Master Method check box is selected, you must 
enter a method name. To let the application name the method with the raw data file 
name, clear the Name the Master Method check box.
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7. To manually create the master method, click OK (or Overwrite).

The method forge results view opens, listing all peaks found in the raw data file.

For each peak listed in the RT column, the application displays a list of possible matches 
in the Libraries pane. The application selects the best match, displays the name in the 
Compound Name list, and displays the peak spectrum for that compound in the first 
Libraries pane.

Figure 30. Method forge results view

Peaks found in raw data file

Best match compound spectra

Possible matches Best match compound name
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8. (Optional) To use a library compound other than the compound chosen by the 
application, do the following:

a. Select the peak in the RT column.

b. In the Libraries pane, scroll to the spectrum for the compound that you want to use.

c. Select the check box in the header of the spectrum pane. 

d. Repeat these steps for each peak that you want to replace.

9. In the Compound Name list, use the CTRL or SHIFT keys to select each compound that 
you want to include in the method compound.

10. (Optional) To exit the method forge results view without creating a method, click 
Cancel.

The method forge results view closes and the application returns to the Method View 
without creating a method. 

11. Click Create. 

The application uses all selected compounds to create the method and displays the 
Acquisition page of the Method View. For detailed descriptions of all the features on the 
Acquisition page, see “Acquisition Page for a Quantitation Method” on page 140.

12. From the Instrument Method list, select an instrument method.

13. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 135. 

This animation shows how to create a new quantitation method using Method Forge. To view 
the animation, click , and then right-click and choose Full Screen Multimedia. To stop 
the animation, press ESC.

Note  When you select multiple compounds, the method forge results view does not 
display any spectrum panes.

Note  To return to the method forge results view to create a method from the same 
results, choose Method View > View Method Forge Results from the main menu.

Selected 
compound
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Method Forge Dialog Box

Use the Method Forge dialog box to create a new master method.

Figure 31. Method Forge dialog box 

Table 17. Method Forge dialog box parameters  (Sheet 1 of 2)

Parameter Description

Method template selection

Open Method 
Template Editor

Opens the Method Template Editor, where you can edit the currently selected method 
template. See “Creating a Method Template” on page 243.

Template Specifies the method template to use to create this master method. All methods require a 
method template. To view the parameters of each template, hold your cursor over the 
method name. See the Method Template Parameters example in “To automatically select 
compounds to create a new method” on page 118.

Name the Master 
Method

Specifies the name for the new master method. If you do not specify a method name, the 
application uses the raw data file name for the method.

Automatically Create 
the Master Method

Specifies that when acquisition is completed, Method Forge performs peak detection, library 
searching, and identification of characteristic ion and reference spectra. This information is 
loaded into a new master method. This process occurs immediately when you specify an 
existing raw data file.
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Raw file selection

Use an Existing Raw 
Data File

Activates the Raw Filename box where you can select a raw data file used in creating the 
master method.

Acquire a New Raw 
Data File

Activates functions to acquire data to create a raw data file used in creating the master 
method.

Instrument 
Method

Specifies the saved method (.meth) file used for acquiring the data.

Raw Filename Specifies the file name where the application writes the raw data.
Path Specifies the location where the application saves the raw data file.
Sample Comment (Optional) Specifies a comment about the acquired sample or the data file.

Manual Injection Performs a manual acquisition.
Use Autosampler Performs an autosampler acquisition.

Vial Position Specifies the tray vial number used for the autosampler acquisition.
Injection Amount Specifies the volume (in milliliters) injected by the autosampler acquisition.

Check Instruments Opens the Submit to Acquisition dialog box that prompts you to prepare the instrument 
before you acquire the sample used to create a method. Available only when you select the 
Acquire a New Raw Data File option.

Function button

Overwrite Overwrites the specified master method name. This function is activated only when the 
specified master method name already exists.

OK Creates a master method using the data and parameters that you specified.
Cancel Closes Method Forge and does not create a master method.

Table 17. Method Forge dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Importing an Xcalibur Master Method

You can create a new master method from an existing Xcalibur processing method.

 To import an Xcalibur master method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. To view all available ways to create a master 
method, see “Create Master Method dialog box” on page 117.

2. Select the Quan by Importing an Xcalibur Processing Method option and click OK.

The Import an Xcalibur Method dialog box opens.

3. For the Xcalibur Method to Import box, browse to the location of the Xcalibur processing 
method file, and open the file.

The application imports the compound information from the Xcalibur method file.

4. (Optional) For the Raw Data File to Associate box, browse to the location of a raw data 
file to associate with the method (or select from the list of previously associated raw data 
files), and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\3.3\Methods\Methodname
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5. (Optional) Change the number of decimal places in the Filter Precision box.

You can set the number of filter precision decimal places to any integer between 2 and 5, 
inclusive.

6. (Optional) Change the number of decimal places in the Mass Precision box.

You can set the number of mass precision decimal places to any integer between 2 and 6, 
inclusive.

7. Click OK.

The application adds all compounds found in the imported Xcalibur method and displays 
the Acquisition page of the Method View. For detailed descriptions of the features on the 
Acquisition page, see “Acquisition Page for a Quantitation Method” on page 140.

8. From the Instrument Method list, select an instrument method.

9. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 135. 

This animation shows how to create a new quantitation method by importing an Xcalibur 
processing method. To view the animation, click , and then right-click and choose Full 
Screen Multimedia. To stop the animation, press ESC.

Note  When you select a raw data file to associate, the application reads the filter 
precision from the file and this feature is not available. 

Note  When you associate a raw data file, the application reads the filter precision 
from the associated file so that you cannot change the Filter Precision value.
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Creating a Blank Method

You can use the compounds in a previously acquired raw data file to create a new blank master 
method.

 To create a blank method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens. To view all available ways to create a master 
method, see “Create Master Method dialog box” on page 117.

2. Select the Quan – Blank Method option and click OK.

The Method View for a new, unnamed method opens. This method has no associated 
data. You can use the compounds in a previously acquired raw data file to create a new 
master method.

3. From the Method View menu, choose Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

4. Browse to a raw data file to associate with the method (or select from the list of previously 
associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\3.3\Methods\Methodname

Browse to a data file.

Select a previously associated data file.
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5. Select the update options to use for creating your method:

• Update Instrument/Trace Selections: Reads the Detector and Trace options from 
the associated raw data file. On the Detection page, only detector types and traces 
that are defined in the raw data file are available. For detailed descriptions of the 
available Detector and Trace values, see “Signal” on page 168.

• Update Target Ion Ratio Values: Reads the ion ratio values from the associated raw 
data file.

• Update Scan Filters for All Peaks: 

– Yes, All Peaks updates all peaks to use the scan filters from the associated raw 
data file. 

– Yes, Only Peaks Without Filters updates only peaks without scan filters to use 
the scan filters from the associated raw data file; it does not override any existing 
scan filter.

• Automatically Set Reference Spectrum: Reads a reference spectrum from the 
associated raw data file.

When you select Yes, with Background Subtraction, the application uses the 
background-subtracted reference spectrum during quantitative processing and 
reports the background-subtracted reference spectrum (indicated with BS in the scan 
heading) as the last scan for each compound in the Quantitation Report - 2 report.

Options that are set to No use the standard values in the method. 

6. Click OK.

The application displays the Acquisition page of the Method View. 

7. Click Compounds in the navigation pane.

The method must include at least one compound.

Note  The background subtraction option is available only when you select a 
background subtraction method on the Acquisition page in the master method. 
See “Editing the Acquisition Page” on page 137.
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8. Click the Detection tab.

The Detection page shows an empty Compound list and displays the chromatographic 
data for the compounds in the raw data file.

9. Select a filter from the Filter list.

10. Select the peak in the chromatogram that represents the compound that you want to add 
to the method. 

11. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the quantitative peak, and the second and third largest ions as the confirming ion peaks. 

Note  When the peak is from an analog trace, the application does not perform a 
library search and does not identify any confirming ions.
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If the name of the first match is already in the library, the Add New Compound dialog 
box opens.

12. (Optional) Do the following:

a. To use a compound other than the compound already in the library, scroll to the 
spectrum for that compound and select the compound name in the title bar of the 
spectrum pane.

b. In the Type of Compound To Add list, select a compound type.

c. Click OK.

13. Repeat this procedure for each compound that you want to add to the method.

For detailed descriptions of all the features on the Detection page, see “Editing the 
Compounds Page” on page 150. 

14. Click Acquisition in the navigation pane.

The Acquisition page for the method opens. For detailed descriptions of all the features 
on the Acquisition page, see “Acquisition Page for a Quantitation Method” on page 140.

Selected 
compound
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15. From the Instrument Method list, select an instrument method.

16. To save the new method, choose File > Save from the main menu and name the method.

For a detailed description of how to modify the parameters in a master method, see 
“Editing a Master Method” on page 135. 

This animation shows how to create a new quantitation method by associating a raw data file. 
To view the animation, click , and then right-click and choose Full Screen Multimedia. 
To stop the animation, press ESC.

Selecting Compounds from the Compound Database

You can select compounds from the compound database to create a new master method. 

 To select compounds from the compound database

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. To view all available ways to create a master 
method, see “Create Master Method dialog box” on page 117.

2. Select the Quan by Selecting Compounds from CDB option and click OK.

The Select Compounds from Database dialog box opens, listing all the compounds 
defined in the compound database. See Select Compounds from Database dialog box.
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Figure 32. Select Compounds from Database dialog box

3. Select the check box for each of the compounds that you want to add to the method.

4. To select all compounds in the database, select the Compound check box at the top of 
the list.

5. Click Apply.

The application adds the selected compounds to the method. 

6. Click Acquisition in the navigation pane.

The Acquisition page for the method opens. For detailed descriptions of all the features 
on the Acquisition page, see “Acquisition Page for a Quantitation Method” on page 140.

7. From the Instrument Method list, select an instrument method.

8. To save the new method, choose File > Save from the main menu and name the method.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 135. 

This animation shows how to create a new quantitation method by selecting compounds from 
the compound database. To view the animation, click , and then right-click and choose 
Full Screen Multimedia. To stop the animation, press ESC.
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Editing a Master Method
You can open a master method to view or edit the compounds, method instructions, and 
reporting options.

See the instructions for the following tasks:

• Modifying Retention Times

• Enabling Auto Reprocessing

• Editing the Acquisition Page

• Editing the Processing Page

• Editing the Compounds Page

• Editing the QAQC Page

• Editing the Groups Page

• Editing the Intelligent Sequencing Page

• Editing the Library Settings Page

• Editing the Reports Page

Modifying Retention Times

Use the Adjust Retention Times dialog box from any page in the Method View or Local 
Method view.

 To modify retention times in a method

1. Do one of the following:

• Choose Method View > Adjust Retention Times from the main menu of the 
Method View in the Method Development mode.

• Choose Local Method > Adjust Retention Times from the main menu of the Local 
Method view in the Analysis mode.

The Adjust Retention Times dialog box opens.
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2. Do one of the following:

a. Select the Absolute option.

b. Specify a positive or negative value to increase or decrease the expected retention 
times. (Valid range: –100.00 through 100.00)

c. Click OK.

The application increases or decreases the expected retention times for all compounds 
in the method by the specified number of minutes. 

–or–

a. Select the Relative option.

b. Specify a positive or negative value to increase or decrease the expected retention 
times. (Valid range: –100.00 through 100.00)

c. Click OK.

The application increases or decreases the expected retention times for all compounds 
in the method by the specified percentage. 

–or–

a. Select the By File option.

b. Click Select.

The Adjust Retention Time by File dialog box opens, displaying all processed 
samples.

c. Select the sample whose retention times you want to use in the method.

d. Click Select.

e. Click OK.

For each detected peak in the selected, processed sample, the application overwrites 
the retention times for the matching compounds in the method. If the method 
contains compounds not detected in the selected sample, the retention times for 
those compounds are not affected.

Note   This option is available only from the Local Method view after you have 
processed the samples in a batch.
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Enabling Auto Reprocessing

The Auto Reprocess option is displayed in the banner of all TraceFinder application views.

• When you select this option, the application automatically reprocesses a batch and 
displays the updated results in Data Review when you make changes to the method or 
make any manual integration changes. 

• When you clear this option, the application does not automatically reprocess batches or 
update the results in Data Review when you make changes to the method or make any 
manual integration changes. The application simply stores the changes to the method or 
the manual integration. The application updates the Data Review results only when you 
manually reprocess the batch.

Editing the Acquisition Page 

The Acquisition page defines basic information about the master method. For detailed 
descriptions of all the features, see “Acquisition Page for a Quantitation Method” on 
page 140.

Follow these procedures:

• To open the Acquisition page

• To specify Acquisition information for a master method

• To edit an instrument method

 To open the Acquisition page

Click Acquisition in the Method View navigation pane.

Note  Batch processing can be slower when you use auto reprocessing.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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 To specify Acquisition information for a master method 

1. In the Lab Name box, type the name to be displayed at the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type to be targeted by the method.

3. From the Injection Volume box, select an injection volume (between 0.1 and 2000 μL) to 
be used for sample injection.

Use the up/down arrows to change the volume in increments/decrements of 1 μL, or use 
the keyboard to enter non-integer injection volumes. 

4. From the Mass Precision box, select a precision value (between 2 and 6 inclusive) as the 
number of decimal places to be used in reports and in peak and spectrum displays. 

5. From the Ion Range Calc Method list, select a method for calculating the ion ratio range 
windows.

When you select Level, the application displays a Use Level list where you can choose a 
calibration level. To define the available calibration levels on the Compounds page, see 
“Editing the Compounds Page” on page 150.

 To edit an instrument method

1. From the Instrument Method list on the Acquisition page, select an instrument method. 

2. To edit the selected instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments. (See Thermo Instrument Setup window.)

IMPORTANT  The application uses this injection volume in the master method, not 
the injection volume from the instrument method.
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Figure 33. Thermo Instrument Setup window

3. Edit the values on the instrument page for your instrument.

4. From the main menu in the Thermo Instrument Setup window, 
choose File > Save and then choose File > Exit.

The application returns you to the Acquisition page. See Acquisition Page for a 
Quantitation Method.

5. To update any changes that were made to the instrument method after you created this 
master method, click Update.

The Update Instrument Method? dialog box opens.

6. Choose one of the following options:

• Send to System Methods: Overwrites the instrument method in the 
C:\TraceFinderData\3.3\Methods folder with the current instrument method.

• Get from System Method: Overwrites the current instrument method with the 
instrument method in the C:\TraceFinderData\3.3\Methods folder.

• Cancel: Makes no changes to the instrument method in the current master method.
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Acquisition Page for a Quantitation Method

Use the features on the Acquisition page to define basic information about the master 
method.

Figure 34. Acquisition page for a quantitation method

Table 18. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name Specifies the laboratory name to be displayed at the top of each 
printed, saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see “Specifying Application 
Defaults” on page 37.

Assay Type Specifies the name for the analysis type to be targeted by the 
method. The assay type associates the method with the analysis of a 
compound or specific class of compounds (for example, you might 
use an assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).

Injection Volume Specifies the system uses the injection volume (in μL) for sample 
injection. For a more detailed explanation, refer to the 
documentation for the autosampler.

The injection volume in the master method overrides the injection 
volume in the instrument method. The injection volume in the 
batch overrides the injection volume in the master method.

Valid range: 0.1 through 2000 μL
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Editing the Processing Page 

The Quantitation – Processing page defines basic information about the master method. For 
detailed descriptions of all the features, see “Processing Page for a Quantitation Method” on 
page 147.

Follow these procedures:

• To set automated background subtraction options

• To set automated background subtraction options

• To specify mass tolerance

• To include data-dependent filters

• To specify a threshold override

• To specify qualitative peak processing parameters

• To specify library selection

• To add unknown screening to the method

Mass Precision Specifies the number of decimal places used in reports and in peak 
and spectrum displays. 

Valid range: Integers from 2 through 6, inclusive.
Ion Range Calc 
Method

Specifies the selected ion range calc method used to calculate the 
ion ratio range windows: Manual (default), Average, Level, or 
Weighted average. When you select Level, an additional list is 
displayed where you can select a calibration level amount. To define 
these calibration levels on the Compounds page, see “Editing the 
Compounds Page” on page 150.

Instrument Method Specifies the instrument method used for acquiring samples.
Edit Opens the Thermo Xcalibur Instrument Setup window where you 

can edit the instrument method.
Update Specifies one of the following:

Send to System Methods: Overwrites the system method in the 
C:\TraceFinderData\3.3\Methods folder with the current 
instrument method.

Get from System Methods: Overwrites the current instrument 
method with the system method in the 
C:\TraceFinderData\3.3\Methods folder.

Table 18. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description
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 To open the Processing page

Click Processing in the Method View navigation pane.

 To set automated background subtraction options

1. In the Background Subtraction Range Option list, select how you want the subtraction 
range determined from the following options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans after the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

When you create a reference spectrum with background subtraction, the application uses 
the selected method to conduct background subtraction of peak spectra during 
quantitative processing. The application then reports the background-subtracted 
reference spectrum (indicated with BS in the scan heading) as the last scan for each 
compound in the Quantitation Report - 2 report. It does not use background subtraction 
with qualitative processing. 

2. In the Number of Scans to Subtract box, enter a number.

The application subtracts this number of scans from the background after averaging. 
When you select the Both Sides of Peak option, the application subtracts this number of 
scans from each side of the peak.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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3. In the Stepoff Value box, enter a number.

The application uses this offset value to average and subtract scans that are not adjacent to 
the apex of the peak, as in this example:

Before Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the left of the peak and applies the averaging and 
subtraction to the 6th, 7th, and 8th scans to the left of the peak.

After Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the right of the peak and applies the averaging and 
subtraction to the 6th, 7th, and 8th scans to the right of the peak.

Both Sides of Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the left of the peak and the first 5 scans to the right 
of the peak. Then it applies the averaging and subtraction to both the 6th, 7th, and 8th 
scans to the left of the peak and the 6th, 7th, and 8th scans to the right of the peak.

 To specify mass tolerance

1. Select the units of measure that you want to use. 

2. Specify the number of millimass units or parts per million to use as the m/z ± tolerance 
value.

The application applies this mass tolerance to the extracted chromatograms.

 To include data-dependent filters

Select the Include Data Dependent Filters option.

The application includes data-dependent filters when you specify filters in the method. 
See “Signal” on page 168.

Data-dependent filters are indicated with a “d”.

When you process a sample using a data-dependent filter, the application uses the TIC 
trace to find all data-dependent full scans, lists them, and performs a library search against 
the data-dependent MS/MS or MSn scan.

Data-dependent filter
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 To specify a threshold override

To set a threshold override and include only peaks with areas above this designated 
threshold, do the following:

a. Select the Threshold Override check box.

b. In the associated box, type the threshold as an area value.

This threshold overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below your specified threshold.

 To specify qualitative peak processing parameters

1. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that results in compound selection, select the Enable Peak Threshold check 
box. 

To consider a peak for a processing method, the application uses the Enable Peak 
Threshold filter to determine which peaks meet the specified percentage of the height or 
area of the largest peak. 

2. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.

3. Select the Use Genesis Algorithm for Qual Processing check box and specify a value for 
internal standard matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value that you specify. For additional information about the Genesis 
algorithm, see “Genesis Detection Method” on page 43.

4. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes quantitative peaks in a range plus or minus the value that you 
specify.

5. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

This option constrains the Data Review to only data-dependent scan spectra. 

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. 
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6. To indicate whether to select peaks above a minimum percentage of the nearest internal 
standard peak that results in compound selection, select the Enable ISTD Threshold 
check box and specify a minimum percentage. 

To consider a peak for a processing method, the application uses the Enable ISTD 
Threshold filter to determine which peaks meet the specified percentage of the height of 
the nearest internal standard peak. 

When you select the Enable ISTD Threshold parameter, the method ignores values set for 
the Enable Peak Threshold parameter in the method template. 

 To specify library selection

1. In the Use these Libraries box, select the libraries that you want to search.

All libraries loaded on your instrument are displayed in the Use these Libraries box. 

2. To limit the number of matches returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

 To add unknown screening to the method

1. Select the Include Unknown Screening check box.

The application adds the Unknown Screening features to the Method View navigation 
pane.

2. To specify unknown screening settings for peaks, libraries, databases, elements, and 
ChemSpider™ searches, click Processing.

For further instructions, see “Editing the Processing Pages” on page 311.

Note  When you create a method with the Method Forge, the application ignores the 
parameters in the Qualitative Peak Processing area.

IMPORTANT   The Include Unknown Screening check box is available only when you 
select the Allow Unknown Screening option in the application configuration console. 
See “Processing Options” on page 62.
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3. To specify unknown screening peak detection settings, click Peak Detection Settings.

For further instructions, see “Editing the Peak Detection Settings Page” on page 334.

The application indicates that a quantitation method includes unknown screening 
features in the following locations:

• In the Batch View in the Analysis mode, when you create a batch using a quantitation 
method, the title bar indicates that the method includes unknown screening features.

• In the Analysis navigation pane, the application displays access to local methods for 
both quantitation and unknown screening.

• In the Submit Options dialog box, when you submit a batch, the Process Data area 
shows all available process data for the batch.

You can select the detection options for each processing method that you want to use 
when you submit the batch.
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Processing Page for a Quantitation Method

Use the features on the Processing page to define basic information about the master method.

Figure 35. Processing page for a quantitation method

 

Table 19. Processing page parameters  (Sheet 1 of 3)

Parameter Description

Background 
Subtraction Range 
Option

Specifies the range used for background subtraction. 

Valid values: None, Before Peak, After Peak, Both Sides of Peak
Default: None
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Number of Scans To 
Subtract

Valid values: Even numbered integers

Default: 0
Stepoff Value Offset from the selected peak to the first subtracted peak.
Mass Tolerance Specifies the upper limit of MMU or PPM.

Default: 500
Valid range: 0.1 through 50 000

• (Default) MMU (millimass units): MMU is a static calculation 
to the extracted mass.

• PPM (parts per million): PPM is a variable calculation 
dependent on the actual mass. The smaller the mass, the 
narrower the tolerance range. The larger the mass, the wider the 
tolerance range.

Include Data 
Dependent Filters

Specifies that the method includes data-dependent filters. Available 
only for quantitation methods.

Threshold Override Overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below this 
specified threshold.

Valid range: 1000 through 1 000 000 000
Default: 5000

Qualitative Peak Processing

Enable Peak 
Threshold 

Specifies whether to select peaks by relative height or area and the 
percentage of the highest peak that results in compound selection.

Only Select Top 
Peaks

Displays a specific number of the largest peaks by height or area.

Use Genesis 
Algorithm For Qual 
Processing

The application uses the Genesis algorithm to match internal 
standards. 

ISTD Matching Excludes all the target compounds found in the method and does 
not list these compounds in the TIC Report or in the Qual Mode 
view in the Data Review.

Exclude Matching 
Quan Peaks

Exclusion Window

Compares the retention time of the internal standard in the method 
to the found retention time of the internal standard in the library 
search and excludes peaks outside the Exclusion Window range. 

Defines a range plus/minus the Exclusion Window value that you 
specify.

Use Data Dependent 
Scans

Constrains the Data Review to only data-dependent scan spectra. In 
addition to the peak information, the TIC Report and TIC 
Summary Report display information about the data-dependent 
filtered data.

Table 19. Processing page parameters  (Sheet 2 of 3)

Parameter Description
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Enable ISTD 
Threshold

% of Internal 
Standard

Specifies that, when identifying a peak, qualitative peak processing 
use the minimum threshold specified as a percentage of the nearest 
internal standard peak, rather than the threshold specified in the 
Enable Peak Threshold parameter in the method template.

Percentage of the nearest internal standard peak to use as the 
minimum threshold for identifying a peak.

Library Selection Specifies the libraries to use for qualitative peak processing.
Limit Library 
Hits

Specifies the number of matches returned when the system searches a 
spectrum against the selected libraries.

Best Match 
Method

Specifies how to sort the library searches. 

Valid values: Search Index, Reverse Search Index, Match Probability
Unknown Screening

Include Unknown 
Screening

Adds unknown screening features to the quantitation method.

Table 19. Processing page parameters  (Sheet 3 of 3)

Parameter Description
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Editing the Compounds Page

Use the Compounds page to set all parameters for identifying, detecting, and quantifying the 
target compound list. 

 To open the Compounds page

Click Compounds in the Method View navigation pane.

From the Compounds page of the Method View, you can access the following pages:

Each page on the Compounds page (except the Acquisition List and Real Time Viewer pages) 
uses a right-click shortcut menu. See “Using the Shortcut Menu Commands” on page 212.

Acquisition List

The Acquisition List page displays all compounds defined for the current method in a display 
similar to the Compound Database view. From the Acquisition List page, you can add 
additional compounds from the Compound Database or delete compounds from the method. 
See Acquisition List page.

For detailed descriptions of all the features in the Compound Database views, see “Working 
with the Compound Database” on page 74.

Acquisition List See also Acquisition List page.
Identification See also Identification page.
Detection See also Detection.
Calibration See also Calibration page.
Calibration Levels See also Calibration Levels page.
Chk Std Levels See also Chk Std Levels page.
Real Time Viewer See also Real Time Viewer page parameters.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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 To remove a compound from the method

1. Select the compound in the Compound list.

2. Click the Remove Compound icon, .

3. To confirm that you want to delete the selected compound, at the prompt, click OK.

The application removes the selected compound and all its peak information.

4. To remove multiple compounds, use the CTRL or SHIFT keys.

The application confirms that you want to remove the selected compounds.

 To add a compound to the method

1. Click the Add Compound from Compound Database icon, .

The Select Compounds from Database dialog box opens, listing all the compounds 
defined in the compound database. This dialog box is identical to the Compound 
Database with the exception that you cannot edit the compound data from here; you can 
only choose which compounds you want to include in your method.

2. Select the compounds to add to the method.

You can use the SHIFT or CTRL keys to select multiple compounds.

3. Click Add Selected Compounds to Method.

The application adds the selected compounds to the acquisition list for the method. 

Figure 36. Acquisition List page
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Identification

The Identification page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values. For descriptions of all values on the Identification page, see 
“Identification Page.” 

 To filter the displayed compounds

From the Show list, select the type of compounds that you want to display in the 
compounds list.

Compound type Description

Quan Compounds Displays only quantitation compounds, such as target 
compounds and internal standards. 

Target Compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.
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Identification Page

Use the features on the Identification page to display all compounds targeted by the method.

Figure 37. Identification page

 

Table 20. Identification page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

The application uses the RT and Window values to determine the start and stop time for 
the acquisition. 

Valid range: 0.00 through 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 through 999.00

Compound A list of identified compounds. To customize the compound names, click the cell and type a 
new name. To display a filtered list of compounds, use the Show list.

Compound Type Displays the compound types as Target Compound or Internal Standard. The application 
uses target compounds and internal standards in quantitative analysis.

Active Identifies each compound to be included in data review and reporting. By default, all added 
compounds are set to active. This active or inactive setting populates the Batch View and 
Data Review view in the Analysis mode. 

CAS No The Chemical Abstract Service (CAS) number that the application matched with each 
compound. To change or add a number, click the CAS No cell and enter a new number.

LIMS ID Laboratory Information Management System identification number.

Use as RT Reference When performing peak detection with retention time standards, the application first 
identifies those compounds identified as retention time standards and then uses their 
observed retention times to adjust any associated target compound.

Reference Compound To be used for retention time adjustment for a compound. This list includes all compounds 
that are selected in the Use as RT Reference column. 

Shortcut menu
The Identification page uses a right-click shortcut menu. See “Using the Shortcut Menu 
Commands” on page 212.
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Detection

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

From the Detection page, you can access the following pages:

On the Detection page (see “Detection page” on page 165), you can configure how 
characteristic ions for targeted compounds are detected and integrated. You can also edit the 
list of characteristic ions for a specific compound. Refining these parameters in the master 
method for each compound and its ions can reduce the degree of manual integration that 
would otherwise be required. 

You can change the parameters used to identify a quantitative peak, mass range, or confirming 
ion peak. The application automatically uses the first match it finds as the compound name, 
the base peak of the mass spectrum as the quantitative peak, and the second and third largest 
ions as the confirming ion peaks. 

Follow these procedures:

• To filter the displayed compounds

• To change the displayed information for detected peaks

• To add compounds to the method

• To change the compound reference spectrum

• To replace a quantitation mass

• To add a mass to the existing quantitation mass ranges

• To add a quantitative peak

• To add a spectral peak as a new compound

• To replace a quantitative peak with a confirming ion peak

• To set a confirming ion peak as an additional quantitative peak

• To add a trace to the Real Time Status pane

• To replace a confirming ion peak

Times See also Times page parameters.
Signal See also Signal page parameters.
Detect See also Detect page parameters for Genesis.

See also Detect page parameters for ICIS.
See also Detect page parameters for Avalon.

Suitability See also System Suitability dialog box parameters.
Spectrum See also Spectrum page shortcut menu commands.
Library See also Library page parameters.
Isotopes See also Isotopes page parameters.
Fragments See also Fragments page parameters.
Ratios See also Ratios page parameters.
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• To add a mass as a new confirming ion peak

• To use the cut-and-paste feature on confirming ion peaks

• To save the new method

 To filter the displayed compounds

From the Show list, select the type of compounds that you want to display in the 
compounds list.

 To change the displayed information for detected peaks

1. Right-click the chromatogram plot for any of the quan or confirming peaks and hold the 
cursor over Peak Labels.

2. Choose to display labels for the peak area, peak retention time, peak height, or 
signal-to-noise.

3. To remove a label, choose the label type again and clear it.

The application globally applies these label settings to all quantitative peaks, confirming 
peaks, and internal standard peaks in the method. 

Compound type Description

Quan Compounds Displays only quantitation compounds, such as target 
compounds, internal standards, and surrogates. 

Target Compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.
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 To add compounds to the method

1. From the main menu, choose Method View > Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

2. Browse to a raw data file to associate with the method (or click the arrow and select from 
the list of previously associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the file in the Methods folder:

…\TraceFinderData\3.3\Methods\Methodname

3. To update the target ion ratio values when you associate this raw data file, select the Yes 
option.

4. To update the scan filters when you associate this raw data file, select the Yes option.

5. To set a reference spectrum, do one of the following:

Select the Yes option.

–or–

Select the Yes, with Background Subtraction option.

The application uses the background-subtracted reference spectrum during quantitative 
processing and reports the background-subtracted reference spectrum (indicated with BS 
in the scan heading) as the last scan for each compound in the Quantitation Report - 2 
report.

Tip  You can add compounds from the current raw data file (begin at step 7), or you 
can associate another raw data file and add compounds from that file (begin at step 1).

Note  This option is available only when you select a background subtraction method 
on the Acquisition page in the master method. See “Editing the Acquisition Page” on 
page 137.

Browse to a data file.

Select a previously associated data file.
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6. Click OK.

The application displays the chromatographic and spectrum data for the compounds in 
the associated raw data file. 

7. Select a filter from the Filter list.

8. Click to select the peak in the chromatogram that represents the compound that you 
want to add to the method. 

9. Right-click and choose Add This Peak as New Compound from the shortcut menu.

IMPORTANT  While the spectra pane displays the associated raw data file, you cannot 
display peak information for an original compound in the Compound list. You can 
display peak information only for compounds in the associated raw data file. To 
return the display functionality for all compounds in the method, save the method.
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The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the quantitative peak, and the second and third largest ions as the confirming ion peaks. 

• When the name of the first match does not exist in the method, the application adds 
this compound to the method and displays the name in the Compound list. You can 
now view and edit the parameters for this compound.

• When the name of the first match is already in the method, the Add New Compound 
dialog box opens (see Add New Compound dialog box). You cannot overwrite a 
compound name in the method. If the selected peak already exists in the method, you 
must give it a new name to add it to the method. Or, you can select a different 
compound to add to the method, following step 10 through step 12.

Figure 38. Add New Compound dialog box

10. Do one of the following:

• Type a new name for the first matched compound.

The application displays a red warning when the selected compound name already 
exists in the method. You cannot overwrite the compound name, and you cannot 
create a duplicate name in the method. You must type a unique name.

–or–
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• To use a compound other than the first matched compound, scroll to the spectrum 
for that compound and select its corresponding check box in the title bar of the 
spectrum pane.

11. In the Type of Compound To Add list, select a compound type.

12. Click OK.

 To change the compound reference spectrum

1. In the chromatogram pane, click a peak.

The application displays the spectrum for the selected peak in the spectrum pane.

2. In the spectrum pane, right-click and choose Use This Spectrum for Compound 
Reference Spectrum from the shortcut menu.

 To replace a quantitation mass 

1. Click the data pane for the quantitation mass that you want to replace. 

2. In the spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Spectral Peak as Quan Value from the shortcut menu.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

You can see the updated ion ratios on the Ratios page for the confirming ion peaks. See 
“Ratios” on page 202.

Selected 
compound
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 To add a mass to the existing quantitation mass ranges

1. In the spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak to Existing Quan Ranges from the 
shortcut menu.

3. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

The application adds the selected mass to the existing quantitation mass ranges to increase 
the signal. 

If you chose to update the ion ratios, you can see the updated ion ratios on the Ratios 
page for the confirming ion peaks. See “Ratios” on page 202.

 To add a quantitative peak

1. In the spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Quan Peak from the shortcut 
menu.

The application adds a new quantitative peak to the compound.

You can use the shortcut menu in the spectrum pane for this new quantitative peak to 
perform any of the tasks that you would perform on the original quantitative peak.

 To add a spectral peak as a new compound

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Compound from the shortcut 
menu.
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The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the quantitative peak, and the second and third largest ions as the confirming ion peaks. 

When there are multiple matches, the Add New Compound dialog box opens (see Add 
New Compound dialog box). If the name of the first match is already in the library, the 
dialog box opens with the matching compound selected.

Figure 39. Add New Compound dialog box

3. (Optional) Make any of the following changes:

• Change the name for the compound in the Name of New Compound box.

• Use a compound other than the compound chosen by the application by scrolling to 
the spectrum for that compound and selecting the compound name in the title bar of 
the spectrum pane.

• In the Type of Compound To Add list, select a compound type.

4. Click OK.

Selected 
compound
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 To replace a quantitative peak with a confirming ion peak

1. When you have multiple quantitative peaks, select the quantitative peak that you want to 
replace.

2. Right-click the header bar for the confirming ion peak that you want to use as the 
quantitative peak, and choose Swap with Quan Peak from the shortcut menu.

The application swaps the quantitative peak and the confirming ion peak. The 
application replaces all information for the quantitative peak with information for the 
confirming ion. This includes the expected retention time that the confirming ion 
inherited from the original quantitative peak. The original quantitative peak replaces the 
confirming ion peak. The application recalculates the ratios for all confirming ion peaks.

 To set a confirming ion peak as an additional quantitative peak

Right-click the header bar for the confirming ion peak and choose Promote to Separate 
Quan Peak from the shortcut menu.

The application creates a new quantitative peak, using information from the confirming 
ion peak. This includes the expected retention time that the confirming ion peak 
inherited from the original quantitative peak. The application removes all references to 
the confirming ion peak from the method.

 To add a trace to the Real Time Status pane

Right-click the header bar for the quantitative peak or confirming ion peak that you want 
to add to the Real Time Status pane and choose Display in Real Time Viewer from the 
shortcut menu.

The application moves the peak to the Traces To Display in Real Time Viewer pane on 
the Real Time Viewer page. See “Real Time Viewer” on page 211.

Trace m/z 311.09 added 
to Real Time Viewer
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When you acquire samples with this method, the application displays the m/z 311.09 
trace in addition to the TIC in the Real Time Status pane.

 To replace a confirming ion peak

1. Click the pane for the confirming ion peak that you want to replace. 

2. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Spectral Peak as Confirming from the shortcut menu.

The application replaces the confirming ion peak with the selected mass.

 To add a mass as a new confirming ion peak 

1. In the spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Confirming from the shortcut 
menu.

The application adds the confirming ion peak to the quantitative peak.

You can use the shortcut menu in the spectrum pane for this new confirming ion peak to 
perform any of the tasks that you would perform on the original confirming ion peaks.

Trace m/z 311.09 added to 
Real Time Status display
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 To use the cut-and-paste feature on confirming ion peaks

1. Right-click the header bar for the confirming ion peak that you want to remove and 
choose Cut Confirming Peak from the shortcut menu.

2. Right-click the header bar for the confirming ion peak that you want to replace and 
choose Paste Confirming Peak from the shortcut menu.

The application pastes the confirming ion peak that you removed. You can paste a deleted 
peak back to the quantitative peak from which it was removed, or you can paste the 
confirming ion peak that was deleted to another quantitative peak for this compound. 

 To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Type a new name for the master method and click OK, or select a method name to 
overwrite and click Overwrite.

The application saves the new method data in the following folder:

…\TraceFinderData\3.3\Methods 
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Detection Page

Use the features on the Detection page to customize peak detection and integration for any 
ions that define peaks and compounds.

Figure 40. Detection page 

Chromatogram pane Spectrum paneSelected compound data

Selected compound
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Table 21.  Detection page panes

Pane Description

Compound Lists all compounds in the master method. The Compound list uses a right-click shortcut 
menu. See “Using the Shortcut Menu Commands” on page 212.

QuanPeakn Displays a chromatogram for the quantitative peak and its confirming ion peaks. The 
quantitative peak and confirming peak panes include additional pages for retention time, 
signal, detection, spectrum, and ratio parameters for the selected compound.

Trace Displays a combination of the Detector and Trace values used for the raw data file. 

Do not confuse this Trace parameter with the Trace parameter on the Signal page. This 
Trace parameter combines both the Detector and Trace values specified on the Signal page. 
See “Signal page for a mass spectrometer detector” on page 173.

Note  When you select a detector option other than MS or PDA, the spectrum pane 
reports “Not Available.”

Filter Displays the filter used for the raw data file. Available only when you set the Trace parameter 
to MS.

Reference 
Chromatogram 
and 
Spectra

Displays a reference chromatogram and spectra for the raw data file.

When you view an analog trace, there is no spectra display. To close the spectra pane and use 
the full width to display the chromatogram, click .

Additional pages

Times Defines the retention time and window for a quantitative peak. See Times.

Signal Defines the detector and detection parameters used to display each chromatogram trace. See 
“Signal” on page 168.

Detect Defines the peak detection algorithm and its options. See “Detect” on page 176.

Spectrum Defines a reference mass spectrum for a quantitative peak or compound. See “Spectrum” on 
page 190.

Ratios Defines the criteria for evaluating, confirming, or qualifying ions. See “Ratios” on page 202.
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Times

Use the features on the Times page to define the expected retention time or a retention time 
range for a quantitative peak. 

Figure 41. Times page

Table 22. Times page parameters  (Sheet 1 of 2)

Parameter Description

Detection Type Single - Detected: (Default) Specified as a centered retention time window. The application 
integrates a distinct peak. In reports, the application displays the expected retention time 
and actual retention time values as Method RT and Detected RT, respectively. 
Range - Detected: Specified as a retention time start/end range. 
Range - Integrated: Specified as a retention time start/end range. The application integrates 
all peaks within the specified time range.

Expected RT (min) Expected retention time for a single peak. Available only for the Single - Detected detection 
type. 

Window (sec) Width of the window (in seconds) to indicate how far around the expected retention time 
the system looks for a peak apex. Available only for the Single - Detected detection type. 

Parameters for single 
RT detection types

Parameters for RT 
range detection types



5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

168 TraceFinder User Guide Thermo Scientific

Signal

Use the Signal page to define the detector and filters as you display each chromatogram trace. 
For detailed descriptions of all the features on the Signal page, see “Signal Page” on page 173. 
The application can use both analog detectors and mass spectrometer detectors. See “Signal 
page for a mass spectrometer detector” on page 173 or “Signal page for an analog detector” on 
page 174.

Follow these procedures:

• To specify ranges of ions for detection and integration

• To specify an XIC filter

• To specify an MS filter

 To specify ranges of ions for detection and integration

1. Select MS from the Detector list.

2. Select Mass Range from the Trace list.

3. In the Ranges area, click Edit.

Start/End RT (min) Beginning and ending retention time window that can encompass multiple peaks. Available 
only for the Range - Detected and the Range - Integrated detection types. When you change 
from a Single - Detected detection type, these values default to the previous beginning and 
ending time calculated from the Expected RT and Window values.

View Width (min) Viewable size of the ion chromatogram display. Changing the view width does not affect the 
peak detection process; the application uses it only for graphical display. When you select 
either Range - Detected or Range - Integrated as the detection type, you cannot select a 
View Width value less than the retention time range (end time minus start time).

Shortcut menu

Set Peak Windows 
Settings to All Peaks in 
Compound

Copies the View Width and Window values to all quantitative peaks for the compound and 
updates the compound. 

Available only when a compound has multiple quantitative peaks.

Set Peak Windows 
Settings to All Peaks in 
Method

Copies the View Width and Window values to all quantitative peaks for the method and 
updates the method. 

Table 22. Times page parameters  (Sheet 2 of 2)

Parameter Description

Note  The parameters in the Ranges area are available only when you set the Detector 
parameter to MS and the Trace parameter to Mass Range.



 5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 169

The Edit Mass Ranges dialog box opens where you can define mass ranges using a center 
of mass value or start and end values.

Figure 42. Edit Mass Ranges dialog box

4. Enter a value in the Center Mass box and click Add.

A new row with this value opens under Ranges. Center mass values are listed in the Start 
m/z column. The application uses a range of one amu that is centered on this value.

5. Enter values in the Start m/z and End m/z columns and click Add.

The application adds a row with these start and end values.

6. Add as many ranges as you want.

When you process a batch with this method, the application sums the multiple ions 
specified by these ranges. 

7. Click Apply.

The application applies the parameters to the list of ranges. 

 To specify an XIC filter 

1. Select MS from the Detector list.

2. Select Mass Range from the Trace list.

3. Select the XIC option.

4. Click the Filter browse button, .

The XIC Filter dialog box opens. See XIC Filter dialog box.

5. Specify your filter options.

Note  The XIC option is available only when you set the Detector parameter to MS 
and the Trace parameter to Mass Range.
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6. Click OK.

The application updates the chromatogram data using the specified XIC filter options, 
and the Filter box indicates the parameters of the specified XIC filter, as in this example:

Figure 43. XIC Filter dialog box

Table 23. XIC Filter dialog box parameters  (Sheet 1 of 2)

Parameter Description

Mass Analyzer 
Type

Any: Any mass analyzer.
FTMS: Fourier Transform Mass Spectrometer
ITMS: Ion Trap Mass Spectrometer
Sector: Static electric or magnetic sectors, or a combination of the two
SQMS: Single Quad Mass Spectrometer
TOFMS: Time-of-Flight Mass Spectrometer
TQMS: Triple Quad Mass Spectrometer

MSX Any: Allows both MSX and non-MSX scans.
On: Allows only MSX scans.
Off: Allows only non-MSX scans.

MS order 

Full-scan mode

Data-dependent filter

MassAnalyzerFTMS analyzer

Positive polarity
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 To specify an MS filter

1. Select the Filter option.

2. Select MS from the Detector list.

3. Select a trace type from the Trace list.

Data 
Dependent

Any: Allows both data-dependent and non-data-dependent filters.
On: Allows only data-dependent filters.
Off: Allows only non-data-dependent filters.

MS Order Any: Allows any MS order.
MS: Single mass spec stage
MS2-MS3: Multiple mass spec stages

Polarity Any: Allows both positive and negative.
Positive
Negative

Scan Mode Any: Allows any scan mode.
Full: Full-scan mode
SIM: Selective ion monitoring
SRM: Selective reaction monitoring
CRM: Consecutive reaction monitoring
Q1MS: MS using quadrupole 1
Q3MS: MS using quadrupole 3

Activations Any: Allows any activation method.
CID: Collision-induced dissociation
MPD: Multiple photodissociation
ECD: Electron capture dissociation
PQD: Pulsed dissociation
ETD: Electron transfer dissociation
HCD: Higher energy collision-induced dissociation
This parameter is available only when the MS Order is set to MS2 or MS3.

First Precursor This parameter is available only when the MS Order is set to MS2 or MS3.

Second 
Precursor

This parameter is available only when the MS Order is set to MS3.

Table 23. XIC Filter dialog box parameters  (Sheet 2 of 2)

Parameter Description
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4. Select a filter from the Filter list.

Filter types can be any of the following:
• MS
• MS2
• MS2 CID
• MS2 HCD

5. To update the new filter selection, click outside the Signal pane.

As long as the filter is highlighted blue, the new selection is not yet applied.

6. (Optional for quantitative peaks) To apply this same quantitative peak filter to other 
peaks, right-click and choose one of the following from the shortcut menu:

• Set Filter Options on All Peaks in This Compound: Applies this filter to all other 
peaks in the compound. 

• Set Filter Options on All Compounds: Applies this filter to all peaks for all 
compounds in the method.

• Set Quan Peak Filter Options on All Compounds: Applies the filter specified for 
the quantitative peak to all quantitative peaks for all compounds in the method. 

7. (Optional for confirming peaks) To apply this same confirming peak filter to other peaks, 
right-click and choose one of the following from the shortcut menu:

• Set Filter Options on All Peaks in This Compound: Applies this filter to all other 
peaks in the compound. 

• Set Filter Options on All Compounds: Applies this filter to all peaks for all 
compounds in the method.

• Set Confirm Peak Filter Options on All Compounds: Applies the filter specified 
for the confirming peak to all confirming peaks for all compounds in the method. 

• Set Confirm Peak 1 Filter Options on All Compounds: Applies the filter specified 
for confirming peak 1 to the first confirming peak for all compounds in the method.
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Signal Page

Use the features on the Signal page to define the detector and filters as you display each 
chromatogram trace for either analog detectors or mass spectrometer detectors. For detailed 
descriptions of all the parameters on the Signal page, see “Signal page parameters” on 
page 174.

• Signal page for a mass spectrometer detector

• Signal page for an analog detector

Figure 44. Signal page for a mass spectrometer detector
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Figure 45. Signal page for an analog detector 

Table 24. Signal page parameters  (Sheet 1 of 3)

Parameter Description

XIC Specifies an Extracted Ion Chromatogram experiment type that uses a single, full-scan mass filter 
that is post-processed to extract a peak for the ions of interest.

Filter Select from the list of mass filters to use for processing the compound.
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Detector The detection options that are used to create the method determine the available detector options. 
The method can use the standard options (all the listed options) or only the detection options used 
to acquire an associated raw data file. To specify the available detector options, see “Specifying 
Default Peak Detection Parameters” on page 39.

MS: Mass spectrometer that ionizes sample molecules and then separates the ions according to their 
mass-to-charge ratio (m/z).

PDA: Photodiode array detector providing a linear array of discrete photodiodes on an integrated 
circuit chip. It is placed at the image plane of a spectrometer to allow simultaneous detection of a 
range of wavelengths.

Analog: Supplemental detectors (for example, FID, ECD). When you select this detector, any reports 
that display a QIon value show the value as Analog and any reports that display spectra show the 
spectra as Not Available.

A/D card: If you have a detector not under data system control, you can capture the analog signal 
and convert it to digital using an interface box (for example, SS420X) for storage in the raw data file.

UV: A UV spectrophotometer (for variable-wavelength detection) or photometer (for 
single-wavelength detection) equipped with a low-volume flow cell. This detector detects analytes 
that readily absorb light at a selected wavelength.

Trace Represents a specific range of the data. The application uses the trace to identify the characteristic 
ions for a compound. 

MS detector options: Mass Range, TIC, or Base Peak. When you select Mass Range, you are 
prompted to enter the start and end m/z values for the ranges.

PDA detector options: Spectrum Maximum, Wavelength Range, or Total Scan.

Analog detector options: Analog 1, Analog 2, Analog 3, or Analog 4. You can configure these 
channel names in your instrument configuration.

A/D Card detector options: AD Card ch1, AD Card ch2, AD Card ch3, or AD Card ch4. You can 
configure these channel names in your instrument configuration.

UV detector options: Channel A, Channel B, Channel C, or Channel D. You can configure these 
channel names in your instrument configuration.

Filter Available only when you select the MS detector. Represents a particular data acquisition channel. 
For example, the filter option + c Full ms [35.00-500.00] represents a positive ion centroid signal 
acquired in single-stage, full-scan mode from m/z 35 to 500. 

Table 24. Signal page parameters  (Sheet 2 of 3)

Parameter Description
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Detect

Use the Detect page to define the peak detection algorithm (sensitivity) and its options and to 
determine the area under a curve. There are three sensitivity modes: Genesis, ICIS, and 
Avalon. Use the Genesis and Avalon sensitivity modes for mass spectrometry detection. You 
use the ICIS sensitivity mode primarily for analog detection.

On this page, you can specify how you want each mode to run. See the following for detailed 
descriptions of all the features on the Detect page:

• For Genesis sensitivity, see “Detect page parameters for Genesis” on page 177.

• For ICIS sensitivity, see “Detect page parameters for ICIS” on page 180.

• For Avalon sensitivity, see “Detect page parameters for Avalon” on page 183.

Ranges Available only when you select the Mass Range trace for an MS detector.

Edit Opens the Edit Mass Ranges dialog box where you can specify a range of ions for detection and 
integration. See “To specify ranges of ions for detection and integration” on page 168.

Start m/z
End m/z

Specifies ranges of ions for detection and integration. The application sums the multiple ions 
specified by these ranges. 

Ranges specified by a center mass value are listed as a single value in the Start m/z column. The 
application uses a range of one amu centered on this value. 

Table 24. Signal page parameters  (Sheet 3 of 3)

Parameter Description
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Figure 46. Detect page for Genesis

Table 25. Detect page parameters for Genesis  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Genesis peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Valid values: Any odd integer from 1 through 15 points
Default: 1

S/N Threshold Current signal-to-noise threshold for peak integration. Peaks with signal-to-noise values less 
than this value are not integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 

Valid range: 0.0 through 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect unresolved peaks. This method 
drops a vertical line from the apex of the valley between unresolved peaks to the baseline. 
The intersection of the vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter controls the minimum 
width that a peak is expected to have if valley detection is enabled. 
With valley detection enabled, any valley points nearer than the expected width/2 to the top 
of the peak are ignored. If a valley point is found outside the expected peak width, the 
application terminates the peak at that point. The application always terminates a peak 
when the signal reaches the baseline, independent of the value set for the expected peak 
width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
activates the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a peak. This factor is the 
maximum ratio of the trailing edge to the leading side of a constrained peak. This text box is 
active only when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Table 25. Detect page parameters for Genesis  (Sheet 2 of 3)

Parameter Description
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Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the application ignores all chromatogram peaks that have 
signal-to-noise values that are less than the S/N Threshold value. 

Valid range: 0.0 (all peaks) through 999.0

Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 
This test identifies an edge of a peak when the baseline adjusted height of the edge is less 
than the ratio of the baseline adjusted apex height and the peak S/N cutoff ratio. 
When the S/N at the apex is 500 and the peak S/N cutoff value is 200, the application 
defines the right and left edges of the peak when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after passing through a 
minimum (before or after the peak). 
This method drops a vertical line from the apex of the valley between unresolved peaks to 
the baseline. The intersection of the vertical line and the baseline defines the end of the first 
peak and the beginning of the second peak. 
When the trace exceeds the rise percentage, the application applies valley detection peak 
integration criteria. 
The application applies this test to both the left and right edges of the peak. 
The rise percentage criterion is useful for integrating peaks with long tails.

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter ensures that the 
surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated using an RMS 
calculation or a peak-to-peak resolution threshold. Options are RMS or Peak to Peak.

Shortcut menu

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the Genesis sensitivity mode. These updates apply to both quantitative and confirming 
ion peaks that use the Genesis sensitivity mode.

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Table 25. Detect page parameters for Genesis  (Sheet 3 of 3)

Parameter Description
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Figure 47. Detect page for ICIS

Table 26. Detect page parameters for ICIS  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the ICIS peak detection algorithm, used primarily with analog detectors.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Valid values: Any odd integer from 1 through 15 points
Default: 1

Area Noise Factor The noise level multiplier used to determine the peak edge after the location of the possible 
peak. 

Valid range: 1 through 500
Default: 5

Peak Noise Factor The noise level multiplier used to determine the potential peak signal threshold.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of scans.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
activates the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a peak. This factor is the 
maximum ratio of the trailing edge to the leading side of a constrained peak. This text box is 
active only when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the application ignores all chromatogram peaks that have 
signal-to-noise values that are less than the S/N Threshold value. 

Valid range: 0.0 (all peaks) through 999.0

Table 26. Detect page parameters for ICIS  (Sheet 2 of 3)

Parameter Description
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Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level.

Repetitive: Uses a multiple pass algorithm to determine the noise level. In general, this 
algorithm is more accurate in analyzing the noise than the INCOS Noise algorithm, but the 
analysis takes longer. 

Min Peak Width The minimum number of scans required in a peak.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two potential peaks. This is a filter 
to determine if two peaks are resolved.

Valid range: 1 through 500 scans
Default: 10

Area Tail Extension The number of scans past the peak endpoint to use in averaging the intensity.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A zero value defines all scans 
(peak-start to peak-end) to be included in the area integration. 

Valid range: 0 through 100 scans
Default: 0

RMS Specifies that the application calculate noise as RMS. By default, the application uses Peak 
To Peak for the noise calculation. RMS is automatically selected if you manually determine 
the noise region.

Shortcut menu

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the ICIS sensitivity mode. These updates apply to both quantitative and confirming ion 
peaks that use the ICIS sensitivity mode.

Table 26. Detect page parameters for ICIS  (Sheet 3 of 3)

Parameter Description
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Figure 48. Detect page for Avalon

Table 27. Detect page parameters for Avalon  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the Avalon peak detection algorithm. 

Detection Method Highest Peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.

Valid values: Any odd integer from 1 through 15 points
Default: 1
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. See Avalon Event List dialog box parameters. For a detailed list 
of events and value ranges, see Event types.

Figure 49. Avalon Event List dialog box

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box. See Avalon Event List.

Shortcut menu

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the Avalon sensitivity mode. These updates apply to both quantitative and confirming 
ion peaks that use the Avalon sensitivity mode.

Table 27. Detect page parameters for Avalon  (Sheet 2 of 2)

Parameter Description
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Figure 50. Event types

Table 28. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.
Event Specifies the type of event. For a detailed list of events and value 

ranges, see “Event types.” 
Value Specifies the value of the event.
Add Adds a new event to the list with the current Time/Event/Value 

parameters.
Delete Removes the selected Time/Event/Value parameter from the event 

list.
Change Applies the current parameter values.
Cancel Closes the dialog box without making any changes. Any additions, 

deletions, or changes revert to their original state.
Apply Closes the dialog box.

Table 29. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999
End Threshold Specifies the threshold at the end of a peak. The End Threshold is directly 

related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999
Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 

threshold will not be detected. This control is in units of area for the data. 

Valid range: 0 through 999 999 999
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P-P Threshold The peak-to-peak resolution threshold controls how much peak overlap 
must be present before two or more adjacent peaks create a peak cluster. 
Peak clusters have a baseline drop instead of valley-to-valley baselines. 
Specified as a percent of peak height overlap.

Valid range: 0.1 through 99.99
Negative Peaks Permits detection of a negative going peak. Automatically resets after 

finding a negative peak.

Valid values: On or Off
Bunch Factor Specifies the number of points grouped together during peak detection. 

This event controls the bunching of chromatographic points during 
integration and does not affect the final area calculation of the peak. A 
high bunch factor groups peaks into clusters.

Valid range: 0 through 999
Tension Controls how closely the baseline should follow the overall shape of the 

chromatogram. A lower tension traces the baseline to more closely follow 
changes in the chromatogram. A high baseline tension follows the baseline 
less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes
Tangent Skim Using this event, you can tangent skim any peak clusters. By default, it 

chooses the tallest peak in a cluster as the parent. You can also identify 
which peak in the cluster is the parent. Tangent skim peaks are detected 
on either side (or both sides) of the parent peak. Tangent skim 
automatically resets at the end of the peak cluster.

Valid range: 0 through 1
Shoulders On Allows peak shoulders to be detected (peaks which are separated by an 

inflection rather than a valley) Sets a threshold for the derivative.
Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50
Force Cluster 
On

Force the following peaks to be treated as a cluster (single peak).

Force Cluster 
Off

End the forced clustering of peaks.

Disable Cluster 
On

Prevent any peaks from being clustered.

Disable Cluster 
Off

Permit clusters to occur again.

Table 29. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Suitability 

Use the Suitability page to determine if the column is degrading and to identify suspicious 
peaks eluting at the same time as the target compound. Suspicious peaks caused by highly 
retained compounds from a previous injection tend to have a broader than expected peak 
profile. Tailing peaks frequently indicate a degrading column. The Suitability page displays 
the parameter values to check the suitability of chromatographic peaks during processing. You 
can edit these parameters in the System Suitability dialog box. See “System Suitability dialog 
box” on page 189.

 To set system suitability parameters 

1. Click Edit.

The System Suitability dialog box opens. See “System Suitability dialog box” on 
page 189.

2. To perform symmetry testing, do the following:

a. Select the Symmetry Parameters check box. 

b. Type a peak height for symmetry testing in the Peak Height box.

c. Type a threshold for symmetry testing in the Symmetry Threshold box.

3. To carry out classification tests, do the following:

a. Select the Peak Classification Parameters check box.
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b. To adjust Xcalibur peak width testing thresholds, type parameters in the Detect Peak 
Width area as follows:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a minimum peak width threshold, type a value in the Min Peak Width 
box.

c. To adjust the Xcalibur peak tailing test, type parameters in the Detect Tailing area:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a threshold limit for peak tailing, type a value in the Failure Threshold 
box.

d. To adjust the Xcalibur column overload test, type parameters in the Detect Column 
Overload area:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a threshold limit for peak tailing, type a value in the Failure Threshold 
box.

e. To adjust the Xcalibur baseline clipping test, type parameters in the Detect Baseline 
Clipping area:

To define the test window, type a value in the Number of Peak Widths for Noise 
Detection box.

4. To save your settings, click OK. 
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Figure 51. System Suitability dialog box

Table 30.  System Suitability dialog box parameters  (Sheet 1 of 2)

Parameter Description

Symmetry Parameters Determines the symmetry of the left and right sides of the detected peak.

Peak Height The percentage of the peak height at which to compare the symmetry of the left and 
right peak widths.

Symmetry Threshold The minimum percentage difference to be considered symmetrical and pass the 
suitability test.

Peak Classification Parameters

Detect Peak Width Determines the minimum width of each side of the peak measured at the specified 
percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the full peak width.

Min Peak Width Minimum peak width (measured at the specified percentage of the peak height) 
required to pass the suitability test.

Left and right widths measured at 30% 
and 50% of the peak height

Full width measured at 30% 
and 50% of the peak height
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Spectrum

Use the Spectrum page to store a reference mass spectrum for a quantitative peak or 
compound.

For detailed descriptions of all the shortcut menu commands on the Spectrum page, see 
“Spectrum Page” on page 195.

Follow these procedures:

• To create a reference spectrum

• To update confirming ion ratios

• To change the quantitation mass used for a quantitative peak

• To add ions together to get an accumulated signal

• To add a quantitative peak to an existing compound

• To add one or more confirming ions to an existing compound

• To zoom in on the chromatogram or spectrum displays

Max Peak Width Maximum allowed peak width (measured at the specified percentage of the peak 
height) to pass the suitability test.

Detect Tailing The width of the right side of the peak divided by the width of the left side of the 
peak at the specified percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the left and right sides of the 
peak.

Failure Threshold Minimum Detect Tailing value (RHS/LHS) required to pass the suitability test.

Detect Column Overload The width of the left side of the peak divided by the width of the right side of the 
peak at the specified percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the left and right sides of the 
peak. 

Failure Threshold Minimum Detect Column Overload value (LHS/RHS) required to pass the 
suitability test.

Table 30.  System Suitability dialog box parameters  (Sheet 2 of 2)

Parameter Description

Left and right widths measured at 10% 
and 30% of the peak height

Left and right widths measured at 30% 
and 50% of the peak height
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 To create a reference spectrum

1. Click a peak in the quantitative peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. Right-click the Spectrum pane and choose Apply Background Subtraction to Peak and 
Set as Reference Spectrum from the shortcut menu.

The application uses the background-subtracted reference spectrum during quantitative 
processing and reports the background-subtracted reference spectrum (indicated with BS 
in the scan heading) as the last scan for each compound in the Quantitation Report - 2 
report.

 To update confirming ion ratios

1. Click a peak in the quantitative peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. Right-click the Spectrum pane and choose Update Confirming Ion Ratios with This 
Spectrum from the shortcut menu.

 To change the quantitation mass used for a quantitative peak

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the mass-to-charge value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose one of the following commands from the shortcut menu:

• Set This Mass as Quan Mass > Don’t Update Ion Ratios

• Set This Mass as Quan Mass > Update Ion Ratios Using This Reference Spectrum

Note  This command is available only when you select a background subtraction 
method on the Acquisition page in the master method. See “Editing the Acquisition 
Page” on page 137.
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The following examples show an original quantitative peak and a quantitative peak with an 
updated quantitation mass.

Figure 52. Original quantitative peak mass example

The application replaces the original quantitation mass with the selected mass.

Figure 53. Updated quantitative peak mass example

Original quantitative peak mass

New quantitative peak mass



 5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 193

 To add ions together to get an accumulated signal

1. Hold the cursor over the m/z value for an ion in the Spectrum pane. 

A red box around the ion’s m/z value indicates that the ion is selected.

2. Right-click and choose Add This Mass to Existing Quan Mass Range from the shortcut 
menu.

You can now update the ion ratios to adjust the confirming ion comparisons to the new 
summed quantitative peak signal.

 To add a quantitative peak to an existing compound

1. Click the peak in the Quan Peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose Set This Mass as New Quan Peak from the shortcut menu. 

The application adds this ion as a new quantitative peak.

New quantitative peak mass
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 To add one or more confirming ions to an existing compound

1. Click the quantitative peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected. 

3. Right-click and choose to Add This Mass as New Confirming Ion from the shortcut 
menu.

The application adds the selected mass as a confirming peak for this quantitative peak.

 To zoom in on the chromatogram or spectrum displays

1. Drag the cursor to delineate a rectangle.

The display zooms in on the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling from the shortcut 
menu.
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Spectrum Page

Use the shortcut menu commands on the Spectrum page to store a reference mass spectrum 
for a quantitative peak or compound.

Figure 54. Spectrum page

Table 31. Spectrum page shortcut menu commands 

Command Description

Update Confirming Ion 
Ratios With This Spectrum

Updates the confirming ion ratios using the selected peak.

Set This Mass as Quan 
Mass

Adds the quantitation mass of the selected ion to the 
quantitation mass used for the quantitative peak. You can 
choose to update the ion ratios or not update the ion ratios 
using this reference spectrum.

Add This Mass to Existing 
Quan Mass Range

Adds the selected mass to your existing quantitation mass 
range. You can choose to update the ion ratios to adjust the 
confirming ion comparisons to the new summed quantitative 
peak signal.

Set This Mass as New 
Quan Peak

Adds a new quantitative peak to an existing compound.

Add This Mass as New 
Confirming Ion

Adds one or more confirming ion peaks to an existing 
compound.

Reset Scaling Returns the chromatogram or spectrum display to its original 
size. 

Copy to Clipboard Copies the graphic display to the Clipboard.
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Library

Use the Library page to define the criteria for library matching. For detailed descriptions of all 
the features on the Library page, see Library page.

 To activate library matching

1. Select the Enable check box.

2. From the Library Search Type list, select the type of library to use for matching.

• NIST: Uses the NIST library that you installed with the TraceFinder application. See 
“Installing the NIST and QED Libraries” on page 14.

• Library Manager: Uses the library that you specified in the Configuration console. 
See “Screening Libraries” on page 59.

• NIST High Resolution: Uses an installed NIST library that contains an EI accurate 
ion m/z or MS/MS spectra. 

The application searches the library, matches the fragment ion spectrum in the library to 
the compound’s ion spectrum, and returns the highest score (best match).

Figure 55. Library page

Note  Because the NIST library is large, using this library can slow sample 
processing.
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Isotopes

Use the Isotopes page to define the criteria for identifying an isotope peak. To identify an 
isotopic pattern, the application must detect the compound for at least one of its defined 
adduct ions. The application identifies the elemental composition to match using the formula 
that is associated with the most intense adduct peak. The application then generates an 
isotopic pattern score (as a percentage value) for the match between the measured and 
expected isotopic patterns of the calculated elemental composition. 

For detailed descriptions of all the features on the Isotopes page, see Isotopes page.

 To specify isotope criteria

1. Select the Enable check box to activate the isotopes features. 

2. In the Fit Threshold box, type the fit threshold percentage.

The resulting score percentage from isotopic pattern matching must be higher than the 
specified fit threshold percentage. 

3. In the Allowed Mass Deviation box, type the parts per million to use as the minimum 
deviation from the expected m/z.

Table 32. Library page parameters 

Command Description

Library Search Type Specifies the type of library to use for matching.
• NIST: Uses the NIST library that you installed with the 

TraceFinder application. 
• Library Manager: Uses the library that you specified in the 

Configuration console. 
• NIST High Resolution: Uses a NIST library that contains 

an EI accurate ion m/z or MS/MS spectra.

Shortcut menu

Set Peak Library Settings 
to All Peaks in 
Compound

Updates all peaks in the current compound with the current 
settings on the Library page. These updates apply to both 
quantitative and confirming ion peaks. The application 
reprocesses all peaks in the compound and performs a new 
library search.

Set Peak Library Settings 
to All Peaks in Method

Updates all compounds in the method with the current settings 
on the Library page. These updates apply to both quantitative 
and confirming ion peaks. When you use this command in the 
local method for a processed batch, the application prompts you 
to reprocess the batch to update the library settings.
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The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this amount away from its expected m/z. For best results, set this value to a 
number that causes up to 98 percent of all mass deviations to be smaller than the allowed 
mass deviation value. 

4. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity, 
relative to the monoisotopic ion’s intensity, is more than the deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.

5. To specify that isotopic pattern calculations use internal mass calibration instead of 
external mass calibration, select the Use Internal Mass Calibration check box. 

With this check box selected, the application applies a requirement that an isotope’s m/z 
must be closer to its theoretical value to avoid a score penalty.

Figure 56. Isotopes page

Table 33. Isotopes page parameters  (Sheet 1 of 2)

Parameter Description

Fit Threshold % To identify a compound, the resulting score percentage from 
isotopic pattern matching must be higher than the specified fit 
threshold percentage. 

Default: 90% 

Allowed Mass Deviation 
(ppm)

Specifies the allowed mass deviation in the spectrum data.
The TraceFinder isotopic pattern algorithm considers an isotope 
peak as found if its measured m/z is less than this amount away 
from its expected m/z. For best results, set this value to a number 
that causes up to 98 percent of all mass deviations to be smaller 
than the allowed mass deviation value. 

Valid range: 3 through 100 ppm 
Default: 3 ppm



 5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 199

Fragments

Use the Fragments page to define the criteria for identifying a fragment ion.

To use fragment ions, the application requires the following conditions:

• The selected compound databases contain the charged mass for each defined fragment 
ion of interest for the compounds in the target list.

• The HCD (higher energy collision-induced dissociation), source CID (source 
collision-induced dissociation), or AIF (all ions fragmentation) ion spectra exist at a time 
point within the compound’s elution time range.

For detailed descriptions of all the features on the Fragments page, see Fragments page.

Allowed Intensity 
Deviation (%)

Specifies the allowed intensity deviation of the mass 
spectrometer, relative to the monoisotopic ion, as a percentage 
of the base peak height.

The TraceFinder isotopic pattern algorithm considers an isotope 
peak as not found if its intensity relative to the monoisotopic 
ion’s intensity is more than this deviation percentage from the 
theoretical relative intensity of the isotope ion. For best results, 
set this value to a number that causes up to 98% of all intensity 
deviations to be smaller than the allowed intensity deviation 
value.

Default: 10%

Use Internal Mass 
Calibration

Specifies that the application require an isotope’s m/z to be 
closer to its theoretical value to avoid a score penalty.

Shortcut menu

Set Peak Isotope Settings 
to All Peaks in 
Compound

Updates all peaks in the current compound with the current 
settings on the Isotopes page. These updates apply to both 
quantitative and confirming ion peaks. The application 
reprocesses all peaks in the compound and performs a new 
library search.

Set Peak Isotope Settings 
to All Peaks in Method

Updates all compounds in the method with the current settings 
on the Isotopes page. These updates apply to both quantitative 
and confirming ion peaks. When you use this command in the 
local method for a processed batch, the application prompts you 
to reprocess the batch to update the library settings.

Table 33. Isotopes page parameters  (Sheet 2 of 2)

Parameter Description
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 To specify fragment ion options

1. Select the Enable check box.

2. To ignore the Fragment Ions options when no fragment is defined in the compound 
database, select the Ignore If Not Defined check box.

When the compound database does not define fragments for a compound, the 
application does not include the results for fragment ions in the results.

• When the Ignore If Not Defined option is selected, the application does not perform 
filtering for the Fragment Ions and, in the Data Review view, the FI column is blank.

• When the Ignore If Not Defined option is not selected, the application considers that 
this target compound is not identified. The Fragment Ions filter fails.

3. In the Min. # of Fragments box, type the minimum number of fragments required to 
identify a compound.

The application uses the number of fragment masses defined in the compound database 
when it processes a sample for fragment ions. The value you specify for Min. # of 
Fragments cannot be greater than the number of fragments defined in the compound 
database.

4. In the Intensity Threshold box, type the intensity threshold value.

The intensity of a fragment must be above this threshold for the application to identify it.

5. In the Mass Tolerance box, type a mass tolerance value and then select ppm or mmu for 
the mass tolerance units.

This mass tolerance value indicates the number of millimass units or parts per million to 
use as the m/z ± tolerance value for the fragment ions. It is separate from the mass 
tolerance value specified for the parent peak. 

Figure 57. Fragments page

Note   When using ion trap data, the application uses 300 mmu regardless of the 
value you enter here.
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Table 34. Fragments page parameters 

Parameter Description

Ignore If Not Defined Ignores the values you specify when no fragment is defined in the 
compound database, and does not include the results for fragment 
ions in the Data Review results.

Min. # of Fragments Specifies the minimum number of fragments required to find the 
compound.

Valid range: 1 through 5
Default: 1

Intensity Threshold Specifies the minimum height of a fragment ion peak. The peak of 
a fragment ion must be above this intensity threshold for the 
application to find it.

Valid range: 1 through 1e9
Default: 10 000

Mass Tolerance Specifies the number of millimass units or parts per million to use 
as the m/z ± tolerance value for the fragment ions and is separate 
from the mass tolerance specified for the parent (see “Editing the 
Acquisition Page” on page 137).

Valid range: 0 through 500 
Default: 5 ppm
Unit: mmu or ppm

Note  When using ion trap data, the application uses 300 mmu 
regardless of the value you enter here.

Shortcut menu

Set Fragment Settings 
to All Peaks in 
Compound

Updates all peaks in the current compound with the current 
settings on the Fragments page. These updates apply to both 
quantitative and confirming ion peaks. The application 
reprocesses all peaks in the compound and performs a new library 
search.

Set Fragment Settings 
to All Peaks in Method

Updates all compounds in the method with the current settings 
on the Fragments page. These updates apply to both quantitative 
and confirming ion peaks. When you use this command in the 
local method for a processed batch, the application prompts you 
to reprocess the batch to update the library settings.
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Ratios

Use the Ratios page to define the criteria for evaluating the confirming or qualifying ions. The 
application detects compounds that have confirming ion values outside their acceptable 
window and flags them in the Acquisition mode and in reports. 

For detailed descriptions of all the features on the Ratios page, see Ratios page.

 To specify ion ratio criteria

1. Select the Enable check box to activate the confirming ion. 

2. In the Target Ratio box, select the theoretical ratio of the confirming ion’s response to the 
quantification ion’s response. 

3. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. In the Window (+/-%) box, select the acceptable ion ratio range. 

5. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

In the following example, the target ratio is expected to be 61.02% and the window is 
Absolute 20%, so the acceptable window for this confirming ion peak is 41.02–81.02%. 

However, if the window type is Relative, the plus or minus value is 20% of 61.02% (or 
12.20%), so the acceptable window for this confirming ion peak is 48.82–73.22%. 
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Figure 58. Ratios page

Table 35. Ratios page parameters 

Parameter Description

Enable Makes the ion ratio criteria available.

Target Ratio (%) Specifies the theoretical ratio of the confirming ion’s response to 
the quantification ion’s response. 

Window Type Specifies the absolute or relative calculation approach for 
determining the acceptable ion ratio range. 

Window (+/-%) Specifies the acceptable ion ratio range.

Ion Coelution (min) Specifies the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

Valid range: 0.025 through 0.1

Shortcut menu commands

Set Ion Ratio to All 
Confirming Peaks in 
Compound

Copies the Window Type, Window, and Ion Coelution values to 
all confirming ion peaks for the compound and updates the 
compound. 
Available only when a compound has multiple confirming ion 
peaks.

Set Ion Ratio to All 
Confirming Peaks in 
Method

Copies the Window Type, Window, and Ion Coelution values to 
all quantitative peaks for the method and updates the method. 
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Calibration

Use the Calibration page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Acquisition mode 
when you view the results of an actual calibration batch. 

Typically, general quantitation uses a measured response (area or height) to determine the 
amount of a compound contained in a sample. The application compares the response of an 
unknown, target compound to the response of a calibration sample that contains a known 
amount of the compound by building a calibration curve to interpolate the amount in the 
target compound. 

To use a semi-quantitative process, you specify the compound’s standard type as Estimated 
and then identify another compound as the linked compound. Instead of using the target 
compound to create a calibration curve, the application uses a calibration curve from the 
linked compound to calculate the amount in the target compound.

To use a real sample for the calibration procedure, you specify the compound’s standard type 
as Std Addition. The autosampler divides the sample into multiple portions (one unspiked 
portion and at least two spiked portions). To maintain consistent conditions across all 
samples, the autosampler adds selected amounts of standard into the vials and adds a volume 
of a solvent calculated to maintain constancy in the total volume of liquid in each vial. 

For detailed descriptions of all the features on the Calibration page, see “Calibration Page” on 
page 206.

Follow these procedures:

• To specify an internal standard type for a compound

• To specify an estimated standard type for a compound

• To specify a standard addition standard type for a compound

 To specify an internal standard type for a compound

1. On the Identification page, specify at least one compound in the method as an internal 
standard compound type. See “Identification” on page 152.

2. On the Calibration page, do the following:

a. In the Standard Type column, select Internal.

b. In the ISTD column, select the compound that you want to use as the internal 
standard for this compound.

The application lists only compounds specified as internal standards on the 
Identification page.

To view the internal standard peak in Data Review, see “Compound Details” on page 498.
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 To specify an estimated standard type for a compound

1. In the Standard Type column, select Estimated.

2. In the Linked Compound column, select any other compound in the method that you 
want to link to this compound.

The Estimation Method value defaults to Ext Curve and is read-only.

The Compound Results in Data Review display the Calculated Amt value as “N/F” (not 
found) highlighted in green.

 To specify a standard addition standard type for a compound 

In the Standard Type column, select Std Addition.

• The Curve Type column value defaults to Linear and is read-only.

• The Origin column value defaults to Ignore and is read-only.

• The Weighting column value defaults to Equal and is read-only.

When you process this sample, the application divides the sample into multiple portions: 
one portion is not spiked and at least two portions are spiked. The application calculates 
the analyte concentration as intercept/slope, where intercept is the y-intercept of the 
regression line and slope is the slope of the regression line.

When you use the Std Addition calibration, the y-intercept on the calibration curve might 
not be at 0, as shown in the following figure:

The Compound Results in Data Review display the following:

• The Calculated Amt value is the spiked amount from the calibration curve.

• The Theoretical Amt value is the level defined in the method.

• The Sample Amt value is the actual amount in the standard spike plus the spiked 
amount in each standard. 
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Calibration Page

Use the features on the Calibration page to define the mathematical model used for preparing 
the initial calibration evaluation for one or more calibration standards. 

Figure 59. Calibration page

Table 36. Calibration page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Compound Type Displays the compound type as a Target Compound or an Internal Standard. 

Standard Type Specifies Internal, External, Estimated, or Std Addition standards.

Response Via The use of area or height. When you set the standard type to Estimated, this column is 
inactive.

Curve Type Specifies Linear, Quadratic, or AverageRF curve types. When you set the standard type to 
Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Linear and is read-only.

Origin The origin treatment is Ignore, Include, or Force. The Origin and Weighting columns are 
available only when you use Linear or Quadratic curve types. When you set the standard type 
to Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Ignore and is read-only.

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2. When you set the standard type 
to Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Equal and is read-only.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate. The list displays all 
compounds with the compound type of Internal Standard. This column is available only when 
you set the standard type to Internal.

Amount The amount of the internal standard for ISTD compounds. When you set the standard type to 
Estimated, this column is inactive.

Linked Compound This column is available only when the standard type is set to Estimated. The list of available 
compounds to be linked does not include any compounds whose standard type is set to 
Estimated.
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Calibration Levels

On the Calibration Levels page for a master method, you can define the standards for 
calibration. You can edit calibration levels and concentrations for master methods only. The 
contents of this page are read-only when you are editing a local method. 

For detailed descriptions of all the features on the Calibration Levels page, see Calibration 
Levels page.

You can use the copy-and-paste functions in the shortcut menu to copy calibration levels from 
one column to another or from one master method to another. For detailed instructions, see 
“Copying and Pasting Column Values” on page 213.

 To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations you want to define. 

2. In the Manage Calibration Levels area, type a value for the first calibration level.

The application adds a new, empty calibration level row beneath the edited row.

3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
compound at each level.

4. To enter the concentrations in the table, do the following:

a. Select the first calibration level table cell.

Estimation Method This column is unavailable for editing when the standard type is set to Estimated. 
• When the compound type for the associated linked compound is Target Compound, the 

estimation method is automatically set to Ext Curve. 
• When the compound type for the associated linked compound is Internal Standard, the 

estimation method is automatically set to Ratio. 

Shortcut menu
The Calibration page uses a right-click shortcut menu. See “Using the Shortcut Menu 
Commands” on page 212.

Table 36. Calibration page parameters  (Sheet 2 of 2)

Parameter Description
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b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat Step 4 for all calibration levels associated with the first compound.

6. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down from the shortcut menu. 

Figure 60. Calibration Levels page

Chk Std Levels 

Use the Chk Std Levels page for a master method to define the standards for Chk Std levels. 
You can edit Chk Std levels for master methods only. The contents of this page are read-only 
when you are editing a local method. For detailed descriptions of all the features on the 
Chk Std Levels page, see “Chk Std Levels page” on page 210.

Table 37. Calibration Levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

CalLevel_1–CalLevel_n User-defined calibration levels for the compound. The names 
you enter here become the column headers for the calibration 
levels.

Manage Calibration Levels Defines values for each of the calibration level values for the 
selected compound.

Shortcut menu
The Calibration Levels page uses a right-click shortcut menu. 
See “Using the Shortcut Menu Commands” on page 212.
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You can use the copy-and-paste functions in the shortcut menu to copy Chk Std levels from 
one column to another or from one master method to another. For detailed instructions, see 
“Copying and Pasting Column Values” on page 213.

 To specify Chk Std levels and concentrations

1. Select the compound whose Chk Std levels, percentage test values, and concentrations 
you want to define.

2. In the Manage Chk Std Levels area, type a name for the first Chk Std level.

The application adds a new, empty Chk Std level row below the edited row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each Chk Std level.

4. Continue adding Chk Std levels and values for the percentage test.

When you finish adding Chk Std levels, you can specify the concentrations for each level 
for each compound.

5. To enter the concentration values in the table, do the following:

a. Select the first Chk Std level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

6. Repeat step 5 for all Chk Std levels associated with the first compound.
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7. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down from the shortcut menu.

Figure 61. Chk Std Levels page

Table 38.  Levels page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.
Level_1–Level_n User-defined quality control levels for the compound.
Manage Levels

Level User-defined quality control level names. The names you enter 
here become the column headers for the levels.

% Test A value for the acceptable difference (as a percentage) between the 
known amount and calculated (measured) amount of each level.

Shortcut menu
The Levels page uses a right-click shortcut menu. See “Using the 
Shortcut Menu Commands” on page 212.
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Real Time Viewer 

Use the Real Time Viewer page to specify which traces display in the Real Time Status pane 
when you perform acquisition in the Acquisition mode. See “Real Time Status Pane” on 
page 388.

Figure 62. Real Time Viewer page

 

Table 39. Real Time Viewer page parameters  (Sheet 1 of 2)

Parameter Description

Show Quan Peaks 
Only

Displays only quantitative peaks in the compounds list. Quantitative peaks are indicated 
with a black dot in the Quan Peak column.

Displayable Traces

Quan Peak Dots indicate quantitative peak traces. Unmarked traces indicate confirming ion peaks.

Compound Name Names of all compounds in the method.

Trace Lists the simple mass or precursor mass for all traces—both quantitative peak and 
confirming ion peak—for each compound.

Moves the selected trace to the Traces to Display in Real Time Viewer pane.
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Using the Shortcut Menu Commands

Each page on the Compounds page (except the Acquisition List and Real Time Viewer pages) 
uses right-click shortcut menu commands to display or hide the retention column, remove 
compounds from the method, copy and paste data, or save the compound list to a CSV file.

Moves the selected trace to the Displayable Traces pane.

Moves all traces to the Displayable Traces pane. 
To move multiple traces to the Traces to Display... pane, hold down the SHIFT key, select 
multiple traces, and then click .

Traces to Display in 
Real Time Viewer (n/25)

List the traces to be displayed and the display order used in the real-time display in the 
Acquisition mode. See “Real-Time Trace Display” on page 402. 
Maximum number of traces is 25. 

Move to Top Moves the selected trace to the top of the Traces to Display... list and the second position in 
the real-time display. The TIC is always the first position in the real-time display in the 
Acquisition mode.

Move Up Moves the selected trace up one position in the list.

Move Down Moves the selected trace down one position in the list.

Move to Bottom Moves the selected trace to the bottom of the list.

Table 39. Real Time Viewer page parameters  (Sheet 2 of 2)

Parameter Description

Table 40.  Compounds page shortcut menu commands (Sheet 1 of 2)

Command Description

Copy Down Copies the value in the selected row to all rows below it. This 
command is available only when you have selected a value that can be 
copied down. See Appendix C, “Using Copy Down and Fill Down.” 

Display Retention 
Time Column

Displays or hides the RT column in the compound list.



 5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 213

Copying and Pasting Column Values

You can use the copy-and-paste functions in the shortcut menu to copy column values within 
a master method or from one master method to another. You can use these copy-and-paste 
techniques on any pages with grids of data in the Compounds and QAQC views.

After you copy grid values to the Clipboard, you can paste them into a text application such as 
Notepad, an email, a spreadsheet, other grid cells in the same master method, or into another 
master method. 

Follow these procedures:

• To copy a value from one cell to another cell

• To copy all values in a column to another column

• To copy multiple columns

• To copy an entire grid to another master method

Delete Compound 
From Method

Removes the selected compound from the current master method.

Copy Copies the data in the selected rows or columns to the Clipboard. Use 
this command to copy compound information to a text editor or 
spreadsheet application. You cannot paste this data back into the 
method development compound list.

Copy With Headers Copies the data in the selected rows or columns and the associated 
column headers to the Clipboard. Use this command to copy sample 
information to a text editor or spreadsheet application. You cannot 
paste this data back into the method development compound list.

Paste Pastes a single column of copied data from a text editor or spreadsheet 
application into the selected column. The pasted data must be valid 
data for the selected column.

Undo Last Paste Removes the last pasted item in the method development compound 
list. 

Export to CSV File Opens the Save As dialog box where you can save the current 
compound list to a CSV file.

Sort by Compound 
Name

Sorts the compounds alphabetically from A to Z.

Sort by Retention 
Time

Sorts the compounds from shortest retention time to longest 
retention time.

Tip  When copying data into an application other than a TraceFinder master method grid, 
use the Copy with Headers command instead of the Copy command in the shortcut 
menu to preserve the column headers.

Table 40.  Compounds page shortcut menu commands (Sheet 2 of 2)

Command Description
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 To copy a value from one cell to another cell

1. Select a cell value to copy to the Clipboard.

You can select either an entire table cell or just a cell value.

2. Right-click and choose Copy from the shortcut menu.

The application copies either the selected cell value or the selected cell to the Clipboard.

3. In this or another master method, select the cell value or table cell that you want to 
overwrite.

• If you copied a cell value, you can select the cell value or simply click in the cell.

• If you copied an entire cell, you must select a table cell to overwrite.

4. Right-click and choose Paste from the shortcut menu.

The application replaces the selected value with the value copied to the Clipboard.

 To copy all values in a column to another column

1. Use the SHIFT key to select the column to copy.

2. Right-click and choose Copy from the shortcut menu.

3. In this or another master method, use the SHIFT key to select the column to overwrite.

4. Right-click and choose Paste from the shortcut menu.

The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

Cell is selected.

Cell value is selected.
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 To copy multiple columns

1. Use the SHIFT key to select the columns to copy.

2. Right-click and choose Copy from the shortcut menu.

3. In this or another master method, use the SHIFT key to select the columns to overwrite.

4. Right-click and choose Paste from the shortcut menu.

The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

 To copy an entire grid to another master method

1. Use the SHIFT key to select all the columns in the grid.

2. Right-click and choose Copy from the shortcut menu.
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3. In another master method, use the SHIFT key to select the columns to overwrite.

4. Right-click and choose Paste from the shortcut menu.

The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

Note  When the Clipboard contains more cells of data than there are selected target 
cells for the paste operation, the application overwrites the selected cells and reports 
that the Clipboard contents were truncated to fit the grid.
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Editing the QAQC Page 

Use the QAQC page to set limits and ranges so that the application can review the data and 
results as an aid to final approval.

On most QAQC pages, you can use the copy-and-paste functions in the shortcut menu to 
copy grid values from one column to another or from one master method to another. For 
detailed instructions, see “Copying and Pasting Column Values” on page 213.

 To open the QAQC page

Click QAQC in the Method View navigation pane.

From the QAQC page of the Method View, you can access these additional pages:

• Limits

• Calibration

• Chk Std

• Matrix Blank

• ISTD

• Solvent Blank

• Threshold

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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Limits

Use the Limits page to define levels of review for quantified results. Quantified results appear 
in printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Figure 63. Limits page

Table 41. Limits page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

LOD 
(Detection Limit)

Limit of detection. The lowest amount that can be detected. Usually derived from a method 
detection limit (mdl) study.

LOQ 
(Quantitation Limit)

Limit of quantitation. The lowest amount that can be confidently and accurately 
quantitated. This is usually the lowest calibration amount.

LOR Limit of reporting. Also called cutoff in some industries. This is the lowest amount that can 
be reported, as determined by each laboratory’s standard operating practices.

ULOL 
(Linearity Limit)

Upper limit of linearity. This is usually the highest calibrator amount.

Carryover Limit The highest amount of a substance that does not leave a residual amount in the instrument. 
If a substance has a carryover limit of 5, amounts higher than 5 usually dirty the instrument 
and leave residue behind, tainting the following sample. A carryover limit of less than 5 does 
not leave any residual amounts of the substance.
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Calibration 

Use the Calibration page to define acceptable criteria for initial calibration. The application 
compares the initial calibration results for each compound found in the sample to the values 
defined on this page. 

In the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Figure 64. Calibration page

Table 42. Calibration page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

R^2 Threshold The minimum correlation coefficient (r2) for an acceptable calibration (when in linear or 
quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable calibration (when in 
average RF mode). 

Note   This RSD value is not the same value used in Data Review or the Compound 
Calibration Report. The application uses this RSD value when you select AverageRF as 
the curve type for the method. See “Calibration Page” on page 206.

Min RF The minimum average response factor (RF) for an acceptable calibration (when in average 
RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical concentrations of the 
calibration curve data points (when in linear or quadratic mode). 

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage is the standard deviation 
of the multiple samples of one level, multiplied by 100, and then divided by the average of 
the multiple samples of that level. This calculation is based on the areas of the peaks.
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Chk Std 

Use the Chk Std page to review the calibration on an ongoing basis. The application compares 
the quality check standard results for each compound in the sample to the initial calibration 
using values defined on this page. 

In the QC Standard report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the QC Std sample versus the theoretical value is set on the QC Levels page of the 
Compounds page.

Figure 65. Chk Std page

Table 43. Chk Std page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
QC Std sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the QC Std sample (when in 
average RF mode). 

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage 
is the standard deviation of the multiple samples of one level, 
multiplied by 100, and then divided by the average of the multiple 
samples of that level. This calculation is based on the areas of the 
peaks.
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Matrix Blank

Use the Matrix Blank page to define acceptable levels of target compounds in blank samples. 
The application compares the calculated concentration for each compound in the sample to 
the maximum concentration defined on this page. You can enter the maximum concentration 
as a percentage of a flag value or as a specified value. 

For detailed descriptions of all the features on the Matrix Blank page, see Matrix Blank page 
parameters.

In the Matrix Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

 To specify the maximum concentration as a percentage

1. From the Method column list, select one of the following methods:
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

 To specify the maximum concentration

1. From the Method column list, select Concentration.

2. In the Max Conc column, type an absolute value.

Figure 66. Matrix Blank page

Table 44.  Matrix Blank page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.
Method The evaluation process used for comparing the calculated concentration. You can specify no 

maximum, a specific concentration, or a percentage of the LOR, LOD, or LOQ. 
Percentage The percentage of the LOR, LOD, or LOQ if you are using the percentage approach. 
Max Conc The maximum concentration if you are using an absolute value. 
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ISTD 

Use the ISTD page to review the response and retention time of internal standards (when 
available). The application compares the area and retention time results for each internal 
standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or if you have not 
identified any compounds as internal standards, this page does not show any values. 

Figure 67. ISTD page

Table 45. ISTD page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Min Recovery (%) The minimum and maximum percent recoveries for the internal standards to define an 
acceptable range. For check standards, the application compares the response of each internal 
standard in each sample to a range around the average of the responses of that compound in all 
of the calibration standards. For all other samples, the application calculates the comparison 
range around the check standard responses if a check standard is available in the batch. If no 
check standard is available, the application tests against the initial calibration.

Max Recovery (%)

Min RT (–min) The minimum and maximum drift (in minutes) for the internal standards to define an 
acceptable range. For check standards, the application compares the retention time of each 
internal standard in each sample to a range around the average of the retention times of that 
compound in all of the calibration standards. For all other samples, the application calculates 
the comparison range around the check standard retention times if a check standard is available 
in the batch. If no check standard is available, the application tests against the initial 
calibration.

Max RT (+min)

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage is the standard deviation of 
the multiple samples of one level, multiplied by 100, and then divided by the average of the 
multiple samples of that level. This calculation is based on the areas of the peaks.
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Solvent Blank 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The application 
compares the calculated response for each compound in the sample to the maximum response 
defined on this page. 

In the Solvent Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

Figure 68. Solvent Blank page

Threshold

Use the Threshold page (see “Threshold page” on page 225) to specify how to create a 
threshold guide to overlay on compounds in the Comparative View in the Data Review mode. 
For each compound, you can specify an absolute value or you can specify a percentage of the 
peak height. The application uses the selected threshold method and the specified amount to 
create a threshold guide in the Comparative View chromatograms. See “Comparative View” 
on page 468.

When you create a batch, you can group samples and then specify a sample in the group as the 
threshold sample to use in the Comparative View. For instructions about specifying a 
threshold sample, see “Threshold Samples Page” on page 446.

Table 46. Solvent Blank page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Method The evaluation process to use as a response for the quantitation 
ion only (Quan Ion RT) or as a summed response for the 
quantitation ion and any confirming ions (All Ion RT). To 
deactivate the solvent blank test for a specific compound, select 
None. 

Upper Limit Specifies an upper limit for each compound in the sample when 
you select an evaluation process. These values are not 
concentrations; they are raw response values.
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In the following figures, the threshold for the dibutyl phthalate compound is 50 percent of 
the peak height in the threshold sample (Threshold page in Method View), the samples 
Benzo26473, Benzo25557, and Benzo26154 are members of groupB (Samples page in Batch 
View), and the threshold sample for the group is Benzo26473 (Threshold Samples page in 
Batch View). In the Comparative Data view (Comparative View in Data Review), you can 
easily see that the peak height of dibutyl phthalate in the other samples in the group is less 
than 50 percent of the peak height in the threshold sample.

Figure 69. Threshold page in Method View

Figure 70. Samples page in Batch View

Figure 71. Threshold Samples page in Batch View

Figure 72. Comparative View in Data Review

Threshold method
Threshold at 50% of the 
peak height in the threshold 
sample

Samples belong to the same group

Benzo26473 selected as the 
threshold sample for groupb

Threshold sample

Threshold percentage - 50%
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Figure 73. Threshold page

Table 47. Threshold page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Method Specifies the threshold method as a specific peak height value 
(Threshold) or as a percentage of the peak height in the threshold 
sample (% of Threshold Sample).

Threshold Specifies the absolute peak height value to use when you select the 
Threshold method. This value represents the default threshold 
value to use when you do not specify a Threshold Sample for a 
group of samples.

Default: 1.000

Percentage Specifies the percentage of the peak height value to use when you 
select the % of Threshold Sample method. This value represents a 
percentage of the actual peak height in the Threshold Sample you 
select for a group of samples. For instructions about specifying a 
Threshold Sample, see “Threshold Samples Page” on page 446.

Valid range: 0.1 through 100.1
Default: 0.1
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Editing the Groups Page
Use the Groups page of the Method View to organize compounds into functional or logical 
groups. You can use these groups for creating a subset of target compounds. For detailed 
descriptions of all the features on the Groups page, see “Groups Page.” 

For quantitative processing, the application processes all compounds in the method and stores 
the complete result set, but only those in the selected group are visible in the Acquisition 
mode. Limiting the displayed compounds to those in the selected group can be useful when 
working with a master method containing a large list of compounds, only some of which are 
required for analysis in certain samples. In that case, the application requires only a single 
method and can reduce the results. To display only those compounds to be used in 
quantitative processing, select Quan Compounds from the Show list. 

You can create multiple groups and include the same compound in more than one group. 

 To open the Groups page

Click Groups in the Method View navigation pane.

 To create a group

1. At the bottom of the Groups area, click Add Group.

The Add a New Group dialog box opens.

2. Type a name for the new group and click OK.

The new group appears in the Groups area.

3. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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4. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose from the shortcut menu.

5. To remove a single compound, right-click the compound name in the group and choose 
Remove from Group from the shortcut menu.

Groups Page

Use the features on the Groups page to organize compounds into functional or logical groups.

Figure 74. Groups page

Table 48. Groups page parameters 

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a New Group dialog box where you can create a 
new group.

Shortcut menu

Empty Group Removes all compounds from the selected group.

Rename Group Changes the name of the selected group.

Delete Group Removes the selected group and all the compounds in it.

Remove From Group Removes the selected compound from its group.
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Editing the Intelligent Sequencing Page 

Use the Intelligent Sequencing page to specify the actions you want the application to take 
when there are acquisition failures with each sample type. The Intelligent Sequencing page is 
available only when you activate the Intelligent Sequencing option in the Configuration 
console. See “Intelligent Sequencing” on page 62.

 To open the Intelligent Sequencing page

Click Intel Seq in the Method View navigation pane.

The Intelligent Sequencing page opens.

 To specify actions for sample acquisition failures

1. In the Sample Types list, select a sample type.

Each sample type has a specific set of failure flags. See “Sample-Specific Failure Flags” on 
page 231.

2. For each failure flag, select a failure action.
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The failure action choices are the same for each failure flag except flags for Solvent or 
Matrix Blank sample types. The Solvent and Matrix Blank sample types do not have Auto 
Sample or Auto Sample and Reinject failure actions.

Each Failure Action requires one or more of the following values:

• Sample Type

• Priority

• Max Action Count

• Failure Continuation

For a detailed description of each of these parameters, see Actions.

3. Select a sample type to use for the failure action.

This value is available only for Auto Sample and Auto Sample and Reinject failure 
actions. When you create your samples list on the Auto Samples page, you must include 
at least one sample with this sample type for the autosampler to use when it encounters 
this error condition. See “Auto Samples Page” on page 443.

4. In the Priority column, type a priority value for this action.

The priority value can be any positive or negative integer. 

• The application performs the failure action for the highest priority failure it 
encounters and ignores all others.

• When you assign the same priority to two or more failures, the application performs 
the failure action for the first failure it encounters and ignores all others.

5. In the Max Action Count column, type a value for the maximum number of times the 
application should repeat a sample.

6. In the Failure Continuation column, do one of the following:

• Select the check box to skip this sample and continue to the next sample when this 
sample exceeds the Max Action Count value.

• Clear the check box to stop the batch when this sample exceeds the Max Action 
Count value. 
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Example

The following example shows the actions that the application uses when the acquisition for a 
sample fails.

1. The acquisition encounters an Ion Ratio Failure error on a sample.

2. The application runs a Solvent sample.

3. The application reinjects the original sample. 

4. This action is priority 0 in the Acquisition queue. 

5. The application repeats this autosample and reinject process two times.

6. After repeating the failure action two times, the application skips the sample and 
continues to the next sample.

Actions

Use the Actions pane to specify what action the application takes when it encounters a 
submission failure for the type of failure flag associated with each sample type. 

1 3 4 5 6

2

Table 49.  Actions parameters  (Sheet 1 of 2)

Parameter Description

Flag Flag (error) types specific to each sample type. See Sample-Specific Failure 
Flags. Each flag type has a set of user-specified actions that the application 
follows when it encounters this error.

Failure Action In the event of a failed sample, the application does one of the following:
• Continue: Continues to the next sample in the batch.
• Stop: Stops the batch.
• Auto Sample: Injects the sample type specified for the Auto Sample 

Type parameter and continues to the next sample.
• Reinject: Reinjects the current sample by inserting a “reinject” sample 

in the batch.
• Auto Sample and Reinject: Injects the sample type specified for the 

Auto Sample Type parameter and then reinjects the failed sample.
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Sample-Specific Failure Flags 

Each sample type has a specific set of failure flags. 

Sample Type Specifies either a Solvent or Matrix Blank sample type to use for the auto 
sample injection. 

Default: Solvent
Priority The priority value can be any positive or negative integer. 

When two or more failures have the same priority, the application 
performs the failure action for the first failure it encounters and ignores all 
others.

The application performs the failure action for the highest priority failure 
and ignores all others.

Max Action 
Count

Specifies the maximum number of times the application should repeat a 
sample before it continues to the next sample or stops the sequence, as 
determined by the value in the Failure Continuation parameter. 

Default: 1
Failure 
Continuation

When this check box is selected, samples that exceed the value specified 
for the Max Action Count parameter cause the application to skip the 
sample and continue to the next sample. 

When this check box is cleared, samples that exceed the value specified for 
the Max Action Count parameter cause the application to stop the batch.

Default: Selected

Table 49.  Actions parameters  (Sheet 2 of 2)

Parameter Description

Sample Type Flag

Matrix Blank • Blank

Cal Std • Out of Range
• Ion Ratio Failure
• Carryover

QC Std • Ion Ratio Failure
• Carryover
• Out of Range

Solvent • Solvent Flag

Unknown • Ion Ratio Failure
• Carryover
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Editing the Library Settings Page 

Use the Library Settings page to specify settings to use for library searches. 

 To open the Library Settings page

Click Library Settings in the Method View navigation pane.

The Library Settings page opens. See Library Settings page.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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Figure 75. Library Settings page

Table 50. Library Settings page parameters  (Sheet 1 of 3)

Parameter Description

General Library Settings

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come 
from the Source CID (MS–In Source CID). 

Use Isolation Width Specifies that the application use the isolation width to 
determine if there is an MS/MS within the same peak RT 
window that includes the precursor fragments. Available only 
when you set the MS Order to MS2.
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NIST Settings

Search Type Normal: Uses a more extensive set of presearch screenings—a 
total of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of 
MS/MS spectra.

In-source HiRes: Searches for an in-source/EI with an 
accurate ion m/z or an MS/MS spectrum in a library that 
contains in-source/EI accurate ion m/z or MS/MS spectra.

Precursor Tolerance Specifies the precursor m/z tolerance range as either amu or 
ppm.

Valid range: 0.015 through 100 000
Default: 1.60

Available only when you select MS/MS or In-source HiRes 
search types.

Product Tolerance Specifies the mass spectral peak tolerance range as either amu 
or ppm.

Valid range: 0.015 through 100 000
Default: 1.60

Available only when you select MS/MS or In-source HiRes 
search types.

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.

Available only when you select MS/MS or In-source HiRes 
search types.

Use Alt Peak Matching Specifies that the application use alternate peak matching.

Available only when you select MS/MS or In-source HiRes 
search types.

Reverse Search Specifies that the NIST library search use the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Presearch Specifies that the application use presearch screening before 
calculating the spectrum-by-spectrum match factor.

Table 50. Library Settings page parameters  (Sheet 2 of 3)

Parameter Description
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SI Threshold The lower threshold value for the search index method that is 
used to search the NIST library. The application does not 
return results below this value.

Valid range: 0 through 999
Default: 250

RSI Threshold The lower threshold value for the reverse search index method 
that is used to search the NIST library. The application does 
not return results below this value.

Valid range: 0 through 999
Default: 250

Probability Threshold Threshold value for the match probability.
Library Manager Settings

Spectrum Tolerance Specifies the spectrum tolerance as either amu or ppm. 

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Score Threshold The application does not return results below this value.

Valid range: 0 through 100
Default: 80.00

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.

Reverse Search Specifies that the Library Manager search use the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Table 50. Library Settings page parameters  (Sheet 3 of 3)

Parameter Description
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Editing the Reports Page

Use the Reports page to specify how you want to save or print your reports. For detailed 
descriptions of the features on the Reports page, see Reports Page.

For the quantitation report types, you can modify quantitation limits flags, user interface 
options, and quantitation flag options on the Quan Report Settings page. 

See the instructions for the following tasks:

• Specifying Report Formats

• Specifying Quan Report Settings

Specifying Report Formats

For each report type, you can create a hard-copy printout, a PDF file, a CSV file, or an Excel 
file. 

 To open the Reports page

Click Reports in the Method View navigation pane.
 

The Reports page opens with a list of all configured reports.

To configure which reports are available when you create a master method or which 
reports create a batch-level report, see “Specifying the Reports” on page 71. 

 To specify report types and output formats

1. To edit the Report Title, double-click the name and type your new custom title.

The application uses this title for all reports that use this master method. You cannot edit 
the Report Title from other report views.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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2. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

3. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available. By default, all report types are cleared. 

Reports Page

Use the features on the Reports page to specify how you want to save or print your reports. 

Figure 76. Reports page

Table 51. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 

Print Sends reports to the default printer. 

Create PDF Saves reports as PDF files. 

Create CSV Saves reports as CSV files. 

Create Excel Saves reports as Excel files. 

Exists Indicates that the report template is identified in the 
C:\TraceFinderData\3.3\Templates\ReportTemplates folder.



5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

238 TraceFinder User Guide Thermo Scientific

Specifying Quan Report Settings 

Use the options on the Quan Report Settings page to choose parameters for flagging values 
and displaying information in reports. See “Quan Report Settings Page” on page 240.

Follow these procedures:

• To specify quantitation limits

• To specify user interface options

• To specify quantitation flag options

 To specify quantitation limits

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
Concentration list.

For a description of concentration limits, see “Editing the QAQC Page” on page 217. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal Places to be Reported box.

3. To include a chromatogram of the sample in the Quantitation Report, select the Show 
Chromatogram on Quantitation Report check box.

4. To display only valid compounds, select the Display Compounds Above Set Limit 
check box.



 5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 239

 To specify user interface options

1. To shade a compound row in any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade Row when Sample is Outside of Evaluation Criteria 
check box.

2. To separate the ion overlay pane from the confirming ion plots, select the Separate Ion 
Overlay Display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of seven calibration standards, select the Use 
Alternate Calibration Report Format check box.

 To specify quantitation flag options

Select the values that you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear in a variety of reports and are defined in “Quan Report Settings page 
parameters” on page 240.



5 Using the Method Development Mode for Quantitation Methods
Editing a Master Method

240 TraceFinder User Guide Thermo Scientific

Quan Report Settings Page

Use the features on the Quan Report Settings page to specify parameters for flagging values 
and displaying information in reports.

Figure 77. Quan Report Settings page
 

 

Table 52. Quan Report Settings page parameters  (Sheet 1 of 2)

Parameter Description

Quan Limits Flags

Report Concentration Reports the concentration at all times or only when the quantified value exceeds either the 
limit of detection (LOD), the limit of quantitation (LOQ), or the limit of reporting (LOR). 
Report concentration: Always, >LOD, >LOQ, or >LOR.

Decimal Places to be 
Reported

Number of decimal places to be included in the report. Maximum value is 6.

Show Chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample in the quantitation report. 

Display Compounds 
Above Set Limit

Prints reports for only the compounds that are found in a sample. If a compound is above 
the specified Quan Flag Options limits, the application reports the compound. This 
prevents generating “empty” reports for the compounds that are not found.

User Interface Options

Shade Row When 
Sample is Outside of 
Evaluation Criteria

Shades a compound row in any of the reports if a value fails one of the criteria used for 
evaluation. 
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Separate Ion Overlay 
Display

Separates the ion overlay pane from the confirming ion plots in an analysis. 

Use Alternate 
Calibration Report 
Format

Uses an alternate format for the Calibration Report that is designed to print more concisely 
(this report is limited to a maximum of seven calibration standards). 

Quan Flag Options
Values that are above or below limits defined on the Limits page. These flags appear in a 
variety of reports. 

Flag Values Below 
LOD

Flags values below the limit of detection (LOD).

Flag Values Below 
LOQ

Flags values below the limit of quantitation (LOQ).

Flag Values Above 
LOR

Flags values above the limit of reporting (LOR).

Flag Values Above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag Values Above 
Carryover

Flags values above the carryover limit.

Flag Values Between 
LOD and LOQ

Flags values between the limit of detection and the limit of quantitation known as the J flag.

Table 52. Quan Report Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Saving a Master Method to a New Name
You can save any method to a new name, or you can use the current method data to overwrite 
an existing method. The new method contains all the data of the saved method.

 To save a method to a new name

1. From the main menu, choose File > Save As.

The Save Master Method As dialog box opens, displaying all available methods.

2. Do one of the following:

• In the New Method box, type a name for the new method.

The application enables the Save button.

• In the Method column, select a method to overwrite.

The application enables the Overwrite button.

3. Click Save or Overwrite.

The application saves all the method data using the specified name and opens the 
Acquisition page of the new method.

Table 53. Save Master Method As dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.
Type Type of method: Quan, Screening, or Unknown Only.
Date Changed Date the method was last updated.
Size Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
New Method Name of the new method to create.
Path Path to the selected method in the Methods folder.
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Creating a Method Template
In the TraceFinder application, you can create a processing method using a method template 
that contains common settings. You can create a method template that specifies peak 
detection criteria, screening libraries, confirming ion criteria, compound calibration, and 
qualitative peak processing. For a complete description of the features in the Method 
Template Editor, see “Method Template Editor” on page 249.

The application uses the settings in the method template to identify the data to display in the 
Qualitative View. See “Qualitative View” on page 475.

Only quantitation methods use method templates. 

Follow these procedures:

• To open the Method Template Editor

• To specify peak criteria

• To identify the peaks

• To specify confirming ions

• To calibrate the compounds

• To save the method template

 To open the Method Template Editor

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens.

2. Click Method View.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens. See “Method Template Editor” on page 249. 
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 To specify peak criteria

1. In the Find the Peaks area, select a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. 

• The ICIS peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. 

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. 

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that results in compound selection, select the Enable Peak Threshold check 
box. 

To consider a peak for a processing method, the application uses the Enable Peak 
Threshold filter to determine which peaks meet the specified percentage of the height or 
area of the largest peak. 

4. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.

Note  Parameters in the Find the Peaks* area might also be used for qualitative peak 
processing.
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 To identify the peaks

1. In the Use these Libraries box, select the libraries that you want to search.

All libraries loaded on your instrument are displayed in the Use these Libraries box. 

2. To limit the number of matches returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

 To specify confirming ions

1. To set the number of confirming ions, select the Include Confirming Ions check box 
and enter a value in the Number of Confirming Ions box.

This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. You can set this value to integers from 1 through 10, inclusive. This value 
defaults to 2 because you typically perform a 3-ion experiment with one quantitation 
mass and two confirming ions. 

The system selects the most intense ion to use as the quantitation mass and uses this mass 
for the mathematical operations. 

Note  Parameters in the Identify the Peaks* area might also be used for qualitative 
peak processing.
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2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
Default Ion Ratio Ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming ion peak 
and the quantification ion peak, set a value in the Ion Coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window Type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

 To calibrate the compounds

1. From the Calibration Method list, select Internal or External.

2. From the Curve Type list, select one of the following:

• Linear: All other settings are available with this exception: When you select Include 
in the Origin list, the Weighting parameter is unavailable.

• Quadratic: All other settings are available with this exception: When you select 
Include in the Origin list, the Weighting parameter is unavailable.

• Average RF: The Weighting and Origin parameters are unavailable. 

3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.
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4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response Via list, select Area or Height.

• Area: Specifies that the application use this area value in response calculations.

• Height: Specifies that the application use this height value in response calculations. 

 To specify qualitative peak processing

1. Select the Use Genesis Algorithm for Qual Processing check box and specify a value for 
internal standard matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value that you specify. For additional information about the Genesis 
algorithm, see “Genesis Detection Method” on page 43.

This parameter is available only when you set the Sensitivity parameter in the Find the 
Peaks area to ICIS or Avalon. When you select the Use Genesis Algorithm for Qual 
Processing check box, the application ignore the Sensitivity parameter in the Find the 
Peaks area. 
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2. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes quantitative peaks in a range plus or minus the value that you 
specify.

3. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

This option constrains the Data Review to only data-dependent scan spectra. See 
“Working in the Local Method View” on page 526.

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. 

4. To indicate whether to select peaks above a minimum percentage of the nearest internal 
standard peak that results in compound selection, select the Enable ISTD Threshold 
check box and specify a minimum percentage. 

To consider a peak for a processing method, the application uses the Enable ISTD 
Threshold filter to determine which peaks meet the specified percentage of the height of 
the nearest internal standard peak. 

When you select the Enable ISTD Threshold parameter, the method ignores values set for 
the Enable Peak Threshold and Only Select Top Peaks parameters. See “To specify peak 
criteria” on page 244. 

 To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

Type a new name for the master method and click OK.

–or–

Select a method name to overwrite and click Overwrite.

The application saves the new method template in the following folder:

…\TraceFinderData\3.3\Templates\Methods\General 

Saved method templates are available when you create a method using Method Forge. See 
“Creating a New Method with Method Forge” on page 118. 

Note  When you create a method with the Method Forge, the application ignores the 
parameters in the Qualitative Peak Processing area.
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Method Template Editor

Use the features in the Method Template Editor to specify peak detection criteria, screening 
libraries, confirming ion criteria, compound calibration, and qualitative peak processing.

Figure 78. Method Template Editor dialog box
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Table 54. Method Template Editor dialog box parameters  (Sheet 1 of 3)

Parameter Description

Find the peaks

Sensitivity Defines how extensively the peak detector algorithm searches for low-level peaks. 

Limit the Retention 
Time Range

Min RT specifies the beginning of the range. Max RT specifies the end of the range. 

Enable Peak Threshold Specifies whether to select peaks by relative height or area and the percentage of the highest 
peak that results in compound selection.

Only Select Top Peaks Displays a specific number of the largest peaks by height or area.

Identify the peaks

Use These Libraries Lists the libraries that you can search.

Limit Library Hits Specifies the number of matches returned when the system searches a spectrum against the 
selected libraries.

Best Match Method Specifies how to sort the library searches. 

Valid values: Search Index, Reverse Search Index, Match Probability

Handle confirming ions

Include Confirming 
Ions/
Number of Confirming 
Ions

Specifies the number of confirming ions, which are other ions in the spectrum whose ratio 
is compared to the quantitation ion to identify the compound.

This value defaults to 2 because you typically perform a 3-ion experiment with one 
quantitation mass and two confirming ions.

Valid values: Integers from 1 through 10, inclusive.

Specify Default Ion 
Ratio Ranges

Enables the ion ratio range features.

Ion Coelution specifies the maximum difference in retention time between a confirming 
ion peak and the quantification ion peak. 

Window Type specifies an Absolute or Relative calculation approach for determining the 
acceptable ion ratio range.

Window (+/-%) specifies the acceptable ion ratio range.

Include Compound 
Peak Spectrum as 
Reference Spectrum

Includes the peak spectrum in the processing method. Use this setting to perform a spectra 
comparison in Data Review. 

Calibrate the compounds

Calibration Method Specifies an internal or external calibration method.

Curve Type Specifies a linear, quadratic, or average RF curve type.
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Origin Specifies that the origin is ignored, forced, or included in the generated calibration curve.
• Ignore: Specifies that the origin is not included as a valid point in the calibration curve 

when the curve is generated. When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Include, the calibration curve might or might 
not pass through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data point in the calculation of 

the calibration curve. When you select Equal, the calibration curve might or might not 
pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their response (or response ratio). 

Response Via Specifies if the application uses area or height in response calculations.
• Area: Specifies that the application use this peak area value in response calculations.
• Height: Specifies that the application use this peak height value in response 

calculations. 

Qualitative Peak Processing

Use Genesis Algorithm 
For Qual Processing

The application uses the Genesis algorithm to match internal standards. 

ISTD Matching Excludes all the target compounds found in the method and does not list these compounds 
in the TIC Report or in the Qual Mode view in the Data Review.

Exclude Matching Quan 
Peaks

Exclusion Window

Compares the retention time of the internal standard in the method to the found retention 
time of the internal standard in the library search and excludes peaks outside the Exclusion 
Window range. 

Defines a range plus/minus the Exclusion Window value that you specify.

Table 54. Method Template Editor dialog box parameters  (Sheet 2 of 3)

Parameter Description
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Use Data Dependent 
Scans

Constrains the Data Review to only data-dependent scan spectra. See “Working in the 
Local Method View” on page 526. In addition to the peak information, the TIC Report 
and TIC Summary Report display information about the data-dependent filtered data.

Enable ISTD Threshold Specifies that, when identifying a peak, qualitative peak processing use the minimum 
threshold specified as a percentage of the nearest internal standard peak, rather than the 
threshold specified in the Enable Peak Threshold and Only Select Top Peaks parameters. 
See Enable Peak Threshold or Only Select Top Peaks in this parameter table.

% of Internal 
Standard

Percentage of the nearest internal standard peak to use as the minimum threshold for 
identifying a peak.

Table 54. Method Template Editor dialog box parameters  (Sheet 3 of 3)

Parameter Description
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Exporting Mass Data
You can export the mass data list from the Compounds page to an XML file that can be read 
by the TSQ, ISQ, Q Exactive, TSQ Endura, or TSQ Quantiva applications. You can export 
mass data only from quantitation methods.

 To export mass data list to an XML file

1. Open the master method whose mass data list you want to export. 

If you make changes to the method, you must save it before you can export the mass data 
list.

2. To view a list of your mass data, click the Acquisition List tab on the Compounds page.

You do not have to display the Acquisition List to export the data, but the compounds in 
the Acquisition List must contain at least one experiment type appropriate to the export 
file format. For information about displaying the Acquisition List, see “Acquisition List” 
on page 150. For information about editing the experiment type for a compound, see 
“Editing Compounds in the Database” on page 84.

3. Choose Method View > Export Mass List from the main menu.

The application writes the mas data in the Acquisition List to the following folder, using a 
format compatible with your configured instrument:

…\TraceFinderData\3.3\Methods\Methodname

For examples of exported mass lists, see the following:

• “Triple Quadrupole Format” on page 79 

• “Q Exactive Format” on page 79

• “TSQ Quantiva/Endura SIM Format” on page 79

• “TSQ Quantiva/Endura SRM Format” on page 80

IMPORTANT   If you have neither a TSQ, an ISQ, a Q Exactive, a TSQ Endura, nor 
TSQ Quantiva instrument configured, a message asks which format you want to 
export: Triple Quadrupole, Q Exactive, TSQ Quantiva/Endura SIM, or TSQ 
Quantiva/Endura SRM.
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6

Using the Method Development Mode for Target 
Screening Methods

This chapter includes method development tasks for creating and editing screening master 
methods. (See Method Development navigation pane.) When user security is activated, you 
must have Method Development Access permission to use these features.

The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for that type 
of application. 

When you create a master method, the application uses the method to determine how the 
application works with a set of samples to provide a set of meaningful results. The application 
uses an instrument method to define how raw data is acquired. The rest of the master method 
defines how the raw data is processed, how the flags information displays the results, and how 
the reporting functionality defines the output for your data and results. 

The application applies your master method to a batch, which is a list of one or more samples 
to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the data processing and information reporting for batches of 
samples. 

Contents

• Opening a Master Method

• Starting a Target Screening Master Method

• Editing a Master Method

• Saving a Master Method to a New Name
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Figure 79. Method Development navigation pane

Table 55. Method Development navigation pane commands 

Command Description

Method View

Acquisition Displays the Acquisition page of the Method View. Use the 
features on the Acquisition page to define basic information about 
the master method. See “Editing the Acquisition Page” on 
page 261.

Screening

Processing Displays the Processing page of the Method View. Use the features 
on the Processing page to specify peak filter settings, screening 
databases, and identification and confirmation settings for a target 
screening method. See “Editing the Processing Page” on page 264.

Peak Detection Displays the Peak Detection page of the Method View. Use the 
features on the Peak Detection page to specify any of the following 
peak detection algorithms: Genesis, ICIS, or Avalon. See “Editing 
the Peak Detection Page” on page 286.

Reports Displays the Reports page of the Method View. See “Editing the 
Reports Page” on page 297.

Compound Database See “Working with the Compound Database” on page 74.

Instrument View See “Working with Instrument Methods” on page 108.
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Opening a Master Method
A target screening master method contains compound databases, identification and 
confirmation criteria used in detecting and processing, and settings for reporting compounds. 

When you open a target screening master method, the Method View navigation pane displays 
the available pages for target screening methods. For descriptions of all the features in the 
Method Development navigation pane, see “Starting a Target Screening Master Method” on 
page 259.

 To open a target screening method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods.

3. Select Screening in the Type list.

The method list displays only target screening methods. See Open Master Method dialog 
box.

4. Select a master method and click Open.

The Acquisition page for the selected method opens. To edit the master method, see 
“Editing a Master Method” on page 261.

The navigation pane displays the available pages for target screening methods. For 
descriptions of all the features in the Method Development navigation pane, see “Starting 
a Target Screening Master Method” on page 259.

Tip  You can also open one of your most recently used master method files. Choose 
Files > Recent Files > Method.
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Figure 80. Open Master Method dialog box

Table 56. Open Master Method dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.
Type Type of method: Quan, Screening, or Unknown Only.
Date Changed Date the method was last updated.
Size Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
Type Type of method to display: Quan, Screening, Unknown 

Only, or Any.
Path Path to the selected method in the 

TraceFinderData\3.3\Methods\General folder.
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Starting a Target Screening Master Method
The following procedure includes the basic parameters you must define to create and save a 
target screening master method. For a detailed description of how to modify all parameters in 
a master method, see “Editing a Master Method” on page 261.

 To create a new method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

Figure 81. Create Master Method dialog box

2. Select the Target Screening Method option and click OK.

The Method View for a target screening method includes the Acquisition, Processing, 
Peak Detection, and Reports pages. 

IMPORTANT   The Unknown Screening Method - Only feature is available only when 
you select the Allow Unknown Screening option in the application configuration 
console. See “Processing Options” on page 62.



6 Using the Method Development Mode for Target Screening Methods
Starting a Target Screening Master Method

260 TraceFinder User Guide Thermo Scientific

The Acquisition page for the method opens.

3. From the Instrument Method list, select an instrument method. 

4. Click Processing in the Method View navigation pane.

The Processing page for the method opens. The application lists the compound databases 
(.cdb) that are stored in the following folder:

…\Thermo\TraceFinder\3.3\General\Databases

5. Select the Enabled check box for at least one compound database.

You must select at least one compound database before you can save the method. The 
target screening method uses only the target list of compounds in the selected compound 
databases to identify the compounds in the samples.

6. To save the new method, choose File > Save from the main menu.

7. In the Save Master Method dialog box, type a name for the method and click OK.

For a detailed description of how to modify a master method, see Editing a Master 
Method. 

This animation shows how to create a new target screening method. To view the animation, 
click , and then right-click and choose Full Screen Multimedia. To stop the animation, 
press ESC.
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Editing a Master Method
You can open a master method to specify method instructions, reporting options, peak filter 
settings, screening databases, identification and confirmation settings, and peak detection 
parameters.

See the instructions for the following tasks:

• Editing the Acquisition Page

• Editing the Processing Page

• Editing the Peak Detection Page

• Editing the Reports Page

Editing the Acquisition Page

Use the features on the Acquisition page to define basic information about the master 
method.

 To edit the parameters on the Acquisition page

1. Click Acquisition in the Method View navigation pane.

The Acquisition page for the method opens. See “Acquisition Page” on page 263.

2. In the Lab Name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

3. In the Assay Type box, type the assay type to be targeted by the method.

4. From the Injection Volume box, select the injection volume (in μL) to be used for sample 
injection.

Valid range: 0.1 through 2000 μL

Use the up/down arrows to change the volume in increments/decrements of 1.0 μL, or 
use the keyboard to enter non-integer injection volumes. 

5. From the Mass Precision box, select the number of decimal places to be used in reports 
and in peak and spectrum displays. 

Valid values: Integers from 2 through 6, inclusive 

IMPORTANT  The application uses this injection volume in the master method, not 
the injection volume in the instrument method.
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6. From the Instrument Method list, select an instrument method. 

7. To edit the instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments. (See Thermo Instrument Setup window.)

Figure 82. Thermo Instrument Setup window

8. Edit the values on the instrument page for your instrument.

9. From the main menu in the Thermo Instrument Setup window, 
choose File > Save and then choose File > Exit.

The application returns you to the Acquisition page of the Method View.
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Acquisition Page

Use the features on the Acquisition page to define basic information about the master 
method. 

Figure 83. Acquisition page for a target screening method 

Table 57. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name The laboratory name to be displayed on the top of each printed, 
saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see “Specifying 
Application Defaults” on page 37.

Assay Type The name for the analysis type to be targeted by the method. The 
assay type associates the method with the analysis of a compound 
or specific class of compounds (for example, you might use an 
assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).

Injection Volume The system uses the injection volume (in μL) for sample injection. 
For a more detailed explanation, refer to the documentation for 
the autosampler.

The injection volume in the master method overrides the injection 
volume in the instrument method. 

The injection volume in the batch overrides the injection volume 
in the master method.

Valid range: 0.1 through 2000 μL
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Editing the Processing Page

Use the features on the Processing page to specify peak filter settings, screening databases, and 
identification and confirmation settings for a master method.

Follow these procedures:

• To open the Processing page

• To specify peak filter settings for limiting the display of unwanted data

• To add unknown screening to the method

• To specify compound databases

• To specify identification and confirmation settings

 To open the Processing page

Click Processing in the Method View navigation pane.

The Processing page for the method opens. See “Processing Page” on page 271.

Mass Precision Number of decimal places used in reports and in peak and 
spectrum displays. 

Valid values: Integers from 2 through 6, inclusive

Instrument Method Instrument method used for acquiring samples.

Edit Opens the Thermo Instrument Setup window where you can edit 
the instrument method.

Update Choose one of the following:

• Send to System Methods: Overwrites the instrument method 
in the C:\TraceFinderData\3.3\Methods folder with the 
current instrument method.

• Get From System Methods: Overwrites the current 
instrument method with the instrument method in the 
C:\TraceFinderData\3.3\Methods folder.

Table 57. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description



 6 Using the Method Development Mode for Target Screening Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 265

 To specify peak filter settings for limiting the display of unwanted data

1. To set a retention time range that excludes searching for peaks outside the range, do the 
following:

a. Select the Use RT Limits check box.

The application activates the Search From and To options.

b. In the Search From box, enter the lower limit; in the To box, enter the upper limit.

2. To use one or more matrix blank samples for subtraction to filter the resulting peaks, do 
the following:

a. Select the Use Matrix Blank check box.

The application activates the Amplifier option.

During automatic processing, the application subtracts the areas of the peaks in the 
matrix blank samples from the matching areas in the unknown samples. 

To determine the pair of peaks to subtract from each other, the application selects the 
two peaks with the mass and the retention time that are closest to each other (as 
defined in the compound database), within the mass tolerance specified in the 
method.

When the same compound peak (same mass and retention time within the 
predefined tolerance windows) is in multiple selected matrix blank samples, the 
application subtracts only the one with the highest area.

When a compound peak in one matrix blank sample has the same primary ion as 
another peak in a different matrix blank sample but has different adducts, the 
application uses all the adducts from both these peaks for subtraction purposes. For 
example, if a compound has the M+H and M+Na ions in one matrix blank sample, 
and this same compound has the M+H and M+NH4 ions in another matrix blank 
sample, the application uses for subtraction the area that results from all of these ions.

When no matrix blank sample exists in the sequence, or if one or more matrix blank 
samples exist but you do not select the Use Matrix Blank check box, then subtraction 
does not occur. If subtraction occurs and the subtracted area is less than 0, the 
application sets the subtracted area to 0.
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b. In the Amplifier box, type an amplifier value. 

Use the up/down arrows to change the value in increments/decrements of 1 unit, or 
use the keyboard to enter non-integer values. 

The application multiplies a matrix blank area by this value before performing 
subtraction. The larger the amplifier value, the more peaks the application filters 
from the final results.

In the Batch View for sequences created with this method, you can select which matrix 
blank samples to use for subtraction. See “Blank Subtraction” on page 535.

3. In the Chromatogram View Width box, type a value to define the chromatogram viewing 
range in the Data Review view. 

4. To use source CID scans for target screening confirmation (fragment ion or library 
search), select the Use Source CID Scans check box.

When you select this check box, the application uses the source CID scans when they are 
available in the data file. If they are not available, then the application uses AIF or 
MS/MS scans when available.

5. To display all compounds from the compound databases in the Data Review display 
(regardless of whether there is a match in the samples), select the Show All Compounds 
check box.

 To add unknown screening to the method

1. Select the Include Unknown Screening check box.

The application adds the Unknown Screening features to the Method View navigation 
pane.

2. To specify unknown screening settings for peaks, libraries, databases, elements, and 
ChemSpider searches, click Processing.

For further instructions, see “Editing the Processing Page” on page 264.

3. To specify unknown screening peak detection settings, click Peak Detection Settings.

IMPORTANT   The Include Unknown Screening check box is available only when you 
select the Allow Unknown Screening option in the application configuration console. 
See “Processing Options” on page 62.
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For further instructions, see “Editing the Peak Detection Page” on page 286.

The application indicates that a target screening method includes unknown screening in 
the following locations:

• In the Batch View in the Analysis mode, when you create a batch using a target 
screening method, the title bar indicates that the method includes unknown 
screening.

• In the Analysis navigation pane, the application displays access to local methods for 
both target screening and unknown screening.

• In the Submit Options dialog box, when you submit a batch, the Process Data area 
shows all processing method types for the batch.

You can select the detection options for each processing method that you want to use 
when you submit the batch.

 To specify compound databases

1. Select the Enabled check box for at least one compound database.

The Compound Databases pane displays all compound databases stored in the 
…\Thermo\TraceFinder\3.3\General\Databases folder.

2. (Optional) To edit a database, click Open and do the following:

a. Edit the database. 

See “Editing Compounds in the Database” on page 84.

b. When you finish editing the database, click Processing in the Method View 
navigation pane to return to the Processing page.
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 To specify identification and confirmation settings

1. To set a target threshold override and include only peaks with areas above this designated 
threshold, do the following:

a. Select the Threshold Override check box.

b. In the associated box, type the threshold as an area value.

This threshold overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below your specified threshold.

c. To include only peaks with signal-to-noise ratios (S/Ns) that are above a specified 
value, in the S/N Ratio Threshold box, type the threshold as a ratio value.

The application ignores the peaks with S/Ns that are below the specified threshold. 

Note  The Identification and Confirmation Settings pane displays parameters for 
identifying or confirming compounds. For additional information about the 
confirmation and identification process, see “Understanding the Identification and 
Confirmation Process” on page 279.
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2. In the Mass Tolerance box, type a mass tolerance value and then select ppm or mmu for 
the mass tolerance units.

The application applies this mass tolerance to the extracted chromatograms.

3. To specify the Retention Time option, do the following:

a. Select either the Identity or Confirm check box.

b. Select the Window Override check box and type the window value.

This window overrides the RT Window value that was set in the compound database 
and includes only peaks within this designated window. The application identifies or 
confirms the presence of a compound only when its measured retention time matches 
the target compound’s expected retention time within the specified Window 
Override retention time. 

For additional information about how the application identifies retention time, see 
“Retention Time” on page 281.

4. To specify the Fragment Ions option, do the following:

a. Select either the Identity or Confirm check box.

b. To ignore the Fragment Ions options when no fragment is defined in the compound 
database, select the Ignore if Not Defined check box.

When the compound database does not define fragments for a compound, the 
application does not include the results of identification or confirmation for fragment 
ions in the target screening results.

c. In the Min. # of Fragments box, type the minimum number of fragments required to 
identify or confirm the presence of a compound.

d. In the Intensity Threshold box, type the intensity threshold value.

The intensity of a fragment must be above this threshold to be identified or 
confirmed.

e. In the Mass Tolerance box, type a mass tolerance value and then select ppm or mmu 
for the mass tolerance units.

This mass tolerance value indicates the number of millimass units or parts per million 
to use as the m/z ± tolerance value for the fragment ions. It is separate from the mass 
tolerance value specified for the parent peak. 

For additional information about how the application identifies fragment ions, see 
“Fragment Ions” on page 281.

Note   When using ion trap data, the application uses 300 mmu regardless of the 
value you enter here.
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5. To specify the Isotopic Pattern option, do the following:

a. Select either the Identity or Confirm check box.

b. In the Fit Threshold box, type the fit threshold percentage.

To identify or confirm the presence of a compound, the resulting score percentage 
from isotopic pattern matching must be higher than the specified fit threshold 
percentage. 

c. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage 
of the base peak height.

The TraceFinder isotopic pattern algorithm considers an isotope peak as not found if 
its intensity, relative to the monoisotopic ion’s intensity, is more than the deviation 
percentage from the theoretical relative intensity of the isotope ion. For best results, 
set this value to a number that causes up to 98% of all intensity deviations to be 
smaller than the allowed intensity deviation value.

d. To specify that isotopic pattern calculations use internal mass calibration instead of 
external mass calibration, select the Use Internal Mass Calibration check box. 

When this check box is selected, the application applies a requirement that an 
isotope’s m/z must be closer to its theoretical value to avoid a score penalty.

For additional information about how the application calculates isotopic pattern scores, 
see “Isotopic Pattern” on page 282.

6. To specify the Library Search option, do the following:

a. Select either the Identity or Confirm check box.

b. Select a Library Search Type, either NIST or Library Manager. 

c. Type the threshold value in the Score Threshold box.

The resulting score percentage from a library search match must be higher than your 
entered threshold value to identify or confirm the presence of a compound.

d. To compare a library entry to an unknown compound, select the Use Reverse 
Library Searching Only check box.

A forward search compares the mass spectrum of an unknown compound to a mass 
spectral library entry.

For additional information about how the application performs library searches, see 
“Library Search” on page 283.
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Processing Page

The Processing page includes the following panes:

• Settings

Use the features in the Settings pane to specify peak filter settings. See Settings pane on 
the Processing page.

• Target Screening Settings

Use the features in the Target Screening Settings pane to specify screening databases and 
identification and confirmation settings. See “Target Screening Settings pane on the 
Processing page” on page 273.

Figure 84. Settings pane on the Processing page

Table 58. Settings pane parameters  (Sheet 1 of 2)

Parameter Description

Peak Filter Settings

Use RT Limits Specifies a lower and upper limit for searches. 

Valid range: 0.00 through 999.99 minutes
Default: 0.00 minutes for lower limit; 999.00 minutes for upper limit

Use Matrix 
Blank

Specifies that during automatic processing, the application subtracts the 
areas of the peaks in the selected matrix blank samples from the matching 
areas in the unknown samples. 

Amplifier The application multiplies a matrix blank area by this value before 
performing subtraction. The larger the amplifier value, the more peaks 
the application filters from the final results.

Valid range: .01 through 1000.00
Default: 1.00
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Chromatogram 
View Width

Specifies a a window width to define the chromatogram viewing range in 
the Data Review view. 

Valid range: 0.10 through 999.00 minutes
Default: 0.75 minutes

Use Source CID 
Scans

Specifies that the application use the source CID scans when they are 
available in the data file. If they are not available, then the application 
uses AIF or MS/MS scans when available.

Show All 
Compounds

Displays results for all compounds in the method, regardless of whether 
they are found in any samples.

Unknown Screening

Include 
Unknown 
Screening

Adds unknown screening features to the target screening method.

Table 58. Settings pane parameters  (Sheet 2 of 2)

Parameter Description
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Figure 85. Target Screening Settings pane on the Processing page 
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Table 59. Target Screening Settings pane parameters  (Sheet 1 of 5)

Parameter Description

Compound Databases

Enabled Specifies databases to use for target screening processing.

Database Name Lists available databases in the Databases folder.

Identification and Confirmation Settings

Peaks
Specifies that the application use the mass-to-charge ratio (m/z) for 
filtering compound peaks.

Threshold Override Overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below this 
specified threshold.

Valid range: 1000 through 1 000 000 000
Default: 5000

S/N Ratio Threshold Includes only peaks with signal-to-noise ratios (S/Ns) above the 
specified value.

Valid range: 1.0 through 100 000
Default: 5.0

Retention Time

Specifies either the Identify or Confirm option for a retention time 
search. To identify a compound, the application searches the 
specified RT window for a match. To confirm a compound, the 
application searches the entire raw data file.

Ignore if Not Defined Ignores the values you specify for Retention Time options when 
no retention time is defined in the compound database, and does 
not include the results of identification or confirmation for 
retention time in the Data Review target screening results.

Window Override Specifies the number of seconds to override the RT Window value 
set in the compound database and include only peaks within this 
designated window. The application identifies or confirms the 
presence of a compound only when its measured retention time 
matches the target compound’s expected retention time within the 
specified Window Override retention time. 

Valid range: 0 through 999 seconds
Default: 30 seconds
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Fragment Ions

Specifies either the Identify or Confirm option for a fragment ion 
match. To identify a fragment, the application searches the 
specified RT window for a match. To confirm a fragment, the 
application searches the entire raw data file.

Ignore if Not Defined Ignores the values you specify for Fragment Ions options when no 
fragment is defined in the compound database, and does not 
include the results of identification or confirmation for fragment 
ions in the Data Review target screening results.

Min. # of Fragments Specifies the minimum number of fragments required to identify 
or confirm the presence of a compound.

Valid range: 1 through 5
Default: 1

Intensity Threshold Specifies the minimum height of a fragment ion peak. The peak of 
a fragment ion must be above this intensity threshold to be 
identified or confirmed.

Valid range: 1 through 1e9
Default: 10 000

Mass Tolerance Specifies the number of millimass units or parts per million to use 
as the m/z ± tolerance value for the fragment ions and is separate 
from the mass tolerance specified for the parent (see “Editing the 
Acquisition Page” on page 261).

Valid range: 0 through 500 
Default: 5
Unit: mmu or ppm

Note  When using ion trap data, the application uses 300 mmu 
regardless of the value you enter here.

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come from 
the Source CID (MS–In Source CID). 

Isotopic Pattern 

Specifies either the Identify or Confirm option for an isotopic 
pattern match. To identify a compound, the application searches 
the specified RT window for a match. To confirm a compound, 
the application searches the entire raw data file.

Fit Threshold To identify or confirm the presence of a compound, the resulting 
score percentage from isotopic pattern matching must be higher 
than the specified fit threshold percentage. 

Default: 90% 

Table 59. Target Screening Settings pane parameters  (Sheet 2 of 5)

Parameter Description
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Allowed Mass 
Deviation

Specifies the allowed mass deviation in the spectrum data.

The TraceFinder isotopic pattern algorithm considers an isotope 
peak as found if its measured m/z is less than this amount away 
from its expected m/z. For best results, set this value to a number 
that causes up to 98 percent of all mass deviations to be smaller 
than the allowed mass deviation value. 

Valid range: 3 through 100 ppm 
Default: 3 ppm

Allowed Intensity 
Deviation

Specifies the allowed intensity deviation of the mass spectrometer, 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

The TraceFinder isotopic pattern algorithm considers an isotope 
peak as not found if its intensity relative to the monoisotopic ion’s 
intensity is more than this deviation percentage from the 
theoretical relative intensity of the isotope ion. For best results, set 
this value to a number that causes up to 98% of all intensity 
deviations to be smaller than the allowed intensity deviation value.

Default: 10%

Use Internal Mass 
Calibration

Specifies that the application require an isotope’s m/z to be closer 
to its theoretical value to avoid a score penalty.

Library Search

Specifies either the Identify or Confirm option for a library search. 
To identify a compound, the application searches the specified RT 
window for a match. To confirm a compound, the application 
searches the entire raw data file.

Library Search Type NIST or Library Manager

General Library Settings

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come from 
the Source CID (MS–In Source CID). 

Use Isolation 
Width

Specifies that the application use the isolation width to determine 
if there is an MS/MS scan within the same peak RT window that 
includes the precursor fragments. Available only when you set the 
MS Order to MS2.

Table 59. Target Screening Settings pane parameters  (Sheet 3 of 5)

Parameter Description
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NIST Settings

Search Type Normal: Uses a more extensive set of presearch screenings—a total 
of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of MS/MS 
spectra.

In-source HiRes: Searches for an in-source/EI with an accurate 
ion m/z or an MS/MS spectrum in a library that contains 
in-source/EI accurate ion m/z or MS/MS spectra.

Precursor 
Tolerance

Specifies the precursor m/z tolerance range as either amu or ppm.

Valid range: 0.015 through 100 000
Default: 1.60
Available only when you select MS/MS or In-source HiRes search 
types.

Product Tolerance Specifies the mass spectral peak tolerance range as either amu or 
ppm.

Valid range: 0.015 through 100 000
Default: 1.60
Available only when you select MS/MS or In-source HiRes search 
types.

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.
Available only when you select MS/MS or In-source HiRes search 
types.

Use Alt Peak 
Matching

Specifies that the application use an alternate peak matching 
method for searching the mass spectra.
Available only when you select MS/MS or In-source HiRes search 
types.

Reverse Search Specifies that the NIST library search use the reverse search 
method. A reverse search compares a library entry to an unknown 
compound (whereas a forward search compares the mass spectrum 
of an unknown compound to a mass spectral library entry).

Presearch Specifies that the application use presearch screening before 
calculating the spectrum-by-spectrum match factor.

Table 59. Target Screening Settings pane parameters  (Sheet 4 of 5)

Parameter Description
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SI Threshold Specifies the lower threshold value for the search index method 
used to search the NIST library. The application does not return 
results below this value.

Valid range: 0 through 999
Default: 250

RSI Threshold Specifies the lower threshold value for the reverse search index 
method used to search the NIST library. The application does not 
return results below this value.

Valid range: 0 through 999
Default: 250

Probability 
Threshold

Threshold value for the match probability.

Library Manager Settings

Spectrum 
Tolerance

Specifies the spectrum tolerance as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Score Threshold Specifies that the application does not return results below this 
value.

Valid range: 0 through 100
Default: 80.00

Ignore Precursor Specifies that the application ignore mass spectral peaks within the 
specified precursor tolerance range.

Reverse Search Specifies using the reverse search method for a Library Manager 
search. A reverse search compares a library entry to an unknown 
compound (whereas a forward search compares the mass spectrum 
of an unknown compound to a mass spectral library entry).

Table 59. Target Screening Settings pane parameters  (Sheet 5 of 5)

Parameter Description
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Understanding the Identification and Confirmation Process

By default, the application uses the mass-to-charge ratio (m/z) for filtering compound peaks. 
In the Identification and Confirmation Settings area, you can select additional criteria to help 
increase confidence using either of the following:

• Compound identification for identifying a sample compound as a minimum requirement 
for a match to be displayed in the results.

To identify a compound, the application searches within the specified RT window (or the 
RT window override if specified in the method) and compares the measured m/z of the 
sample peak against the expected m/z of the target compound. When the sample peak’s 
m/z is within the default ±5 ppm tolerance of the target compound’s m/z, the application 
considers that this target compound is identified.

• Compound confirmation for confirming a sample compound and to increase confidence 
in the match results.

To confirm a compound, the application searches the entire raw data file and compares 
the measured m/z of the sample peak against the expected m/z of the target compound. 
When the sample peak’s m/z is within the tolerance of the target compound’s m/z, the 
application considers that this target compound is confirmed.

The application processes identification and confirmation settings in a specific order. When a 
compound passes identification at each point in the order of processing, the application 
continues to the next automatic or selected identification or confirmation test. 

When a compound fails identification at a point in the processing, the application skips the 
testing of all remaining criteria, even when they are selected, and the flags for those criteria are 
blank.

The application processes identification and confirmation settings in the following order:

1. m/z and Retention Time

The application automatically identifies the mass to charge ratio for all compounds. 
When you select the Retention Time settings, the compound must pass this criteria first. 
When a compound fails the m/z or the Retention Time identification test, the application 
does not perform identification or confirmation testing for any other selected criteria 
lower in the processing order.

For additional information about the m/z and Retention Time parameters, see Mass to 
Charge (m/z) and “Retention Time” on page 281.

2. Threshold

The application automatically identifies the default area threshold (5000) for the 
compound after the compound passes the m/z and Retention Time criteria. When you 
specify a Threshold Override, the application uses the specified threshold value instead.

Note   When you select the Ignore if Not Defined option and the related data is not 
defined in the compound databases, the application skips that criteria test.
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When a compound fails the Threshold identification test, the application does not 
perform the selected Fragment Ions or Library Search testing for identification or 
confirmation.

For additional information about the Threshold parameter, see Threshold.

3. Isotopic Pattern

For additional information about the Isotopic Pattern parameter, see “Isotopic Pattern” 
on page 282.

4. Fragment Ions

For additional information about the Fragment Ions parameter, see “Fragment Ions” on 
page 281.

5. Library Search 

For additional information about the Library Search parameter, see “Library Search” on 
page 283.

Mass to Charge (m/z)

The application automatically uses the m/z and mass tolerance values to identify each 
compound, using the mass tolerance value you specified on the Acquisition page. See “Editing 
the Acquisition Page” on page 261.

The application compares the measured m/z of the sample peak against the expected m/z of 
the target compound. When the measured m/z is within the mass tolerance of the expected 
m/z, the application considers that this target compound is found and the m/z criteria passes.

On the Target Screening page in Data Review, the MZ column in the Compounds table 
indicates whether this criteria passes or fails. The Flag column indicates whether the target 
compound is identified, fully confirmed, or both. For details, see “Compounds Pane” on 
page 569.

The Compounds table also displays the m/z Expected, m/z Measured, and m/z Delta values for 
each compound.

Threshold

To identify each sample compound, the application automatically uses the area and threshold 
values defined in the selected compound database. 

In the Identification and Confirmation Settings pane, you can specify a threshold override to 
use instead of the area threshold defined in the compound database.

The application compares the area of the sample peak against the defined area thresholds. 
When the sample peak’s area is greater than or equal to the corresponding area threshold from 
the compound database or the override area threshold, the target compound is identified.
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On the Target Screening page in Data Review, the Flag column in the Compounds table 
indicates whether this criteria passes or fails. The Flag column indicates whether the target 
compound is identified, fully confirmed, or both. For details, see “Compounds Pane” on 
page 569. 

The Compounds table also displays Measured Area column displays the area value in green to 
indicate that the peak’s area is greater than or equal to the area threshold; otherwise, this 
column displays the area value in red.

Retention Time

The application uses the expected retention time and retention time window values defined in 
the selected compound database to identify or confirm each sample compound. 

In the Identification and Confirmation Settings pane, you can set an override value to use for 
the retention time window instead of using the retention time window that is specified in the 
compound database.

When the compound database defines an expected retention time for a compound, it uses the 
following process to identify or confirm the compound.

• Identify: the application searches within the specified retention time window (or the 
retention time window override) and compares the measured m/z of the sample peak 
against the expected m/z of the target compound. When the measured m/z is within 
the mass tolerance of the expected m/z, this target compound is identified.

• Confirm: the application searches the entire raw data file and compares the measured 
m/z of the sample peak against the expected m/z of the target compound. When the 
measured m/z is within the specified mass tolerance of the expected m/z, the target 
compound is confirmed.

When the compound database does not define an expected retention time for a compound, 
the application cannot identify or confirm the compound. If you select the Ignore if Not 
Defined option, the application does not perform testing for the retention time and the RT 
flag is blank on the Target Screening page in Data Review. 

On the Target Screening page in Data Review, the RT column in the Compounds table 
indicates whether this criteria passes or fails. The RT column indicates whether the target 
compound is identified, fully confirmed, or both. For details, see “Compounds Pane” on 
page 569. The Compounds table also displays the RT Expected, RT Measured, and RT Delta 
values for each compound.

Fragment Ions

To use fragment ions for identification or confirmation, the application requires the following 
conditions:

• The selected compound databases contain the charged mass for each defined fragment 
ion of interest for the compounds in the target list.
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• The HCD (higher energy collision-induced dissociation), source CID (source 
collision-induced dissociation), or AIF (all ions fragmentation) ion spectra exist at a time 
point within the compound’s elution time range.

When no fragment is defined in a compound database for a target compound, the following 
apply:

• When the Ignore if Not Defined option is selected in the method, the application does 
not perform filtering for the Fragment Ions. In the Data Review view, the FI column is 
blank.

• When the Ignore if Not Defined option is not selected in the method, the application 
considers that this target compound is not identified. The Fragment Ions filter fails.

The application uses the number of fragment masses defined in the compound database when 
it processes a sample for fragment ions. The value you specify for Min. # of Fragments cannot 
be greater than the number of fragments defined in the compound database.

For example, if a compound has three fragment ion masses defined in a compound database, 
any of the following scenarios can occur:

• You enter “2” in the Min. # of Fragments box of the method, and the application finds at 
least two out of the three defined fragment ions. The Fragment Ions filter passes.

• You enter “4” in the Min. # of Fragments box of the method, and the application finds 
only the three defined fragment ions. The Fragment Ions filter fails.

• You enter “2” in the Min. # of Fragments box of the method, but the application finds 
only one of the three defined fragment ions. The Fragment Ions filter fails.

The application repeats the following process for each of the fragment ions:

1. When the mass of the parent (plus or minus half of the isolation window value from the 
acquired raw data file) is not within the mass range of the extracted ion chromatogram 
shown in the Chromatogram pane of the Data Review view, the application considers the 
fragment ion as not found and the application fails the Fragment Ions filter; otherwise, 
the application continues.

2. The application inspects the processed fragment ion scan closest to the target compound’s 
expected retention time and locates the MS/MS spectrum closest to the compound’s apex.

Within this spectrum, the application finds the intensity for the tallest fragment whose 
mass is within the mass tolerance of an entered fragment ion mass. When this intensity is 
not found or when it is less than the intensity threshold defined in the method, the 
application determines that the entered fragment ion is not found; otherwise, it 
determines that the fragment ion is found.

Isotopic Pattern

You can choose to either identify or confirm the isotopic patterns for all compounds in a 
batch. The application calculates an isotopic pattern score (as a percentage value), using the 
target compound’s formula. 
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For the isotopic pattern filter, enter the isotopic pattern parameters, including a fit threshold 
value, in the processing method. To identify or confirm the presence of a compound, the 
resulting score from isotopic pattern matching must be higher than the fit threshold. 

To identify or confirm an isotopic pattern, the application must detect the compound for at 
least one of its defined adduct ions. The application identifies the elemental composition to 
match using the formula that is associated with the most intense adduct peak. The application 
then generates an isotopic pattern score (as a percentage value) for the match between the 
measured and expected isotopic patterns of the calculated elemental composition. 

• For profile data, the application calculates the measured isotopic pattern using the average 
of all scans (within the allowed intensity deviation of the spectrum closest to the 
compound’s apex retention time). In the Data Review view, the application displays both 
the expected and measured spectra.

• For centroid data, the application calculates the measured isotopic pattern using the apex 
scan. In the Data Review view, the application displays the expected spectra.

A high isotopic pattern score (approaching 100 percent) occurs when the measured isotope 
patterns, the expected isotope patterns, and the intensities are almost identical using the 
scoring parameters specified in the processing method. When the patterns are not similar, the 
score is closer to 0 percent. When the score is greater than or equal to the specified fit 
threshold and the number of isotopes matched is not 1 out of 1, this filter passes. 

When you view results in the Data Review view, the IP column displays a green or red flag to 
indicate whether the compound passed or failed based on the criteria specified in the method. 

Library Search

For a target screening analysis, you can select the Library Search criterion for either 
identification or confirmation in the processing method. The application identifies or 
confirms the sample compound by searching the selected library and returning the library 
entry with the highest score (as a percentage value) for the fragment ion spectrum in that 
library that matches the compound’s ion spectrum. 

For this criterion, you enter a score threshold value in the processing method. The resulting 
score from a library search match must be higher than your entered threshold value, and the 
library entry must match a compound’s name, a compound’s formula, or both to identify or 
confirm the presence of the compound.

The application uses the following logic to determine when a match is successful:

• When a formula is available in the library entry and the formula matches the target 
compound formula:

– A library score that is higher than or equal to the score threshold meets the criteria.

– A library score that is lower than the score threshold fails to meet the criteria.
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• When a formula is available in the library entry and the name in the library entry matches 
the target compound name but the formula does not match the target compound formula 
(or it is not available):

– A library score that is higher than or equal to the score threshold meets the criteria.

– A library score that is lower than the score threshold fails to meet the criteria.

• When neither the formula nor the library entry name match the target compound, the 
criteria fails and the Lib Match Name, Library Score, and Library Match Rank columns 
display N/A in black text.

• When an MS/MS scan has been performed and both the library entry and the formula 
match the target compound:

– A library score that is higher than or equal to the score threshold meets the criteria. 
The Lib Match Name, Library Score, and Library Match Rank columns display their 
values in green text.

– A library score that is lower than the score threshold fails to meet the criteria. The Lib 
Match Name, Library Score, and Library Match Rank columns display their values in 
red text.

To use a library search for identification or confirmation, the application requires that the data 
meet these conditions:

• The raw data file contains HCD (higher energy collision-induced dissociation), source 
CID (source collision-induced dissociation), or AIF (all ions fragmentation) ion spectra.

• The spectra exist at a time point within the compound’s elution time range.

The application performs either a forward library search or a reverse library search. A forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry, whereas a reverse search compares a library entry to an unknown compound.

When a parent-selected MS/MS spectrum does not exist, the application performs a reverse 
library search because the compound scan contains a mixture of fragments from all co-eluting 
parents. A forward search with such a mixture biases the results toward the strongest parent 
because its fragments would be dominant, and a forward search also takes more time because 
the application must search every spectrum in the library.

When a parent-selected MS/MS spectrum exists, the application performs a forward library 
search because the scan usually contains fragments of only one or two parents, so matching 
this spectrum against the library is faster and more accurate. When you select the Use Reverse 
Library Searching Only check box in the processing method, the application performs only a 
reverse library search.

Note  When the compound is identified, but no MS/MS scan has been performed, 
the Lib Match Name, Library Score, and Library Match Rank columns display N/A 
in red text.
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When you use profile data, the application uses the averaged spectrum of the unknown peak 
as the input spectrum for the library search. This averaged spectrum is based on the average of 
all scans within 10 percent of the spectrum closest to the peak’s apex retention time. When 
you use centroid data, the application uses the apex scan as the input spectrum for the library 
search.

When the application locates a match, it generates a score percentage for the matching library 
entry. This library search can result in multiple matches with different scores.

After searching based on the m/z in the input spectrum, the application performs another 
search for only the matches from the first library search, but this time based on the name, and 
then the formula, of the target compound. If at least one match is found, the application 
displays the highest scoring match from the second search for data review. If no match is 
found from the second search, the application displays the highest scoring match from the 
first search.
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Editing the Peak Detection Page

Use the features on the Peak Detection page to specify any of the following peak detection 
algorithms: Genesis, ICIS, or Avalon.

 To specify peak detection parameters

1. Click Peak Detection in the Method View navigation pane. 

The Peak Detection page for the method opens. 

2. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. For detailed descriptions of the Genesis method parameters, see 
Genesis Detection Method.

• The ICIS peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. For detailed descriptions of the ICIS 
method parameters, see “ICIS Detection Method” on page 290.

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. For detailed descriptions of the Avalon method parameters, see 
“Avalon Detection Method” on page 293.

3. Specify the parameters for the selected detection algorithm. 



 6 Using the Method Development Mode for Target Screening Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 287

Genesis Detection Method

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur 1.0 studies. 

Figure 86. Genesis peak detection

Table 60. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection 
Algorithm

Specifies the Genesis peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.
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Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. The 
ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks with 
signal-to-noise values greater than this value are integrated. 

Valid range: 0.0 through 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect unresolved 
peaks. This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected Width The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if you 
enable valley detection. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley point is 
found outside the expected peak width, the application terminates the 
peak at that point. The application always terminates a peak when the 
signal reaches the baseline, independent of the value set for the 
expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak 
Width

Constrains the peak width of a component during peak integration of 
a chromatogram. You can then set values that control when peak 
integration is turned on and off by specifying a threshold and a tailing 
factor. Selecting the Constrain Peak Width check box activates the 
Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height 
(100%) before integration is turned on or off. This text box is active 
only when you select the Constrain Peak Width check box. 

Valid range: 0.0 through 100.0%

Table 60. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Tailing Factor A factor that controls how the application integrates the tail of a peak. 
This factor is the maximum ratio of the trailing edge to the leading 
side of a constrained peak. This text box is active only when you select 
the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, 
the application defines the right and left edges of the peak when the 
S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). This criteria is 
useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley between 
unresolved peaks to the baseline. The intersection of the vertical line 
and the baseline defines the end of the first peak and the beginning of 
the second peak. 

When the trace exceeds rise percentage, the application applies valley 
detection peak integration criteria. This test is applied to both the left 
and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter 
ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background 
Scans

Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 60. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 87. ICIS peak detection 

Table 61. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1 
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Area Noise Factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5

Peak Noise Factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of 
scans. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Table 61. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Min Peak Width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculate noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 61. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 88. Avalon peak detection 

Table 62. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters. See “Avalon Event List.” 
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 89. Avalon Event List dialog box

Table 63. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types.” 

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 90. Event types

Table 64. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off
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Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters. By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 64. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Editing the Reports Page 

Use the Reports page to specify the reports and report output formats that you want to create 
for the method. See Reports Page.

Follow these procedures:

• To open the Reports page

• To configure the compounds in the reports

• To specify output formats

 To open the Reports page

Click Reports in the Method View navigation pane.

The Reports page for the method opens (see Reports page), displaying only the reports 
that are configured in the Configuration Console. To configure the reports that are 
available, see “Specifying the Reports” on page 71.

 To configure the compounds in the reports

In the Target Screening Report Settings pane, select one of the following options:

• Include All Compounds: Generates reports that include all compounds from the 
screening library, whether or not they are found in the samples.

• Include Only Found Compounds: Generates reports that include only the 
compounds from the screening library that are found in the samples.

 To specify output formats

1. To edit the Report Title, double-click the name and type a new title.

The application uses this title for all reports that use this master method. You cannot edit 
the Report Title from other report views.

2. To specify the type of report output to create for each report (hard copy, PDF, CSV, or 
Excel), select the check box in the appropriate column.

3. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. 

By default, all report types are cleared.
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Reports Page

Use the features on the Reports page to specify the reports and report output formats that you 
want to create with the method.

Figure 91. Reports page 

Table 65. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 
Print Sends reports to the default printer. 
Create PDF Saves reports as PDF files. 
Create CSV Saves reports as CSV files. 
Create Excel Saves reports as Excel files. 
Exists Identifies the report template in the 

C:\TraceFinderData\3.3\Templates\ReportTemplates folder.



 6 Using the Method Development Mode for Target Screening Methods
Saving a Master Method to a New Name

Thermo Scientific TraceFinder User Guide 299

Saving a Master Method to a New Name
You can save any method to a new name, or you can use the current method data to overwrite 
an existing method. The new method contains all the data of the original method.

 To save a method to a new name

1. From the main menu, choose File > Save As.

The Save Master Method As dialog box opens, displaying all quantitation, target 
screening, and unknown screening methods.

2. Do one of the following:

• In the New Method box, type a name for the new method.

The application enables the Save button.

• In the Method column, select a method to overwrite.

The application enables the Overwrite button.

3. Click Save or Overwrite.

The application saves all the method data using the specified name and opens the 
Acquisition page of the new method.

Table 66. Save Master Method As dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.
Type Type of method to display: Quan, Screening, or Unknown 

Only.
Date Changed Date the method was last updated.
Size Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
New Method Name of the new method to create.
Path Path to the selected method in the Methods folder.
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7

Using the Method Development Mode for Unknown 
Screening Methods

This chapter includes method development tasks for creating and editing an unknown 
screening method. (See Method Development navigation pane.) When user security is 
activated, you must have Method Development Unknown Screening Access permission to use 
these features. 

The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for your 
application. 

An unknown screening master method contains a list of compounds and the settings for 
detecting, processing, and reporting those compounds. 

When you create a master method, the application uses the method to determine how the 
application works with a set of samples to provide a set of meaningful results. The application 
uses an instrument method to define how raw data is acquired. The rest of the master method 
defines how the raw data is processed and how the reporting functionality defines the output 
for your data and results. 

The application applies your master method to a batch, which is a list of one or more samples 
to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the data processing and information reporting for batches of 
samples. 

Contents

• Opening a Master Method

• Starting a New Unknown Screening Master Method

• Editing a Master Method
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Figure 92. Method Development navigation pane 

Table 67. Method Development navigation pane commands 

Command Description

Method View Displays the Method View for the master method. 

Acquisition Displays the Acquisition page of the Method View. See “Editing the 
Acquisition Page” on page 307.

Unknown Screening

Processing Displays the Processing page of the Method View. See “Editing the 
Processing Pages” on page 311.

Peak Detection 
Settings

Displays the Peak Detection Settings page of the Method View. See 
“Editing the Peak Detection Settings Page” on page 334.

Reports Displays the Reports page of the Method View. See “Editing the 
Reports Page” on page 345.

Compound Database See “Working with the Compound Database” on page 74.

Instrument View See “Working with Instrument Methods” on page 108.
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Opening a Master Method
Use the TraceFinder application to open an unknown screening master method that was 
created and saved in the current application.

 To open an unknown screening method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

For descriptions of all the features in this navigation pane, see “Starting a New Unknown 
Screening Master Method” on page 305.

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods. See Open 
Master Method dialog box.

3. Select Unknown Only in the Type list.

The method list displays all unknown screening methods.

4. Select an unknown screening master method and click Open.

The Acquisition page for the selected method opens. For detailed descriptions of all the 
features on the Acquisition page, see “Acquisition Page for an Unknown Screening 
Method” on page 309.

Tip  You can also open one of your most recently used master method files. Choose 
Files > Recent Files > Method.
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Figure 93. Open Master Method dialog box

Table 68. Open Master Method dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.

Type Type of method: Quan, Screening, or Unknown Only.

Date Changed Date the method was last updated.

Size Size of the method in megabytes.

Domain TraceFinder domain for which the method was created.

Type Type of method to display: Quan, Screening, Unknown Only, or Any.

Path Path to the selected method in the TraceFinderData\3.3\Methods 
folder.
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Starting a New Unknown Screening Master Method
The following procedure includes the basic parameters you must define to create and save an 
unknown screening master method. For a detailed description of how to modify all 
parameters in a master method, see “Editing a Master Method” on page 307.

 To create a new method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

2. Select the Unknown Screening Method – Only option and click OK.

The Method View for an unknown screening method includes the Acquisition, 
Processing, Peak Detection Settings, and Reports pages. 

The Acquisition page for the method opens.

3. From the Instrument Method list, select an instrument method. 

4. Click Processing in the Method View navigation pane.

The Processing page for the method opens. See Processing page for an unknown 
screening method.

This animation shows how to create a new unknown screening method. To view the 
animation, click , and then right-click and choose Full Screen Multimedia. To stop the 
animation, press ESC.

IMPORTANT   The Unknown Screening Method - Only feature is available only when 
you select the Allow Unknown Screening option in the application configuration 
console. See “Processing Options” on page 62.
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Figure 94. Processing page for an unknown screening method
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Editing a Master Method
You can open an unknown screening master method to specify acquisition instructions and 
the settings for processing, peak detection, and reports.

See the instructions for the following tasks:

• Editing the Acquisition Page

• Editing the Processing Pages

• Editing the Peak Detection Settings Page

• Editing the Reports Page

Editing the Acquisition Page 

The Acquisition page defines basic information used to acquire samples. For detailed 
descriptions of all the features, see “Acquisition Page for an Unknown Screening Method” on 
page 309.

Follow these procedures:

• To open the Acquisition page

• To specify acquisition information for a master method

• To edit an instrument method

 To open the Acquisition page

Click Acquisition in the Method View navigation pane.

The Acquisition page for the method opens. See “Acquisition Page for an Unknown 
Screening Method” on page 309.

 To specify acquisition information for a master method 

1. In the Lab Name box, type the name to be displayed at the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type for the method.

3. From the Injection Volume box, select an injection volume (between 0.1 and 2000 μL) 
that the method uses for sample injection.

Use the Up/Down arrows, , to change the volume in increments/decrements of 1 μL, or 
use the keyboard to enter non-integer injection volumes. 
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4. From the Mass Precision box, select a precision value (between 2 and 6 inclusive) for the 
number of decimal places to use in reports and in peak and spectrum displays. 

 To edit an instrument method

1. From the Instrument Method list on the Acquisition page, select an instrument method. 

2. To edit the selected instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments. (See Thermo Instrument Setup window.)

Figure 95. Thermo Instrument Setup window

3. Edit the values on the instrument page for your instrument.

4. From the main menu in the Thermo Instrument Setup window, 
choose File > Save and then choose File > Exit.

The application returns you to the Acquisition page. See “Acquisition Page for an 
Unknown Screening Method” on page 309.

IMPORTANT  The application uses this injection volume in the master method, not 
the injection volume from the instrument method.
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5. To update any changes that were made to the instrument method after you created this 
master method, click Update.

The Update Instrument Method? dialog box opens.

6. Choose one of the following options:

• Send to System Methods: Overwrites the instrument method in the 
C:\TraceFinderData\3.3\Methods folder with the current instrument method.

• Get from System Method: Overwrites the current instrument method with the 
instrument method in the C:\TraceFinderData\3.3\Methods folder.

• Cancel: Makes no changes to the instrument method in the current master method.

Acquisition Page for an Unknown Screening Method

Use the features on the Acquisition page to define basic information about the method.

Figure 96. Acquisition page for an unknown screening method

Table 69. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name Specifies the laboratory name to be displayed at the top of each 
printed, saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see “Specifying Application 
Defaults” on page 37.
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Assay Type Specifies the name for the analysis type to be targeted by the 
method. The assay type associates the method with the analysis of a 
compound or specific class of compounds (for example, you might 
use an assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).

Injection Volume Specifies the system uses the injection volume (in μL) for sample 
injection. For a more detailed explanation, refer to the 
documentation for the autosampler.

The injection volume in the master method overrides the injection 
volume in the instrument method. The injection volume in the 
batch overrides the injection volume in the master method.

Valid range: 0.1 through 2000 μL
Mass Precision Specifies the number of decimal places used in reports and in peak 

and spectrum displays. 

Valid range: Integers from 2 to 6, inclusive.
Instrument Method Specifies the instrument method used for acquiring samples.
Edit Opens the Thermo Instrument Setup window where you can edit 

the instrument method.
Update Specifies one of the following:

Send to System Methods: Overwrites the system method in the 
C:\TraceFinderData\3.3\Methods folder with the current 
instrument method.

Get from System Methods: Overwrites the current instrument 
method with the system method in the 
C:\TraceFinderData\3.3\Methods folder.

Table 69. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Processing Pages 

The Unknown Screening – Processing pages define basic information about the method. 

 To open the Processing pages

Click Processing in the Method View navigation pane.

The Processing pages include settings for peaks and settings for library, database, element, and 
ChemSpider searches. 

See the following topics:

• Editing the Peak Settings

• Editing the Library Settings

• Editing the Database Settings

• Editing the Element Settings

• Editing the ChemSpider Settings

Editing the Peak Settings

Use the features on the Peak Settings page to define how the method detects and identifies 
peaks.

Follow these procedures:

• To open the Peak Settings page

• To calculate default peak detection values from a raw data file

• To specify the peak detection settings

• To specify the search options

IMPORTANT   After the first processing, you might see an error message stating that the 
total number of results is too large for a single batch (more than 500 000). Return to the 
Processing pages in the method and make one or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.
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 To open the Peak Settings page

Click Processing in the Method View navigation pane.

By default, the Peak Settings page opens. See “Peak Settings Page” on page 314 or “Peak 
Settings page parameters” on page 315.

 To calculate default peak detection values from a raw data file

For the Autocalc Defaults from Rawfiles box, click  and select a raw data file.

The application populates the parameters in the Peak Detection Settings area with the 
values from the raw data file. (To reset the default values in the method, click .)

 To specify the peak detection settings

1. In the Absolute MS Signal Threshold box, type the number of counts for the application 
to detect an ion.

The application calculates the MS signal threshold (noise level) from the raw data file and 
sets this value to reflect a signal-to-noise level of 20.

Valid range: This value depends on the instrument. The minimum value is 0, and the 
maximum value is never larger than the maximum intensity component in the sample.
Default: Calculated from the raw data file

2. In the Min Peak Width box, type a value for the minimum acceptable peak width for the 
chromatographic peak.

3. In the Max Peak Width box, type a value for the maximum acceptable peak width for the 
chromatographic peak. 

4. In the RT Shift box, type a value for the maximum allowable peak alignment correction 
for the chromatographic peak.

The application applies this value only when you enable batch processing. 

5. In the RT Window box, type a value for the maximum viewable window around the 
identified chromatographic peak.

6. To create one peak list for the batch regardless of threshold settings, select the Alignment 
and Gap Filling check box.

The application processes the batch as a group instead of as individual samples. When the 
application finds a peak in one sample but not in another, this option adds the missing 
peak to all sample lists and displays N/A or the found peak information in the results. 
This option is similar to the Show All Compounds option in a quantitation or a target 
screening method. The application displays the results for the batch in a color-coded heat 
map grid. See “Heat Map Pane” on page 645.
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When you clear this option, the application creates a unique peak list for each sample 
based on the method peak settings, similar to clearing the Show All Compounds option 
in a target screening method.

 To specify the search options

1. In the Search Types area, select the check box for the type of search that you want to 
perform:

• Database Search

• Library Search 

• Elemental Composition

• ChemSpider Search

You can select as many search types as you want.

2. To perform the search only on the sample that has the highest peak response in the batch, 
select the Highest Point Analysis check box.

When you select this option, the application performs the search only on the sample in 
the batch that has the highest peak response.

When you clear this option, the application uses all search criteria on a per-peak basis.

For example, in a batch with samples 1, 2, and 3 with responses of 10, 1000, and 50, 
respectively, the application performs the search only on the peak from sample 2 with the 
greatest peak response. Because the mass and retention time for the peak are the same in 
each sample, the application identifies the same chemical. When you use this option with 
the Top Peaks option, the application uses the responses across the batch to filter the 
results and treats the entire batch of sample data as it would when returning the top n 
responses for a single sample.

3. Select one of the following options:

• Simple Search: When the application identifies a peak by one of the identification 
points, it lists only that compound name in Data Review.

• Exhaustive Search: The application lists all identified peaks from each search 
criterion and displays them as hierarchical entries under the top hit in Data Review.

4. To specify the number of matching peaks to display for each search type, enter a value for 
Number of Top Matches.

IMPORTANT   To perform alignment, each sample in the batch must include the 
same scan filters used by the first sample. Samples 2-n can have additional filters as 
long as they also include all filters specified in the first sample.
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Peak Settings Page

Use the features on the Peak Settings page to define how the method detects and identifies 
peaks.

Figure 97. Peak Settings page
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Table 70.  Peak Settings page parameters  (Sheet 1 of 3)

Command Description

Peak Detection Settings

Autocalc Defaults from 
Rawfiles

Populates the parameters in the Peak Detection Settings area with the values from the 
selected raw data file.

Absolute MS Signal 
Threshold

Specifies the number of counts that the application uses to detect an ion.The application 
calculates the MS signal threshold (noise level) from the raw data file and sets this value 
to reflect a signal-to-noise level of 20.

Valid range: This value depends on the instrument. The minimum value is 0, and the 
maximum value is never larger than the maximum intensity component in the sample.

Default: Calculated from the raw data file

Min Peak Width Specifies the minimum allowable peak width for chromatographic peak detection.

Default: 0.50

Max Peak Width Specifies the maximum allowable peak width for chromatographic peak detection.

Default: 1.00

RT Shift (minutes) Specifies the maximum allowable peak alignment for chromatographic peak detection.

Default: 1.0

RT Window (seconds) Specifies the maximum viewable window around the identified chromatographic peak.

Default: 30.00

Use RT Limits Specifies a lower and upper limit for searches. 

Valid range: 0.00 through 999.99 minutes
Default: 0.00 minutes for lower limit; 999.00 minutes for upper limit

Mass Tolerance Specifies the number of millimass units or parts per million to use as the m/z ± tolerance 
value.

Valid range: 0 through 500 
Default: 5.00
Unit: mmu or ppm

Note  When using ion trap data, the application uses 300 mmu regardless of the value 
you enter here.
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Alignment and Gap Filling Specifies that the application create a single peak list for the whole batch whether or not 
a peak was found in a raw data file. 

Note   To perform alignment, each sample in the batch must include the same scan 
filters used by the first sample. Samples 2-n can have additional filters as long as they 
also include all filters specified in the first sample.

When you clear this option, each data file has its own unique peak list based on the 
unknown peak settings.

All Peaks / Top Peaks Specifies that the application display results for the top n peaks or for all peaks.

(number of ) Top Peaks Specifies the maximum number of peaks to identify. Available only when you select the 
previous Top Peaks option. 

Default: 50

Search Options

Search Types Database Search: To specify the unknown database search parameters, see “Editing the 
Database Settings” on page 323.

Library Search: To specify the unknown library search parameters, see “Editing the 
Element Settings” on page 327.

Elemental Composition: To specify the unknown elemental search parameters, see 
“Editing the Element Settings” on page 327.

ChemSpider Search: To specify the ChemSpider search parameters, see “Editing the 
ChemSpider Settings” on page 331.

Highest Point Analysis Specifies that the application perform the search only on the sample that has the highest 
peak response of all samples in the batch, working in conjunction with the Alignment 
and Gap Filling option. 

For example, in a batch with samples 1, 2, and 3 with responses of 10, 1000, and 50, 
respectively, the application performs the search only on the peak from sample 2 with 
the greatest peak response. Because the mass and retention time for the peak are the same 
in each sample, the application identifies the same chemical. When you use this option 
with the Top Peaks option, the application uses the responses across the batch to filter 
the results and treats the entire batch of sample data as it would when returning the top 
n responses for a single sample.

When you clear this option, the application uses single-sample logic.

Table 70.  Peak Settings page parameters  (Sheet 2 of 3)

Command Description
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Editing the Library Settings

Use the Library Settings page to specify the settings for library searches. The application uses 
these settings only when you select the Library Search option as a search type. See “To specify 
the compound databases to use” on page 324.

To find the identity of an unknown compound, the application searches the MS/MS 
spectrum against a mass spectral library using the library search parameters specified in the 
method. The application displays the results in Data Review. The application uses the 
MS/MS scan closest to the apex of the detected peak or from the associated data-dependent 
scan for the extracted mass chromatogram and submits it for a library search.

When the application finds a library match and the formula is present in the library record, 
the application reports the formula in Data Review.

When the application does not find a library match, or when the match does not have an 
associated formula, the application does the following:

• Performs a reverse search of the mass spectrum against the library.

• Returns the top n hits, where n is the value of the Number of Top Matches parameter.

• Displays each match as a separate row in Data Review.

• Shows the score for each match in Data Review (except matches with a score of zero).

Follow these procedures:

• To open the Library Settings page

• To specify the libraries to use

• To specify the general library settings

• To specify the NIST settings

• To specify the Library Manager settings

Exhaustive Search / Simple 
Search

Simple Search (Default): When the application identifies a peak by one of the 
identification points, it lists only that compound name in Data Review.

Exhaustive Search: The application lists all identified peaks from each search criterion 
and displays them as hierarchical entries under the top hit entry in Data Review.

Number of Top Matches Specifies the maximum number of matches returned from a library search that you want 
to display in the Cross Sample Peak List in Data Review and in reports.

Valid range: 1 through 99
Default: 3

Table 70.  Peak Settings page parameters  (Sheet 3 of 3)

Command Description
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 To open the Library Settings page

Click the Library Settings tab.

The Library Settings page opens. See “Library Settings Page” on page 320 or “Library 
Settings page parameters” on page 321.

 To specify the libraries to use

In the Library Selection area, select the Enabled check box for each library that you want 
to use for unknown screening searches.

The Database Name list displays the libraries located in the following folders:

C:\Program Files (x86)\NISTMS\MSSEARCH

C:\TraceFinderData\New Libraries

 To specify the general library settings

1. To specify the source for the confirming peaks, select one of the following:

• MS: Confirming peaks come from the same scan.

• MS2: Confirming peaks are fragments from an adjacent scan.

• MS–In Source CID: Confirming peaks come from the Source CID.

2. (Optional only when you select MS2) To use the isolation width when no precursor 
match is found, select the Use Isolation Width check box.

The application uses the isolation width to determine if there is an MS/MS scan within 
the same peak RT window that includes the precursor fragments.

 To specify the NIST settings

1. To specify the type of search to perform, select one of the following:

• Normal: Uses a more extensive set of presearch screenings—a total of four different 
criteria.

When you select this option, skip to step 6.

• MS/MS: Searches for an MS/MS spectrum in a library of MS/MS spectra.

• In-source HiRes: Searches for an in-source/EI with an accurate ion m/z or an 
MS/MS spectrum in a library that contains in-source/EI accurate ion m/z or MS/MS 
spectra.

2. Select a value for Precursor Tolerance, and then select the units of measure.

3. Select a value for Product Tolerance, and then select the units of measure.
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4. To ignore mass spectral peaks within the specified precursor tolerance range, select the 
Ignore Precursor check box.

5. To use alternate peak matching, select the Use Alt Peak Matching check box.

6. To specify that the application use the reverse search method, select the Reverse Search 
check box. 

A reverse search compares a library entry to an unknown compound (whereas a forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry).

7. For libraries created before 2014, set the Presearch option to Off.

8. Select a threshold value for SI Threshold.

The application uses this lower threshold value for the search index method used to search 
the NIST library. The application does not return results below this value.

9. Select a threshold value for RSI Threshold.

The application uses this lower threshold value for the reverse search index method used 
to search the NIST library. The application does not return results below this value.

10. Select a threshold value for Probability Threshold.

The application uses this lower threshold value for the match probability.

 To specify the Library Manager settings

1. Select a value for Spectrum Tolerance.

2. Select the units of measure for spectrum tolerance.

3. Select a threshold value for Score Threshold.

The application uses this lower threshold value for the Library Score in Data Review. The 
application does not return results below this value. See “Peak Identifications Pane” on 
page 652.

4. To ignore mass spectral peaks within the specified precursor tolerance range, select the 
Ignore Precursor check box.

5. To specify that the application use the reverse search method, select the Reverse Search 
check box. 

A reverse search compares a library entry to an unknown compound (whereas a forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry).

Note  This option is available only when you select MS/MS as the NIST search type.

Note  This option is available only when you select MS/MS as the NIST search type.
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Library Settings Page

Use the Library Settings page to specify the parameters for library searches. The application 
uses these settings only when you select the Library Search option as a search type.

Figure 98. Library Settings page
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Table 71.  Library Settings page parameters  (Sheet 1 of 2)

Parameter Description

Library Selection

Enabled The databases for unknown screening searches.
Library Name Specifies all libraries that you configured in the Configuration 

Console. See “Screening Libraries” on page 59.
Library Type Specifies the library type as either NIST or LibraryManager.
General Library Settings

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come 
from the Source CID (MS–In Source CID). 

Use Isolation Width Specifies that the application use the isolation width to 
determine if there is an MS/MS scan within the same peak RT 
window that includes the precursor fragments. Available only 
when you set the MS Order to MS2.

NIST Settings

Search Type Normal: Uses a more extensive set of presearch screenings—a 
total of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of 
MS/MS spectra.

In-source HiRes: Searches for an in-source/EI with an 
accurate ion m/z or an MS/MS spectrum in a library that 
contains in-source/EI accurate ion m/z or MS/MS spectra.

Precursor Tolerance Specifies the precursor m/z tolerance range as either amu or 
ppm.

Valid range: 0.015 through 100 000
Default: 1.60
Available only when you select MS/MS or In-source HiRes 
search types.

Product Tolerance Specifies the mass spectral peak tolerance range as either amu 
or ppm.

Valid range: 0.015 through 100 000
Default: 1.60
Available only when you select MS/MS or In-source HiRes 
search types.

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.
Available only when you select MS/MS or In-source HiRes 
search types.
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Use Alt Peak Matching Specifies that the application use an alternate peak matching 
method for searching the mass spectra.
Available only when you select MS/MS or In-source HiRes 
search types.

Reverse Search Specifies that the NIST library search use the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Presearch Specifies that the application use presearch screening before 
calculating the spectrum-by-spectrum match factor.

SI Threshold Specifies the lower threshold value for the search index method 
used to search the NIST library. The application does not 
return results below this value.

Valid range: 0 through 999
Default: 250

RSI Threshold Specifies the lower threshold value for the reverse search index 
method used to search the NIST library. The application does 
not return results below this value.

Valid range: 0 through 999
Default: 250

Probability Threshold Threshold value for the match probability.
Library Manager Settings

Spectrum Tolerance Specifies the spectrum tolerance as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Score Threshold Specifies that the application does not return results below this 
value.

Valid range: 0 through 100
Default: 80.00

Ignore Precursor Specifies that the application ignore mass spectral peaks within 
the specified precursor tolerance range.

Reverse Search Specifies using the reverse search method for a Library 
Manager search. A reverse search compares a library entry to 
an unknown compound (whereas a forward search compares 
the mass spectrum of an unknown compound to a mass 
spectral library entry).

Table 71.  Library Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Database Settings

Use the Database Settings page to specify the compound databases and the settings for 
database searches. The application uses these settings only when you select the Database 
Search option as a search type. See “To specify the compound databases to use” on page 324. 
The application compares the specified compound databases with found peaks from the mass 
analyzer peak detector. 

When a found peak is within the mass range of a compound in a specified database, the 
application scores it as a match and adds the labeled peak result to the Data Review results 
grid for unknown screening analysis.

If the application finds a conflict of information, then the application uses the next level of 
identification to compare the fragments of any associated data-dependent scan. The 
application chooses the peak with the most matching fragments as the name of the peak.

If there are no fragments available, then the application labels the compound database entry 
with the mass that is closest to the mass of the extracted mass analyzer peak.

Follow these procedures:

• To open the Database Settings page

• To specify the database matching settings

• To specify the fragments settings

• To specify the isotopes settings

• To specify the compound databases to use

 To open the Database Settings page

Click the Database Settings tab.

The Database Settings page opens. See “Database Settings Page” on page 325.

 To specify the database matching settings

1. In the CDB RT Window box, type a value (in seconds) for the database retention time 
window.

2. Specify the number of millimass units or parts per million for the m/z ± tolerance value.

3. Select the units of measure for mass tolerance.

The application applies this mass tolerance to the extracted chromatograms.

 To specify the fragments settings

1. In the Intensity Threshold box, type a value for the minimum intensity value for 
fragments. 

Fragments with intensity values less than this value are ignored.

2. Specify the number of millimass units or parts per million to use as the m/z ± tolerance 
value for fragments.
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3. Select the units of measure that you want to use for mass tolerance for fragments. 

The application applies this mass tolerance to the fragment chromatograms.

4. To specify the source for the fragment peaks, select one of the following:

• MS: Fragment peaks come from the same scan.

• MS2: Fragment peaks are fragments from an adjacent scan.

• MS–In Source CID: Fragment peaks come from the Source CID. 

 To specify the isotopes settings

1. In the Allowed Mass Deviation box, type a value (in parts per million) to specify the 
allowed mass deviation in the spectrum data.

The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this deviation amount away from its expected m/z. For best results, set this value 
to a number that causes up to 98 percent of all mass deviations to be smaller than the 
allowed mass deviation value. 

2. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity 
relative to the monoisotopic ion’s intensity is more than this deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.

3. To specify that isotopic pattern calculations use internal mass calibration, select the Use 
Internal Mass Calibration check box. 

Otherwise, to use external mass calibration, clear the check box.

When selected, the application applies a requirement that an isotope’s m/z must be closer 
to its theoretical value to avoid a score penalty.

For more information, see “Isotopic Pattern Score Calculations” on page 725.

 To specify the compound databases to use

1. Select the Selected check box for each compound database that you want to use for the 
database search.

2. (Optional) To edit a database, click open and do the following:

a. Edit the database. 

See “Editing Compounds in the Database” on page 84.

b. When you finish editing the database, click Processing in the Method View 
navigation pane to return to the Processing page.
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Database Settings Page

Use the Database Settings page to specify the compound databases and settings for database 
searches. The application uses these settings only when you select the Database Search option 
as a search type.

Figure 99. Database Settings page

Table 72.  Database Settings page parameters  (Sheet 1 of 2)

Parameter Description

CDB Matching

CDB RT 
Window 
(seconds)

Specifies the database retention time window in seconds.

Default: 30.00

Mass Tolerance Specifies the number of millimass units or parts per million to use as the m/z ± tolerance value for 
CDB matching and for calculating isotopic patterns.

Default: 5.00
Valid range: 0.1 through 999
Unit: mmu or ppm

• mmu (millimass units): mmu is a static calculation to the extracted mass.
• (Default) ppm (parts per million): ppm is a variable calculation dependent on the actual

mass. The smaller the mass, the narrower the tolerance range. The larger the mass, the wider
the tolerance range.

IMPORTANT  If you set this mass tolerance value greater than the value for Allowed 
Mass Deviation, the application might not be able to generate the isotopic patterns.
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Fragments

Intensity 
Threshold

Fragments with intensity values less than this are ignored.

Default: 10 000
Mass Tolerance Specifies the number of millimass units or parts per million to use as the m/z ± tolerance value for 

calculating fragments.

Default: 5.00
Valid range: 0.1 through 999
Unit: mmu or ppm

• mmu (millimass units): mmu is a static calculation to the extracted mass.
• (Default) ppm (parts per million): ppm is a variable calculation dependent on the actual

mass. The smaller the mass, the narrower the tolerance range. The larger the mass, the wider
the tolerance range.

MS Order Specifies that the confirming peaks come from the same scan (MS), are fragments from an 
adjacent scan (MS2), or come from the Source CID (MS–In Source CID). 

Isotopes

Allowed Mass 
Deviation

Specifies the allowed mass deviation in the spectrum data.

Valid range: 3 through 100 ppm
Default: 5 ppm

IMPORTANT  If you set this mass deviation value less than the value for Mass Tolerance, the 
application might not be able to generate the isotopic patterns.

Allowed Intensity 
Deviation

Specifies the allowed intensity deviation of the mass spectrometer relative to the monoisotopic 
ion, as a percentage of the base peak height.

Valid range: 1 through 100%
Default: 10%

Use Internal Mass 
Calibration

Specifies that isotopic pattern calculations use internal mass calibration.

Database List

Selected Specifies that the application use the compound database for a database search.
Database Name Specifies the name of the database.
Refresh Updates the database list.
Open Opens the compound database in the Method Development mode. 

Table 72.  Database Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Element Settings

Use the Element Settings page to specify settings to use for elemental composition searches. 
The application uses these settings only when you select the Elemental Composition option as 
a search type. See “To specify the compound databases to use” on page 324.

Follow these procedures:

• To open the Element Settings page

• To specify the scoring settings

• To specify the elemental composition settings

• To select elements to use in the elemental formula

 To open the Element Settings page

Click the Element Settings tab.

The Element Settings page opens. See “Element Settings Page” on page 330.

 To specify the scoring settings

1. In the Allowed Mass Deviation box, type a value (in parts per million) to specify the 
allowed mass deviation in the spectrum data.

The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this deviation amount away from its expected m/z. For best results, set this value 
to a number that causes up to 98 percent of all mass deviations to be smaller than the 
allowed mass deviation value. 

2. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity 
relative to the monoisotopic ion’s intensity is more than this deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.

3. To specify that isotopic pattern calculations use internal mass calibration, select the Use 
Internal Mass Calibration check box. 

Otherwise, to use external mass calibration, clear the check box.

When using internal mass calibration, the application applies a requirement that an 
isotope’s m/z must be closer to its theoretical value to avoid a score penalty.

For more information, see “Isotopic Pattern Score Calculations” on page 725. 
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 To specify the elemental composition settings 

1. From the Electron Rule list, select one of the following rules to use in the formula 
calculation: Do Not Use, Even Electrons, or Odd Electrons.

2. In the RDB Equiv Low and the RDB Equiv High boxes, type values for double bonds 
and ring equivalents—a measure of the number of unsaturated bonds in a 
compound—to limit the calculated formulas to only those that make sense.

The RDB Equiv Low value must be smaller than the RDB Equiv High value. 

 To select elements to use in the elemental formula 

1. Click View Elements.

The Elements In Use dialog box opens. By default, all elements are selected for use.

Figure 100. Element in Use dialog box 

2. To activate an element in the list, select the corresponding Use check box.

3. To deactivate an element in the list, clear the corresponding Use check box.

4. To add an element to the list, do the following:

a. Click Add.

The Periodic Table of Elements opens. See Periodic Table of Elements.

Figure 101. Periodic Table of Elements
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b. Select an element and click Apply. 

The periodic table closes, and the application adds the selected element to the 
Elements In Use dialog box.

The values in the Element column and the Nominal Mass column are read-only. You 
can edit the values in the Minimum, Maximum, and Relative columns.

5. In the Relative column, do one of the following:

• To specify the maximum or minimum value as an absolute number of atoms, clear 
the check box. 

• To specify the maximum or minimum value as a relative percentage by weight, select 
the check box.

Default: Selected for H, C, and O; cleared for all other elements

6. In the Minimum and Maximum columns, specify a minimum value and a maximum 
value to define the calculated element.

You can type each of these values as either an absolute number of atoms (0 through 1000) 
or as a relative percentage by weight (0 through 100%), depending on the setting in the 
Relative column.

The value you enter for the Minimum column must be smaller than the value for the 
Maximum column.

7. To remove elements from use in the elemental formula, do the following:

a. Select the element row by clicking in the row selector area marked by the arrow icon.

b. Right-click and choose Delete Row from the shortcut menu (or press the DELETE 
key).

c. Click Yes in the confirmation dialog box to remove the selected rows from the table.

Tip  If the element you select displays several isotopes, for best results, select the 
most abundant one before you click Apply.

IMPORTANT  Add candidates only for the neutral molecule, not for adducts.

Click here to select the row, right-click, 
and select Delete Row.



7 Using the Method Development Mode for Unknown Screening Methods
Editing a Master Method

330 TraceFinder User Guide Thermo Scientific

Element Settings Page

Use the Element Settings page to specify settings to use for elemental composition searches.

Figure 102. Element Settings page

Tip  To select noncontiguous rows, hold down the CTRL key when you select them. 
To select contiguous rows, select the first row in the group, hold down the SHIFT key, 
and then select the last row in the group. Or, drag your pointer across the group of 
rows.

Tip   You can also deactivate an element from use in the elemental formula without 
removing it from the table by clearing the element’s Use check box.

Table 73.  Element Settings page parameters  (Sheet 1 of 2)

Parameter Description

Scoring Settings

Allowed Mass 
Deviation (ppm)

Specifies the allowed mass deviation in the spectrum data.

Valid range: 3 through 100 ppm
Default: 5 ppm

Allowed Intensity 
Deviation (%)

Specifies the allowed intensity deviation of the mass spectrometer 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

Valid range: 1 through 100%
Default: 10%

Use Internal Mass 
Calibration

Specifies that isotopic pattern calculations use internal mass 
calibration.
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Editing the ChemSpider Settings

Use the ChemSpider Settings page to specify settings to use for ChemSpider searches. The 
application uses these settings only when you select the ChemSpider Search option as a search 
type. See “To specify the compound databases to use” on page 324.

ChemSpider is an online search engine that provides access to millions of chemical structures 
in databases. The ChemSpider search engine aggregates and indexes chemical structures and 
their associated information into a single, searchable repository. 

The application sends suggested elemental compositions to the ChemSpider search engine 
and retrieves compound names that match the searched elemental compositions. The 
application uses the active databases that you select and ranks the results according to the 
number of databases that return found references for each matched compound. The higher 
the number of databases with found references, the higher the ranking for that match. To 
speed processing, the application stores the results in a local cache. The cache maintains the 
age of each result from the time that the entry is saved. During a search, the application 
deletes any cached entry older than the time period specified in the Cached Entries Expire 
After list and replaces it with newer information.

Elemental Composition

Electron Rule Specifies whether to use a rule in the formula calculation.

Valid values: Do Not Use, Even Electrons, Odd Electrons
Default: Even Electrons

RDB Equiv Low Specifies the lower limit value for double bonds and ring 
equivalents—a measure of the number of unsaturated bonds in a 
compound—to limit the calculated formulas to only those that 
make sense. The RDB Equiv Low value must be smaller than the 
RDB Equiv High value.

Valid range: –1.5 through 99.9
Default: –1.5

RDB Equiv High Specifies the upper limit value for double bonds and ring 
equivalents—a measure of the number of unsaturated bonds in a 
compound—to limit the calculated formulas to only those that 
make sense.

Valid range: 0 through 100
Default: 100.00

View Elements Opens the Elements in Use dialog box where you can specify the 
elements to use in the elemental formula.

Table 73.  Element Settings page parameters  (Sheet 2 of 2)

Parameter Description

IMPORTANT  You must have an Internet connection to access the ChemSpider databases.
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Each time you update the list of active databases, the application clears the entire cache and 
starts over with new information from the next search. Unknown screening searches that use 
the ChemSpider search engine might take longer until the application populates the cache 
with results again. When you change the list of active databases, the ranking of the results 
might also change accordingly.

Follow these procedures:

• To open the ChemSpider Settings page

• To update the list of available databases

• To make databases active

• To specify an expiration time for cached entries

 To open the ChemSpider Settings page

Click the ChemSpider Settings tab.

The ChemSpider Settings page opens. See ChemSpider Settings Page.

 To update the list of available databases

Click Refresh.

The application updates the list of available databases with the most current list from the 
ChemSpider website.

 To make databases active

1. From the Available Databases list, select the ChemSpider databases that you want to 
search.

2. Click  to move the selected databases to the Active Databases list.

The application searches all active ChemSpider databases for matching compound 
formulas.

IMPORTANT  Each time you access the ChemSpider Settings page, the application 
automatically compares the list of available databases with the most current list from 
the ChemSpider website. The Refresh button becomes available only when there is a 
difference between the two lists.

Note  Use the CTRL or SHIFT keys to select multiple databases.

IMPORTANT  Whenever you change the list of active databases, the application 
deletes all previous results stored in the cache and starts over with new information 
from the next search. This might increase the time required to complete the search.

IMPORTANT  If a database in the Active Databases box is no longer available on the 
website, the application automatically removes that database name.
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 To specify an expiration time for cached entries

Select one of the following time periods from the Cached Entries Expire After list:

• ThreeMonths

• SixMonths

• OneYear

• Never

During a search, the application deletes any cached entry older than this value and 
replaces it with newer information.

ChemSpider Settings Page

Use the ChemSpider Settings page to specify settings to use for ChemSpider searches.

Figure 103. ChemSpider Settings page

Table 74. ChemSpider Settings page parameters 

Parameter Description

Available Databases Lists the most current databases from the ChemSpider website.
Refresh Updates the list of available databases with the most current list from 

the ChemSpider website.
Cached Entries 
Expire After

During a search, the application deletes any cached entry older than 
the specified value and replaces it with newer information.

Active Databases Lists the ChemSpider databases that you can search.
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Editing the Peak Detection Settings Page

Use the features on the Peak Detection page to specify any of the following peak detection 
algorithms: Genesis, ICIS, or Avalon.

 To specify peak detection parameters

1. Click Peak Detection in the Method View navigation pane. 

2. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. For detailed descriptions of the Genesis method parameters, see 
Genesis Detection Method.

• The ICIS peak detection algorithm is designed for MS data and has highly efficient 
peak detection at low MS signal levels. For detailed descriptions of the ICIS method 
parameters, see “ICIS Detection Method” on page 338.

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. For detailed descriptions of the Avalon method parameters, see 
“Avalon Detection Method” on page 341.

3. Specify the parameters for the selected detection algorithm. 
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Genesis Detection Method

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur 1.0 studies. 

Figure 104. Genesis peak detection

Table 75. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the Genesis peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1
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S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks 
with signal-to-noise values greater than this value are integrated. 

Valid range: 0.0 through 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if 
valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the application 
terminates the peak at that point. The application always 
terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
threshold and a tailing factor. Selecting the Constrain Peak Width 
check box activates the Peak Height (%) and Tailing Factor 
options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Table 75. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the application defines the right and left edges of the peak 
when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). This 
criteria is useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the application applies 
valley detection peak integration criteria. This test is applied to 
both the left and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 75. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method

The ICIS peak detection algorithm is designed for MS data and has highly efficient peak 
detection at low MS signal levels. 

Figure 105. ICIS peak detection 

Table 76. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.\

Valid values: Any odd integer from 1 through 15 points
Default: 1 
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Area Noise Factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5

Peak Noise Factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of 
scans. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Table 76. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Min Peak Width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculate noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 76. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 106. Avalon peak detection 

Table 77. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters. See “Avalon Event List.” 
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 107. Avalon Event List dialog box

Table 78. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types.” 

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 108. Event types

Table 79. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap. 

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off
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Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters. By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 79. Event type descriptions  (Sheet 2 of 2)

Event type Description



 7 Using the Method Development Mode for Unknown Screening Methods
Editing a Master Method

Thermo Scientific TraceFinder User Guide 345

Editing the Reports Page

Use the Reports page to specify how you want to save or print your reports. For descriptions 
of the features on the Reports page, see Reports Page.

See the instructions for the following tasks:

• Specifying Report Formats

• Specifying Report Options

Specifying Report Formats

For each report type, you can create a hard-copy printout, a PDF file, a CSV file, or an Excel 
file. 

 To open the Reports page

Click Reports in the Method View navigation pane.
 

The Reports page opens with a list of all configured reports.

To configure which reports are available when you create a master method or which 
reports create a batch-level report, see “Specifying the Reports” on page 71. 

 To specify reports and output formats

1. To specify the type of report output to create for each report, select the check box in the 
appropriate column.

2. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available. By default, all report type options are cleared. 
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Reports Page

Use the features on the Reports page to specify how you want to save or print your reports. 

Figure 109. Reports page

Specifying Report Options 

Use the options on the Report Options page to choose the compounds to display in reports.

Figure 110. Reports Options page

Table 80. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 

Print Sends reports to the default printer. 

Create PDF Saves reports as PDF files. 

Create CSV Saves reports as CSV files. 

Create Excel Saves reports as Excel files. 

Exists Indicates that the report template is identified in the 
C:\TraceFinderData\3.3\Templates\ReportTemplates folder.

Table 81. Report Options page parameters 

Parameter Description

Include All 
Compounds

Generates reports that include all compounds results, whether or 
not they are found in the samples.

Include Only Found 
Compounds

Generates reports that include only the compounds that are found 
in the samples.
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8

Using the Acquisition Mode 

This chapter describes the tasks associated with the Acquisition mode.

When you plan to work with multiple samples or use similarly designed batches, use the 
Acquisition mode to reduce the amount of data you must enter. 

Because the nature and types of batches are often similar (in some cases specified by laboratory 
standard practices), you can define a batch template that supplies the basic structure of a 
batch. 

Using a master method, you can create a batch and run the samples. A batch represents one or 
more samples that are to be acquired, processed, reviewed, and reported as a set. After you 
create a batch of samples, you can submit the batch and review the results in Data Review or 
you can go directly to viewing and printing reports. 

You can set up a calibration batch with known concentrations of the target compounds and 
compare the calibration values against samples in future batches. 

You can also use the Quick Acquisition feature to quickly submit a single sample from any 
page in the Acquisition mode. See Appendix A, “Using Quick Acquisition.” 

Contents 

• Working with Batches

• Real Time Status Pane

• Sample Types

IMPORTANT  When user security is activated, you must have Acquisition Wizard – 
Template Editing permission to create a batch template.
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Working with Batches 
See the instructions for the following tasks:

• Opening and Navigating the Acquisition Mode

• Creating and Submitting Batches

Opening and Navigating the Acquisition Mode

 To access the Acquisition mode

Click Acquisition in the navigation pane.

The navigation pane for the Acquisition mode opens. 

As you progress through the Acquisition mode using any of these methods for creating a 
batch, the task pane at the top of the view tracks your progress. As you complete each 
stage, you can hold your cursor over the view name in the task pane to display the 
parameters that you specified for the batch. See Example task pane when you have 
completed the Acquisition mode. 
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Figure 111. Example task pane when you have completed the Acquisition mode

Categories in the Sample Definition list:

QC Samples: QC Std

Calibration Samples: Cal Std

Blank Samples: Matrix Blank

Unknown Samples: All other samples

Hold your cursor over Batch Selection, Sample Definition, 
or Report Selection to view the parameters for your batch.
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Creating and Submitting Batches

To create and submit a batch, the Acquisition mode uses a wizard-style interface to guide you 
through these major steps:

1. Selecting a Batch

2. Defining a Sample List

3. Selecting and Reviewing Reports

4. Submitting a Batch

The Acquisition mode provides multiple techniques for creating either a batch or a batch 
template. Each batch creation technique has an associated workflow, as shown in the 
following flowcharts. Each workflow uses a different combination of Acquisition mode pages.

Workflow for Creating an Original Batch

To create an original batch, start with any of these instructions: “To start a new quantitation 
batch” on page 352, or “To start a new target screening batch” on page 353, or “To start a new 
unknown screening batch” on page 354.

Workflow for Acquiring a Prepared Batch

To acquire a prepared batch, start with the instructions “To select a prepared batch” on 
page 355.

Batch and
Method

Finish

Reports

Samples

Batch

Finish Samples
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Workflow for Reinjecting a Previously Acquired Batch

To process a previously acquired batch, start with the instructions “To reinject samples in a 
previously acquired batch” on page 356.

Workflow for Creating or Editing a Batch Template

To create a batch template, start with any of these instructions: “To create a quantitation 
batch template” on page 357, “To create a target screening batch template” on page 358, or 
“To create an unknown screening batch template” on page 359. 

IMPORTANT  When user security is activated, you must have Acquisition Wizard – 
Template Editing permission to create a batch template.

Batch

Finish

Samples

Finish

Samples

Template and
Method
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Selecting a Batch 

On the Batch Selection page of the Acquisition mode, you can create a new quantitative, 
target screening, or unknown screening batch in any of your current projects/subprojects. Or, 
you can submit a batch that you previously prepared and saved, reinject the samples in a batch 
that you previously acquired, or create a batch template to use for future batches.

Follow these procedures:

• To start a new quantitation batch

• To start a new target screening batch

• To start a new unknown screening batch

• To start a new batch from a template

• To select a prepared batch

• To reinject samples in a previously acquired batch

• To create a quantitation batch template

• To create a target screening batch template

• To create an unknown screening batch template

 To start a new quantitation batch

1. Click Create a New Batch in the navigation pane.

2. Select the Quantitation option.

3. Select the batch folder where you want to create the new batch.

4. Type a unique name for the new batch in the Batch Name box.

If the name you enter is not unique, a red warning flashes.

5. Select a method from the Method Selection list.
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The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

6. To continue to the next page, click Next.

The Sample Definition page opens. See “Defining a Sample List” on page 360.

 To start a new target screening batch

1. Click Create a New Batch in the navigation pane.

2. Select the Target Screening option.

3. Select the batch folder where you want to create the new batch.

4. Type a name for the new batch in the Batch Name box.

If the name you enter is not unique, a red warning flashes.

5. Select a method from the Method Selection list.

The Method Compound Databases pane displays the compound databases in the 
method. The application uses these databases to identify the compounds in the samples. 
You cannot edit the compound database list from the Acquisition mode.

6. To continue to the next page, click Next.

The Sample Definition page opens. See “Defining a Sample List” on page 360.
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 To start a new unknown screening batch

1. Click Create a New Batch in the navigation pane.

2. Select the Unknown Screening option.

3. Select the batch folder where you want to create the new batch.

4. Type a name for the new batch in the Batch Name box.

5. Select a method from the Method Selection list.

The Method Search Databases pane displays the databases that you selected in the 
method. The application uses these databases to identify the compounds in the samples. 
You cannot edit the database list from the Acquisition mode.

6. To continue to the next page, click Next.

The Sample Definition page opens. See “Defining a Sample List” on page 360.

 To start a new batch from a template

1. Click Create a New Batch in the navigation pane.

2. Select either the Quantitation, Target Screening, or Unknown Screening option.

The Available Templates pane displays only batch templates for the selected option.
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3. In the Available Templates pane, select the template and method combination that you 
want to use.

The system creates a batch name with the selected template name and appends the date 
and time stamp. You can change the batch name, the default batch folder, or the method 
associated with this template. 

4. (Optional) Click  and select a different batch folder where you want to create the 
new batch.

5. (Optional) Select a different method to use for the new batch.

6. To continue to the next page, click Next.

The Sample Definition page of the Acquisition mode opens. See “Defining a Sample 
List” on page 360.

 To select a prepared batch

1. Click Submit a Prepared Batch in the navigation pane.

The application displays all your unacquired, saved batches. The application stores all 
unacquired batches in the …\TraceFinderData\3.3\Projects\… folder.

2. Select the batch that you want to acquire.
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3. To continue to the next page, click Next.

The Finish page of the Acquisition mode opens. From the Finish page, you can save the 
batch, submit the batch for acquisition, or go to the Sample Definition page to edit the 
sample list for this batch.

• If the batch is unreadable, the application reports that the batch file is not valid and 
cannot be opened.

• If a sample in the batch is unreadable, the application cannot open the sample. The 
application creates a new sample with the same name and flags the sample. You must 
complete the missing information such as Sample Type, Level, and so forth, and then 
save the batch before you submit it for acquisition. Or, you can browse in a new raw 
data file to replace the corrupt file.

4. Do one of the following:

• To edit the sample list, click Previous.

For detailed instructions, see “Defining a Sample List” on page 360.

–or–

• To prepare the batch for acquisition, click Submit, .

For detailed instructions, see “Submitting a Batch” on page 379. 

–or–

• To save the batch to be acquired later, click Save, .

The application saves your batch in the following folder:

…\TraceFinderData\3.3\Projects\...

The application closes the Acquisition mode and returns you to the mode you were 
last using.

 To reinject samples in a previously acquired batch

1. Click Reinject Samples in the navigation pane.

2. On the Batch page, select the batch that you want to reacquire.

The Batch page displays all previously acquired quantitation, target screening, and 
unknown screening batches.
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3. To continue to the next page, click Next.

The Sample Definition page of the Acquisition mode opens. See “Defining a Sample 
List” on page 360.

• If the batch is unreadable, the application reports that the batch file is not valid and 
cannot be opened.

• If a sample in the batch is unreadable, the application creates a new sample with the 
same name and flags the sample. You must complete the missing information, such as 
Sample Type, Level, and so forth, and then save the batch before you submit it for 
acquisition. Or, you can browse in a new raw data file to replace the corrupt file.

 To create a quantitation batch template

1. Click Create or Edit a Template in the navigation pane.

2. Select the Quantitation option.

3. Click  and select the folder where you want to create the new batch template.

4. Type a name for the new batch template in the Template Name box.

5. Select a method from the Method Selection list.

The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

Note  When user security is activated, you must have Acquisition Wizard – Template 
Editing permission to create a batch template.
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6. To continue to the next page, click Next.

The Sample Definition page of the Acquisition mode opens. See “Defining a Sample 
List” on page 360.

 To create a target screening batch template

1. Click Create or Edit a Template in the navigation pane.

2. Select the Target Screening option.

3. Click  and select the folder where you want to create the new batch template.

4. Type a name for the new batch template in the Template Name box.

5. Select a method from the Method Selection list.

The Method Compound Databases pane displays the screening databases available for the 
selected method. 

6. Select the check box for each database that you want to use for screening.

7. To continue to the next page, click Next.

The Sample Definition page of the Acquisition mode opens. See “Defining a Sample 
List.” 

Note  When user security is activated, you must have Acquisition Wizard – Template 
Editing permission to create a batch template.
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 To create an unknown screening batch template

1. Click Create or Edit a Template in the navigation pane.

2. Select the Unknown Screening option.

3. Click  and select the folder where you want to create the new batch template.

4. Type a name for the new batch template in the Template Name box.

5. Select a method from the Method Selection list.

The Method Compound Databases pane displays the unknown screening databases 
available for the selected method. 

6. Select the check box for each database that you want to use for unknown screening.

7. To continue to the next page, click Next.

The Sample Definition page of the Acquisition mode opens. See “Defining a Sample 
List.” 

Note  When user security is activated, you must have Acquisition Wizard – Template 
Editing permission to create a batch template.
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Defining a Sample List

Use the Samples page on the Sample Definition page of the Acquisition mode, to create a list 
of samples for the batch. See “Samples” on page 371. You can add samples, insert samples, 
import a sample list, or remove samples from the list. You can use the Reference Sample page 
to select a reference sample to use as a reference peak in the Data Review. See “Reference 
Sample” on page 376.

To create the sample list, you can use either of two sets of function buttons (described in the 
following graphic) or you can use commands in the shortcut menu (see the Shortcut menu 
commands area of the “Samples page parameters” on page 371).

As you enter sample values, you can use the Copy Down and Fill Down commands to quickly 
enter column values. For detailed instructions on using Copy Down and Fill Down to enter 
column values, see Appendix C, “Using Copy Down and Fill Down.” 

Use any of the following procedures to create a sample list. When you finish defining the list 
of samples, click Next.

• When you create a batch from scratch and click Next, the Report Selection page opens. 
See “Selecting and Reviewing Reports” on page 377.

• When you edit a prepared batch, reinject samples, create a batch from a template, or edit 
a batch template and then click Next, the Finish Selection page opens. See “Submitting a 
Batch” on page 379.

Icons in the toolbar

Buttons at the bottom of the sample definition page

Add samples

Insert samples

Remove samples

Import samples

Add samples Insert samples Import samples
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Follow these procedures:

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To reinject a sample from a previously acquired batch

• To select channels for the batch

• To assign a specific channel to a sample

• To select a reference sample

• To add an auto sample type

• To specify different instrument methods for samples

 To add samples to the list

1. Select the number of sample rows to add  and then click the Add icon,  or 
.

2. Type a file name in the Filename column for each sample. 

Each file name must be unique. 

3. Select a sample type from the Sample Type list for each sample. 

For a detailed description of each sample type, see “Sample Types” on page 404.

4. For each Cal Std or QC Std sample, select a level from the Level list.

The master method defines the sample levels. If there are no levels to select in the Level 
list, ask a user with Method Development permission to edit the method and specify the 
levels. Then return to the Acquisition mode, and begin the batch again. The application 
does not save a batch when you leave the Acquisition mode.

If you have Method Development permission, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Compounds tab.

d. Click the Calibration Levels tab.

e. Add the levels.

f. Save the method.

For detailed instructions, see “Calibration Levels” on page 207.

Available sample types

Matrix Blank Solvent QC Std Unknown
Cal Std
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5. (Optional) To assign samples to a group, do the following:

a. For each sample, type a group name in the Groups column.

Repeat this for each sample that you want to include in a group.

b. Create as many groups as you want. 

• For quantitation experiments, after creating groups, you can choose one of the 
samples as a threshold sample for the group and then compare all of the samples in 
the Comparative View in Data Review. 

For information about specifying a threshold sample for a group of samples, see 
“Threshold Samples Page” on page 446. For information about viewing grouped 
samples in Data Review, see “Comparative View” on page 468.

• For unknown screening experiments, you can create a control group (specify the 
group name as Control) to use for group averages in Data Review.

For information about Group Averages, see “Group Averages Pane” on page 656.

6. For each sample, type a vial position in the Vial Position column. 

7. For each sample, type a volume in the Injection Volume column. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix C, 
“Using Copy Down and Fill Down.” 

Note  To assign a sample to multiple groups, separate the groups with a comma. 

In unknown screening analysis, the application uses only the first group listed for 
the Maximum Fold analysis and in the Group Averages pane. 

For information about Group Averages, see “Group Averages Pane” on page 656. 
For information about Maximum Fold analysis, see “Cross Sample Peak List 
Pane” on page 643.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Qual Processing 
(quantitation) or Blank Subtraction (target screening), Level, Sample ID, and Sample 
Name, while the other columns scroll right and left. 
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 To insert samples into the list

1. Select the sample above which you want to insert new Unknown samples.

You cannot use the Insert command to create the first sample row.

2. Select the number of samples to insert  and then click the Insert icon,  or 
.

The application inserts the Unknown samples above the selected sample.

3. For each sample, type a file name in the Filename column. 

Each file name must be unique. 

4. For each sample, select a sample type from the Sample Type list. 

5. For each Cal Std or QC Std sample, click the Level cell and select a level from the list.

The master method defines the sample levels. If there are no levels to select from the Level 
list, ask a user with Method Development permission to edit the method and specify the 
levels. Then return to the Acquisition mode, and begin the batch again. The application 
does not save a batch when you leave the Acquisition mode.

If you have Method Development permission, follow the instructions in step 4 of the 
procedure “To add samples to the list” on page 361.

6. (Optional) To assign samples to a group, do the following:

a. For each sample, type the group name in the Groups column.

Repeat this for each sample that you want to include in a group.

b. Create as many groups as you want. 

Available sample types

Matrix Blank Solvent QC Std Unknown
Cal Std

Inserted 
samples
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• For quantitation experiments, after creating groups, you can choose one of the 
samples as a threshold sample for the group and then compare all of the samples in 
the Comparative View in the Analysis mode. 

For information about specifying a threshold sample for a group of samples, see 
“Threshold Samples Page” on page 446. 

For information about viewing grouped samples in Data Review, see “Comparative 
View” on page 468.

• For unknown screening experiments, you can create a control group (specify the 
group name as Control) to use for group averages in Data Review.

For information about group averages, see “Group Averages Pane” on page 656.

7. Type a vial position in the Vial Position column for each sample. 

8. For each sample, type a volume in the Injection Volume column. 

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.

9. (Optional) Type or edit the values for the remaining columns.

Note  To assign a sample to multiple groups, separate the groups with a comma. 

In unknown screening analysis, the application uses only the first group listed for 
the Maximum Fold analysis and in the Group Averages pane. 

For information about Group Averages, see “Group Averages Pane” on page 656. 
For information about Maximum Fold analysis, see “Cross Sample Peak List 
Pane” on page 643.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Qual Processing 
(quantitation) or Blank Subtraction (target screening), Level, Sample ID, and Sample 
Name, while the other columns scroll right and left. 
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 To import samples into the list 

1. Click Import, .

The Sample Import Tool dialog box opens.

Use this dialog box to import a sample list from a CSV, an XML, or an SLD file.

2. Click Browse and select a CSV, an XML, or an SLD file with the sample definitions that 
you want to import.

3. From the Imported Samples Will Be list, select either Appended to the End of the List 
or Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the sample list. 

When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following column name substitutions.

When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following sample type substitutions.

For each imported sample, the application uses the Instrument Method specified in the 
local method. 

Note  The .csv, .xml, or .sld data format must match the TraceFinder data format. 

Xcalibur column TraceFinder column

Position Vial position
Inj Vol Injection volume
Dil Factor Conversion Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank
QC QC Std
Std Bracket Cal Std
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5. For each Cal Std or QC Std sample, click the Level cell and select a level from the list.

The master method defines the sample levels. If there are no levels to select from the Level 
list, ask a user with Method Development permission to edit the method and specify the 
levels. Then return to the Acquisition mode, and begin the batch again. The application 
does not save a batch when you leave the Acquisition mode.

If you have Method Development permission, follow the instructions in step 4 of the 
procedure “To add samples to the list” on page 361.

For detailed instructions about defining calibration levels, see “Calibration Levels” on 
page 207.

6. Type a vial position in the Vial Position column for each sample. 

7. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

9. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto. 

 To remove samples from the list

1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To reinject a sample from a previously acquired batch 

1. In the sample list, select the sample to reinject.

2. Right-click and choose Reinject Selected Samples from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the same sample are numbered INJ002, INJ003, and so 
forth.

The application copies all parameter values from the original sample.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Qual Processing 
(quantitation) or Blank Subtraction (target screening), Level, Sample ID, and Sample 
Name, while the other columns scroll right and left. 

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit this batch, the application acquires only the reinjection samples. 

 To select channels for the batch

To disable a configured channel, clear the check box for the channel in the Multiplexing 
Channels area at the bottom of the page.

By default, all configured channels are selected. The configured channels are determined 
by the multiplexing settings in the Configuration console. See “Multiplexing” on page 61. 

Clearing a channel in the Multiplexing Channels area does not remove this channel 
selection from the Channels list for each sample. When you assign a channel to a sample, 
be careful not to assign a channel that is not available.

 To assign a specific channel to a sample 

1. Scroll to the Channel column.

All samples default to Auto. 

2. Select a channel from the Channel list. 

When you submit the batch, samples that are set to Auto run on any of the available 
channels and samples that are set to a specific channel run only on that channel.

Note  These features are available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

Note  The Channel column is available only when you have activated multiplexing in 
the Configuration console. See “Multiplexing” on page 61.
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If you select a channel that is not available for this batch, the application flags the sample 
sequence on the Finish page of the Acquisition mode. See the previous procedure, To 
select channels for the batch.

3. If you see this error, do the following:

a. Click Previous to return to the Sample Definition page.

The incorrect sample is marked with an error flag.

b. Correct the channel selection. 

 To select a reference sample 

1. Click the Reference Sample tab.

The Reference Sample page on the Sample Definition page opens. See “Reference 
Sample” on page 376.

You can select one reference sample to use as a reference peak in the Data Review. 

2. Right-click the Reference Sample page and choose Add Reference Sample from the 
shortcut menu.

The Open Chromatograph Reference Sample dialog box opens.

3. Select a batch from the list.

The application displays only batches that were created using the current master method. 

Note  If you are using a new method, you will not see any samples here. You must 
create and save a batch using the current method to see available samples in this list.
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4. Select a sample from the list of processed samples on the right.

The application displays all the processed samples in the selected batch. To use a sample 
as a reference sample, the sample must have been processed with the current master 
method.

5. Click Open.

The application adds the reference sample to the Reference Sample page.

6. (Optional) Enter values for Sample ID, Sample Name, Comment, and Barcode Actual.

7. (Optional) Change the Vial Position for the sample.

The application uses the peak in this sample as a reference peak in Data Review. See 
“Reference Peak” on page 513.

 To add an auto sample type

1. Click the Auto Samples tab.

The Auto Samples page opens. See “Auto Samples” on page 375.

2. Right-click and choose Add Auto Sample from the shortcut menu, or click the Add New 
Auto Sample icon, .

The application adds a Solvent sample to the sample list.

You can add, insert, or remove samples from this list as you would any sample list. 

3. To change the sample type to a Matrix Blank, click the Sample Type column and select 
Matrix Blank from the list.

4. In the Injection Volume column for the sample, type a volume.

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

5. In the Number of Injections column, type the number of injections available in the 
designated Solvent or Matrix Blank vial.

After auto sample injections have occurred, you can return to this page to view the 
number of Injections Used in each vial.

6. In the Vial Position column, type the vial position for the Solvent or Matrix Blank 
sample. 
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 To specify different instrument methods for samples

1. Display the Instrument Method column in the sample list:

a. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens.

b. In the Available Columns pane, select Instrument Method.

c. Click  to move the Instrument Method column to the Displayed Columns 
pane.

d. Click OK.

The application displays the Instrument Method column, defaulting to the instrument 
method specified in the master method. 

2. Click the Instrument Method column and select an instrument method from the list.

This list contains all the available instrument methods. The application prefixes 
instrument methods from external sources with “Ext:”.

You can specify a different instrument method for each sample.

Figure 112. Instrument method column
 

When you submit the batch, the application saves a copy of the selected instrument 
methods to the following folders:

External instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method\ExternalMethods

Local instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method

Note   By default, the Instrument Method column is not displayed on the Sample 
Definition page. See Instrument method column.
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Samples

Use the features on the Samples page to create a list of samples for the batch.

Figure 113. Samples page on the Sample Definition page

 

Table 82. Samples page parameters  (Sheet 1 of 2)

Parameter Definition 

Previous Returns you to the previous Acquisition page.

Next Takes you to the next Acquisition page.

Status color codes  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Sample Controls

Add Adds the specified number of empty rows to the sample grid.

Insert Inserts the specified number of empty rows above the selected row.

Import Opens the Sample Import Tool to import samples from a CSV, an XML, or an SLD file. 

Multiplexing Channels 
These features are available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

All Channels Uses all configured channels to acquire this batch.

Channel 1-n Uses only the selected channels to acquire this batch.

Shortcut menu commands

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.
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Remove Selected 
Samples

Removes selected samples from the sample grid.

Import Samples Opens the Sample Import Tool. See “To import samples into the list” on page 365.

Copy Down Copies the value in the selected row to all rows below it. For detailed instructions about 
using the Copy Down command, see Appendix C, “Using Copy Down and Fill Down.” 

Fill Down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. For detailed instructions about using the Fill 
Down command, see Appendix C, “Using Copy Down and Fill Down.” 

Modify Columns Opens the Modify Columns dialog box. See Column Display.

Enable/Disable Sample 
Weight Calculation

Displays or hides the Sample Volume, Dilution Factor, Sample Weight, Calculation Type, 
and Final Units columns.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to a text editor or spreadsheet application. You cannot paste this 
data back into the Acquisition mode sample list.

Copy with Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to a text editor or spreadsheet 
application. You cannot paste this data back into the Acquisition mode sample list. 

Paste Pastes a single column of copied data from a text editor or spreadsheet application, into the 
selected column.

Undo Last Paste Removes the last pasted item in the Acquisition mode sample list. 

Export to CSV File Opens the Save As dialog box where you can save the current sample list to a CSV file.

Edit Instrument Method Opens the Instrument Setup window where you can edit the parameters of the instrument 
method. 

• When you edit an external method, the application updates the method in the 
…\Xcalibur\methods folder. 

• When you edit an internal method, the application updates the method in the 
…\TraceFinderData\3.3\Projects\project\subproject\batch\Methods\method folder.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Table 82. Samples page parameters  (Sheet 2 of 2)

Parameter Definition 
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Column Display

The Samples page contains many columns of information. You can scroll to see all the 
columns, and you can customize which ones to display and their display order.

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the following columns 
remain fixed: Status, Filename, Sample Type, Groups, Qual Processing (quantitation) or 
Blank Subtraction (target screening) Level, Sample ID, and Sample Name, while the 
other columns scroll right and left. 

 To customize the column display 

1. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

These columns appear after the Status, Filename, Sample Type, Groups, Qual Processing 
(quantitation) or Blank Subtraction (target screening), Level, Sample ID, and Sample 
Name columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Samples page 
sample list, and the last column in the list represents the rightmost column in the 
Samples page sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. Repeat step 4 for all columns whose widths you want to change, and click OK.

The columns in the sample list immediately reflect your changes. 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Qual Processing (quantitation) or Blank Subtraction (target screening), Level, 
Sample ID, and Sample Name.
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Figure 114. Modify Columns dialog box 

Table 83.  Button descriptions for the Modify Columns dialog box

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Qual Processing (quantitation) or Blank Subtraction (target 
screening), Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except fixed columns.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 
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Auto Samples 

Use the features on the Auto Samples Sample page to identify the Solvent or Matrix Blank 
samples to use for any Auto Sample or Auto Sample and Reinject failure actions as specified 
on the Intelligent Sequencing page of the method. See “Editing the Intelligent Sequencing 
Page” on page 228.

Each sample type that you specify for a failure action on the Intelligent Sequencing page must 
be defined in the samples list on the Auto Samples page.

Figure 115. Auto Samples page on the Sample Definition page

Table 84. Auto Samples page parameters

Column Description

Sample Type The sample type for the auto sample injection as specified on the Intelligent Sequencing page of 
the method—either Solvent or Matrix Blank. 

Default: Solvent

Injection Volume The injection volume used for the sample acquisition as specified on the Samples page.

Valid range: 0.1 through 5000 μL

Injections Used The number of times a vial has been used. The count is cumulative across all batches.

Number of 
Injections

The number of injections available in the designated Solvent or Matrix Blank vial.

Vial Position Vial position for this sample type as specified on the Samples page. 
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Reference Sample

Use the features on the Reference Sample page to select a sample to use as a reference peak in 
Data Review.

Figure 116. Reference Sample page on the Sample Definition page

 

Table 85.  Reference Sample page parameters 

Parameter Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Filename Name of the raw data file that contains the sample data.

Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Barcode Actual A user-entered barcode for the vial.

Shortcut menu commands

Add Reference Sample Opens the Open Chromatogram Reference Sample dialog box where you can select a 
reference sample.

Delete Selected Deletes the reference sample.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to a text editor or spreadsheet application. You cannot paste this 
data back into the reference sample list.

Copy with Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to a text editor or spreadsheet 
application. You cannot paste this data back into the reference sample list. 

Paste Pastes a single column of copied data from a text editor or spreadsheet application, into the 
selected column.

Export to CSV File Opens the Save As dialog box where you can save the current sample list to a CSV file.
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Selecting and Reviewing Reports 

On the Report Selection page, you can specify the types of reports that you want to create. See 
Report Selection. In addition to the report type, you can specify a report description for each 
of your reports. 

For each report that you generate, you can create a hard-copy printout, a PDF file, a CSV file, 
or an Excel file.

Use any of the following procedures to create a reports list. When you finish specifying your 
report options, click Next to go to the Finish page and submit your batch. See “Submitting a 
Batch” on page 379.

The application writes the resulting output files for your reports to the following folder:

…\TraceFinderData\3.3\Projects\…\batch\Reports

Follow these procedures:

• To edit a report title

• To specify a report in print format or as a PDF, a CSV, or an Excel file

 To edit a report title 

Select the Report Title column and edit the default title.

The default report title is the same as the report name. 

 To specify a report in print format or as a PDF, a CSV, or an Excel file

1. For each type of report that you want to create, select the corresponding check box in the 
Print, Create PDF, Create CSV, or Create Excel column.

2. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. This action applies only to report types that make this output 
format available.
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Report Selection

Use the features on the Report Selection page to specify the types of reports that you want to 
create. 

Figure 117. Report Selection page

 

Table 86. Report Selection page parameters 

Parameter Description

Report Name The name of a report. 

Report Title User-editable description to be used on a report. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 

Create CSV Reports to be exported as CSV files. 

Create Excel Reports to be exported as Excel files.

Shortcut menu:
Copy Down

Copies the selected or cleared state to all subsequent reports in the column. 
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Submitting a Batch

In the Finish page of the Acquisition mode, you can specify a startup method, a shutdown 
method, or a calibration batch. You can save the batch to be acquired later, or you can acquire 
and process data and optionally create reports. See “Finish page” on page 387.

Follow these procedures:

• To specify startup or shutdown methods

• To automatically update the timed SRM information

• To specify a calibration batch

• To specify device states

• To save a batch for later acquisition or processing

• To start acquisition or processing

• To view the output files

 To specify startup or shutdown methods

1. Select a method from the System Startup Method list.

The application runs this method before running the batch. No autosampler injection 
takes place. This feature is not available for all instruments.

2. Select a method from the System Shutdown Method list.

The application runs this method after running the batch. This feature is not available for 
all instruments.

 To automatically update the timed SRM information 

Select the Auto TSRM Update check box.

When you submit the batch, the application updates the TSQ method with mass 
transitions, collision energy, and other appropriate data for TSRM functionality.

Note  If you are working with a batch template, the only available function is Save.
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 To specify a calibration batch

1. In the Calibration area, select a calibration (.calx) file from the list.

2. To add calibration data from the current batch to the selected calibration file, select the 
Extend Calibration option. 

 To specify device states

In the System Status area, select the name of the device, right-click, and then choose a 
device state from the shortcut menu.

Note  You must acquire at least one batch with the current method to create a 
calibration (.calx) file.

Table 87. Instrument states (Sheet 1 of 2)

Instrument state Description

Turn Device On Keeps the system in the On state when the current run finishes, 
so you can begin another run without waiting. All power and 
flows are maintained at operational levels. 

Default: On

Turn Device Standby Keeps the system in the Standby state when the current run 
finishes, so you can begin another run with only a short delay 
between runs. 

Some devices do not have a Standby feature. For devices with 
this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on in approximately 15 minutes. Depending on the 
instrument, this state turns liquid flows off but maintains 
heaters and other subsystems in an On state so that there is no 
warm-up time required when you change from Standby to On. 
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 To save a batch for later acquisition or processing

From the Finish page, click Save, .

The application saves your batch as a prepared file.

 To start acquisition or processing

1. Click Submit, .

The Submit Options dialog box opens. For detailed descriptions of the parameters, see 
“Submit Options dialog box” on page 384.

2. To acquire (or reacquire) the submitted samples, select the Acquire Data check box.

• When all submitted samples have been previously acquired, this option is (by default) 
not selected. 

• When one or more submitted samples have not been acquired, this option is (by 
default) selected.

3. To process the submitted samples, select the Process Data check box.

The application displays options for each type of method that the batch uses: 
Quantitation, Target Screening, Unknown Screening, or a combination of methods.

Turn Device Off Keeps the system in the Off state when the current run 
finishes. The Off state indicates that all power to the 
instrument, which the application can control, is turned off. 
This includes power to all heaters and subassemblies, but in 
some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do 
have this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on. When several runs are queued, the application uses the 
system power scheme of the last submitted run. 

Instrument status indicators

Green indicates that the device is turned on or is running.

Yellow indicates that the device is in standby mode or is 
waiting for contact closure.

Red indicates that the device is turned off or that there is an 
error with the device.

Tip  You can process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when reprocessing samples.

Table 87. Instrument states (Sheet 2 of 2)

Instrument state Description
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4. For each method type, select the check box for the options that you want to use.

Peak Detect: Performs peak detection for all method types. You can process the data with 
or without performing peak detection. For example, you might want to turn off peak 
detection when reprocessing samples.

Quantitate: Performs quantitation for quantitation methods.

Identify: Performs identification for unknown screening methods.

Identify and Confirm: Performs both identification and confirmation for target 
screening methods.

With RT Alignment: Performs retention time alignment for unknown screening 
methods. This produces the heat map and group averages data in the Unknown Screening 
View. When you select this option, the application automatically selects the Peak Detect 
option.

5. (Optional) Select the Create Reports check box. 

6. (Optional with multiplexing activated) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

7. (Optional without multiplexing activated) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

8. To specify the following optional parameters, click Show Details.

a. Select the Use check box for the device that you want to use for this acquisition.

b. Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

c. Select the Start When Ready check box, which starts all instruments together when 
they are all ready. 

When you clear this check box, individual instruments can start at different times 
and then must wait for the last instrument to be ready.

d. Select the system state after it acquires the last batch: On, Standby, or Off.

Note  When you select Full Sequence Submission in the Configuration console, these 
options are unavailable because the current batch and the current sample are, in effect, 
the same thing. 
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9. To start the selected processes, click OK.

The selected processes begin, and the application shows the real-time display at the 
bottom of the current window. You can begin another batch in the Acquisition mode 
while you watch the real-time display of the currently acquiring batch. 

IMPORTANT   When your batch uses unknown screening features, after the first 
processing, you might see an error message stating that the total number of results is too 
large for a single batch (more than 500 000). Return to the Processing pages for the 
unknown screening features (“Editing the Processing Pages” on page 311) and make one 
or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.
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Figure 118. Submit Options dialog box

Table 88. Submit Options dialog box parameters  (Sheet 1 of 3)

Parameter Description 

User Name Name of the current user.

Samples Number of samples to be submitted for acquisition, processing, or 
reporting.

Method Types Lists the types of methods (quantitation, target screening, or unknown 
screening) used in the submitted batches.

Workflow Steps to Perform

Acquire Data Submits the current batch to acquisition.
• When all submitted samples have been previously acquired, this 

option is (by default) not selected. 
• When one or more samples in the batch have not been acquired, 

this option is (by default) selected.
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Process Data Processes the data for the current batch using any of the following 
options:

Peak Detect: Performs peak detection for all method types. You can 
process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when reprocessing 
samples.

Quantitate: Performs quantitation for quantitation methods.

Identify: Performs identification for unknown screening methods.

Identify and Confirm: Performs both identification and confirmation 
for target screening methods.

With RT Alignment: Performs retention time alignment for unknown 
screening methods. This produces the heat map and group averages 
data in the Unknown Screening View. When you select this option, the 
application automatically selects the Peak Detect option.

Create Reports Creates reports for the current batch.

Submit as a Priority Sequence?

Priority Sequence With multiplexing activated, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing activated, specifies one of the following priority 
options to place the batch in the queue:

Next Available Batch: Places the batch immediately after the currently 
acquiring batch. 

Next Available Sample: Places the batch immediately after the 
currently acquiring sample.

Note  When you select Full Sequence Submission in the 
Configuration console, these options are unavailable because the 
current batch and the current sample are, in effect, the same thing. 

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument that you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then reopen 
the application. You cannot configure an instrument while the 
TraceFinder application is running.

Available only when you select the Acquire Data check box.

Table 88. Submit Options dialog box parameters  (Sheet 2 of 3)

Parameter Description 
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 To view the output files

Locate the files to view from the following directories:

The application writes saved batches to the project folder:

…\TraceFinderData\3.3\Projects\…

For each acquired sample, the application writes an RSX file to the batch Data folder:

…\TraceFinderData\3.3\Projects\…\Data

The application saves method information to the batch Methods folder:

…\TraceFinderData\3.3\Projects\…\Methods

The application writes the reports to the batch Reports folder:

…\TraceFinderData\3.3\Projects\…\batch\Reports

Use Specifies the instruments used for this acquisition.
Available only when you select the Acquire Data check box.

Start Device Specifies the instrument that initiates the communication with the 
other instruments. This is usually the autosampler.
Available only when you select the Acquire Data check box.

Start When Ready Starts the specified device when all the instruments are ready to acquire 
data. When this is cleared, individual instruments can start at different 
times and then must wait for the last instrument to be ready.

Post-run System 
State

Specifies the system state after it acquires the last batch: On (default), 
Standby, or Off.

Buttons

Hide/Show 
Details

Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any tasks.

Table 88. Submit Options dialog box parameters  (Sheet 3 of 3)

Parameter Description 
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Finish

Use the features on the Finish page to save the batch to be acquired later or acquire and 
process data and optionally create reports. 

Figure 119. Finish page

Table 89. Finish page parameters 

Parameter Description 

System Status The System Status pane displays the following: 
• Devices used for the acquisition
• Project, subproject, and name of the batch
• Number of acquired and unacquired samples in the batch
• Number of reports to be printed and saved as PDF, CSV, or Excel files
• Local method and instrument method used for the batch
• Number of compounds in the method

System Startup Method
System Shutdown Method

The instrument methods that run before and after the batch. No autosampler injection 
takes place. These features are not available for all instruments.

Auto TSRM Update Updates the TSQ method with mass transitions, collision energy, and other appropriate 
data for TSRM functionality.

Calibration • Use calibration: Uses the selected calibration file to process the current data.
• Extend calibration: Adds calibration data from the current batch to the selected 

calibration file.

Save Saves the current batch as a prepared batch.

Submit Opens the Submit Options dialog box.
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Real Time Status Pane
You can access the Real Time Status pane from any mode in the application.

 To access the Real Time Status Pane from any mode

Click Real Time Status in the upper right corner of the TraceFinder window.

The Real Time Status pane opens at the bottom of the current view. 

Figure 120. Real Time Status pane

The Real Time Status pane has four pages of information and a real-time trace pane:

• Acquisition Page

• Instrument Page

• Devices Page

• Queues Page

• Real-Time Trace Display
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Acquisition Page

Use the Acquisition page to monitor the progress as the application acquires the samples. 

 To display the last acquired raw data file in a qualitative browser

On the Acquisition page of the real-time status pane, right-click and choose View Last 
File in Qual Explorer from the shortcut menu.

The last acquired file opens in either the FreeStyle or Qual Browser application.

Use the Start, , Stop, , or Pause, , icons 
to control batches in the Acquisition queue.
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 To open the Instrument Setup window

Right-click anywhere in the Acquisition page and choose Open Instrument Method 
Editor from the shortcut menu.

The Thermo Instrument Setup window opens, displaying the currently running 
instrument method.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Instrument Page

Use the Instrument page to monitor the currently acquiring sample. 

 To view the last acquired file in a qualitative browser 

Right-click anywhere in the top pane of the Instrument page and choose View Last File 
in Qual Explorer from the shortcut menu.

The last acquired file opens in either the FreeStyle or Qual Browser application.

Note  Changes you make and save to the instrument method do not affect the 
currently running batch.

When you run single sample 
submission, this displays the 
sample name instead of the 
batch name.
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 To open the Instrument Setup window

Right-click anywhere in the top pane of the Instrument page and choose Open 
Instrument Method Editor from the shortcut menu.

The Thermo Instrument Setup window opens, displaying the currently running 
instrument method.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Devices Page

Use the Devices page to monitor the status of the instrument. The feedback you see on the 
Devices page depends on the instrument you are using. The following examples show an 
Accela™ autosampler and an Aria™ multiplexing device.

Accela Autosampler Feedback

Note  Changes you make and save to the instrument method do not affect the 
currently running batch.
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Aria Multiplexing Feedback

Follow these procedures:

• To pause the autosampler

• To control the channels

• To open the Instrument Setup window

• To view the pressure trace

• To access the Aria multiplexing controls

• To view the last acquired file in a qualitative browser

 To pause the autosampler

1. Click Hold Autosampler.

The autosampler finishes the current autosampler step and then pauses. The autosampler 
and LC pumps continue to run.

2. To restart the autosampler, click Hold Autosampler again.



 8 Using the Acquisition Mode
Real Time Status Pane

Thermo Scientific TraceFinder User Guide 393

 To control the channels

Right-click the channel name and choose a command from the shortcut menu.

 To open the Instrument Setup window

Right-click in the header of the Devices page and choose Open Instrument Method 
Editor from the shortcut menu.

The Thermo Instrument Setup window opens, displaying the currently running 
instrument method.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Table 90. Autosampler shortcut menu commands 

Command Description 

On Turns on a stopped pump and continues acquiring the sample 
list assigned to that channel.

Off After the current sample completes, the application stops 
acquiring and the pump shuts down.

Standby After the current sample completes, the application stops 
acquiring. The pump continues to run.

Disable / Enable Disable: Prevents the channel from receiving samples. When 
you choose Disable during a run, the application finishes the 
current sample on the channel and then stops. 

Enable: Allows the channel to receive samples.

When you disable a channel that is set to On, the channel is 
highlighted in green and the status is READY. You can turn 
the channel to Off or Standby. 

Note  Changes you make and save to the instrument method do not affect the 
currently running batch.
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 To view the pressure trace

1. Click the Pres tab.

The Pressure page displays a pump pressure graph for each sample in the batch. A 
fluctuation or change in the pump pressure could indicate a change in the 
chromatography conditions.

2. To view the pressure for a specific pump, select the Pres 1 or Pres 2 option.

By default, the pressure for all pumps are displayed.

3. To view the pressure for a specific channel, select the corresponding channel number.

By default, the pressure for all channels is displayed.
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 To access the Aria multiplexing controls

Click Direct Control.

The Aria MX Direct Control window opens.

For detailed descriptions of the features in this window, refer to the Transcend Systems with 
Xcalibur Software User Guide.

 To view the last acquired file in a qualitative browser 

Right-click in the header of the Devices page and choose View Last File in Qual 
Explorer from the shortcut menu.

The last acquired file opens in either the FreeStyle™ or Qual Browser application.
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Queues Page
Use the Queues page to monitor and control the Acquisition, Processing, and Reporting 
queues.

• Queue-Level Commands: Pause or remove batches in any of the queues. 

• Batch-Level Commands: Pause or remove entire batches or samples within batches from 
any of the queues.

• Additional Commands: Open the FreeStyle application or the Instrument Setup window.

Queue-Level Commands

Use the queue-level commands to pause or remove batches in any of the queues on the 
Queues page. See “Queue-Level Shortcut Menu” on page 398.

Follow these procedures:

• To pause all batches in a queue

• To remove a single batch from a queue

• To remove all batches in a queue

• To remove all pending batches

 To pause all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Pause Queue from the shortcut menu.

After the current sample completes, the application pauses all batches and samples in the 
specified queue. Only the selected queue is affected.

3. To restart a paused queue, select the queue, right-click, and choose Resume Queue from 
the shortcut menu.

Note  When multiplexing is activated, you can have as many as four samples acquiring 
at once. Pausing the Acquisition queue does not affect any acquiring samples.
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 To remove a single batch from a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Active Batch from the shortcut menu.

The application confirms that you want to remove the active batch from the selected 
queue. After the current sample completes, the application removes the batch and all 
pending samples from the queue. Only the selected queue is affected.

 To remove all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop All Batches from the shortcut menu.

The application removes all batches with pending samples from the selected queue. The 
current sample continues to acquire. Only the selected queue is affected.

 To remove all pending batches

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batches from the shortcut menu.

The application removes all batches that contain only pending samples. Only the selected 
queue is affected.

Note  This command is available only when there are active batches in the queue. 
Paused batches and batches that contain only pending samples are not “active.”

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, the batch is not affected by this command.
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Queue-Level Shortcut Menu

Use the commands in the shortcut menu to pause or remove batches in any of the queues on 
the Queues page.

Figure 121. Queue-level shortcut menu

 

Batch-Level Commands

Use the batch-level commands to pause or remove entire batches or samples within batches 
from any of the queues on the Queues page. See “Batch-level shortcut menu” on page 400.

Follow these procedures:

• To remove a single pending sample from a batch

• To remove all pending samples from a batch

• To stop a batch

• To remove a pending batch

Table 91. Queue-level shortcut menu commands

Command Description 

Pause Queue

Resume Queue

After the current sample completes, the application pauses the 
specified queue. Only the selected queue is affected.

Returns the paused queue to active status.

Stop Active Batch Removes all pending samples from the specified queue. The active 
sample is not affected.

Stop All Batches Removes all pending samples and batches from the specified 
queue. The active sample is not affected.

Reactivate All Batches Returns all paused batches to active status.

Remove Pending 
Batches

Removes all pending batches from the specified queue. The active 
batch is not affected.
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 To remove a single pending sample from a batch

1. Select a pending sample.

2. Right-click the sample and choose Remove Sample from the shortcut menu.

The application confirms that you want to remove the selected sample from the batch and 
then removes the sample.

 To remove all pending samples from a batch

1. Select a batch in any of the queues (Acquisition, Processing, or Reporting).

The batch must have at least one pending sample. 

2. Right-click and choose Remove Pending Samples from the shortcut menu.

The application confirms that you want to remove all pending samples from the batch 
and then removes the samples. If the batch includes only pending samples, the 
application removes the batch from the queue.

 To stop a batch

1. Select an active batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue. 
After the current sample completes, the application removes the batch and all pending 
samples from the queue.

Note  The batch must have at least one active sample and one pending sample.
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 To remove a pending batch

1. Select a pending batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue and 
then removes the batch from the queue.

Figure 122. Batch-level shortcut menu

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, this command is not available.

Table 92. Batch-level shortcut menu commands

Command Description 

Stop Batch After the current sample completes, the application removes all 
samples in the selected batch.

Remove Pending Batch Removes all samples from the selected pending batch.

Remove Pending 
Samples

Removes all pending samples from the selected batch.
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Additional Commands

You can open the FreeStyle application or the Instrument Setup window using additional 
commands that you access from the Queues page. 

To access the shortcut menu with these commands, you must click in the white space below 
the list of queues. If you click on the name of or to the right of the queues, the application 
displays queue-, batch-, or sample-level shortcut menus.

 To view the last acquired file in a qualitative browser

Right-click below the queues list on the Queues page and choose View Last File in Qual 
Explorer from the shortcut menu.

The last acquired file opens in either the FreeStyle or Qual Browser application.

 To open the Instrument Setup window

Right-click below the queues list on the Queues page and choose Open Instrument 
Method Editor from the shortcut menu.

The Thermo Instrument Setup window opens, displaying the currently running 
instrument method.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Note  Changes you make and save to the instrument method do not affect the 
currently running batch.

Right-click below the 
list of queues.
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Real-Time Trace Display

As each sample acquires, the real-time chromatogram pane shows the retention time and 
intensity of the TIC trace.

By default, the Real Time Status pane shows only the TIC trace as each sample acquires. To 
observe specific traces, such as the internal standard, use the RTV Display Traces function to 
display multiple traces.

When you create your method, you can specify additional traces to display in the real-time 
viewer and in which order the traces are displayed. The application always displays the TIC 
trace in the top pane. See “Real Time Status Pane” on page 388.

 To display multiple traces

Right-click the chromatogram pane and choose the number of traces to display.

The chromatogram pane displays real-time chromatograms for the selected number of 
traces. 

The TIC is always displayed at the top. When there are more traces than can fit in the 
pane, you can scroll through the traces.

For each trace, the application displays the mass or precursor mass. See Real-time trace 
display with multiple traces.



 8 Using the Acquisition Mode
Real Time Status Pane

Thermo Scientific TraceFinder User Guide 403

Figure 123. Real-time trace display with multiple traces
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Sample Types 
The TraceFinder application uses the following sample types in all sample definitions and 
reports. 

Table 93. Sample type definitions 

Sample type Definition

Matrix Blank Contains no target compounds but might contain an ISTD when you 
use the internal standard quantitative analysis technique. By analyzing a 
blank sample, you can confirm that there are no residual compounds in 
the solvent system that can cause erroneous results.

Cal Std (Calibration standard) Contains known amounts of all target 
compounds. The purpose of a standard is to measure the response of the 
instrument to the target compounds so that the processing application 
can generate a calibration curve for each compound.

QC Std (Quality Check standard) Contains a known amount of one or more 
specific target compounds. The application places check standard 
samples in the sequence so that it can test quantitative analysis results 
for quality assurance purposes. After the application analyzes the QC 
Std sample, it compares the measured quantity with the expected value 
and an acceptability range. The quantitative analysis of a QC Std sample 
is classified as passed if the difference between the observed and expected 
quantities is within the user-defined tolerance. A QC Std sample is 
classified as failed if the difference between the observed and expected 
quantities is outside the user-defined tolerance.

Solvent Contains only solvent.

Unknown Used for quantitative analysis of samples.
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9

Using the Analysis Mode for Quantitation Batches

This chapter includes instructions about using the features of the Analysis mode to do the 
following:

• Create quantitation batches.

• Submit quantitation batches for acquisition, processing, or report generation.

• Review quantitation batches, batch data, reports, and local methods.

 To access the Analysis mode

Click Analysis in the navigation pane.

The Analysis navigation pane opens.

Contents

• Working in the Batch View

• Working in Data Review

• Working in the Report View

• Working in the Local Method View
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Working in the Batch View
In the Batch View, you can manually create and edit a new quantitation batch or open and 
edit a previously saved batch. When you submit a batch, you can acquire and process data and 
optionally create reports for the submitted samples.

The Analysis mode includes a toolbar:

Use the toolbar or the equivalent commands in the Batch View shortcut menu to create the 
sample list and submit samples for acquisition. See “Toolbar” on page 414 or “Batch View 
Shortcut Menu” on page 418.

See the following topics:

• Samples Page

• Auto Samples Page 

• Reference Sample Page

• Threshold Samples Page

 To open the Batch View

1. Click Analysis in the navigation pane of the current mode.

2. Click Batch View.

The Batch View navigation pane opens. 

Samples Page

To open the Samples page, click Samples in the Batch View navigation pane.

This section contains information about the following topics:

• Samples Page Features

• Creating a New Batch

• Editing a Batch

• Submitting a Batch

Available only when you activate Intelligent 
Sequencing in the Configuration console
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Samples Page Features

The Samples page is divided into two panes: 

• Samples pane

Use the samples pane to create a batch. See Samples Pane.

• Compound Active Status pane

Use the Compound Active Status pane to make specific compounds active or inactive. See 
“Compound Active Status Pane” on page 420.

Samples Pane

The samples pane includes the following features:

• Column Display

• Status Indicators

• Groups

• Qual Processing

• Sample Weight Calculation

• Instrument Methods

• Toolbar

• Batch View Sample List

• Batch View Shortcut Menu

Samples pane

Compound Active Status pane

Tip  To resize the panes, drag the separator that divides the panes.
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Column Display

The sample list contains many columns of information. You can scroll to see all the columns, 
and you can customize which ones to display and their display order.

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the following columns 
remain fixed: Status, Filename, Sample Type, Groups, Qual Processing, Level, Sample ID, 
and Sample Name, while the other columns scroll right and left. 

 To customize the column display 

1. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

These columns appear to the right of the sample list’s fixed columns: Status, Filename, 
Sample Type, Groups, Qual Processing, Level, Sample ID, and Sample Name.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. Repeat step 4 for all columns whose widths you want to change, and click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View. 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Qual Processing, Level, Sample ID, and Sample Name.
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Figure 124. Modify Columns dialog box 

Table 94.  Button descriptions for the Modify Columns dialog box 

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Qual Processing, Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except fixed columns.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 
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Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing.

 Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Groups

Use the Groups feature to assign samples to a group. 

 To create a group

1. For each sample, type the name of a group in the Groups column.

Repeat this for each sample that you want to include in a group.

2. Create as many groups as you want. 

Note  To assign a sample to multiple groups, separate the groups with a comma. 

Status indicators
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Qual Processing

Use the Qual Processing feature to indicate samples to be processed with the qualitative peak 
processing criteria specified in the method. 

The Qualitative View displays processed data for the selected samples. See “Qualitative View” 
on page 475.

Sample Weight Calculation

Use the sample weight features to calculate the conversion factor for a sample. The application 
uses different methods to calculate the conversion factor for liquid or solid calculation types.

Liquid: SampleVolume DilutionFactor

Solid: (SampleVolume × DilutionFactor) SampleWeight

Manual: The application does not calculate the Conversion Factor. Instead, you can enter the 
Conversion Factor value.

Follow these procedures:

• To display the features for calculating sample weight

• To calculate the conversion factor for a liquid sample

• To calculate the conversion factor for a solid sample

• To manually specify the conversion factor for a sample

 To display the features for calculating sample weight

If the Conversion Factor, Sample Volume, Dilution Factor, Sample Weight, Calculation 
Type, and Final Units columns are not visible, right-click and choose Enable Sample 
Weight Calculation from the shortcut menu.
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 To calculate the conversion factor for a liquid sample

1. From the Calculation Type list, select Liquid.

For a liquid sample, the Sample Weight value is not editable.

2. In the Sample Volume column, type the volume in ng/mL for your sample.

3. In the Dilution Factor column, type the value for the dilution. 

For example, if you have 1000 ng/mL of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

4. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

 To calculate the conversion factor for a solid sample

1. From the Calculation Type list, select Solid.

2. In the Sample Weight column, type the weight in ng for your sample.

3. In the Sample Volume column, type the volume in ng/ml for your sample.

4. In the Dilution Factor column, type the value for the dilution.

For example, if you have 1000 ng/ml of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

5. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

 To manually specify the conversion factor for a sample

1. From the Calculation Type list, select Manual.

For a manually calculated sample, the only available columns are the Conversion Factor 
and the Final Units. 

2. In the Conversion Factor column, type the conversion factor to use for your sample.

3. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

Note  The application uses the following formula to calculate the Conversion Factor: 
SampleVolume DilutionFactor

Note  The application uses the following formula to calculate the Conversion Factor: 
(SampleVolume × DilutionFactor) SampleWeight

Note  The application uses the specified conversion factor when it calculates the 
amount for the sample.
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Instrument Methods

Use the Instrument Methods column to specify instrument methods for the samples. 

 To specify instrument methods for samples

1. Display the Instrument Method column in the sample list:

a. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens.

b. In the Available Columns pane, select Instrument Method.

c. Click  to move the Instrument Method column to the Displayed Columns 
pane.

d. Click OK.

The application displays the Instrument Method column, defaulting to the instrument 
method specified in the master method. 

2. Click the Instrument Method column and select an instrument method from the list.

This list contains all the available instrument methods. Instrument methods from 
external sources are prefixed with “Ext:”.

You can specify a different instrument method for each sample.
 

When you submit the batch for acquisition, the application saves a copy of the selected 
instrument methods to the following folders:

External instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method\ExternalMethods

Local instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method

Note   By default, the Instrument Method column is not displayed in the Batch View 
sample list.
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Toolbar

The Analysis mode includes this toolbar for creating and submitting a batch.

Table 95. Toolbar icons

Icon Description

Adds the specified number of new, empty samples to the end of the 
sample list. See the instructions “To add samples to the list” on 
page 422.

Inserts a new, empty sample or samples above the selected sample. See 
the instructions “To insert samples into the list” on page 423.

Removes the selected samples from the sample list. See the 
instructions “To remove samples from the list” on page 424.

Adds imported samples from a CSV, an XML, or an SLD file to the 
sample list. See the instructions “To import samples into the list” on 
page 423.

Submits only the selected samples for acquisition, processing, or 
report generation. See the instructions “To submit samples in the 
batch” on page 433.

Submits the batch for acquisition, processing, or report generation. 
See the instructions “To submit samples in the batch” on page 433.

Submits only the selected peaks for processing. See the instructions 
“To submit selected peaks for processing” on page 433.

Opens the Acquisition mode where you can use a batch template to 
define a standard sequence composed of various sample types to be 
assembled into a batch of samples. See “Working in Data Review” on 
page 447. 

Opens the Acquisition mode where you can create a batch template 
that contains the basic settings and sample types for your batches. See 
“Using the Acquisition Mode” on page 347.

Opens the Quick Acquisition window where you can quickly submit a 
single sample. See Appendix A, “Using Quick Acquisition.” 

Opens the Audit Viewer where you can view audit logs. See 
Chapter 13, “Using the Audit Viewer.”  Available only when you 
enable Auditing in the Administrator Console. Refer to the 
instructions in the TraceFinder Administrator Console User Guide.
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Batch View Sample List

The sample list displays all the quantitative data for the samples of a batch. 

Status indicators for each sample indicate if the sample is currently acquiring, not acquired, 
acquired, or processed. 

The sample list includes the following columns of information:

Figure 125. Batch View sample list
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Table 96. Batch View sample list columns  (Sheet 1 of 2)

Column Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Note   When you include unknown screening features in the quantitation method and you 
choose to process with only the quantitation criteria, the Sample View shows the Status for 
the samples as acquired and processed ( ), and the Unknown Screening View shows the 
Status for the samples as acquired but not processed ( ). 

Note  When you include unknown screening features in the quantitation method and you 
choose to process with only the unknown screening criteria, both the Sample View and the 
Unknown Screening View show the Status for the samples as acquired and processed ( ). 

Groups Threshold group to which a sample belongs. Samples can be viewed by group in the 
Comparative View of Data Review.

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the application processes the sample data. Each sample is classified as one of the 
following sample types: Matrix Blank, Solvent, Cal Std, QC Std, or Unknown

Default: Unknown

Qual Processing Indicates samples to be processed with the qualitative peak processing criteria specified in the 
method. The Qualitative View displays processed data for the selected samples. 

Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Injection Volume The injection volume (in microliters) of the injected sample. 
When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the autosampler you configure. The usable range depends 
on the injection mode and might be smaller than the displayed range.
The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Valid range: 0.1 through 5000 μL
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Calculation Type Liquid: The application calculates the Conversion Factor as 

SampleVolume DilutionFactor

Solid: The application calculates the Conversion Factor as 

(SampleVolume × DilutionFactor) SampleWeight

Manual: Sample Volume, Dilution Factor, Sample Weight, and Final Units columns are not 
available, and the Conversion Factor value is editable.

Conversion Factor Editable only when Calculation Type is Manual. 

Default: 1

Sample Volume Default: 1

Dilution Factor Default: 1

Sample Weight Available only when Calculation Type is Solid. 

Default: 1

Final Units Specifies the calculated amount in the Data Review view or in reports.

Default: 1

Instrument Method Specifies the instrument to use for the acquisition. This column is hidden by default. To display 
this column, see “To customize the column display” on page 408.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

Barcode Expected A user-entered barcode for the vial.

Barcode Actual An actual barcode for the vial. This value is not editable.

Comment A user-defined comment for the sample.

Table 96. Batch View sample list columns  (Sheet 2 of 2)

Column Description
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Batch View Shortcut Menu

The Batch View includes a shortcut menu for creating a batch.

Table 97. Batch View shortcut menu commands  (Sheet 1 of 2)

Command Description

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected 
row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the 
row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the 
file name. Additional reinjections of the same sample are 
numbered INJ002, INJ003, and so forth.

Remove Selected 
Samples

Removes selected samples from the sample grid.

Import Samples Opens the Sample Import Tool. See “To import samples into the 
list” on page 423.

Browse in Raw File 
(Move)

Opens a dialog box where you can select a raw data file to use for 
the selected sample row. The application removes the raw data 
file from the source location.

Browse in Raw File 
(Copy)

Opens a dialog box where you can select a raw data file to use for 
the selected sample row. The application copies the raw data file 
from the source location.

Map Raw Files to 
Samples

Opens a dialog box where you can select multiple raw data files 
to use for the selected sample rows.

Copy Down Copies the value in the selected row to all rows below it. This 
command is available only when you have selected a value that 
can be copied down.

Fill Down Enters sequential values in the column starting with the value in 
the selected row and ending with the last row in the column. 
This command is available only when you have selected a value 
that can be filled down.

Modify Columns Opens the Modify Columns dialog box. See “Column Display” 
on page 408.

Enable/Disable Sample 
Weight Calculation

Displays or hides the Sample Volume, Dilution Factor, Sample 
Weight, Calculation Type, and Final Units columns.

Copy Copies the data in the selected rows or columns to the Clipboard. 
Use this command to copy sample information into a text editor 
or spreadsheet application. You cannot paste this data back into 
the Batch View sample list.
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Copy with Headers Copies the data in the selected rows or columns and the 
associated column headers to the Clipboard. Use this command 
to copy sample information into another text editor or 
spreadsheet application. You cannot paste this data back into the 
sample list. 

For example

Paste Pastes a single column of copied data from another text editor or 
spreadsheet application into the selected column.

Undo Last Paste Removes the last pasted item in the Batch View. 

Export to CSV File Opens the Save As dialog box where you can save the current 
sample list to a CSV file.

Edit Instrument Method Opens the Instrument Setup window where you can edit the 
parameters of the instrument method. 

• When you edit an external method, the application updates 
the method in the …\Xcalibur\methods folder. 

• When you edit an internal method, the application updates 
the method in the 
…\TraceFinderData\3.3\Projects\…\batch\Methods\method 
folder.

For detailed information about editing instrument methods, see 
“Working with Instrument Methods” on page 108.

Table 97. Batch View shortcut menu commands  (Sheet 2 of 2)

Command Description

Copy with Headers 
from TraceFinder

Paste into an Excel spreadsheet.
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Compound Active Status Pane

In the Compound Active Status pane, you can choose specific compounds to be active or 
inactive.

 To set a compound as active or inactive

1. In the sample list, select a sample.

All compounds in the selected sample are listed in the Compound Active Status pane.

The default active/inactive status is determined by the identification settings in the local 
method. For information about setting the identification parameters, see “Identification” 
on page 152.

• To display compounds alphabetically, right-click and choose Sort by Compound 
Name from the shortcut menu.

• To display compounds from shorter to longer retention time, right-click and choose 
Sort by Retention Time from the shortcut menu.

2. Select or clear the Active check box for the compound.

For instructions about changing the active/inactive status in the Data Review view, see 
“Inactive and Excluded Compounds” on page 496.

Compound Active/Inactive Status

You can specify which compounds are active or inactive in the Local Method View or the 
Batch View.

Figure 126. Active and inactive compounds in the Local Method View

For details about setting the status on the Identification page, see “Identification” on 
page 152.
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Figure 127. Active and inactive compounds in the Batch View

For details about setting the status in the Batch View, see “Compound Active Status Pane” on 
page 420.

Creating a New Batch

In the Batch View, you can create a new batch. 

Follow these procedures:

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To browse in raw data files

• To customize the column display

 To create a new batch

1. Choose File > New > Batch from the main menu.

The Create New Batch dialog box opens, displaying all drives that contain projects. See 
“Create New Batch Dialog Box” on page 428.
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2. Select a drive from the list.

3. Select the folder where you want to store your batch.

To create a new folder for the storage location, see “Editing Folders for Batches” on 
page 429.

4. Select Quan from the Type list.

The batch list displays all batches in the selected folder. The Method list displays all 
methods for the quantitation type.

5. Select a master method from the Master Method list. 

6. Click Create.

A new batch opens with one Unknown sample. 

The batch name in the title bar indicates that you are creating a quantitation batch.

When you create a batch using a quantitation method that includes unknown screening 
features, the title bar indicates that the method includes unknown screening.

 To add samples to the list

1. To add a single sample row, right-click the sample list and choose Add Sample from the 
shortcut menu.

2. To add multiple sample rows, select the number of rows and then click the Add Sample 
icon, .

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  The application displays all configured and enabled repositories. 

Tip  To activate the Create button, you must enter a unique batch name. If the Create 
button is not activated, you have entered a batch name that is already used.
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 To insert samples into the list

Select the sample above which you will insert new, Unknown samples, and then do one of 
the following:

• To insert a single sample row, right-click and choose Insert Sample from the shortcut 
menu. 

• To insert multiple sample rows, select the number of rows and then click the Insert 
Sample icon .

The application inserts the Unknown samples above the selected sample.

 To import samples into the list

1. Choose Batch > Import Samples from the main menu, or click the Import Samples 
icon, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a CSV, an XML, or an SLD file.

2. Click Browse and select a CSV, an XML, or an SLD file that contains the samples to 
import.

3. From the Imported Samples Will Be list, select Appended to the End of the List or 
Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the sample list. 

Inserted samples
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When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following column name substitutions:

When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following sample type substitutions:

5. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The application inserts the copy above the selected sample.

 To reinject a sample

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

Xcalibur column TraceFinder column

Position Vial Position

Inj Vol Injection Volume

Dil Factor Conversion Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank

QC QC Std

Std Bracket Cal Std

Note  The Channel column is available only when you have activated multiplexing in 
the Configuration console. See “Multiplexing” on page 61.

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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 To edit sample values

1. For each sample, do one of the following:

Type a new file name over the current filename.

–or–

Double-click the Filename column and locate a raw data file to use for the sample. 

–or–

Right-click and choose Browse in Raw File from the shortcut menu, and then locate a 
raw data file to use for the sample.

By default, the application sets the Sample Type to Unknown.

2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or QC Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select in the 
Level list, do the following:
a. Return to the Method Development mode.
b. Open the method.
c. Click the Compounds tab.
d. Click the Calibration Levels tab.
e. Add the levels.
f. Save the method.
g. Return to the Batch View in the Analysis mode, and then click Update.

The application updates the local method with the new sample levels.

For detailed instructions about specifying calibration levels, see “Calibration Levels” on 
page 207.

4. Type a vial position in the Vial Position column for each sample. 

5. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

Available sample types

Matrix Blank Solvent QC Std Unknown
Cal Std
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6. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix C, 
“Using Copy Down and Fill Down.” 

 To browse in raw data files

1. Do one of the following:

Double-click the Filename column.

–or–

Right-click and choose Browse in Raw File from the shortcut menu.

The What Raw File Would You Like to Use dialog box opens.

2. Select a raw data file to use for the sample or use the CTRL key to select multiple files, 
and then click Open.

The application overwrites the selected, unacquired sample in the batch with the first 
“browsed in” file and adds any additional browsed in files below the selected sample.

For all browsed-in raw data files, the application sets the Status to Acquired, , and sets 
the Sample Type to Unknown. 

 To customize the column display

1. Right-click the Batch View sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box” on page 427.

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select appear after the Status, Filename, Sample Type, Groups, Qual 
Processing, Level, Sample ID, and Sample Name columns.

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Qual Processing, 
Level, Sample ID, and Sample Name, while the other columns scroll right and left. 

Note  You cannot overwrite an acquired sample. When you select a sample that is 
acquired, the application adds all browsed in files below the selected sample.
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3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

Modify Columns Dialog Box

Use the Modify Columns dialog box to select the columns that you want to display.

Figure 128. Modify Columns dialog box 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Qual Processing, Level, Sample ID, and Sample Name.
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Create New Batch Dialog Box

Use the Create New Batch dialog box to select a folder and method for your batch and to 
name the new batch.

 

Table 98.  Button descriptions for the Modify Columns dialog box 

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Qual Processing, Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except those that are fixed.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 

Table 99. Create New Batch dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.
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Editing Folders for Batches

From the Create New Batch dialog box, you can create new folders for your batches. You can 
also delete or rename folders.

Use these procedures:

• To create new project folders

• To delete project folders

• To rename project folders

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level folders; you must delete the lower-level 
folders first.

Or, right-click and choose Delete from the shortcut menu.

 

Rename Folder

Renames the selected folder.

Or, right-click and choose Rename from the shortcut menu.

Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Type Type of batch to create: Quan, Screening, or Unknown Only.

Method Method used to create the new batch.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Create Creates the specified batch and opens the Batch View for the new batch.

Cancel Closes the Create New Batch dialog box without creating a batch.

Table 99. Create New Batch dialog box parameters  (Sheet 2 of 2)

Parameter Description
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 To create new project folders

1. In the Create New Batch dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names are limited to 30 characters and can contain spaces and special characters, 
except for the following special characters: \ / : + ? ” < >

 To delete project folders

1. In the Create New Batch dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

 To rename project folders

1. In the Create New Batch dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Editing a Batch

In the Batch View, you can open a saved batch and edit the sample list. You can add samples, 
edit samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for reinjection. If the batch has unacquired samples when you complete your edits, 
you can save it as a “ready to acquire” batch. 

Note  After you add a lower-level folder, you cannot rename the parent folder.

Note  You cannot delete folders that contains lower-level folders; you must delete the 
lower-level folders first.

Note  You cannot rename folders that contain lower-level folders.
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Follow these procedures:

• To open a saved batch

• To open a recent batch

• To edit samples in a batch

• To reinject a sample from a previously acquired batch

 To open a saved batch

1. Choose File > Open > Batch from the main menu.

The Open Batch dialog box opens. See Open Batch dialog box.

2. Select a project and a subproject.

3. Select Quan or Any from the Type list.

The batch list displays all batches created with quantitation methods (or all methods of all 
types when you select Any).

4. Select a batch from the list. 

5. Click Open.

The selected batch opens in the Batch View. 

Open Batch Dialog Box

Use the Open Batch dialog box to select a batch to open.

Figure 129. Open Batch dialog box

Table 100. Open Batch dialog box parameters  (Sheet 1 of 2)

Parameter Description

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date the batch was last updated.



9 Using the Analysis Mode for Quantitation Batches
Working in the Batch View

432 TraceFinder User Guide Thermo Scientific

 To open a recent batch 

Choose File > Recent Files > batch from the main menu.

The selected batch opens in the Batch View.

 To edit samples in a batch

Use the commands described in “Working in the Batch View” on page 406.

You can add new samples, edit samples, or delete samples.

 To reinject a sample from a previously acquired batch

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

Path Path to the project in the TraceFinderData\3.3\Projects folder 
where the batch is stored.

Buttons

Type Type of batch to display in the Batch list: Quan, Screening, 
Unknown Only, or Any.

Open Opens the Batch View for the selected batch.

Cancel Closes the Open Batch dialog box without opening a batch.

Table 100. Open Batch dialog box parameters  (Sheet 2 of 2)

Parameter Description
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A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit all samples in this batch, the application acquires all samples (including 
previously acquired samples).

3. To save this batch with the new samples for reinjection, choose File > Save > Batch from 
the main menu.

The batch is saved as a prepared batch that is ready to submit. You can open this batch 
from the Reinject Samples page in the Acquisition mode and submit the batch. The 
application acquires only the samples that have not been previously acquired.

Submitting a Batch

In the Batch View, you can submit an entire batch or only selected samples in the batch. 
When you submit a batch for acquisition and processing, you can choose to create reports for 
the submitted samples. See “Submit Options dialog box” on page 436.

For a description of commands in the shortcut menu, see “ Batch View shortcut menu 
commands” on page 418.

Follow these procedures:

• To submit selected peaks for processing

• To submit samples in the batch

• To view the output files

 To submit selected peaks for processing

1. In the Peak List, select the Selected check box for the peaks that you want to process.

2. Click the Submit … for Processing icon, .

The application processes the selected peaks and updates the data in the Data Review 
panes.

 To submit samples in the batch

1. Do one of the following:

• To submit all samples in the batch, click the Submit Batch icon, .

• To submit specific samples, select the samples and click the Submit Selected

Samples icon, .
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The Submit Options dialog box opens. See “Submit Options dialog box” on page 436.

2. To acquire (or reacquire) the submitted samples, select the Acquire Data check box.

• When all submitted samples have been previously acquired, this option is (by default) 
not selected. 

• When one or more samples in the batch have not been acquired, this option is (by 
default) selected.

3. To process the submitted samples, select the Process Data check box.

The application displays processing options for the method. 

If the quantitation method includes unknown screening features, the application also 
displays unknown screening options. For specifying processing data for batches that also 
use unknown screening features, see “To submit samples in the batch” on page 633 of 
Chapter 11, “Using the Analysis Mode for Unknown Screening Batches.” 

4. Select the check box for the quantitation options that you want to use.

Peak Detect: Performs peak detection. You can process the data with or without 
performing peak detection. For example, you might want to turn off peak detection when 
reprocessing samples.

Quantitate: Performs quantitation.

5. (Optional) Select the Create Reports check box.

6. (Optional with multiplexing activated) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

7. (Optional without multiplexing activated) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

Note  You can also submit only selected peaks for processing. See “To submit selected 
peaks for processing” on page 433.

Tip  You can process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when reprocessing samples.

Note  When you select Full Sequence Submission in the Configuration console, these 
options are unavailable because the current batch and the current sample are, in effect, 
the same thing. 
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8. To specify the following optional parameters, click Show Details.

a. Select the Use check box for the device that you want to use for this acquisition.

b. Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

c. Select the Start When Ready check box, which starts all instruments together when 
they are all ready. 

When this is cleared, individual instruments can start at different times and then have 
to wait for the last instrument to be ready.

d. Select the system state after it acquires the last batch: On, Standby, or Off.

9. To start the selected processes, click OK. 

The selected processes begin, and the application shows the real-time display at the 
bottom of the current window. You can begin another batch in the Analysis mode while 
you watch the real-time display of the currently acquiring batch. 

IMPORTANT   When your batch also uses unknown screening features, after the first 
processing, you might see an error message stating that the total number of results is too 
large for a single batch (more than 500 000). Return to the Processing pages for the 
unknown screening features (“Editing the Processing Pages” on page 311) and make one 
or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.
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Submit Options Dialog Box

Use the Submit Options dialog box to submit a batch for acquisition, processing, or 
reporting.

Figure 130. Submit Options dialog box

Table 101. Submit Options dialog box parameters  (Sheet 1 of 3)

Parameter Description 

User Name Name of the current user.
Samples Number of samples to be submitted for acquisition, processing, or 

reporting.
Workflow Steps to Perform

Acquire Data Submits the current batch to acquisition.
• When all submitted samples have been previously acquired, this 

option is (by default) not selected. 
• When one or more samples in the batch have not been 

acquired, this option is (by default) selected.
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Process Data Processes the data for the current batch using any of the following 
options:

Peak Detect: Performs peak detection. You can process the data 
with or without performing peak detection. For example, you 
might want to turn off peak detection when reprocessing samples.

Quantitate: Performs quantitation.
Note   Quantitation methods can include unknown screening 
features. For specifying processing data for batches that also use 
unknown screening features, see “To submit samples in the batch” 
on page 633.

Create Reports Creates reports for the current batch.
Submit as a Priority Sequence?

Priority Sequence With multiplexing activated, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing activated, specifies one of the following 
priority options to place the batch in the queue:

Next Available Batch: Places the batch immediately after the 
currently acquiring batch. 

Next Available Sample: Places the batch immediately after the 
currently acquiring sample.
Note  When you select Full Sequence Submission in the 
Configuration console, these options are unavailable because the 
current batch and the current sample are, in effect, the same 
thing. 

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument that you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then reopen 
the application. You cannot configure an instrument while the 
TraceFinder application is running.

Available only when you select the Acquire Data check box.
Use Specifies the instruments used for this acquisition.

Available only when you select the Acquire Data check box.
Start Device Specifies the instrument that initiates the communication with the 

other instruments. This is usually the autosampler.
Available only when you select the Acquire Data check box.

Table 101. Submit Options dialog box parameters  (Sheet 2 of 3)

Parameter Description 
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 To view the output files

Locate the files to view from the following directories:

The application writes saved batches to the project folder:

…\TraceFinderData\3.3\Projects\…

For each acquired sample, the application writes an RSX file to the batch Data folder:

…\TraceFinderData\3.3\Projects\…\Data

The application saves method information to the batch Methods folder:

…\TraceFinderData\3.3\Projects\…\Methods

The application writes the reports to the batch Reports folder:

…\TraceFinderData\3.3\Projects\…\batch\Reports

Start When Ready Starts the specified device when all the instruments are ready to 
acquire data. When this is cleared, individual instruments can start 
at different times and then must wait for the last instrument to be 
ready.

Post-run System State Specifies the system state after it acquires the last batch: On 
(default), Standby, or Off.

Buttons

Hide/Show Details Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.
Cancel Closes the Submit Options dialog box without submitting any 

tasks.

Table 101. Submit Options dialog box parameters  (Sheet 3 of 3)

Parameter Description 
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Saving a Batch to a New Location

You can move the current batch to a different project folder, or you can make a copy of the 
current batch and save the copy to a different project folder.

Follow these procedures:

• To save a batch to another project folder

• To move a batch to another folder

• To create a new project folder

• To delete project folders

• To rename project folders

 To save a batch to another project folder

1. Choose File > Save > Save Batch As from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 441.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

If you are saving the batch to a different folder, you must give it a unique name. You 
cannot overwrite an existing batch in a folder.

5. Click Save.

When you save the batch to a different folder, the reports reflect the original project 
folders and the application does not save the calibration history.

 To move a batch to another folder

1. Choose File > Save > Move Batch from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 441.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

You must give the batch a unique name in the new subproject folder. You cannot 
overwrite an existing batch.
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5. Click Save.

When you move the batch, the reports reflect the original project and subproject folders 
and the application does not save the calibration history.

 To create a new project folder 

1. In the Save Batch As dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names can contain spaces and special characters, except for the following special 
characters: \ / : + ? ” < >

 To delete project folders

1. In the Save Batch As dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

 To rename project folders

1. In the Save Batch As dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Note  After you add a lower-level folder, you cannot rename the parent folder.

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.
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Save Batch As Dialog Box

Use the features in the Save Batch As dialog box to save a batch to a new name or to move a 
batch to a different project folder.

Figure 131. Save Batch As dialog box

Table 102. Save Batch As dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Delete from the shortcut menu.

 

Rename Folder

Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Rename from the shortcut menu.

Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.
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Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Save Saves the batch to the specified name and folder and opens the Batch View for the new 
batch.

Cancel Closes the Save Batch As dialog box without saving the batch.

Shortcut menu commands 

Create Folder Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Delete Folder Immediately removes the selected folder. There is no prompt to confirm that you want to 
delete the selected folder.

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Rename Folder Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Expand Child Nodes Expands all project and subproject folders in the Project tree.

Collapse Child Nodes Collapses all project and subproject folders in the Project tree.

Table 102. Save Batch As dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Auto Samples Page 

The Auto Samples page identifies the Solvent or Matrix Blank samples to use for any Auto 
Sample or Auto Sample and Reinject failure actions as specified on the Intelligent Sequencing 
page of the method. See “Editing the Intelligent Sequencing Page” on page 228.

Each sample type that you specify for a failure action on the Intelligent Sequencing page must 
be defined in the samples list on the Auto Samples page.

 To add an auto sample type 

1. Click Auto Samples in the Batch View navigation pane.

The Auto Samples page opens. See Auto Samples page.

2. Right-click and choose Add Auto Sample from the shortcut menu, or click the Add New 
Auto Sample icon, .

The application adds a Solvent sample to the sample list.

You can add, insert, or remove samples from this list as you would any sample list. See 
“Samples Page” on page 406.

3. To change the sample type to a Matrix Blank, click the Sample Type column and select 
Matrix Blank from the list.

4. In the Injection Volume column for the sample, type a volume.

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

5. In the Number of Injections column, type the number of injections available in the 
designated Solvent or Matrix Blank vial.

After auto sample injections have occurred, you can return to this page to view the 
number of Injections Used in each vial.

6. In the Vial Position column, type the vial position for the Solvent or Matrix Blank 
sample. 
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Auto Samples Page

Use the Auto Samples page to specify the sample types to use with Intelligent Sequencing.

Figure 132. Auto Samples page

Table 103. Auto Samples page parameters

Column Description

Sample Type The sample type for the auto sample injection as specified on the 
Intelligent Sequencing page—either Solvent or Matrix Blank. 

Default: Solvent

Injection Volume The injection volume used for the sample acquisition as specified on 
the Samples page.

Valid range: 0.1 through 5000 μL

Injections Used The number of times a vial has been used. The count is cumulative 
across all batches.

Number of 
Injections

The number of injections available in the designated Solvent or Matrix 
Blank vial.

Vial Position Vial position for this sample type as specified on the Samples page. 
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Reference Sample Page

The Reference Sample page displays the reference samples that you selected for this batch.

 To specify a chromatogram reference sample

1. In the Batch View, click Reference Samples.

An empty reference sample table opens.

2. Click the Add Reference Sample icon, , or right-click and choose Add 
Reference Sample from the shortcut menu.

The Open Chromatogram Reference Sample dialog box opens.

3. Select a project from the list of projects.

4. Select a subproject from the list of subprojects.

5. Select a batch from the list of batches.

The application displays only batches that were created using the current master method. 

6. Select a sample from the list of processed samples.

The application displays all the processed samples in the selected batch. Before using a 
sample as a reference sample, you must have processed the sample with the current master 
method.

7. Click Open.

Note  If you are using a new method, no reference samples appear here. You must first 
process a batch using the current method to see the reference samples in this list.
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Threshold Samples Page

For each group in a batch, you can specify a sample in the group as the threshold sample to 
use in the Comparative View.

 To specify a threshold sample

1. In the Batch View, click Threshold Samples.

2. Click the Sample list for each group and select a sample in the group to be the threshold 
sample.

The Comparative View uses the threshold method and amount you specified in the method, 
the group you created on the Samples page, and the threshold sample you selected on this 
page to define the threshold guide that it displays in the sample peak plots.

For information about specifying the method to use for creating a threshold guide, see 
“Threshold” on page 223.

For information about creating groups, see “Groups” on page 410.

For information about using the threshold guide in the Comparative View, see “Comparative 
View” on page 468.
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Working in Data Review
In the Data Review view, you can view the data generated by the master method. Use Data 
Review to verify the data for a compound before you generate reports. 

 To open the Data Review view

1. Click Analysis in the navigation pane.

The Analysis navigation pane opens.

2. Click Data Review.

The Data Review navigation pane opens. 

Choose from a Sample View, Compound View, Comparative View, or Qualitative View to 
analyze the data generated by the master method.

 To move, dock, or float Data Review panes

Follow the instructions in Appendix D, “Moving Data Review Panes.” 

 To restore the default layout

Choose View > Restore Default Layout.

The Sample View, Compound View, Comparative View, and Qualitative View have their 
own defaults for which panes are displayed and in which location.

See the following topics:

• Sample View

• Compound View

• Comparative View

• Qualitative View

• Features Common to All Data Review Pages
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Sample View

The Sample View displays the following information in three different panes: a list of all 
samples in the current batch, the compound results for all compounds in the method, and 
peak plots for all compounds found in the currently selected sample. 

These are the default panes and their locations:

When you select a sample in the Samples Pane, the associated Compound Results Pane flags 
any compound with errors in the selected sample. The associated Sample Peaks Pane displays 
the chromatogram, retention time, area, height, and signal-to-noise ratio for all compounds in 
the selected sample. The Sample Peaks pane highlights the compound selected in the 
Compound Results pane.

The Sample View display includes the following features:

• Samples Pane

• Compound Results Pane

• Sample Peaks Pane

• Caution Flags

• Viewing Sample View Panes

Samples pane Compound Results paneSample Peaks pane
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Samples Pane

Use the Samples pane in the Sample View to select a specific sample. The associated 
Compound Results Pane displays all compounds in the method and flags any compound with 
errors in the selected sample.

 To hide or display columns in the Samples pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Samples pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Samples pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 

Note  The Field Chooser also lists any custom columns that you defined in the 
Configuration Console. See “Creating Custom Columns” on page 63.



9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

450 TraceFinder User Guide Thermo Scientific

Figure 133. Samples pane

 

Table 104.  Samples pane columns 

Column Description

Flags Caution flag displayed when a compound in the sample has an error. See 
“Caution Flags” on page 454.

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.
Note   When you include unknown screening features in the 
quantitation method and you choose to process with only the 
quantitation criteria, the Sample View shows the Status for the samples 
as acquired and processed ( ), and the Unknown Screening View 
shows the Status for the samples as acquired but not processed ( ). 
Note  When you include unknown screening features in the quantitation 
method and you choose to process with only the unknown screening 
criteria, both the Sample View and the Unknown Screening View show 
the Status for the samples as acquired and processed ( ). 

Sample Name A user-defined name that identifies a sample.
Sample Type Defines how the application processes the sample data. Each sample is 

classified as one of the following sample types: Matrix Blank, Solvent, Cal 
Std, QC Std, or Unknown.

Comments User-defined comments for the sample.
Excluded Turns a compound on or off in the calibration curve in the Compound 

Details pane. 
Filename A user-defined name that identifies a sample.
Level The level defined for a calibration sample or quality control sample.
Sample ID A user-defined, alphanumeric string that identifies a sample.

No compound error in the selected sample

Compound error in the selected sampleSelected sample
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Compound Results Pane

Use the Compound Results pane in the Sample View to select a specific compound in the 
selected sample. The associated Sample Peaks Pane highlights the selected compound.

 To hide or display columns in the Compound Results pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Compound Results pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application displays or hides the column in the Compound Results pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 
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Figure 134. Compound Results pane

 

Table 105.  Compound Results pane columns 

Column Description

Flags Caution flag displayed when the compound has an error. See 
“Caution Flags” on page 454.

Compound Compound names as identified in the library.

Compound Type Specified compound type: Target Compound or Internal 
Standard.

The remainder of the columns in the results list are common to the Compound Results 
pane in the Sample View and the Sample Results pane in both the Compound View and the 
Comparative View. See “Common Column Parameters” on page 490.
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Sample Peaks Pane

The Sample Peaks pane in the Sample View displays the chromatogram, retention time, area, 
height, and signal-to-noise ratio for all compounds in the Compound Results pane. The 
application highlights the chromatogram for the compound that is currently selected in the 
Compound Results pane.

 To display details for a compound

Double-click the chromatogram in the Sample Peaks pane.

The Compound Details pane opens.

The Compound Details pane displays information about the quantitative peak, 
calibration curve, confirming ion, internal standard, reference peak, ion overlay, and 
spectra for the compound.

For a detailed description of the available information in the Compound Details pane, see 
“Compound Details” on page 498.
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Caution Flags 

In the Sample View, the application displays caution flags in both the Samples pane and the 
Compound Results pane.

See the following topics:

• Flags in the Samples Pane

• Flags in the Compound Results Pane

• Error Indicators in the Sample Peaks Pane

Flags in the Samples Pane

The Flags column in the Samples pane displays a caution flag if any compound in the sample 
is not in compliance with the method criteria. 

Click the caution flag icon, , to display the details. Information in the pop-up box shows 
the compound that is in error and describes the exact error condition.

Flags in the Compound Results Pane

The Flags column in the Compound Results pane displays a flag if the compound in the 
selected sample is not in compliance with the method criteria. 

Error condition

Compound name

Error condition of the Sulfisomidine 
compound in the selected sample

Selected sample
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Hold your cursor over the flag icon, , to display details for the compound in the selected 
sample.

Flags in the Compound Results pane indicate the following:
 

A red flag for compounds that have violated (or are activated by) any of the values 
set in the method. See “Editing the QAQC Page” on page 217.

A red flag for compounds that are outside the specified ion ratio range. See Ion ratio 
failure flag.

An orange flag for compounds that are below the LOQ, below the LOD, or 
between the LOD and LOQ values specified in the method. For descriptions of 
these limits, see “Limits” on page 218.

A green flag for “found” compounds that are over the LOR amount specified in the 
method. For a description of the LOR limit, see “Limits” on page 218.

A yellow flag for compounds that are equal to or below the LOR amount specified 
in the method.

A yellow flag for compounds that are not found in Calibrator or QC sample types. 
The Compound Results pane does not flag compounds that are not found in 
Specimen sample types. 

No flag for compounds that have no errors or where no report options are selected.

Note  These criteria for flag states do not apply to Matrix Blank sample types when the 
compound is an internal standard.
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Error Indicators in the Sample Peaks Pane

In the Sample Peaks pane, peak plots are outlined with the color of their associated error flag. 
In the following example, the FENTHION peak plot is highlighted in blue to indicate that 
FENTHION is the selected compound, and the Sulfisomidine peak plot is outlined in red to 
indicate that the Sulfisomidine compound in the selected sample is outside the specified ion 
ratio range.

Figure 135. Ion ratio failure flag
Red flag indicating ion ratio failure

Peak with ion ratio failure outlined in redSelected peak
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Viewing Sample View Panes

The Sample View displays data using multiple panes: Samples, Compound Results, Sample 
Peaks, and Compound Details. You can display, hide, or move any of these panes.

 To display or hide a Sample View pane

From the View menu, choose from the following:

• Compounds with Data: Displays or hides the Compound Results pane.

• Sample View Peaks: Displays or hides the Sample Peaks pane.

• Compound Details: Displays or hides the Compound Details pane.

A check mark indicates a displayed pane.

Note  The Samples pane is required for the Sample View display. You cannot hide the 
Samples pane.
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Compound View

The Compound View uses three different panes to display a list of all compounds available in 
the method, all samples in the current batch, and the peak plots for all compounds found in 
each sample.

These are the default panes and their locations:

When you select a compound in the Compounds Pane, the Sample Results Pane flags any 
sample that contains errors associated with the selected compound. The Sample Peaks Pane 
highlights the selected compound, displays the name of the sample in which the compound 
was found, and, for the compound, displays the chromatogram, retention time, area, height, 
and signal-to-noise ratio.

The Compound View includes the following features:

• Compounds Pane

• Sample Results Pane

• Sample Peaks Pane

• Caution Flags

Compounds pane Sample Results paneSample Peaks pane
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Compounds Pane 

Use the Compounds pane in the Compound View to select a specific compound. The Sample 
Results Pane displays all samples in the batch and flags any sample that contains errors 
associated with the selected compound.

 To hide or display columns in the Compounds pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Compounds pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Compounds pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 

Figure 136. Compounds pane

 

Table 106. Compounds pane columns 

Column Description

Flags Caution flag displayed when a compound has an error in any of the samples.
Compound Compound names as identified in the library. If there is no library selected in 

the method template, the compound name is identified as peak@RT.
Compound 
Type

Specified compound type: Target Compound or Internal Standard.

Expected RT Expected retention time for the compound.

Selected compound No error associated with 
the selected compound in 
these samples

Error associated with 
the selected compound 
in this sample
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Sample Results Pane

Use the Sample Results pane in the Compound View to select a specific compound in a 
specific sample. The Sample Peaks pane highlights the selected compound and displays the 
name of the sample in which the compound was found and the following information about 
the compound: chromatogram, retention time, area, height, and signal-to-noise ratio. See 
Sample Results pane.

 To hide or display columns in the Sample Results pane

1. Click the Field Chooser icon, , in the upper left corner of the pane. 

The Field Chooser displays all available columns of data for the Sample Results pane.

Note  The Field Chooser also lists any custom columns that you defined in the 
Configuration Console. See “Creating Custom Columns” on page 63.
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2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Sample Results pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 

Figure 137. Sample Results pane

Table 107. Sample Results pane columns  (Sheet 1 of 2)

Column Description

Acquisition Order Sequentially numbers the samples.

Flags Caution flag displayed when a compound within the sample has 
an error. 

Flag Details Indicates the type of error:
• I: Confirming ion coelution failure or Ion ratio failure
• A: Amount error
• B: Matrix blank error
• H: Peak not found
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Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Note   When you include unknown screening features in the 
quantitation method and you choose to process with only the 
quantitation criteria, the Sample View shows the Status for the 
samples as acquired and processed ( ), and the Unknown 
Screening View shows the Status for the samples as acquired but 
not processed ( ). 

Note  When you include unknown screening features in the 
quantitation method and you choose to process with only the 
unknown screening criteria, both the Sample View and the 
Unknown Screening View show the Status for the samples as 
acquired and processed ( ). 

Filename A user-defined name that identifies a sample.

Sample Type Defines how the application processes the sample data. Each 
sample is classified as one of the following sample types: Matrix 
Blank, Solvent, Cal Std, QC Std, or Unknown.

The remainder of the columns in the Sample Results pane are common to both the Sample 
View and the Compound View displays. See “Common Column Parameters” on page 490.

Table 107. Sample Results pane columns  (Sheet 2 of 2)

Column Description
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Sample Peaks Pane

The Sample Peaks pane in the Compound View displays the compound chromatogram, 
retention time, area, height, and signal-to-noise ratio associated with the selected compound 
in each of the samples in the batch. The application highlights the compound chromatogram 
for the sample that is currently selected in the Sample Results pane.

 To display details for a compound

1. Double-click the chromatogram in the Sample Peaks pane.

The application adds the Compound Details pane to the window.

The Compound Details pane displays information about the quantitative peak, calibration 
curve, confirming ion, internal standard, reference peak, ion overlay, and spectra for the 
compound.

For details about the available information in the Compound Details pane, see “Compound 
Details” on page 498.
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Caution Flags 

In the Compound View, the application displays caution flags in both the Compounds pane 
and in the Sample Results pane.

See the following topics:

• Flags in the Compounds Pane

• Flags in the Sample Results Pane

• Error Indicators in the Sample Peaks Pane

Flags in the Compounds Pane

The Flags column in the Compounds pane displays a caution flag if the compound in any of 
the samples is not in compliance with the method criteria. 

Click the caution flag icon, , to display the details. Information in the pop-up box shows 
the sample where the compound is in error and describes the exact error condition.

Flags for the Sulfisomidine compound 
in each sample

Selected Sulfisomidine compound 

Error condition

Sample name
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Flags in the Sample Results Pane

The Flags column in the Sample Results pane displays a flag if the selected compound in the 
sample is not in compliance with the method criteria. 

Hold your cursor over the flag icon, , to display the details for the selected compound in 
the sample.

Flags in the Sample Results pane indicate the following:
 

Flag Description

A green flag for compounds that are over the LOR amount specified in the 
method.

A red flag for compounds that have violated (or are activated by) any of the values 
set in the method. See “Editing the QAQC Page” on page 217.

A red flag for compounds that are outside the specified ion ratio range. See Ion 
ratio failure flag.

An orange flag for compounds that are not found in Cal Std or QC Std sample 
types.

“Not found” compounds are below the LOQ, below the LOD, or between the 
LOD and LOQ values specified in the method. The Sample Results pane does 
not flag compounds that are not found in Unknown sample types. 

No flag for compounds that have no errors or where no report options are 
selected.

Note  These criteria for flag states do not apply to Matrix Blank sample types when the 
compound is an internal standard.
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Error Indicators in the Sample Peaks Pane

In the Sample Peaks pane, peak plots are outlined with the color of their associated error flag. 
In the following example, the peak plot is highlighted in blue to indicate that Benzo_25557 is 
the selected sample and outlined in red to indicate that the FENTHION compound in the 
selected sample is outside the specified ion ratio range.

Figure 138. Ion ratio failure flag

Red flag indicating ion ratio failure

Peak with ion ratio failureSelected peak
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Viewing Compound View Panes

The Compound View displays data using multiple panes: Compounds, Sample Results, 
Sample Peaks, and Compound Details. You can display, hide, or move any of these panes.

 To display or hide a Compound View pane

From the View menu, choose from the following:

• Samples with Data: Displays or hides the Sample Results pane.

• Compound View Peaks: Displays or hides the Sample Peaks pane.

• Compound Details: Displays or hides the Compound Details pane.

A check mark indicates a displayed pane.

For procedures about creating docked, floating, or tabbed panes, see “Moving Data 
Review Panes” on page 739.

Note  The Compounds pane is required for the Compound View display. You cannot 
hide the Compounds pane.
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Comparative View

The Comparative View uses three panes to display a list of all compounds available in the 
method, all samples in the current batch, and the sample peak plots for all compounds found 
in the samples with the horizontal threshold guide.

These are the default panes and their locations:

The panes in the Comparative View are identical to the Compound View with the addition of 
the Group column in the Sample Results. This column identifies any groups that a sample 
belongs to, as specified in the Batch View. 

The following factors define the threshold guide that the Comparative View displays in the 
sample peak plots:

• The threshold method and amount that you specified in the method

• The group that you created on the Sample page

• The threshold sample that you selected on the Threshold Samples page

Compounds pane Sample Results paneSample Peaks pane

Horizontal guide indicates 
the threshold value as 
specified in the method.
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See the following topics:

• Configuring Sample Peaks Display Settings

• Manually Integrating Peaks

For information about specifying the method to use for creating a threshold guide, see 
“Threshold” on page 223.

For information about creating groups, see “Groups” on page 410.

For information about specifying a threshold sample, see “Threshold Samples Page” on 
page 446.

Configuring Sample Peaks Display Settings

The Sample Peaks pane in the Comparative View displays one row per compound and one 
column per sample. The Sample Peaks pane displays all samples in a group when you select 
any of the samples belonging to that group.

For information about creating groups, see “Groups” on page 410.

 To change the Sample Peaks pane display

1. From the View menu, choose Chromatogram Pane Settings.

The Chromatogram Plot Settings dialog box opens. See “Chromatogram Plot Settings 
Dialog Box” on page 472.

2. To change the number of rows or columns to fit in the Sample Peaks pane, type new 
values in the Number of Rows or Number of Columns boxes.

These values do not change the number of rows (compounds) and columns (samples) that 
are available in the Sample Peaks pane. These values determine how many rows and 
columns you want to view at one time in the display. The default is three rows and three 
columns.

In the following examples, the Number of Rows and Number of Columns are set to 1 
(Number of Rows equals 1 and Number of Columns equals 1) and the Number of Rows 
and Number of Columns are set to 4 (Number of Rows equals 4 and Number of 
Columns equals 4).
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Figure 139. Number of Rows equals 1 and Number of Columns equals 1

Figure 140. Number of Rows equals 4 and Number of Columns equals 4

Because there are only three 
samples, this column is empty.
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3. To change the display type for the y-axis scale, select one of the following:

• Relative: Displays the y-axis scale from 0 through 100.

• Absolute: Displays the y-axis scale from 0 to the actual value of the most intense peak 
in the group.

• Label in Scientific Notation: Displays the y-axis scale in scientific notation.

4. Specify which labels you want to display in the sample peak plots.

For an example of all available peak plot labels, see Peak Plot Labels.

Note  The Sample Peaks pane displays a y axis only in the first chromatogram in each 
row. The limits of the scale are determined by the most intense peak in the group.

Vertical bars indicate the 
expected retention time 
and window, as specified 
in the method.

Horizontal bar indicates 
the threshold value as 
specified in the method.
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Chromatogram Plot Settings Dialog Box

Use the Chromatogram Plot Settings dialog box to change the Sample Peaks pane display.

Table 108. Chromatogram Plot Settings dialog box parameters  (Sheet 1 of 2)

Parameter Description

Number of Rows Specifies the number of rows visible in the Sample Peaks pane. 
When Number of Rows equals 1, the application scales the height 
of all chromatograms to fill the Y dimension of the Sample Peaks 
pane. 

Default: 3

Number of Columns Specifies the number of columns visible in the Sample Peaks pane. 
When Number of Columns equals 1, the application scales the 
width of all chromatograms to fill the X dimension of the Sample 
Peaks pane.

Default: 3

Y-Axis Type Displays the y-axis scale as Relative (to the most intense peak), 
Absolute, or in scientific notation.
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Peak Plot Labels Displays or hides the following peak labels:
• RT
• Area
• Height
• Filter
• Threshold
• Show All Apex Times
• Sample Filename
• Compound Name
• Signal to Noise

Example with all peak labels displayed:

Table 108. Chromatogram Plot Settings dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Manually Integrating Peaks

Use the manual integration feature to manually add a peak. You can manually add a peak in a 
chromatogram plot only when the application fails to identify a peak.

 To manually integrate a peak

1. In the Sample Peaks plot, click the Manual Integration icon.

The cursor changes to look like this:

2. Integrate a peak as follows:

a. Drag the cursor to define the beginning and ending base points for the new peak.

b. Click outside the plot to refresh the display.

3. To zoom in on an area, do the following:

a. Drag the cursor below the x axis or to the left of the y axis.

The plot zooms to fit the defined X or Y dimension into the entire pane. The 
application zooms all compounds in the row to the same scale.

b. To return to the original view, right-click and choose Reset Scaling from the shortcut 
menu.

Note  You must drag the cursor inside the x axis and y axis.

Manual integration 
icon

Click the first base 
point, and then drag to 
the second base point.

Click outside the plot to 
refresh the view.

The application identifies the peak 
and indicates the manual 
integration in the labels.
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Qualitative View

The Qualitative View uses several different panes to display qualitative information for the 
selected sample. See Displaying Qualitative View Panes. 

If the application finds no detected peaks for the selected sample, you can manually add 
peaks.

To see processed data for a sample in the Qualitative View, you must select the Qual 
Processing parameter for that sample in the Batch View before you process the batch. See 
“Batch View Sample List” on page 415.

These are the default panes and their locations:
Peaks pane

Sample 
chromatogram pane

Peak Chromatogram 
pane

 Spectrum pane  Library Hits pane

Samples pane
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The Qualitative View displays data in the following panes:

• Samples Pane

• Peaks Pane

• Sample Chromatogram Pane

• Peak Chromatogram Pane

• Spectrum Pane (Library and Data)

• Library Hits Pane

Displaying Qualitative View Panes

The Qualitative View displays data using multiple panes: Samples, Peaks, Sample 
Chromatogram, Peak Chromatogram, Spectrum, and Library Hits. You can display, hide, or 
move any of these panes.

 To display or hide a Qualitative View pane

From the View menu, choose to display or hide the following:

• Peaks

• Sample Chromatogram

• Peak Chromatogram

• Spectrum

• Library Hits

A check mark indicates a displayed pane.

For procedures about creating docked, floating, or tabbed panes, see “Moving Data 
Review Panes” on page 739.

Note  The Samples pane is required for the Qualitative View display. You cannot hide 
the Samples pane.
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Samples Pane

Use the Samples pane in the Qualitative View to select a specific sample. The associated Peaks 
Pane displays all peaks found in the selected sample.

 To hide or display columns in the Samples pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Samples pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Samples pane.

3. Click  to close the Field Chooser. 

Figure 141. Samples pane

 

Table 109. Samples pane columns  (Sheet 1 of 2)

Column Description

Acquisition 
Order

Sequentially numbers the samples.

Flags Caution flag displayed when a compound in the sample has an error. See 
“Caution Flags” on page 454. 
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Peaks Pane 

The Peaks pane in the Qualitative View works with the Samples pane to display graphical 
values for a unique sample and peak combination. For detailed descriptions of parameters in 
the Peaks pane, see “Peaks Pane” on page 481.

Follow these procedures:

• To display peaks for a specific compound

• To remove a peak

• To hide or display columns in the Peaks pane

 To display peaks for a specific compound

1. From the Samples pane, select a sample. 

The Peaks pane displays the retention times for peaks identified in the selected sample, 
the values for the best match methods for each peak, and the library match. 

The method specifies which technique to use for identifying peaks: peaks within a specific 
retention time range, as a minimum percentage of the height or area of the largest peak, 
or as a minimum percentage of the nearest internal standard peak. You can change the 
method for identifying peaks in the Method Template Editor. See “Creating a Method 
Template” on page 243.

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.
Note   When you include unknown screening features in the quantitation 
method and you choose to process with only the quantitation criteria, the 
Sample View shows the Status for the samples as acquired and processed 
( ), and the Unknown Screening View shows the Status for the samples as 
acquired but not processed ( ). 
Note  When you include unknown screening features in the quantitation 
method and you choose to process with only the unknown screening 
criteria, both the Sample View and the Unknown Screening View show the 
Status for the samples as acquired and processed ( ). 

Filename A user-defined name that identifies a sample.
Sample 
Type

Defines how the application processes the sample data. Each sample is 
classified as one of the following sample types: Matrix Blank, Solvent, Cal Std, 
QC Std, or Unknown.

Table 109. Samples pane columns  (Sheet 2 of 2)

Column Description
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2. In the Peaks pane, select a peak in the sample.

The application displays the selected peak in the Peak Chromatogram pane, displays the 
Qual Data and Qual Library sections in the Spectrum pane, and locates the selected peak 
in the Sample Chromatogram pane.

• The Qual Data section shows spectrum data for the peak in the raw data file.

• The Qual Library section shows actual spectrum for the identified library compound.

Figure 142. Peak Chromatogram pane

 

Note  When you select a data-dependent sample, the peak can be from either a full 
scan or a QED spectrum of an SRM-filtered chromatogram.
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Figure 143. Spectrum pane

Figure 144. Selected peak in the Sample Chromatogram pane

 To remove a peak

1. Select a peak in the Sample Chromatogram pane.

2. Right-click the Peak Chromatogram pane and choose Remove Qual Peak from the 
shortcut menu.

The application removes the selected peak from all Qualitative View panes.

Note  There is no undo for this action, but you can manually add a peak to redefine a 
removed peak. See “Sample Chromatogram Pane” on page 482.

Reference 
spectrum from 
the library

Actual spectrum 
data for the 
compound



 9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

Thermo Scientific TraceFinder User Guide 481

 To hide or display columns in the Peaks pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Peaks pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Peaks pane.

3. When you are finished modifying the column display, click  to close the Field Chooser. 

Peaks Pane

Use the features in the Peaks pane to display graphical values for each sample and peak 
combination.

Figure 145. Peaks pane

Table 110. Peaks pane parameters  (Sheet 1 of 2)

Parameter Description

Filter Filter used to identify the peaks. Specified in the raw data file or the master 
method.

When your raw data file is data-dependent, the filter indicates this with a “d”.

Data-dependent filter



9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

482 TraceFinder User Guide Thermo Scientific

Sample Chromatogram Pane

The Sample Chromatogram pane in the Qualitative View displays all peaks in the selected 
sample. The peak selected in the Peaks pane displays a red marker. See “Sample 
Chromatogram Pane” on page 484.

 To zoom in on a peak

1. In the Sample Chromatogram pane, drag the cursor to delineate a rectangle around the 
peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the Sample Chromatogram pane and choose Reset 
Scaling from the shortcut menu. 

 To manually add a peak

1. Zoom in to better identify which peak to add to the results set.

2. Right-click the Sample Chromatogram pane, and choose Add Qual Peak from the 
shortcut menu.

Peak RT Peak retention time. The time after injection when the compound elutes. The 
total time that the compound is retained on the column. 

SI Search index method used to search the NIST library.

RSI (Reverse search index) A method used to search the NIST library. A reverse 
search compares a library entry to an unknown compound (whereas a forward 
search compares the mass spectrum of an unknown compound to a mass 
spectral library entry).

MP Match probability.

Est Amt Estimated amount of the compound.

Library Hit Library compound that matches the identified peak.

Table 110. Peaks pane parameters  (Sheet 2 of 2)

Parameter Description
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3. Click to indicate the left and right base points for the peak. 

The application marks the peak in the Sample Chromatogram pane.

The application places the peak delimiter tags at the base point locations and 
automatically updates the peak values in the Peaks pane and Peak Chromatogram pane. 
See Peak Chromatogram pane with a manually added peak.

Figure 146. Peak Chromatogram pane with a manually added peak

Manually added 
base points
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Sample Chromatogram Pane

Use the features in the Sample Chromatogram pane to display peaks in the selected sample.

Figure 147. Sample Chromatogram pane 

 

Peak Chromatogram Pane 

The Peak Chromatogram pane in the Qualitative View displays the selected peak. For a 
description of commands in the shortcut menu, see “Peak Chromatogram Pane” on page 486.

Follow these procedures:

• To zoom in on a peak

• To manually add a peak

• To remove a peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Table 111. Sample chromatogram pane shortcut menu commands

Command Description

Add Qual Peak Select the beginning and ending base points for a new 
qualitative peak. Available only when no peak is detected. 

Reset Scaling Resets the original scaling after a zoom operation.
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 To manually add a peak

1. Right-click anywhere in the Peak Chromatogram pane, and choose Add Qual Peak from 
the shortcut menu.

If a peak is already detected, the Add Qual Peak command is not activated. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

 To remove a peak

Right-click the Peak Chromatogram pane, and choose Remove Qual Peak from the 
shortcut menu.

The application removes the peak displayed in the Peak Chromatogram pane. All data for 
this peak are removed from the Qualitative View panes.

 To switch between method and manual integration modes

Right-click the Peak Chromatogram pane and choose either Method Integration or 
Manual Integration from the shortcut menu. 

Initially, the method integration and manual integration settings that are stored for a 
compound and file are identical. When you switch modes, the saved result set does not 
change. However, when manual data are available, the Peak Chromatogram plots update 
and the result set updates as you switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

Manually added base points
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 To change the displayed information for detected peaks

1. Right-click the Peak Chromatogram pane and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time (RT), peak height (AH), peak area 
(AA), or signal-to-noise (SN).

3. To remove a label, choose the label type again to clear it.

Peak Chromatogram Pane

Use the features in the Peak Chromatogram pane to display the selected peak. 

Figure 148. Peak Chromatogram pane

Table 112. Peak Chromatogram pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.

Method Integration Displays method integration settings.

Manual Integration Displays manual integration settings.

Peak Labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label to Noise).

Remove Qual Peak Available only for manually added peaks. Removes the 
peak displayed in the Peak Chromatogram pane. 

Label not displayed in the chromatogram

Label displayed in the chromatogram
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Spectrum Pane (Library and Data)

The Spectrum pane in the Qualitative View displays the reference spectrum from the library 
and the spectrum data for the selected sample. The top pane displays the spectrum for the 
identified compound found in the reference library; the bottom pane displays the actual 
spectrum data for the selected peak.

Figure 149. Spectrum pane

 To zoom in on a peak

1. In either spectrum plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the default view, right-click the spectrum plot and choose Reset Scaling from 
the shortcut menu. 

Reference 
spectrum from 
the library

Actual spectrum 
data for the 
compound
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Library Hits Pane 

The Library Hits pane in the Qualitative View displays the best library matches for the 
selected peak. Use this pane to select a different library entry for the peak. For detailed 
descriptions of the Library Hits pane parameters, see Library Hits pane.

When you select a library entry other than the original entry, the TIC Report and TIC 
Summary Report indicate this with a “P” flag:

 To change the library entry for a selected peak

In the Library Hits pane, select the check box for the library entry that you want to use to 
identify the selected peak.

• In the Spectrum pane, the reference spectra change to show the spectra for the 
selected library entry.

• In the Peaks pane, the SI, RSI, MP, and Compound values update to reflect the 
selected library entry.

P flag

Selected library entry 
in the Library Hits pane

Reference spectra 
for Hexanone 

Peak list for 
Hexanone
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Figure 150. Library Hits pane

Table 113. Library Hits pane parameters

Parameter Description

<Check box column> Indicates selected library entries for the selected peak.

Rank Indicates the order of best matches between the selected 
peak and library entries.

SI (Search index) A method used to search the NIST library.

RSI (Reverse search index) A method used to search the NIST 
library. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares 
the mass spectrum of an unknown compound to a mass 
spectral library entry).

MP Match probability.

Library Entry Library compound that matches the identified peak.
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Features Common to All Data Review Pages 

The following parameters and features are common to all quantitation batch data review 
pages:

• Common Column Parameters

• Inactive and Excluded Compounds

• Compound Details

• Exporting Compounds

Common Column Parameters

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 1 of 7)

Column Description

%CV Coefficient of Variance. Standard deviation of the multiple samples of one level, multiplied 
by 100, and divided by the average of the multiple samples of that level. This calculation is 
based on the areas of the peaks.

%Diff The calculated amount minus the expected amount, divided by the expected amount, and 
then multiplied by 100.

%RSD Standard deviation of the multiple samples of one level, multiplied by 100, and divided by 
the average of the multiple samples of that level. This calculation is based on the calculated 
amounts.

Note   This RSD value is not the same as the RSD value used with the Average RF curve 
type in the method. See “Calibration” on page 204. 
The application uses this %RSD value in Data Review and in the Compound Calibration 
Report when you acquire multiple samples for the same QC Std or Cal Std samples.

Active Displays or hides a compound for a particular sample. 

• When a compound is marked inactive, the application does not remove its data and 
calculated values from the result set. Instead, the application masks the appearance of 
that compound for that particular sample and grays the compound in the compounds 
list. 

• When a calibration standard is marked inactive, the application no longer uses the data 
file’s calibration point for the calibration and removes it from the graphical view of the 
calibration curve displayed in the Compound Details pane. It is no longer part of the 
result set. 

In a Sample View, the Active parameter is in the Compound Results pane.

In a Compound View, the Active parameter is in the Sample Results pane.

Acquisition Order Sequentially numbers the samples.
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Actual RT Actual retention time for the compound. Retention time is the time after injection when a 
compound elutes and the total time that the compound is retained on the chromatograph 
column.

Adduct The most intense adduct for the retention time for a compound.

Area The area obtained by integrating peak intensities from the start to the end of the peak. 
When the Response Ratio is specified as Area, this column displays an asterisk (*Area).

Calculated Amt The amount present in the sample, as determined using the calibration curve and the 
response ratio.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

Confirm The number of criteria confirmed out of the total number specified in the method.

Expected RT Expected retention time for the compound.

FI Fragment Ions flag. The application displays one of these indicators:
• A green circle (pass) when the measured m/z value of any of the fragments is within the 

mass tolerance specified in the method. On the Isotopes page in the Spectrum pane, the 
All Isotopes and Multi-Isotopes flags are also green.

• A red square (fail) when the measured m/z value of none of the fragments is within the 
mass tolerance specified in the method. On the Isotopes page in the Spectrum pane, the 
All Isotopes and Multi-Isotopes flags are also red.

• A blank when there are no fragments detected.

To display a list of fragments and their pass/fail status, hold your cursor over the indicator. 

Filename Name of the raw data file that contains the sample data.

Final Units Specifies the calculated amount.

Default: 1

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 2 of 7)

Column Description
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Flag Details Indicates all errors found in the compound.

Type of error:
• I: Confirming ion coelution failure
• A: Amount error
• B: Matrix blank error
• PK: Peak not found
• LS: Library matching error
• IP: Isotope error
• FI: Fragment ions error
• IR: Ion ratio error

Flags Caution flag displayed when a compound within the sample has an error. 

Formula The formula for the peak as specified in the compound database.

Fragment n Displays the measured m/z for the fragment ion. The application displays a separate column 
for each found fragment. 

• For each fragment found in the compound database that passes the filter in the method, 
the Compounds table displays the m/z value in green text. 

• For each fragment found in the compound database that does not pass the filter in the 
method, the Compounds table displays the m/z value in red text.

• For each fragment that is not found in the compound database, the Compounds table 
displays N/S (none specified).

Note  Compounds can have a maximum of five fragments, and the Compounds table has 
a maximum of five Fragment columns. When a compound contains fewer than five 
fragments, all remaining Fragment columns display N/S.

Fragment n (Delta 
(ppm/mmu))

The difference between the expected fragment ion m/z from the compound database and the 
measured fragment ion m/z. 

The application displays a separate delta column for each identified fragment.

Group Threshold group to which a sample belongs. You can view samples by group in the 
Comparative View of Data Review.

Height The distance from the peak maximum to the peak base, measured perpendicular to the 
ordinate. When the Response Ratio is specified as Height, this column displays an asterisk 
(*Height).

Integration Mode Integration mode specified in the method. See “Quan Peak” on page 499.

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 3 of 7)

Column Description

Fragment not found in the compound database
Fragment found but does not meet method parameters
Fragment found and meets method parameters
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IP Isotopic Pattern flag. The application displays one of these indicators:
• A green circle (pass) when the score percentage is higher than the specified fit threshold 

percentage.
• A red square (fail) when the score percentage is lower than the specified fit threshold 

percentage.
• A blank when the parameter is not scored.

To display the score of matched isotopes, hold your cursor over the indicator. 

IR Ion Ratio flag. The application displays one of these indicators:
• A green circle when the ion ratio is within the acceptable ion ratio range.
• A red square when the ion ratio is not within the acceptable ion ratio range.

Isotopic Pattern Score 
(%)

The percentage of the number of total isotopes to the number of matched isotopes.

ISTD Amt Amount of internal standard. 

ISTD Response Response of the internal standard.

Lib Match Name The name of the best matching compound in the library search. When the application finds 
a match in the library, this column displays the matching library entry with the highest 
score.

• When the application does not perform a library search, this column displays “N/A” in 
black text.

• When the application does not perform an MS/MS scan, this column displays “N/A” in 
red text.

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 4 of 7)

Column Description
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Library Match Rank Displays the ranking of the library match. When the application finds a match in the library, 
this column displays the library entry’s relative rank, in the format “x of y”, where

• x = the rank of the highest scoring library match.
• y = the total number of library matches from the list of matches for a particular adduct 

that contains the highest scoring match.

Results are as follows when the application performs both a library search and an MS/MS 
scan and both the library entry and the formula match the target compound:

• A library score that is higher than or equal to the score threshold meets the criteria, and 
the values in this column appear in green.

• A library score that is lower than the score threshold fails to meet the criteria, and the 
values in this column appear in red.

When the application does not perform a library search, this column displays “N/A” in 
black text. 
When the application does not perform an MS/MS scan, this column displays “N/A” in red 
text.

Library Score (%) The score from the library fit. When the application finds a match in the library, this 
column displays the highest score associated with the Lib Match Name parameter. 

Results are as follows when the application performs both a library search and an MS/MS 
scan and both the library entry and the formula match the target compound:

• A library score that is higher than or equal to the score threshold meets the criteria, and 
the values in this column appear in green.

• A library score that is lower than the score threshold fails to meet the criteria, and the 
values in this column appear in red.

When the application does not perform a library search, this column displays “N/A” in 
black text. 

When the application does not perform an MS/MS scan, this column displays “N/A” in red 
text.

Valid range: 1 through 100%

LS Library Search flag. The application displays one of these flags:
• A green circle when the library search is successful.
• A red square when the library search is not successful.

m/z (Apex) Mass-to-charge ratio found in the spectra for the peak. Assumes that the charge is 1.

When the application successfully integrates the peak, this column displays the charged m/z 
value for the compound, which is the highest intensity in the apex scan. 

When the application cannot successfully integrate the peak, this column displays “N/F” 
(not found).

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 5 of 7)

Column Description
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m/z (Delta (mmu)) Difference between the m/z (Expected) and m/z (Apex). Assumes that the charge is 1.

When the m/z (Apex) column displays m/z value for the compound, this column displays 
the delta m/z corresponding to the highest intensity in the apex scan.

• When the mass tolerance is specified in ppm in the master method, then
m/z (Delta) = 1 000 000 × ([m/z (Apex) – m/z (Expected)] × m/z (Expected)).

• When the mass tolerance is specified in mmu in the master method, then 
m/z (Delta) = 1000 × m/z (Apex) – m/z (Expected)).

m/z (Expected) Mass-to-charge ratio from the compound database. Assumes that the charge is 1. 

• When an adduct is found, the application displays the neutral mass value for the 
compound (calculated from the neutral formula) ± the mass of the most intense adduct 
ion found for the compound. 

• When no adduct is found, the application displays the neutral mass value for the 
compound ± the mass of the first adduct entered in the compound database. 

For details about defining adducts for the compound database, see “Specifying Adducts” on 
page 53.

For details about adding adducts to compounds, see “Editing Compounds in the Database” 
on page 84.

Note  When the adduct is a gain, the adduct mass is a positive number. When the adduct 
is a loss, the adduct mass is a negative number. The resulting mass value after adding or 
subtracting the adduct mass is always a positive number.

Num Isotopes Matched The number of isotopes matched in the expected calculated isotope spectra relative to the 
total number of isotopes used in the score calculation, in the format “x of y”, where

• x = the number of isotopes matching the elemental composition used for the Isotopic 
Pattern Score calculation.

• y = the total number of isotopes considered in the Isotopic Pattern Score calculation. 
This is the number of isotope peaks expected to be above the spectral noise.

PK Peak found 

The application displays one of these flags:
• A green circle when the peak is found.
• A red square when the peak is not found.

Response Ratio The ratio of the Response value to the IS Response value. If the Response is specified as Area 
in the processing method, the units of both Response and IS Response are counts-sec. If the 
Response is specified as Height in the processing method, the units of both Response and IS 
Response are counts.

RT Delta Difference between the expected retention time and the measured retention time.

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 6 of 7)

Column Description
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Inactive and Excluded Compounds

Use the Active and Excluded columns to control which compounds are used for calculating 
the calibration curve and for reporting. 

Follow these procedures:

• To make a sample active or inactive

• To exclude a calibration point

Sample Amt The injected volume multiplied by the conversion factor. For example, if you have 
1000 ng/mL of a substance that is too concentrated for the mass spectrometer, you can 
dilute it by 1000. Then your injection volume is 1, your conversion factor is 1000, and your 
sample amount is 1000. 

Sample Type Defines how the application processes the sample data. Each sample is classified as one of 
the following sample types: Matrix Blank, Solvent, Cal Std, QC Std, or Unknown.

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Note   When you include unknown screening features in the quantitation method and you 
choose to process with only the quantitation criteria, the Sample View shows the Status for 
the samples as acquired and processed ( ), and the Unknown Screening View shows the 
Status for the samples as acquired but not processed ( ). 

Note  When you include unknown screening features in the quantitation method and you 
choose to process with only the unknown screening criteria, both the Sample View and 
the Unknown Screening View show the Status for the samples as acquired and processed 
( ). 

Theoretical Amt Theoretical amount of the compound expected in the sample. 

Excluded Turns a compound on or off in the calibration curve in the Compound Details pane. 

Table 114. Common parameters for Compound Results and Sample Results tables (Sheet 7 of 7)

Column Description
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 To make a sample active or inactive

1. Select the sample in the Sample Results pane.

All compounds in the selected sample appear in the Compounds pane. Inactive 
compounds are grayed out.

2. In the Compounds pane, select the compound whose active/inactive status you want to 
change.

• When a compound it marked inactive, the application does not remove its data and 
calculated values from the result set. Instead, the application masks the appearance of 
that compound for that particular sample and grays the compound name in the 
compounds list. 

• When a calibration standard is marked inactive, the application no longer uses the 
data file’s calibration point for the calibration and removes it from the graphical view 
of the calibration curve displayed in the Qualification pane. The calibration point is 
no longer part of the result set. 

3. In the Sample Results pane, select or clear the Active check box. 

Use the horizontal scroll bar at the bottom of the table to scroll to the Active column.

 To exclude a calibration point

In the sample list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

The application displays a value that is no longer used for calibration as an empty box in 
the graphical view of the calibration curve.

Note  Only calibration samples have the Excluded check box available.

Excluded 
calibration 
point
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Compound Details

Use the Compounds Details pane to display any of the following types of data:

• Quan Peak

• Confirming Ions

• Calibration Curve

• Ion Overlay

• ISTD

• Reference Peak

• Spectra

• Library Match

• Isotope

• Fragments

 To open the Compound Details pane

1. Double-click the chromatogram in the Sample Peaks pane.

The Compound Details pane opens.

By default, the first display pane shows the quantitative peak for the selected compound.

2. In the second pane, select the additional type of data that you want to display. 

Follow these procedures to change the display of the peak data in either of the panes:

• To change the peak panes

• To zoom in on a peak
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 To change the peak panes

In any of the peak panes, click  to view a list of commands.

 To zoom in on a peak

1. In any of the views, drag your cursor to delineate a rectangle around the peak or spectra. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Quan Peak

A compound can have multiple quantitative peaks. You can switch between quantitative 
peaks, but you cannot view multiple quantitative peaks at the same time. The Quan Peak 
pane uses a unique shortcut menu. See “Quan Peak pane shortcut menu commands” on 
page 503.

Figure 151. Quantitative peak pane with multiple quantitative peaks

Command Description

Make All Panels 
the Same Size

Evenly divides the area to make all panes the same width. This 
command does not change the pane height.

Move Panel Left Moves the current panel one space to the left. This command is 
not available when the current pane is the leftmost pane.

Move Panel Right Moves the current panel one space to the right. This command is 
not available when the current pane is the rightmost pane.

Add a Panel Adds an empty peak pane to the display. You can display a 
maximum of four peak panes.
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Follow these procedures to modify the quantitative or confirming ion peak data:

• To manually add a peak

• To remove a manually created peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

• To modify the peak detection settings

 To manually add a peak

1. Right-click anywhere in the quantitative peak pane, and choose Add Quan Peak from 
the shortcut menu.

2. Click the left base of the peak that you want to identify.

3. Drag to the right base and release the mouse.

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

 To remove a manually created peak

Right-click the pane, and choose Cancel Add Peak from the shortcut menu.

The application cancels the Add Peak operation. If you have already completed adding 
the peak, select the peak and then choose Remove Quan Peak from the shortcut menu.

 To manually integrate a quantitative peak 

1. Hold your cursor over one of the two peak delimiter tags in the peak pane.

When the tag can be selected, the cursor changes to a crosshair-style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

Manually added right 
and left base points

Crosshair cursor
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2. Drag the peak delimiter tag to another location and automatically update the peak values 
(area, height, and so forth) into the result set. 

The generated reports for these data identify the manual modifications.

You can store two peak value sets (method and manual integration settings) with each 
compound in each file. These settings can result in a different set of stored values. The 
application originally calculates the method values based on the processing method 
parameters. The manual values are a result of what you have edited. 

 To switch between method and manual integration modes

Right-click the chromatogram view and choose either Method Integration Settings or 
Manual Integration Settings from the shortcut menu. 

Initially, the method integration and manual integration settings that are stored for a 
compound and file are identical. When you switch modes, the saved result set does not 
change. However, when manual data are available, the chromatogram plots update and 
the result set updates as you switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

 To change the displayed information for detected peaks

1. Right-click the peak pane and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and are cleared for labels that are 
not displayed.

3. To remove a label, choose the label type again and clear it.

Label settings are globally applied to quantitative peaks, confirming ion peaks, and 
internal standard peaks. 

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, and then reselect the compound whose labels you changed.



9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

502 TraceFinder User Guide Thermo Scientific

 To modify the peak detection settings

1. Right-click the chromatogram view and choose one of the following from the shortcut 
menu:

• Peak Detection Settings > Edit Local Method Peak Detection Settings: Makes 
changes to the selected compound for all samples in this batch. 

• Peak Detection Settings > Edit User Defined Peak Detection Settings: Makes 
changes to the selected compound for only the selected sample. The application saves 
these changes with the batch and stops applying the local method detection settings 
to the compound for this sample only.

The Peak Detection Settings dialog box opens where you can adjust detection settings 
that were specified in the method. The title bar of the dialog box lists the selected 
compound and indicates whether you are making changes to only the selected sample or 
to the local method. 

Figure 152. Peak Detection Settings dialog box

Editing all samples in the batch

Editing only the selected sample



 9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

Thermo Scientific TraceFinder User Guide 503

2. Edit any of the detection settings.

For detailed descriptions of all detection settings, see “Detection” on page 154.

3. To save your changes to this compound, click Apply. 

• When you are editing a single sample, the application makes changes to the selected 
compound for this sample. If the sample is a calibration sample type, this update 
changes the calibration curve which, in turn, affects all calculated amounts.

• When you are editing the local method, the application makes changes to the selected 
compound for all samples in this batch.

Note  The Peak Detection Settings commands are also available in the Confirming Ions 
pane.

Table 115. Quan Peak pane shortcut menu commands  (Sheet 1 of 2)

Command Description

Method Integration Settings Use Local Method Peak Detection Settings: Applies the 
local method integration settings to the selected compound.

To edit these peak detection settings, use the Peak Detection 
Settings > Edit Local Method Peak Detection Settings 
command.

Use User Peak Detection Settings: Applies the 
user-customized method integration settings to the selected 
compound.

To edit these user-customized settings, use the Peak 
Detection Settings > Edit User Defined Peak Detection 
Settings command.

Manual Integration Settings Displays manual integration settings.

Add Quan Peak
–or–
Remove Quan Peak
–or–
Cancel Add Peak

Adds a peak, removes a peak, or cancels an add peak 
operation in progress.

Confirming Ion List Select the confirming ions to be viewed. Not available for 
analog compounds.

Send RT to Method Sets the current retention time as the expected retention time 
for the compound in the local method.

Peak Labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).
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Confirming Ions

The Confirming Ions pane displays a list of peaks, a graphical view of all 
qualifying/confirming ions for the selected compound, and calculated ion ratios and ion ratio 
acceptance windows. A red border indicates that an ion ratio is outside of its window. See 
“Quantitative peak with multiple confirming ions” on page 507. The Confirming Ions pane 
uses a unique shortcut menu. See “ Confirming Ions pane shortcut menu commands” on 
page 508.

In the peaks list, the application displays the mass of each confirming ion peak. When a peak 
is within the tolerance set, the peak status is green. When a peak is not within the tolerance 
set, the peak status is red. 

Show Peak Info Displays peak information for the selected compound, as in 
this example:

Reset Scaling Resets the original scaling after a zoom operation.

Peak Detection Settings Edit User Defined Peak Detection Settings: Opens the 
Peak Detection Settings dialog box where you can make 
changes to the selected compound for this sample.

Edit Local Method Peak Detection Settings: Opens the 
Peak Detection Settings dialog box where you can make 
changes to the selected compound for all samples in this 
batch. 

After you apply either of these updates, the application does 
not retain manual integration settings.

Note  For compounds with an analog detection type, the application displays “No 
Confirming Ions are Enabled” in the Confirming Ions pane.

Table 115. Quan Peak pane shortcut menu commands  (Sheet 2 of 2)

Command Description
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Follow these procedures:

• To zoom in on a peak

• To remove a peak

• To customize the labels in the display

• To display surrounding apex times

• To manually integrate a peak

• To switch between method and manual integration modes

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak.

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu.

 To remove a peak

Right-click the Confirming Ions pane, and choose Delete Peak from the shortcut menu.

The application removes the peak displayed in the Confirming Ions pane. All data for this 
peak are removed from the Compound View panes.

 To customize the labels in the display

1. Right-click and choose Peak Display Settings from the shortcut menu.

The Peak Settings dialog box opens. For detailed descriptions of commands, see “Peak 
Settings dialog box” on page 509.

2. To display labels for the peak retention time (RT), mass area (MA), mass height (MH), or 
signal-to-noise (SN), select the appropriate check box.

3. Click OK in the Peak Settings dialog box.

Figure 153. Example of displayed labels

 To display surrounding apex times

1. Right-click and select Peak Display Settings from the shortcut menu.

The Peak Settings dialog box opens. For detailed descriptions of commands, see See “Peak 
Settings dialog box” on page 509.
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2. Select the Show All Apex Times check box.

3. Click OK in the Peak Settings dialog box.

Figure 154. Example of displayed apex times

 To manually integrate a peak

1. Right-click and choose Swipe Manual Integration from the shortcut menu, or click the 
Swipe Manual Integration icon, .

The cursor changes to indicate the manual integration mode.

2. Drag the cursor to define the beginning and ending base points for the new peak.

The application updates the area of the peak to the baseline that you have just added. 
When you regenerate the reports, they display the manually modified data.

Note  You must drag the cursor inside the x axis and y axis.

Drag the cursor across 
the peak at the base 
points for the new peak.

The application identifies the peak 
and indicates the manual 
integration in the labels.
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You can store two peak value sets (method and manual integration settings) with each 
compound in each file. These settings can result in a different set of stored values. The 
application originally calculates the method values based on the processing method 
parameters. The manual values are a result of what you edited. 

 To switch between method and manual integration modes

Right-click the Confirming Ions pane and choose Toggle Integration Settings (Manual 
or Method) from the shortcut menu.

Initially, the method integration and manual integration settings that are stored for a 
compound and file are identical. When you switch modes, the saved result set does not 
change. However, when manual data are available, the Confirming Ions plots update and 
the result set updates as you switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

Figure 155. Quantitative peak with multiple confirming ions

Note  Because a Blank Report displays only the quantitation mass, when you manually 
integrate a confirming ion, the manual integration flag in the report is displayed on 
the quantitation mass.
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Figure 156. Confirming ion with coelution failure

Table 116. Confirming Ions pane shortcut menu commands 

Command Description

Reset Scaling Resets the original scaling after a zoom operation.

Copy to Clipboard Copies the graphic display to the Clipboard.

Swipe Manual 
Integration

Switches to manual integration mode, where you can manually 
define the peak.

Also available from the icon in the upper right corner, .

Toggle Integration 
Settings (Manual or 
Method)

Switches the display between manual integration and method 
integration modes.

Delete Peak Removes the peak and all data for this peak from all Compound 
View panes.

Also available from the icon in the upper right corner, .

Peak Display Settings Opens the Peak Settings dialog box. See Peak Settings dialog box.

Peak Detection 
Settings

Edit User Defined Peak Detection Settings: Opens the Peak 
Detection Settings dialog box where you can make changes to the 
selected compound for this sample.

Edit Local Method Peak Detection Settings: Opens the Peak 
Detection Settings dialog box where you can make changes to the 
selected compound for all samples in this batch. 

After you apply either of these updates, the application does not 
retain manual integration settings.



 9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

Thermo Scientific TraceFinder User Guide 509

Figure 157. Peak Settings dialog box

Table 117. Peak Settings dialog box parameters

Command Description

Y-Axis Type

Relative Displays the y-axis scale from 0 through 100.
Absolute Displays the y-axis scale from 0 to the actual value of the most 

intense peak in the group.
Label in Scientific 
Notation

Displays the y-axis scale in scientific notation.

Peak Labels

RT Displays the retention time (RT) label in the peak 
chromatogram pane.

Height Displays the peak height (AH) label in the peak chromatogram 
pane.

Area Displays the peak area (AA) label in the peak chromatogram 
pane.

Signal to Noise Displays the signal-to-noise (SN) label in the peak 
chromatogram pane.

Plot Header

Sample ID Displays a user-defined, alphanumeric string that identifies a 
sample.

Threshold Displays the peak threshold.
m/z Displays the mass-to-charge ratio found in the spectrum for the 

peak. Assumes the charge is 1.
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Calibration Curve

The Calibration Curve pane displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of the calibration. The 
Calibration Curve pane uses a unique shortcut menu. See Calibration Curve pane shortcut 
menu commands.

Figure 158. Quantitative peak with a calibration curve plot

Sample Filename Displays the name of the current, selected sample where the peak 
was found.

Compound Name Displays the matched compound name found in the library or 
compound database.

Filter String Displays the filter used to identify the peak. Specified in the raw 
data file or the master method.

Chromatogram

Show All Apex Times Displays all surrounding apex times in the plot.

Table 117. Peak Settings dialog box parameters

Command Description
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 To manually exclude a calibration point

In the sample list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

When a value is no longer used for calibration, it is displayed as an empty box in the 
graphical view of the calibration curve.

Table 118. Calibration Curve pane shortcut menu commands

Command Description

Standard Type Sets the standard type to External or Internal. 
Calibration Curve Type Sets the calibration curve type to one of the following:

• Linear: Allows all settings with this exception: When Origin 
is set to Include, all Weighting values are grayed out and 
Weighting is set to Equal.

• Quadratic: Allows all settings with this exception: When 
Origin is set to Include, all Weighting values are grayed out 
and Weighting is set to Equal.

• Average RF: Allows no Weighting or Origin selections. All 
Weighting and Origin values are grayed out. Weighting is set 
to Equal, and Origin is set to Ignore. 

Response Via Sets the response to Area or to Height.
Weighting Sets the weighting to equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.
Origin Sets the origin to Ignore, Force, or Include.
Units Sets the units.
Done with Settings Saves the calibration curve settings.
Reset Scaling Resets the original scale in the calibration curve pane.

Excluded 
calibration 
point
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Ion Overlay

The Ion Overlay pane represents an overlay of the entire ion set—quantification and 
qualifying/confirming—for the selected compound. Use this pane to graphically review the 
peak apex alignment and coeluting peak profiles. 

Figure 159. Quantitative peak with confirming ion overlay

ISTD

The ISTD pane displays the internal standard specified for the compound in the method. See 
“To specify an internal standard type for a compound” on page 204.

Figure 160. Quantitative peak with an internal standard

Note  For compounds with an analog detection type, the application displays “No Data” 
in the Ion Overlay pane.
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Reference Peak

The Reference Peak pane displays the reference peak as specified in the method. 

Figure 161. Quantitative peak with a reference peak

 To specify a chromatogram reference peak

1. In the Batch View task pane, click Reference Sample.

An empty reference sample table opens.

2. Click the Add Reference Sample icon, , or right-click and choose Add 
Reference Sample from the shortcut menu.
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The Open Chromatograph Reference Sample dialog box opens.

3. Select a project from the list of projects.

4. Select a subproject from the list of subprojects.

5. Select a batch from the list of batches.

The application displays only batches that were created using the current master method. 

6. Select a sample from the list of processed samples.

The application displays all the processed samples in the selected batch. To use a sample 
as a reference sample, the sample must have been processed with the current master 
method.

7. Click Open. 

The selected sample is displayed as the chromatogram reference sample in the Method 
View in the Method Development mode. 

Note  If you are creating a new method, you will not see any reference samples here. 
You must create and save a batch using the current method to see the reference 
samples in this list.

Tip  To clear the reference sample from the master method, select None in the Set 
Chromatogram Reference Samples pane.
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Spectra

The Spectra pane displays a comparison of the spectra found in the data and the method 
reference. 

Figure 162. Quantitative peak with data and reference spectra

Library Match

The Library Match pane displays all library matches for the selected compound. 

Figure 163. Library Match for selected compound

Note  For compounds with an analog detection type, the application displays “Not 
Available” in the Spectra pane.
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If you have no matches for any of your compounds, make sure you have completed all of the 
following:

• You installed a library. 

• You selected screening libraries in the Configuration console. See “Screening Libraries” on 
page 59.

• You enabled Library Matching in the method. See “To activate library matching” on 
page 196.

Isotope

The Isotope pane displays all isotopes for the selected compound. The Isotope pane includes a 
shortcut menu. See Isotopes pane shortcut menu commands.

The isotopes pane displays isotopic pattern results for all adducts of a compound according to 
the threshold and deviation parameters defined in the method. 

To identify or confirm the presence of a compound, the resulting score percentage from 
isotopic pattern matching must be higher than the specified fit threshold percentage. 

• An isotope peak is not found if its intensity, relative to the monoisotopic ion’s intensity, is 
more than the specified intensity deviation percentage away from the theoretical relative 
intensity of the isotope ion. 

• An isotope peak is found if its measured m/z is less than the specified mass deviation 
amount away from its expected m/z. 

To specify isotopic criteria in a method, see “Isotopes” on page 197.

Figure 164. Isotopes for the selected compound

Note  When you select different samples, the current compound remains selected (as long 
as that compound is found in the sample).
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Fragments

The Fragments pane displays a composite of all fragments found in the compound. The 
application displays the measured peak as a solid red line and displays the expected peak as a 
dashed blue line.

Figure 165. Fragments for the selected compound

Table 119. Isotopes pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the simulated 
spectrum and the peak apex spectrum.

Show/Hide Noise Label Adds a noise label to each peak. Expected isotope peaks 
(displayed in blue) do not display a noise label.

Show/Hide Resolution 
Label

Adds a resolution label to each peak. Expected isotope peaks 
(displayed in blue) do not display a resolution label.
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Exporting Compounds

You can export compound data to an Excel spreadsheet, to a CSV file, to a compound 
database, or to a new quantitation method. These export commands are available from the 
File menu in the Sample View, Compound View, and Comparative View.

Follow these procedures:

• To export compounds to an Excel spreadsheet

• To export compounds to a CSV file 

 To export compounds to an Excel spreadsheet

1. Choose File > Export Data To > CSV or Excel from the main menu.

The Data Review Export dialog box opens.

2. Click Browse and, in the Export Data to Excel dialog box, locate the folder where you 
want to save the file.

3. Type a file name for the XLSX file and click Save.

4. In the File Format area, in the Data Review Export dialog box, select the Excel option.

5. In the Sheet Layout area, select one of the following file formats for the spreadsheet.

• Multiple Worksheets: Writes one sample to each Excel worksheet tab.

• Single Worksheet: Writes all samples to a single Excel worksheet tab. 

6. In the Data to Export area, select one of the following sets of data to export.

• Export Visible Columns Only: Writes data from only the displayed columns to the 
specified worksheet format.

• Export All Batch Data: Writes data from all columns (displayed or hidden) of all 
samples to the specified worksheet format.

7. Click Export.

The application saves the specified compound data to an Excel spreadsheet and opens the 
folder where you saved the file. The application names the file Batch.xlsx.



 9 Using the Analysis Mode for Quantitation Batches
Working in Data Review

Thermo Scientific TraceFinder User Guide 519

 To export compounds to a CSV file

1. Choose File > Export Data To > CSV or Excel from the main menu.

The Data Review Export dialog box opens.

2. Click Browse and, in the Export Data to Excel dialog box, locate the folder where you 
want to save the file.

3. Type a file name for the CSV file and click Save.

4. In the File Format area, in the Data Review Export dialog box, select the CSV option.

5. In the Sheet Layout area, select one of the following file formats for the spreadsheet.

• Multiple Files: Writes one sample to each CSV file.

• Single File: Writes all samples to a single CSV file. 

6. In the Data to Export area, select one of the following sets of data to export.

• Export Visible Columns Only: Writes data from only the displayed columns to the 
specified worksheet format.

• Export All Batch Data: Writes all data from all samples in the batch to the specified 
worksheet format.

7. Click Export.

The application saves the specified compound data to a CSV spreadsheet.

When you selected to create multiple files, the application opens the folder where you 
saved the files. The application names each file Batch_Compound.csv.

When you selected to create a single file, the Excel application opens, displaying the 
exported data for all samples. The application names the file Batch.csv.
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Working in the Report View
The Report View displays example reports for the current batch. You must have an open 
batch to use the features in the Report View.

Follow these procedures:

• To open the Report View

• To preview a report

• To generate a report as a PDF, an Excel, or a CSV file

• To print a report

• To display a generated report

• To edit a report template

• To create a new report template

 To open the Report View

Click Report View in the navigation pane.

The application opens the Report View. For detailed descriptions of all parameters, see 
“Report View” on page 524.

 To preview a report

1. In the Template pane, select a report template.

The template list shows all the quantitation report templates that you configured in the 
Configuration console. See “Specifying the Reports” on page 71. 

Figure 166. Example of a report template list
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2. Click Preview, .

The application opens the Report Designer, showing the report information for the 
current batch in the selected report template format.

For details about using the Report Designer, see Chapter 12, “Using the Report 
Designer.” 

 To generate a report as a PDF, an Excel, or a CSV file

1. In the Template pane, select a report template.

2. Select the check box for each of the file types that you want to create: PDF, Excel, or 
CSV.

3. Click Generate, .

The application does the following:

• Displays a green progress bar as it generates the reports.

• Creates a report for the current batch as a PDF, an Excel, or a CSV file, using the 
selected report template format.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 524.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.

 To print a report 

1. In the Template pane, select a report template.

2. Select the check box for the Print file format.

3. Click Generate, .

The application does the following:

• Creates a report for the current batch using the selected report template format.

• Prints the report to your default printer.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 524.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.
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 To display a generated report

In the Generated Reports pane, click View for the report that you want to see.

Figure 167. Generated Reports pane showing a PDF report

The application opens the output file.

 To edit a report template

1. In the Template pane, select a report template.

2. Click Open, .

The application opens the Report Designer showing the template in an Excel spreadsheet. 
See Report Designer showing the template for the selected report.

Figure 168. Report Designer showing the template for the selected report

3. Use the features in the Report Designer to edit the template.

See Chapter 12, “Using the Report Designer.” 

4. When you finish your changes, choose File > Save from the Report Designer menu bar.

Note   You cannot edit report templates that were provided with the TraceFinder 
application; however, you can open a TraceFinder template, make changes, and save it 
to a new template name.

Note  When user security is activated, you must have Template Editing permission to 
edit report templates created by your laboratory. If the Open button is not active, user 
security is activated and you do not have Template Editing permission. 

Opens the generated file.
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 To create a new report template

1. Click New, .

The application opens the Report Designer showing an empty template in an Excel 
spreadsheet. See Report Designer showing a new, empty template.

The Report Type is None.

In the left pane, the spreadsheet lists all samples in the current batch and all compounds 
in the method used for the batch.

Figure 169. Report Designer showing a new, empty template

2. Use the features in the Report Designer to create the report template.

See Chapter 12, “Using the Report Designer.” 

3. When you finish your changes, choose File > Save from the Report Designer menu bar.

The Save Template dialog box opens.

Figure 170. Save Template dialog box

4. Type a name for the new report template and click OK.
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Report View

Use the features in the Report View to display example reports for the current batch. 

Figure 171. Report View

Table 120. Report View parameters  (Sheet 1 of 2)

Parameter Description

Template

Displays all report templates.
Rules

Sheet Name Specifies each sheet in the report.
Rules Specifies the type of data used in each sheet in the selected report.

• Batch
• EachSample
• SampleType: SampleType
• CompoundType: CompoundType
• SampleCustomFormula: 
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Buttons

 View Report Templates Displays the C:\TraceFinderData\3.3\Templates\ReportTemplates folder that contains 
all report templates.
Opens the selected report template in the Report Designer.

Opens a blank report template in the Report Designer.

Opens the Report Designer showing the report information for the current batch in the 
selected report template format.

PDF Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

Excel Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

CSV Saves the generated report as a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

When the report contains multiple sheets, the application writes each sheet as a separate 
CSV file.

Print Prints the generated report to your default printer.
Generates the selected type of reports for the current batch using the selected report 
template.

Generated Reports

Template Report template used for the report. See “Example of a report template list” on 
page 520.

Rule Type of data used in each sheet of the report. See Rules.
Sample For sample-level reports, the name of each sample in the report.
Output Type of output specified for the report: PDF, Excel, CSV, or Print.
Generated Report File Lists the output file name for each report in the …\TraceFinderData\3.3\Projects folder.
View Displays the generated output file.

 View Generated Reports Displays the C:\TraceFinderData\3.3\Projects folder that contains all report outputs.
Clear Removes all reports from the Generated Reports display. This does not delete the reports 

from the C:\TraceFinderData\3.3\Projects folder.

Table 120. Report View parameters  (Sheet 2 of 2)

Parameter Description
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Working in the Local Method View 
In the Local Method view, you can edit the local method parameters. A local method is a copy 
of a master method associated with a batch. 

You can edit only the local copy of the method, or you can edit the master method and 
overwrite the local copy with the edited master method. Local methods are named 
Batch_MasterMethod. 

 To open the Local Method View

1. Click Analysis in the navigation pane.

2. Click Local Method.

The Local Method view for the currently selected batch opens. See Local Method view.

You can edit many of the method parameters in a local method. Editing the local method 
does not affect parameters in the master method.

For detailed descriptions of method parameters, see “Editing a Master Method” on 
page 135.

3. Enter any local changes to the method.

4. When you have finished editing the local method, choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. 
You can use this feature to overwrite an edited local method with the original master 
method or to overwrite the local method with an updated master method.
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Figure 172. Local Method view
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10

Using the Analysis Mode for Target Screening 
Batches

This chapter includes instructions about using the features of the Analysis mode to do the 
following:

• Create target screening batches.

• Submit target screening batches for acquisition, processing, or report generation.

• Review target screening batches, batch data, reports, and local methods.

 To access the Analysis mode

Click Analysis in the navigation pane.

The Analysis navigation pane opens.

Contents

• Working in the Batch View

• Working in Data Review

• Working in the Report View

• Working in the Local Method View
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Working in the Batch View
In the Batch View, you can manually create and edit a new target screening batch or open and 
edit a previously saved batch. When you submit a batch, you can acquire and process data and 
optionally create reports for the submitted samples.

The Analysis mode includes a toolbar:

Use the toolbar or the equivalent commands in the Batch View shortcut menu to create the 
sample list and submit samples for acquisition. See “Toolbar” on page 538 or “Batch View 
Shortcut Menu” on page 541.

 To open the Batch View

1. Click Analysis in the navigation pane of the current mode.

2. Click Batch View.

The Batch View navigation pane opens. 

The Batch View includes a single page of information, the Samples page.

This section contains information about the following topics:

• Samples Page Features

• Creating a New Batch

• Editing a Batch

• Submitting a Batch
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Samples Page Features

The Samples page is divided into two panes: 

• Samples pane

Use the samples pane to create a batch. See Samples Pane.

• Compound Active Status pane

Use the Compound Active Status pane to make specific compounds active or inactive. See 
“Compound Active Status Pane” on page 543.

Samples Pane

The samples pane includes the following features:

• Column Display

• Status Indicators

• Groups

• Blank Subtraction

• Sample Weight Calculation

• Instrument Methods

• Toolbar

• Batch View Sample List

• Batch View Shortcut Menu

Samples pane

Compound Active Status pane

Tip  To resize the panes, drag the separators that divide the panes.
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Column Display

The sample list contains many columns of information. You can scroll to see all the columns, 
and you can customize which ones to display and their display order.

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the following columns 
remain fixed: Status, Filename, Sample Type, Groups, Blank Subtraction, Level, Sample 
ID, and Sample Name, while the other columns scroll right and left. 

 To customize the column display 

1. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

These columns appear after the Status, Filename, Sample Type, Groups, Blank 
Subtraction, Level, Sample ID, and Sample Name columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. Repeat step 4 for all columns whose widths you want to change, and click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View. 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Blank Subtraction, Level, Sample ID, and Sample Name.
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Figure 173. Modify Columns dialog box 

Table 121. Button descriptions for the Modify Columns dialog box

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Blank Subtraction, Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except fixed columns.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 
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Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing.

 Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Groups

Use the Groups feature to assign samples to a group. 

 To create a group

1. For each sample, type the name of a group in the Groups column.

Repeat this for each sample that you want to include in a group.

2. Create as many groups as you want. 

Note  When you include unknown screening features in the target screening method and 
you choose to process with only the target screening criteria, the Samples view shows the 
Status for the samples as acquired and processed ( ), and the Unknown Screening View 
shows the Status for the samples as acquired but not processed ( ).

Note  When you include unknown screening features in the target screening method and 
you choose to process with only the unknown screening criteria, both the Samples view 
and the Unknown Screening View show the Status for the samples as acquired and 
processed ( ). 

Status indicators
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Blank Subtraction

Use the Blank Subtraction feature to select which matrix blank samples you want to use for 
peak subtraction. The application subtracts the areas of the peaks in the selected matrix blank 
samples from the matching areas in the unknown samples. 

When you process the batch sequence, the application subtracts the peaks in a selected matrix 
blank sample from all unknown samples that follow it, until it encounters another matrix 
blank sample. 

To activate the Blank Subtraction feature, see “Editing the Processing Page” on page 264.

Sample Weight Calculation

Use the sample weight features to calculate the conversion factor for a sample. The application 
uses different methods to calculate the conversion factor for liquid or solid calculation types.

Liquid: SampleVolume DilutionFactor

Solid: (SampleVolume × DilutionFactor) SampleWeight

Manual: The application does not calculate the Conversion Factor. Instead, you can enter the 
Conversion Factor value.

Follow these procedures:

• To display the features for calculating sample weight

• To calculate the conversion factor for a liquid sample

• To calculate the conversion factor for a solid sample

• To manually specify the conversion factor for a sample

Note  To assign a sample to multiple groups, separate the groups with a comma. 
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 To display the features for calculating sample weight

If the Conversion Factor, Sample Volume, Dilution Factor, Sample Weight, Calculation 
Type, and Final Units columns are not visible, right-click and choose Enable Sample 
Weight Calculation from the shortcut menu.
 

 To calculate the conversion factor for a liquid sample

1. From the Calculation Type list, select Liquid.

For a liquid sample, the Sample Weight value is not editable.

2. In the Sample Volume column, type the volume in ng/mL for your sample.

3. In the Dilution Factor column, type the value for the dilution. 

For example, if you have 1000 ng/mL of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

4. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

 To calculate the conversion factor for a solid sample

1. From the Calculation Type list, select Solid.

2. In the Sample Weight column, type the weight in ng for your sample.

3. In the Sample Volume column, type the volume in ng/ml for your sample.

4. In the Dilution Factor column, type the value for the dilution.

For example, if you have 1000 ng/ml of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

5. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

Note  The application uses the following formula to calculate the Conversion Factor: 
SampleVolume DilutionFactor

Note  The application uses the following formula to calculate the Conversion Factor: 
(SampleVolume × DilutionFactor) SampleWeight
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 To manually specify the conversion factor for a sample

1. From the Calculation Type list, select Manual.

For a manually calculated sample, the only available columns are the Conversion Factor 
and the Final Units. 

2. In the Conversion Factor column, type the conversion factor to use for your sample.

3. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

Instrument Methods

Use the Instrument Methods column to specify instrument methods for the samples. 

 To specify instrument methods for samples

1. Display the Instrument Method column in the sample list:

a. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens.

b. In the Available Columns pane, select Instrument Method.

c. Click  to move the Instrument Method column to the Displayed Columns 
pane.

d. Click OK.

The application displays the Instrument Method column, defaulting to the instrument 
method specified in the master method. 

2. Click the Instrument Method column and select an instrument method from the list.

This list contains all the available instrument methods. Instrument methods from 
external sources are prefixed with “Ext:”.

You can specify a different instrument method for each sample.

When you submit the batch for acquisition, the application saves a copy of the selected 
instrument methods to the following folders:

External instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method\ExternalMethods

Local instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method

Note  The application uses the specified conversion factor when it calculates the 
amount for the sample.

Note   By default, the Instrument Method column is not displayed in the Batch View 
sample list.
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Toolbar

The Analysis mode includes this toolbar for creating and submitting a batch.

Table 122. Toolbar icons

Icon Description

Adds the specified number of new, empty samples to the end of the 
sample list. See the instructions “To add samples to the list” on 
page 545.

Inserts a new, empty sample or samples above the selected sample. See 
the instructions “To insert samples into the list” on page 546.

Removes the selected samples from the sample list. See the 
instructions “To remove samples from the list” on page 547.

Adds imported samples from a CSV, an XML, or an SLD file to the 
sample list. See the instructions “To import samples into the list” on 
page 546.

Submits only the selected samples for acquisition, processing, or 
report generation. See the instructions “To submit samples in the 
batch” on page 557.

Submits the batch for acquisition, processing, or report generation. 
See the instructions “To submit samples in the batch” on page 557.

Submits only the selected samples for processing. See the instructions 
“To submit selected peaks for processing” on page 556.

Opens the Acquisition mode where you can use a batch template to 
define a standard sequence composed of various sample types to be 
assembled into a batch of samples. See “Working in Data Review” on 
page 566. 

Opens the Acquisition mode where you can create a batch template 
that contains the basic settings and sample types for your batches. See 
“Using the Acquisition Mode” on page 347.

Opens the Quick Acquisition window where you can quickly submit a 
single sample. See Appendix A, “Using Quick Acquisition.” 

Opens the Audit Viewer where you can view audit logs. See 
Chapter 13, “Using the Audit Viewer.”  Available only when you 
enable Auditing in the Administrator Console. Refer to the 
instructions in the TraceFinder Administrator Console User Guide.
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Batch View Sample List

The sample list displays all the quantitative data for the samples of a batch. 

Status indicators for each sample indicate if the sample is currently acquiring, not acquired, 
acquired, or processed. 

The sample list includes the following columns of information:

Figure 174. Batch View sample list

Table 123. Batch View sample list columns  (Sheet 1 of 3)

Column Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the application processes the sample data. Each sample is classified as one of 
the following sample types: Matrix Blank, Solvent, Cal Std, QC Std, or Unknown

Default: Unknown
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Groups Threshold group to which a sample belongs.

Blank Subtraction Specifies a matrix blank sample to use for blank subtraction. 

Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Injection Volume The injection volume (in microliters) of the injected sample. 

When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the Autosampler you configure. The usable range 
depends on the injection mode and might be smaller than the displayed range.

The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Valid range: 0.1 through 5000 μL

Calculation Type Liquid: The application calculates the Conversion Factor as 

SampleVolume DilutionFactor

Solid: The application calculates the Conversion Factor as 

(SampleVolume × DilutionFactor) SampleWeight

Manual: Sample Volume, Dilution Factor, Sample Weight, and Final Units columns are not 
available, and the Conversion Factor value is editable.

Conversion Factor Editable only when Calculation Type is Manual. 

Default: 1

Sample Volume Default: 1

Dilution Factor Default: 1

Sample Weight Available only when Calculation Type is Solid. 

Default: 1

Final Units Specifies the calculated amount in the Data Review view or in reports.

Default: 1

Instrument Method Specifies the instrument to use for the acquisition. This column is hidden by default. To 
display this column, see “To customize the column display” on page 532.

Table 123. Batch View sample list columns  (Sheet 2 of 3)

Column Description
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Batch View Shortcut Menu

The Batch View includes a shortcut menu for creating a batch.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

Barcode Expected A user-entered barcode for the vial.

Barcode Actual An actual barcode for the vial. This value is not editable.

Comment A user-defined comment for the sample.

Table 123. Batch View sample list columns  (Sheet 3 of 3)

Column Description

Table 124. Batch View shortcut menu commands  (Sheet 1 of 2)

Command Description

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.

Remove Selected 
Samples

Removes selected samples from the sample grid.

Import Samples Opens the Sample Import Tool. See “To import samples into the list” on page 546.

Browse in Raw File 
(Move)

Opens a dialog box where you can select a raw data file to use for the selected sample row. 
The application removes the raw data file from the source location.

Browse in Raw File 
(Copy)

Opens a dialog box where you can select a raw data file to use for the selected sample row. 
The application copies the raw data file from the source location.

Map Raw Files to 
Samples

Opens a dialog box where you can select multiple raw data files to use for the selected 
sample rows.

Copy Down Copies the value in the selected row to all rows below it. This command is available only 
when you have selected a value that can be copied down.

Fill Down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. This command is available only when you have 
selected a value that can be filled down.

Modify Columns Opens the Modify Columns dialog box. See “Column Display” on page 532.

Enable/Disable Sample 
Weight Calculation

Displays or hides the Sample Volume, Dilution Factor, Sample Weight, Calculation Type, 
and Final Units columns.
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Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information into a text editor or spreadsheet application. You cannot paste 
this data back into the Batch View sample list.

Copy with Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information into another text editor or 
spreadsheet application. You cannot paste this data back into the sample list. 

For example

Paste Pastes a single column of copied data from another text editor or spreadsheet application 
into the selected column.

Undo Last Paste Removes the last pasted item in the Batch View. 

Export to CSV File Opens the Save As dialog box where you can save the current sample list to a CSV file.

Edit Instrument Method Opens the Instrument Setup window where you can edit the parameters of the instrument 
method. 

• When you edit an external method, the application updates the method in the 
…\Xcalibur\methods folder. 

• When you edit an internal method, the application updates the method in the 
…\TraceFinderData\3.3\Projects\…\batch\Methods\method folder.

For detailed information about editing instrument methods, see “Working with 
Instrument Methods” on page 108.

Table 124. Batch View shortcut menu commands  (Sheet 2 of 2)

Command Description

Copy with Headers 
from TraceFinder

Paste into an Excel spreadsheet.
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Compound Active Status Pane

In the Compound Active Status pane, you can choose specific compounds to be active or 
inactive.

 To set a compound as active or inactive

1. In the sample list, select a sample.

All compounds in the selected sample are listed in the Compound Active Status pane.

The default active/inactive status is determined by the identification settings in the local 
method. For information about setting the identification parameters, see “Identification” 
on page 152.

• To display compounds alphabetically, right-click and choose Sort by Compound 
Name from the shortcut menu.

• To display compounds from shorter to longer retention times, right-click and choose 
Sort by Retention Time from the shortcut menu.

2. Select or clear the Active check box for the compound.

Compound Active/Inactive Status

You can specify which compounds are active or inactive in the Local Method View or the 
Batch View.

Figure 175. Active and inactive compounds in the Local Method View

For details about setting the status on the Identification page, see “Identification” on 
page 152.
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Figure 176. Active and inactive compounds in the Batch View

For details about setting the status in the Batch View, see “Compound Active Status Pane” on 
page 543.

Creating a New Batch

In the Batch View, you can create a new batch. 

Follow these procedures:

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To browse in raw data files

• To customize the column display

 To create a new batch

1. Choose File > New > Batch from the main menu.

The Create New Batch dialog box opens, displaying all drives that contain projects. See 
“Create New Batch Dialog Box” on page 551.
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2. Select a drive from the list.

3. Select the folder where you want to store your batch.

To create a new folder for the storage location, see “Editing Folders for Batches” on 
page 552.

4. Select Screening from the Type list.

The batch list displays all batches in the selected folder. The Method list displays all 
methods for the target screening type.

5. Select a master method from the Master Method list. 

6. Click Create.

A new batch opens with one Unknown sample. 

The batch name in the title bar indicates that you are creating a target screening batch.

 To add samples to the list

1. To add a single sample row, right-click the sample list and choose Add Sample from the 
shortcut menu.

2. To add multiple sample rows, select the number of rows and then click the Add Sample 
icon, .

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  The application displays all configured and enabled repositories. 

Tip  To activate the Create button, you must enter a unique batch name. If the Create 
button is not activated, you have entered a batch name that is already used.
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 To insert samples into the list

Select the sample above which you will insert new, Unknown samples, and then do one of 
the following:

• To insert a single sample row, right-click and choose Insert Sample from the shortcut 
menu. 

• To insert multiple sample rows, select the number of rows and then click the Insert 
Sample icon .

The application inserts the Unknown samples above the selected sample.

 To import samples into the list

1. Choose Batch > Import Samples from the main menu, or click the Import Samples 
icon, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a CSV, an XML, or an SLD file.

2. Click Browse and select a CSV, an XML, or an SLD file that contains the samples to 
import.

3. From the Imported Samples Will Be list, select Appended to the End of the List or 
Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the sample list. 

Inserted samples
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When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following column name substitutions:

When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following sample type substitutions:

5. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The application inserts the copy above the selected sample.

 To reinject a sample

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

Xcalibur column TraceFinder column

Position Vial Position

Inj Vol Injection Volume

Dil Factor Conversion Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank

QC QC Std

Std Bracket Cal Std

Note  The Channel column is available only when you have activated multiplexing in 
the Configuration console. See “Multiplexing” on page 61.

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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 To edit sample values

1. For each sample, do one of the following:

Type a new file name over the current filename.

–or–

Double-click the Filename column and locate a raw data file to use for the sample. 

–or–

Right-click and choose Browse in Raw File from the shortcut menu, and then locate a 
raw data file to use for the sample.

By default, the application sets the Sample Type to Unknown.

2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or QC Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select in the 
Level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Compounds tab.

d. Click the Calibration Levels tab.

e. Add the levels.

f. Save the method.

g. Return to the Batch View in the Analysis mode, and then click Update.

The application updates the local method with the new sample levels.

For detailed instructions about specifying calibration levels, see “Calibration Levels” on 
page 207.

4. Type a vial position in the Vial Position column for each sample. 

5. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

Available sample types

Matrix Blank Solvent QC Std Unknown
Cal Std
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6. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix C, 
“Using Copy Down and Fill Down.” 

 To browse in raw data files

1. Do one of the following:

Double-click the Filename column.

–or–

Right-click and choose Browse in Raw File from the shortcut menu.

The What Raw File Would You Like to Use dialog box opens.

2. Select a raw data file to use for the sample or use the CTRL key to select multiple files, 
and then click Open.

The application overwrites the selected, unacquired sample in the batch with the first 
“browsed in” file and adds any additional browsed in files below the selected sample.

For all browsed-in raw data files, the application sets the Status to Acquired, , and sets 
the Sample Type to Unknown. 

 To customize the column display

1. Right-click the Batch View sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box” on page 550.

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select appear after the Status, Filename, Sample Type, Groups, Blank 
Subtraction, Level, Sample ID, and Sample Name columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Blank Subtraction, 
Level, Sample ID, and Sample Name, while the other columns scroll right and left. 

Note  You cannot overwrite an acquired sample. When you select a sample that is 
acquired, the application adds all browsed in files below the selected sample.
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The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

Figure 177. Modify Columns dialog box 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Blank Subtraction, Level, Sample ID, and Sample Name.

Table 125. Button descriptions for the Modify Columns dialog box  (Sheet 1 of 2)

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Blank Subtraction, Level, Sample ID, and Sample Name.
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Create New Batch Dialog Box

Use the Create New Batch dialog box to select a folder and method for your batch and to 
name the new batch.

 

Moves the selected column to the Available Columns pane. 

Moves all columns except those that are fixed.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 

Table 125. Button descriptions for the Modify Columns dialog box  (Sheet 2 of 2)

Button Description

Table 126. Create New Batch dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level folders; you must delete the lower-level 
folders first.

Or, right-click and choose Delete from the shortcut menu.
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Editing Folders for Batches

From the Create New Batch dialog box, you can create new folders for your batches. You can 
also delete or rename folders.

Use these procedures:

• To create new project folders

• To delete project folders

• To rename project folders

 

Rename Folder

Renames the selected folder.

Or, right-click and choose Rename from the shortcut menu.

Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Type Type of batch to create: Quan, Screening, or Unknown Only.

Method Method used to create the new batch.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Create Creates the specified batch and opens the Batch View for the new batch.

Cancel Closes the Create New Batch dialog box without creating a batch.

Table 126. Create New Batch dialog box parameters  (Sheet 2 of 2)

Parameter Description
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 To create new project folders

1. In the Create New Batch dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names are limited to 30 characters and can contain spaces and special characters, 
except for the following special characters: \ / : + ? ” < >

 To delete project folders

1. In the Create New Batch dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

 To rename project folders

1. In the Create New Batch dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Note  After you add a lower-level folder, you cannot rename the parent folder.

Note  You cannot delete folders that contains lower-level folders; you must delete the 
lower-level folders first.

Note  You cannot rename folders that contain lower-level folders.
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Editing a Batch

In the Batch View, you can open a saved batch and edit the sample list. You can add samples, 
edit samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for reinjection. If the batch has unacquired samples when you complete your edits, 
you can save it as a “ready to acquire” batch. 

Follow these procedures:

• To open a saved batch

• To open a recent batch

• To edit samples in a batch

• To reinject a sample from a previously acquired batch

 To open a saved batch

1. Choose File > Open > Batch from the main menu.

The Open Batch dialog box opens. See Open Batch dialog box or Open Batch dialog box 
parameters.

2. Select a project and a subproject.

3. Select Screening or Any from the Type list.

The batch list displays all batches created with Target Screening methods (or when you 
select Any, all methods of all types).

4. Select a batch from the list. 

5. Click Open.

The selected batch opens in the Batch View. 

Figure 178. Open Batch dialog box
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 To open a recent batch 

Choose File > Recent Files > batch from the main menu.

The selected batch opens in the Batch View.

 To edit samples in a batch

Use the commands described in “Working in the Batch View” on page 530.

You can add new samples, edit samples, or delete samples.

Table 127. Open Batch dialog box parameters 

Parameter Description

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

Path Path to the project in the TraceFinderData\3.3\Projects folder 
where the batch is stored.

Buttons

Type Type of batch to display in the Batch list: Quan, Screening, 
Unknown Only, or Any.

Open Opens the Batch View for the selected batch.

Cancel Closes the Open Batch dialog box without opening a batch.
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 To reinject a sample from a previously acquired batch

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit all samples in this batch, the application acquires all samples (including 
previously acquired samples).

3. To save this batch with the new samples for reinjection, choose File > Save > Batch from 
the main menu.

The batch is saved as a prepared batch that is ready to submit. You can open this batch 
from the Reinject Samples page in the Acquisition mode and submit the batch. The 
application acquires only the samples that have not been previously acquired.

Submitting a Batch

In the Batch View, you can submit an entire batch or only selected samples in the batch. 
When you submit a batch for acquisition and processing, you can choose to create reports for 
the submitted samples. See “Submit Options dialog box” on page 559.

For a description of commands in the shortcut menu, see “ Batch View shortcut menu 
commands” on page 541.

Follow these procedures:

• To submit selected peaks for processing

• To submit samples in the batch

• To view the output files

 To submit selected peaks for processing

1. In the Peak List, select the Selected check box for the peaks that you want to process.

2. Click the Submit … for Processing icon, .

The application processes the selected peaks and updates the data in the Peak 
Identifications pane.
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 To submit samples in the batch

1. Do one of the following:

• To submit all samples in the batch, click the Submit Batch icon, .

• To submit specific samples, select the samples and click the Submit Selected

Samples icon, .

The Submit Options dialog box opens. See “Submit Options dialog box” on page 559.

2. To acquire (or reacquire) the submitted samples, select the Acquire Data check box.

• When all submitted samples have been previously acquired, this option is (by default) 
not selected. 

• When one or more samples in the batch have not been acquired, this option is (by 
default) selected.

3. To process the submitted samples, select the Process Data check box.

The application displays processing options for the Target Screening method.

If the method includes unknown screening features, the application also displays 
unknown screening options. For specifying processing data for batches that also use 
unknown screening features, see “To submit samples in the batch” on page 633 of 
Chapter 11, “Using the Analysis Mode for Unknown Screening Batches.” 

4. Select the check box for the options that you want to use.

Peak Detect: Performs peak detection. You can process the data with or without 
performing peak detection. For example, you might want to turn off peak detection when 
reprocessing samples.

Identify and Confirm: Performs both identification and confirmation.

5. (Optional) Select the Create Reports check box.

6. (Optional with multiplexing activated) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

Note  You can also submit only selected peaks for processing. See “To submit selected 
peaks for processing” on page 556.

Tip  You can process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when reprocessing samples.
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7. (Optional without multiplexing activated) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

8. To specify the following optional parameters, click Show Details.

a. Select the Use check box for the device that you want to use for this acquisition.

b. Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

c. Select the Start When Ready check box, which starts all instruments together when 
they are all ready. 

When this is cleared, individual instruments can start at different times and then have 
to wait for the last instrument to be ready.

d. Select the system state after it acquires the last batch: On, Standby, or Off.

9. To start the selected processes, click OK. 

The selected processes begin, and the application shows the real-time display at the 
bottom of the current window. You can begin another batch in the Analysis mode while 
you watch the real-time display of the currently acquiring batch. 

Note  When you select Full Sequence Submission in the Configuration console, these 
options are unavailable because the current batch and the current sample are, in effect, 
the same thing. 

IMPORTANT   When your batch also uses unknown screening features, after the first 
processing, you might see an error message stating that the total number of results is too 
large for a single batch (more than 500 000). Return to the Processing pages for the 
unknown screening features (“Editing the Processing Pages” on page 311) and make one 
or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.
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Figure 179. Submit Options dialog box

Table 128. Submit Options dialog box parameters  (Sheet 1 of 3)

Parameter Description 

User Name Name of the current user.
Samples Number of samples to be submitted for acquisition, processing, or 

reporting.
Workflow Steps to Perform

Acquire Data Submits the current batch to acquisition.
• When all submitted samples have been previously acquired, this 

option is (by default) not selected. 
• When one or more samples in the batch have not been 

acquired, this option is (by default) selected.
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Process Data Processes the data for the current batch using any of the following 
options:

Peak Detect: Performs peak detection. You can process the data 
with or without performing peak detection. For example, you 
might want to turn off peak detection when reprocessing samples.

Identify and Confirm: Performs both identification and 
confirmation.
Note   Target Screening methods can include unknown screening 
features. For specifying processing data for batches that also use 
unknown screening features, see “To submit samples in the batch” 
on page 633.

Create Reports Creates reports for the current batch.
Submit as a Priority Sequence?

Priority Sequence With multiplexing activated, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing activated, specifies one of the following 
priority options to place the batch in the queue:

Next Available Batch: Places the batch immediately after the 
currently acquiring batch. 

Next Available Sample: Places the batch immediately after the 
currently acquiring sample.
Note  When you select Full Sequence Submission in the 
Configuration console, these options are unavailable because the 
current batch and the current sample are, in effect, the same 
thing. 

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument that you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then reopen 
the application. You cannot configure an instrument while the 
TraceFinder application is running.

Available only when you select the Acquire Data check box.
Use Specifies the instruments used for this acquisition.

Available only when you select the Acquire Data check box.

Table 128. Submit Options dialog box parameters  (Sheet 2 of 3)

Parameter Description 
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 To view the output files

Locate the files to view from the following directories:

The application writes saved batches to the project folder:

…\TraceFinderData\3.3\Projects\…

For each acquired sample, the application writes an RSX file to the batch Data folder:

…\TraceFinderData\3.3\Projects\…\Data

The application saves method information to the batch Methods folder:

…\TraceFinderData\3.3\Projects\…\Methods

The application writes the reports to the batch Reports folder:

…\TraceFinderData\3.3\Projects\…\batch\Reports

Start Device Specifies the instrument that initiates the communication with the 
other instruments. This is usually the autosampler.
Available only when you select the Acquire Data check box.

Start When Ready Starts the specified device when all the instruments are ready to 
acquire data. When this is cleared, individual instruments can start 
at different times and then must wait for the last instrument to be 
ready.

Post-run System State Specifies the system state after it acquires the last batch: On 
(default), Standby, or Off.

Buttons

Hide/Show Details Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.
Cancel Closes the Submit Options dialog box without submitting any 

tasks.

Table 128. Submit Options dialog box parameters  (Sheet 3 of 3)

Parameter Description 
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Saving a Batch to a New Location

You can move the current batch to a different project folder, or you can make a copy of the 
current batch and save the copy to a different project folder.

Follow these procedures:

• To save a batch to another project folder

• To move a batch to another folder

• To create a new project folder

• To delete project folders

• To rename project folders

 To save a batch to another project folder

1. Choose File > Save > Save Batch As from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 564.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

If you are saving the batch to a different folder, you must give it a unique name. You 
cannot overwrite an existing batch in a folder.

5. Click Save.

When you save the batch to a different folder, the reports reflect the original project 
folders and the application does not save the calibration history.

 To move a batch to another folder

1. Choose File > Save > Move Batch from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 564.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

You must give the batch a unique name in the new subproject folder. You cannot 
overwrite an existing batch.
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5. Click Save.

When you move the batch, the reports reflect the original project and subproject folders 
and the application does not save the calibration history.

 To create a new project folder 

1. In the Save Batch As dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names can contain spaces and special characters, except for the following special 
characters: \ / : + ? ” < >

 To delete project folders

1. In the Save Batch As dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

 To rename project folders

1. In the Save Batch As dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Note  After you add a lower-level folder, you cannot rename the parent folder.

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.
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Save Batch As Dialog Box

Use the features in the Save Batch As dialog box to save a batch to a new name or to move a 
batch to a different project folder.

Figure 180. Save Batch As dialog box

Table 129. Save Batch As dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Delete from the shortcut menu.

 

Rename Folder

Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Rename from the shortcut menu.

Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.
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Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Save Saves the batch to the specified name and folder and opens the Batch View for the new 
batch.

Cancel Closes the Save Batch As dialog box without saving the batch.

Shortcut menu commands 

Create Folder Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Delete Folder Immediately removes the selected folder. There is no prompt to confirm that you want to 
delete the selected folder.

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Rename Folder Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Expand Child Nodes Expands all project and subproject folders in the Project tree.

Collapse Child Nodes Collapses all project and subproject folders in the Project tree.

Table 129. Save Batch As dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Working in Data Review 
The Data Review view displays the data generated by the master method. Use Data Review to 
verify the data for a compound before you generate reports. 

Follow these procedures:

• To open the Data Review view

• To display or hide a pane on the Target Screening page

• To move, dock, or float Data Review panes

• To restore the default layout

 To open the Data Review view

1. Click Analysis in the navigation pane.

The Analysis navigation pane opens.

2. Click Data Review.

The Data Review navigation pane opens. 

On the Target Screening page, the panes show the following:

• A list of all samples in the current batch

• The compound results for all compounds in the method

• Chromatogram and spectrum plots for all compounds found in the currently selected 
sample

 To display or hide a pane on the Target Screening page

From the View menu, choose to display—indicated with a check mark—or hide the 
following panes:

See Target Screening panes.

Displays the Samples Pane.

Displays the Compounds Pane.

Displays the Chromatogram Pane.

Displays the Spectrum Pane.
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Figure 181. Target Screening panes

When you select a sample in the Samples pane, the associated Compounds pane flags any 
compound with errors in the selected sample. The associated Chromatogram pane displays 
the chromatogram, retention time, area, height, and signal-to-noise ratio for all compounds in 
the selected sample. The Spectrum pane highlights the compound selected in the Compounds 
pane. You can display, hide, or move any of these panes.

 To move, dock, or float Data Review panes

Follow the instructions in Appendix D, “Moving Data Review Panes.” 

 To restore the default layout

Choose View > Restore Default Layout.

The Target Screening view displays the default panes in their default locations.

Samples pane Compounds pane

Chromatogram pane

Spectrum pane
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Samples Pane

Use the Samples pane to select a specific sample in the batch. The associated Compounds 
Pane displays all compounds in the method and flags any compound with errors in the 
selected sample.

Flags in the Samples pane indicate one of the following:

 A green circle means that the sample/compound/peak combination is identified and 
fully confirmed.

 A yellow triangle means that the sample/compound/peak combination is identified but 
not fully confirmed.

 A red square means that the sample/compound/peak combination is not identified.

Figure 182. Samples pane

Table 130. Samples pane shortcut menu commands

Command Description

Sort by Alphabetical Sorts the samples alphabetically by sample name.
Sort by Import Order Sorts the samples in the order they were processed.
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Compounds Pane

The Compounds pane displays all found peaks in the selected sample and flags any 
compound with errors. The compounds table reflects the identified compounds found in the 
compound database and the results of the method processing criteria. See “Compounds Pane 
Columns” on page 576.

Color Coding for Measured or Calculated Values

The Compounds pane uses color-coded text to indicate the following:

• Green—Indicates that the measured value of scoring and confirmations pass the criteria 
specified in the method. 

• Red—Indicates that the measured or calculated value does not pass the criteria specified 
in the method.

Displaying Multiple Adducts

When the application finds multiple adducts at the same retention time in a sample, the 
Compounds pane displays the adducts on separate rows in the table.

Exporting Compounds

Use the commands in the File menu to export data to an Excel spreadsheet, a CSV file, a 
compound database, or a new quantitation method. 

Follow these procedures:

• To export compounds to an Excel spreadsheet

• To export compounds to a CSV file

• To export compounds to a compound database

• To create a new quantitation method with the selected compounds

• To create a new quantitation method and update the compound database
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 To export compounds to an Excel spreadsheet 

1. For each compound that you want to export to an Excel spreadsheet, select the check box 
in the Selected column.

2. Choose File > Export Data To > CSV or Excel from the main menu

The Data Review Export dialog box opens.

3. Click Browse and, in the Export Data to Excel dialog box, locate the folder where you 
want to save the file.

4. Type a file name for the XLSX file and click Save.

5. In the File Format area, select the Excel option.

6. In the Sheet Layout area, select one of the following file formats for the spreadsheet.

• Multiple Worksheets: Writes one sample to each Excel worksheet tab.

• Single Worksheet: Writes all samples to a single Excel worksheet tab. 

7. In the Data to Export area, select one of the following sets of data to export.

• Export Filtered and Selected Rows (Visible Columns Only): Writes data from the 
displayed columns of selected samples to the specified worksheet format.

• Export All Batch Data: Writes data from all columns (displayed or hidden) of all 
samples to the specified worksheet format.

8. Click Export.

The application saves the specified compound data to an Excel spreadsheet and opens the 
folder where you saved the file.
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 To export compounds to a CSV file

1. For each compound that you want to export to a CSV file, select the check box in the 
Selected column.

2. Choose File > Export Data > To CSV or Excel from the main menu.

The Data Review Export dialog box opens.

3. Click Browse and, in the Export Data to Excel dialog box, locate the folder where you 
want to save the file.

4. Type a file name for the CSV file and click Save.

5. In the File Format area, select the CSV option.

6. In the Sheet Layout area, select one of the following file formats for the spreadsheet.

• Multiple Files: Writes one sample to each CSV file.

• Single File: Writes all samples to a single CSV file. 

7. In the Data to Export area, select one of the following sets of data to export.

• Export Filtered and Selected Data Only: Writes data from the selected compounds 
to the specified worksheet format.

• Export All Batch Data: Writes all data from all samples in the batch to the specified 
worksheet format.

8. Click Export.

The application saves the specified compound data to an CSV spreadsheet and opens the 
folder where you saved the file.
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 To export compounds to a compound database

1. For each compound that you want to export to a compound database, select the check 
box in the Selected column, including any adducts that you want to export.

2. Choose File > Export Data To > Compound Database from the main menu.

The Export Compounds to CDB dialog box opens.

3. Do one of the following:

• Accept the default target database.

• Click Create and type the name for a new compound database.

• Click Browse and select from the list of compound databases.

4. Click Import.

• When you export compounds to a database that already contains these compounds, 
the application updates the retention times in the database.

• When you add compounds to a database that does not contain these compounds, the 
application adds all the compound data to the database.

When you export only one adduct for a compound, the application uses the selected 
adduct as the peak in the updated or new compound database. When you export multiple 
adducts for export, the application uses the adducts in the order of intensity.

The application uses the measured retention time value for the compound in the updated 
or new compound database.

The application uses the expected m/z value for the compound in the updated or new 
compound database.

The application exports all found fragments to the updated or new compound database.
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 To create a new quantitation method with the selected compounds

1. For each compound that you want to export to a new quantitation method, select the 
check box in the Selected column including any adducts that you want to export.

2. Choose File > Export Data To > New Quantitation Method from the main menu.

The Acquisition page of a new quantitation method opens. 

3. From the Instrument Method list, select a method (.meth) file to use for acquiring the 
data.

4. Choose File > Save from the main menu.

5. In the Save Master Method dialog box, type a name for the method and click OK.

6. Click Compounds in the Method View navigation pane. 

The application exports the selected compounds from the target screening method to the 
new quantitation method and uses data from the selected compounds as follows:

• Exports quantitation peaks in the order of intensity.

• Exports measured retention time value for the compounds in the new method.

• Exports expected m/z value for the compounds in the new method.

• Exports all found fragments to the new method.

• Adds a filter for both quantitative peaks and confirming ions. 
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 To create a new quantitation method and update the compound database

1. For each compound that you want to export, select the check box in the Selected column, 
including any adducts that you want to export.

2. Choose File > Export Data > Update Compound Database and Create New 
Quantitation Method from the main menu.

The Import Compounds to CDB dialog box opens.

The dialog box lists all compounds selected in the screening batch. 

3. Do one of the following:

• Accept the default target database.

• Click Create and type the name for a new target database.

• Click Browse and select from the list of compound databases.

The compounds list indicates which compounds already exist in the target compound 
database and which do not.

4. When any of the compounds already exist in the target database, choose one of the 
following options:

• Update Retention Times: Updates only the retention times for the duplicate 
compounds in the target database.

• Overwrite: Overwrites all compound data for the duplicate compounds in the target 
database.

• Skip: Does not write any data from the duplicate compounds to the target database.
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5. Click Import.

The Acquisition page of a new quantitation method opens.

6. From the Instrument Method list, select a method (.meth) file to use for acquiring the 
data.

7. Choose File > Save from the main menu.

8. In the Save Master Method dialog box, type a name for the method and click OK.

9. Click Compounds in the Method View navigation pane.

The application exports the selected compounds (with the specified options) from the 
target screening method to the new quantitation method.
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Compounds Pane Columns

The columns of data in the Compounds pane display all parameter values associated with 
each compound in the selected sample. See Compounds Pane Parameters.

 To hide or display columns in the Compounds pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Compounds pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Compounds pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 
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Compounds Pane Parameters

The Compounds pane displays all parameter values associated with each compound in the 
selected sample.

Figure 183. Compounds pane

 

Table 131. Compounds pane parameters  (Sheet 1 of 6)

Column Description

Displays the current compound database. When you have multiple screening databases, 
the application lists the results for each database separately. 

Selected Identifies individual compounds for export. To select all compounds for export, select 
the check box in the first column. 

MZ Mass-to-charge ratio flag. The application displays one of these indicators:
• A green circle (pass) when the measured m/z value is within the specified threshold.
• A red square (fail) when the measured m/z value is not within the specified threshold.
• A blank when the mass-to-charge value is unavailable.

To display the expected, measured, and delta m/z, hold your cursor over the indicator. 

Expand the list of found compounds in 
the screening database.

Selects all compounds in the 
Compounds pane.

Selects the compound for 
export.
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RT Retention Time flag. The application displays one of these indicators:
• A green circle (pass) when the measured retention time value is within the RT 

Window value specified in the compound database.
• A red square (fail) when the measured retention time value is not within the RT 

Window value specified in the compound database. In turn, this results in a failure 
flag for the m/z value because the application cannot identify an m/z value that meets 
the retention time.

• A blank when the retention time value is unavailable. When the retention time is 
selected as “confirm” and the m/z is not detected, there is no flag.

Or, you can set a different retention time window in the method. See “Editing the 
Processing Page” on page 264.

To display the expected, measured, and delta retention times, hold your cursor over the 
indicator. 

IP Isotopic Pattern flag. The application displays one of these indicators:
• A green circle (pass) when the score percentage is higher than the specified fit 

threshold percentage.
• A red square (fail) when the score percentage is lower than the specified fit threshold 

percentage.
• A blank when the parameter is not scored.

To display the score of matched isotopes, hold your cursor over the indicator. 

Table 131. Compounds pane parameters  (Sheet 2 of 6)

Column Description
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FI Fragment Ions flag. The application displays one of these indicators:
• A green circle (pass) when the measured m/z value of any of the fragments is within 

the mass tolerance specified in the method. On the Isotopes page in the Spectrum 
pane, the All Isotopes and Multi-Isotopes flags are also green.

• A red square (fail) when the measured m/z value of none of the fragments is within 
the mass tolerance specified in the method. On the Isotopes page in the Spectrum 
pane, the All Isotopes and Multi-Isotopes flags are also red.

• A blank when there are no fragments detected.

To display a list of fragments and their pass/fail status, hold your cursor over the 
indicator. 

LS Library Search flag. The application displays one of these flags:
• A green circle when the library search is successful.
• A red square when the library search is not successful.

Flag Indicates the status of the identification and confirmation criteria.
• A green circle when the sample/compound/peak combination is identified and fully 

confirmed.
• A yellow triangle when the sample/compound/peak combination is identified but 

not fully confirmed.
• A red square when the sample/compound/peak combination is not identified.

Compound Name The compound name match in the compound database.

Match Result Name The compound name match in the compound database and the retention time.

Formula The formula for the peak as specified in the compound database.

Adduct The most intense adduct for the retention time for a compound.

Confirmed The number of criteria confirmed out of the total number specified in the method.

Table 131. Compounds pane parameters  (Sheet 3 of 6)

Column Description
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m/z (Expected) Mass-to-charge ratio from the compound database. Assumes the charge is 1. 

• When an adduct is found, the application displays the neutral mass value for the 
compound (calculated from the neutral formula) ± the mass of the most intense 
adduct ion found for the compound. 

• When no adduct is found, the application displays the neutral mass value for the 
compound ± the mass of the first adduct entered in the compound database. 

For details about defining adducts for the compound database, see “Specifying Adducts” 
on page 53.

For details about adding adducts to compounds, see “Editing Compounds in the 
Database” on page 84.

Note  When the adduct is a gain, the adduct mass is a positive number. When the 
adduct is a loss, the adduct mass is a negative number. The resulting mass value after 
adding or subtracting the adduct mass is always a positive number.

m/z (Apex) Mass-to-charge ratio found in the spectra for the peak. Assumes the charge is 1.

When the application successfully integrates the peak, this column displays the charged 
m/z value for the compound, which is the highest intensity in the apex scan. 

When the application cannot successfully integrate the peak, this column displays “N/F” 
(not found).

m/z (Delta) Difference between the m/z (Expected) and m/z (Apex). Assumes the charge is 1.

When the m/z (Apex) column displays m/z value for the compound, this column displays 
the delta m/z corresponding to the highest intensity in the apex scan.

• When the mass tolerance is specified in ppm in the master method, then
m/z (Delta) = 1 000 000 × ([m/z (Apex) – m/z (Expected)] × m/z (Expected)).

• When the mass tolerance is specified in mmu in the master method, then 
m/z (Delta) = 1000 × m/z (Apex) – m/z (Expected).

RT (Expected) The retention time for the peak as specified in the compound database.

RT (Measured) The found retention time for the peak apex.

RT (Delta) Difference between the expected and measured retention time for the peak. 

Measured Area The AA value from the chromatogram pane.

Isotopic Pattern Score (%) The percentage of the number of total isotopes to the number of matched isotopes.

Table 131. Compounds pane parameters  (Sheet 4 of 6)

Column Description
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Num Isotopes Matched The number of isotopes matched in the expected calculated isotope spectra relative to the 
total number of isotopes used in the score calculation, in the format “x of y”, where

• x = the number of isotopes matching the elemental composition used for the 
Isotopic Pattern Score calculation.

• y = the total number of isotopes considered in the Isotopic Pattern Score calculation. 
This is the number of isotope peaks expected to be above the spectral noise.

Lib Match Name The name of the best matching compound in the library search. When the application 
finds a match in the library, this column displays the matching library entry with the 
highest score.

• When the application does not perform a library search, this column displays “N/A” 
in black text.

• When the application does not perform an MS/MS scan, this column displays 
“N/A” in red text.

Library Score (%) The score from the library fit. When the application finds a match in the library, this 
column displays the highest score associated with the Lib Match Name parameter. 

When the application performs both a library search and an MS/MS scan and both the 
library entry and the formula match the target compound:

• A library score that is higher than or equal to the score threshold meets the criteria, 
and the values in this column appear in green.

• A library score that is lower than the score threshold fails to meet the criteria, and the 
values in this column appear in red.

When the application does not perform a library search, this column displays “N/A” in 
black text. 

When the application does not perform an MS/MS scan, this column displays “N/A” in 
red text.

Valid range: 1 through 100%

Table 131. Compounds pane parameters  (Sheet 5 of 6)

Column Description
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Library Match Rank Displays the ranking of the library match. When the application finds a match in the 
library, this column displays the library entry’s relative rank, in the format “x of y”, where

• x = the rank of the highest scoring library match.
• y = the total number of library matches from the list of matches for a particular 

adduct that contains the highest scoring match.

When the application performs both a library search and an MS/MS scan and both the 
library entry and the formula match the target compound:

• A library score that is higher than or equal to the score threshold meets the criteria, 
and the values in this column appear in green.

• A library score that is lower than the score threshold fails to meet the criteria, and the 
values in this column appear in red.

When the application does not perform a library search, this column displays “N/A” in 
black text. 
When the application does not perform an MS/MS scan, this column displays “N/A” in 
red text.

Fragment n Displays the measured m/z for the fragment ion. The application displays a separate 
column for each found fragment. 

• For each fragment found in the compound database that passes the filter in the 
method, the Compounds table displays the m/z value in green text. 

• For each fragment found in the compound database that does not pass the filter in 
the method, the Compounds table displays the m/z value in red text.

• For each fragment that is not found in the compound database, the Compounds 
table displays N/S (none specified).

Note  Compounds can have a maximum of five fragments, and the Compounds table 
has a maximum of five Fragment columns. When a compound contains fewer than five 
fragments, all remaining Fragment columns display N/S.

Fragment n (Delta 
(ppm/mmu))

The difference between the expected fragment ion m/z from the compound database and 
the measured fragment ion m/z. 

The application displays a separate delta column for each identified fragment.

S/N The signal-to-noise ratio calculated for the found peak.

Left RT The time point of the left leading edge of the integrated peak.

Right RT The time point of the right trailing edge of the integrated peak.

Table 131. Compounds pane parameters  (Sheet 6 of 6)

Column Description

Fragment not found in the compound database
Fragment found but does not meet method parameters
Fragment found and meets method parameters



 10 Using the Analysis Mode for Target Screening Batches
Working in Data Review

Thermo Scientific TraceFinder User Guide 583

Chromatogram Pane

Use the Chromatogram pane to display all extracted chromatograms of all adducts of the 
selected compound.

The first tab displays the most intense target adduct for the peak result. Additional (optional) 
tabs display extracted ion chromatograms for other adducts for the target compound at the 
same retention time in order of intensity. If no signal exists for an adduct, it displays the XIC 
of the expected m/z within the specified retention and chromatogram windows. When you do 
not specify a retention time or window, the application displays the full time range. 

For each adduct, the Spectrum pane displays the spectrum, isotopes, fragments, and library 
matches. See Spectrum Pane.

Figure 184. Chromatogram pane

Table 132. Chromatogram pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
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Spectrum Pane

Use the Spectrum pane to display the spectrum, isotopes, fragments, and library search 
information for the selected adduct in the Chromatogram pane. The Spectrum pane displays 
only the identification and confirmation criteria specified in the method. The confirmations 
are based only on the most intense adduct. See “Editing the Processing Page” on page 264.

The Spectrum pane includes the following pages of information (when available) for each 
selected sample/compound/peak combination:

• Spectrum

• Isotopes

• Fragments

• Library

Spectrum

The application displays the neutral loss (NL) and compound/peak name information on the 
right side of the Spectrum page. When data is available, the plot width is the full mass range 
in the raw data file. Otherwise, the application scales the width to the scan range.

Figure 185. Spectrum page

Table 133. Spectrum page shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
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Isotopes

The isotopes page displays isotopic pattern results for all adducts of a compound according to 
the threshold and deviation parameters defined in the screening method. 

To identify or confirm the presence of a compound, the resulting score percentage from 
isotopic pattern matching must be higher than the specified fit threshold percentage. 

• An isotope peak is not found if its intensity, relative to the monoisotopic ion’s intensity, is 
more than the specified intensity deviation percentage away from the theoretical relative 
intensity of the isotope ion. 

• An isotope peak is found if its measured m/z is less than the specified mass deviation 
amount away from its expected m/z. 

To specify threshold and deviation parameters, see “Editing the Processing Page” on page 264.

The Isotopes page displays the isotopes in one of three ways:

• All Isotopes

• Multi-Isotopes

• Individual Isotopes

All isotopes pages use a shortcut menu so that you can specify how to display the data. See 
“Isotopes Page Shortcut Menu” on page 590.

All Isotopes

The All Isotopes view displays a composite of all isotopes found in the compound. The 
application scales the window with respect to the most intense isotope. The most intense 
isotope is usually the first isotope unless you are using halogenated compounds. The 
application displays the measured peak as a solid red line; the application displays the 
expected peak as a dashed blue line.

The application displays these headers for the All Isotopes view:

Scan range for 
the isotopes

Retention time 
range for all 
scans

Number of 
averaged 
scans 

Processing 
filter

File name
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Figure 186. Isotopes page with stacked spectra for all isotopes

Figure 187. Isotopes page with overlaid spectra for all isotopes

Measured spectrum Expected spectrumExpected m/z of the isotope

Measured spectrum in redExpected spectrum in blue
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Multi-Isotopes

The Multi-Isotopes view displays individual plots for each isotope. You can individually stack 
or overlay the plots for each isotope. 

The application displays these headers for the Multi-Isotopes view:

Figure 188. Isotopes page with overlaid spectra for multi-isotopes

Scan range for 
the isotopes

Retention time 
range for all 
scans

Number of 
averaged 
scans 

Expected spectrum in blue Measured spectrum in red
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Figure 189. Isotopes page with stacked spectra for multi-isotopes

Figure 190. Isotopes page with stacked and overlaid spectra for multi-isotopes

Measured spectrum in redExpected spectrum in blue

Measured spectrum in redExpected spectrum in blue
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Individual Isotopes

The individual isotopes view displays the expected and measured peaks for a single isotope. 

The application displays these headers for the individual isotopes view:

Figure 191. Isotopes page with overlaid spectra for a single isotope
 

Scan range for 
the isotopes

Retention time range 
for all scans

Number of averaged 
scans 

Expected m/z 
for isotope 5

Measured m/z 
for isotope 5

Delta between 
expected and 
measured m/z

Measured spectrum in redExpected spectrum in blue
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Figure 192. Isotopes page with stacked spectra for a single isotope
 

Isotopes Page Shortcut Menu

Use the commands in the shortcut menu to specify how you want the data displayed.

Table 134. Isotopes page shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the simulated 
spectrum and the peak apex spectrum.

Show/Hide Noise Label Adds a noise label to each peak. Expected isotope peaks 
(displayed in blue) do not display a noise label.

Show/Hide Resolution 
Label

Adds a resolution label to each peak. Expected isotope peaks 
(displayed in blue) do not display a resolution label.

Measured spectrum in redExpected spectrum in blue
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Fragments

The Fragments page displays the maximum number of fragments as specified in the screening 
method. See “Editing the Processing Page” on page 264. 

If there are no fragments defined in the screening library for the compound, you can add 
fragments to the screening library. See “To add a fragment to a target peak” on page 90.

The Fragments page displays the fragments in one of two ways:

• All Fragments

• Individual Fragments

All fragments pages use a shortcut menu so that you can specify how to display the data. See 
“Fragments Page Shortcut Menu” on page 593.

All Fragments

The All Fragments view displays a composite of all fragments found in the compound. The 
application displays the measured peak as a solid red line; the application displays the 
expected peak as a dashed blue line.

The application displays these headers for the All Fragments view:

Figure 193. Fragments page with overlaid spectra for all fragments

Minimum number 
of fragments 
specified in the 
method

Processing 
filter

File name
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Figure 194. Fragments page with stacked spectra for all fragments

Individual Fragments

The individual fragments view displays the expected and measured peaks for a single 
fragment. 

The application displays these headers for the individual fragments view:
Minimum number of fragments specified 
in the method

Expected m/z 
for fragment 1

Measured m/z 
for fragment 1

Delta between 
expected and 
measured m/z
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Figure 195. Fragments page with overlaid spectra for a single fragment

Figure 196. Fragments page with stacked spectra for a single fragment

Fragments Page Shortcut Menu

Use the commands in the shortcut menu to specify how you want the data displayed. 

Table 135. Fragments page shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the simulated 
spectrum and the peak apex spectrum.

Intensity threshold specified in the method



10 Using the Analysis Mode for Target Screening Batches
Working in Data Review

594 TraceFinder User Guide Thermo Scientific

Library

The Library page displays the matching library spectrum (in blue) and the experimental 
spectrum (in black). The resulting score percentage from a library search match must be 
higher than your specified threshold value to identify or confirm the presence of a compound. 
See “Editing the Processing Page” on page 264. 

The application scales both the matched library spectrum and the highest peak in the 
experimental spectra at 100 percent intensity and displays the resulting neutral loss (NL) 
value for the matched library entry name on the right of the plot. 

The application displays these headers for the individual adducts:

Figure 197. Library page with stacked spectra

 Library match name

 Adduct  Formula  Library match rank

 Library score percentage
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Figure 198. Library page with overlaid spectra

Library Page Shortcut Menu

Use the commands in the shortcut menu to specify how you want the data displayed. 

Table 136. Library page shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the simulated 
spectrum and the peak apex spectrum.
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Working in the Report View
The Report View displays example reports for the current batch. You must have an open 
batch to use the features in the Report View.

Follow these procedures:

• To open the Report View

• To preview a report

• To generate a report as a PDF, an Excel, or a CSV file

• To print a report

• To display a generated report

• To edit a report template

• To create a new report template

 To open the Report View

Click Report View in the navigation pane.

The application opens the Report View. For detailed descriptions of all parameters, see 
“Report View” on page 600.

 To preview a report

1. In the Template pane, select a report template.

The template list shows all the report templates that you configured in the Configuration 
console. See “Specifying the Reports” on page 71. 

Figure 199. Example of a report template list

2. Click Preview, .

The application opens the Report Designer, showing the report information for the 
current batch in the selected report template format.

For details about using the Report Designer, see Chapter 12, “Using the Report 
Designer.” 
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 To generate a report as a PDF, an Excel, or a CSV file

1. In the Template pane, select a report template.

2. Select the check box for each of the file types that you want to create: PDF, Excel, or 
CSV.

3. Click Generate, .

The application does the following:

• Displays a green progress bar as it generates the reports.

• Creates a report for the current batch as a PDF, an Excel, or a CSV file, using the 
selected report template format.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 600.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.

 To print a report 

1. In the Template pane, select a report template.

2. Select the check box for the Print file format.

3. Click Generate, .

The application does the following:

• Creates a report for the current batch using the selected report template format.

• Prints the report to your default printer.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 600.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.

 To display a generated report

In the Generated Reports pane, click View for the report that you want to see.

The application opens the output file.

Opens the generated file.
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 To edit a report template

1. In the Template pane, select a report template.

2. Click Open, .

The application opens the Report Designer showing the template in an Excel spreadsheet. 
See Report Designer showing the template for the selected report.

Figure 200. Report Designer showing the template for the selected report

3. Use the features in the Report Designer to edit the template.

See Chapter 12, “Using the Report Designer.” 

4. When you finish your changes, choose File > Save from the Report Designer menu bar.

 To create a new report template

1. Click New, .

The application opens the Report Designer showing an empty template in an Excel 
spreadsheet. See Report Designer showing a new, empty template.

The Report Type is None.

In the left pane, the spreadsheet lists all samples in the current batch and all compounds 
in the method used for the batch.

Note   You cannot edit report templates that were provided with the TraceFinder 
application; however, you can open a TraceFinder template, make changes, and save it 
to a new template name.

Note  When user security is activated, you must have Template Editing permission to 
edit report templates created by your laboratory. If the Open button is not active, user 
security is activated and you do not have Template Editing permission. 
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Figure 201. Report Designer showing a new, empty template

2. Use the features in the Report Designer to create the report template.

See Chapter 12, “Using the Report Designer.” 

3. When you finish your changes, choose File > Save from the Report Designer menu bar.

The Save Template dialog box opens.

Figure 202. Save Template dialog box

4. Type a name for the new report template and click OK.
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Report View

Use the features in the Report View to display example reports for the current batch. 

Figure 203. Report View

Table 137. Report View parameters  (Sheet 1 of 2)

Parameter Description

Template

Displays all report templates.
Rules

Sheet Name Specifies each sheet in the report.
Rules Specifies the type of data used in each sheet in the selected report.

• Batch
• EachSample
• SampleType: SampleType
• CompoundType: CompoundType
• SampleCustomFormula: 

Buttons

 View Report Templates Displays the C:\TraceFinderData\3.3\Templates\ReportTemplates folder that contains 
all report templates.
Opens the selected report template in the Report Designer.

Opens a blank report template in the Report Designer.

Opens the Report Designer showing the report information for the current batch in the 
selected report template format.
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PDF Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

Excel Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

CSV Saves the generated report as a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

When the report contains multiple sheets, the application writes each sheet as a separate 
CSV file.

Print Prints the generated report to your default printer.
Generates the selected type of reports for the current batch using the selected report 
template.

Generated Reports

Template Report template used for the report. See “Example of a report template list” on 
page 596.

Rule Type of data used in each sheet of the report. See Rules.
Sample For sample-level reports, the name of each sample in the report.
Output Type of output specified for the report: PDF, Excel, CSV, or Print.
Generated Report File Lists the output file name for each report in the …\TraceFinderData\3.3\Projects folder.
View Displays the generated output file.

 View Generated Reports Displays the C:\TraceFinderData\3.3\Projects folder that contains all report outputs.
Clear Removes all reports from the Generated Reports display. This does not delete the reports 

from the C:\TraceFinderData\3.3\Projects folder.

Table 137. Report View parameters  (Sheet 2 of 2)

Parameter Description
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Working in the Local Method View 
A local method is a copy of a master method associated with a batch. You can edit only the 
local copy of the method, or you can edit the master method and overwrite the local copy 
with the edited master method.

In the Local Method view, you can edit the local method parameters. A local method is a copy 
of a master method associated with a batch. Local methods are named Batch_MasterMethod. 

 To open the Local Method View

1. Click Analysis in the navigation pane.

2. Click Local Method.

The Local Method view for the currently selected batch opens. See Local Method View.

You can edit many of the method parameters in a local method. Editing the local method 
does not affect parameters in the master method.

For detailed descriptions of method parameters, see “Editing a Master Method” on 
page 261.

3. Enter any local changes to the method.

4. When you have finished editing the local method, choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. 
You can use this feature to overwrite an edited local method with the original master 
method or to overwrite the local method with an updated master method.
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Figure 204. Local Method View
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11

Using the Analysis Mode for Unknown Screening 
Batches

This chapter includes instructions about using the features of the Analysis mode to do the 
following:

• Create unknown screening batches.

• Submit unknown screening batches for acquisition, processing, or report generation.

• Review unknown screening batches, batch data, reports, and local methods.

 To access the Analysis mode

Click Analysis in the navigation pane.

The Analysis navigation pane opens.

Contents

• Working in the Batch View

• Working in Data Review

• Working in the Report View

• Working in the Local Method View



11 Using the Analysis Mode for Unknown Screening Batches
Working in the Batch View

606 TraceFinder User Guide Thermo Scientific

Working in the Batch View 
In the Batch View, you can manually create and edit a new unknown screening batch or open 
and edit a previously saved batch. When you submit a batch, you can acquire and process data 
and optionally create reports for the submitted samples.

The Analysis mode includes a toolbar:

Use the toolbar or the equivalent commands in the Batch View shortcut menu to create the 
sample list and submit samples for acquisition. See “Toolbar” on page 614 or “Batch View 
Shortcut Menu” on page 618.

 To open the Samples page in the Batch View

1. Click Analysis in the navigation pane of the current mode.

2. Click Batch View or Samples.

The Samples page opens.

This section contains information about the following topics:

• Samples Page Features

• Creating a New Batch

• Editing a Batch

• Submitting a Batch

Samples Page Features

The Samples page (see Samples page) is divided into two panes: 

• Samples pane

Use the samples pane to create a batch. See Samples Pane.

• Compound Active Status pane

Use the Compound Active Status pane to make specific compounds active or inactive. See 
“Compound Active Status Pane” on page 620.



 11 Using the Analysis Mode for Unknown Screening Batches
Working in the Batch View

Thermo Scientific TraceFinder User Guide 607

Figure 205. Samples page

Samples Pane

The samples pane includes the following features:

• Column Display

• Status Indicators

• Groups

• Sample Weight Calculation

• Instrument Methods

• Toolbar

• Batch View Sample List

• Batch View Shortcut Menu

Column Display

The sample list contains many columns of information. You can scroll to see all the columns, 
and you can customize which ones to display and their display order.

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the following columns 
remain fixed: Status, Filename, Sample Type, Groups, Level, Sample ID, and Sample 
Name, while the other columns scroll right and left. 

Samples pane

Compound Active Status pane

Tip  To resize the panes, drag the separators that divide the panes.
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 To customize the column display 

1. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

These columns appear after the Status, Filename, Sample Type, Groups, Level, Sample 
ID, and Sample Name columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. Repeat step 4 for all columns whose widths you want to change, and click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View. 

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Level, Sample ID, and Sample Name.
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Figure 206. Modify Columns dialog box 

Table 138. Button descriptions for the Modify Columns dialog box

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except fixed columns.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 
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Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing.

 Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Groups

Use the Groups feature to assign samples to a group. 

 To create a group 

1. For each sample, type the name of a group in the Groups column.

Repeat this for each sample that you want to include in a group.

2. Create as many groups as you want. 

You can create a control group (specify the group name as Control) to use for group 
averages in Data Review.

For information about group averages, see “Group Averages Pane” on page 656. For 
information about maximum fold analysis, see “Cross Sample Peak List Pane” on 
page 643.

Note  To assign a sample to multiple groups, separate the groups with a comma. 

The application uses the first group listed for the Maximum Fold analysis and in 
the Group Averages pane. 

Status indicators
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Sample Weight Calculation

Use the sample weight features to calculate the conversion factor for a sample. The application 
uses different methods to calculate the conversion factor for liquid or solid calculation types.

Liquid: SampleVolume DilutionFactor

Solid: (SampleVolume × DilutionFactor) SampleWeight

Manual: The application does not calculate the Conversion Factor. Instead, you can enter the 
Conversion Factor value.

Follow these procedures:

• To display the features for calculating sample weight

• To calculate the conversion factor for a liquid sample

• To calculate the conversion factor for a solid sample

• To manually specify the conversion factor for a sample

 To display the features for calculating sample weight 

If the Conversion Factor, Sample Volume, Dilution Factor, Sample Weight, Calculation 
Type, and Final Units columns are not visible, right-click and choose Enable Sample 
Weight Calculation from the shortcut menu.
 

 To calculate the conversion factor for a liquid sample

1. From the Calculation Type list, select Liquid.

For a liquid sample, the Sample Weight value is not editable.

2. In the Sample Volume column, type the volume in ng/mL for your sample.

3. In the Dilution Factor column, type the value for the dilution. 

For example, if you have 1000 ng/mL of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

4. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

Note  The application uses the following formula to calculate the Conversion Factor: 
SampleVolume DilutionFactor
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 To calculate the conversion factor for a solid sample

1. From the Calculation Type list, select Solid.

2. In the Sample Weight column, type the weight in ng for your sample.

3. In the Sample Volume column, type the volume in ng/ml for your sample.

4. In the Dilution Factor column, type the value for the dilution.

For example, if you have 1000 ng/ml of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

5. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

 To manually specify the conversion factor for a sample

1. From the Calculation Type list, select Manual.

For a manually calculated sample, the only available columns are the Conversion Factor 
and the Final Units. 

2. In the Conversion Factor column, type the conversion factor to use for your sample.

3. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view or in reports.

Instrument Methods

Use the Instrument Methods column to specify instrument methods for the samples. 

 To specify instrument methods for samples

1. Display the Instrument Method column in the sample list:

a. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens.

b. In the Available Columns pane, select Instrument Method.

c. Click  to move the Instrument Method column to the Displayed Columns 
pane.

Note  The application uses the following formula to calculate the Conversion Factor: 
(SampleVolume × DilutionFactor) SampleWeight

Note  The application uses the specified conversion factor when it calculates the 
amount for the sample.

Note   By default, the Instrument Method column is not displayed in the Batch View 
sample list.
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d. Click OK.

The application displays the Instrument Method column, defaulting to the instrument 
method specified in the master method. 

2. Click the Instrument Method column and select an instrument method from the list.

This list contains all the available instrument methods. Instrument methods from 
external sources are prefixed with “Ext:”.

You can specify a different instrument method for each sample.

When you submit the batch for acquisition, the application saves a copy of the selected 
instrument methods to the following folders:

External instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method\ExternalMethods

Local instrument methods:

…\TraceFinderData\3.3\Projects\…\batch\Methods\method
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Toolbar

The Analysis mode includes this toolbar for creating and submitting a batch.

Table 139. Toolbar icons

Icon Description

Adds the specified number of new, empty samples to the end of the 
sample list. See the instructions “To add samples to the list” on 
page 622.

Inserts a new, empty sample or samples above the selected sample. See 
the instructions “To insert samples into the list” on page 623.

Removes the selected samples from the sample list. See the 
instructions “To remove samples from the list” on page 624.

Adds imported samples from a CSV, an XML, or an SLD file to the 
sample list. See the instructions “To import samples into the list” on 
page 623.

Submits only the selected samples for acquisition, processing, or 
report generation. See the instructions “To submit samples in the 
batch” on page 633.

Submits the batch for acquisition, processing, or report generation. 
See the instructions “To submit samples in the batch” on page 633.

Submits only the selected samples for processing. See the instructions 
“To submit selected peaks for processing” on page 633.

Opens the Acquisition mode where you can use a batch template to 
define a standard sequence composed of various sample types to be 
assembled into a batch of samples. See “Working in Data Review” on 
page 642. 

Opens the Acquisition mode where you can create a batch template 
that contains the basic settings and sample types for your batches. See 
“Using the Acquisition Mode” on page 347.

Opens the Quick Acquisition window where you can quickly submit a 
single sample. See Appendix A, “Using Quick Acquisition.” 

Opens the Audit Viewer where you can view audit logs. See 
Chapter 13, “Using the Audit Viewer.”  Available only when you 
enable Auditing in the Administrator Console. Refer to the 
instructions in the TraceFinder Administrator Console User Guide.
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Batch View Sample List

The sample list displays all the quantitative data for the samples of a batch. 

Status indicators for each sample indicate if the sample is currently acquiring, not acquired, 
acquired, or processed. 

The sample list includes the following columns of information:

Figure 207. Batch View sample list
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Table 140. Batch View sample list columns  (Sheet 1 of 2)

Column Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Note   When you include unknown screening features in a quantitation method and you 
choose to process with only the unknown screening criteria, both the Sample View and 
the Unknown Screening View show the Status for the samples as acquired and processed 
( ). 

Note  When you include unknown screening features in a target screening method and 
you choose to process with only the unknown screening criteria, both the Samples view 
and the Unknown Screening View show the Status for the samples as acquired and 
processed ( ). 

Groups Threshold group to which a sample belongs. 

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the application processes the sample data. Each sample is classified as one of 
the following sample types: Matrix Blank, Solvent, Cal Std, QC Std, or Unknown

Default: Unknown

Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Injection Volume The injection volume (in microliters) of the injected sample. 

When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the Autosampler you configure. The usable range 
depends on the injection mode and might be smaller than the displayed range.

The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Valid range: 0.1 through 5000 μL
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Calculation Type Liquid: The application calculates the Conversion Factor as 

SampleVolume DilutionFactor

Solid: The application calculates the Conversion Factor as 

(SampleVolume × DilutionFactor) SampleWeight

Manual: Sample Volume, Dilution Factor, Sample Weight, and Final Units columns are not 
available, and the Conversion Factor value is editable.

Conversion Factor Editable only when Calculation Type is Manual. 

Default: 1

Sample Volume Default: 1

Dilution Factor Default: 1

Sample Weight Available only when Calculation Type is Solid. 

Default: 1

Final Units Specifies the calculated amount in the Data Review view or in reports.

Default: 1

Instrument Method Specifies the instrument to use for the acquisition. This column is hidden by default. To 
display this column, see “To customize the column display” on page 608.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have activated multiplexing in the 
Configuration console. See “Multiplexing” on page 61.

Barcode Expected A user-entered barcode for the vial.

Barcode Actual An actual barcode for the vial. This value is not editable.

Comment A user-defined comment for the sample.

Table 140. Batch View sample list columns  (Sheet 2 of 2)

Column Description
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Batch View Shortcut Menu

The Batch View includes a shortcut menu for creating a batch.

Table 141. Batch View shortcut menu commands  (Sheet 1 of 2)

Command Description

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected 
row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the 
row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the 
file name. Additional reinjections of the same sample are 
numbered INJ002, INJ003, and so forth.

Remove Selected 
Samples

Removes selected samples from the sample grid.

Import Samples Opens the Sample Import Tool. See “To import samples into the 
list” on page 623.

Browse in Raw File 
(Move)

Opens a dialog box where you can select a raw data file to use for 
the selected sample row. The application removes the raw data 
file from the source location.

Browse in Raw File 
(Copy)

Opens a dialog box where you can select a raw data file to use for 
the selected sample row. The application copies the raw data file 
from the source location.

Map Raw Files to 
Samples

Opens a dialog box where you can select multiple raw data files 
to use for the selected sample rows.

Copy Down Copies the value in the selected row to all rows below it. This 
command is available only when you have selected a value that 
can be copied down.

Fill Down Enters sequential values in the column starting with the value in 
the selected row and ending with the last row in the column. 
This command is available only when you have selected a value 
that can be filled down.

Modify Columns Opens the Modify Columns dialog box. See “Column Display” 
on page 607.

Enable/Disable Sample 
Weight Calculation

Displays or hides the Sample Volume, Dilution Factor, Sample 
Weight, Calculation Type, and Final Units columns.

Copy Copies the data in the selected rows or columns to the Clipboard. 
Use this command to copy sample information into a text editor 
or spreadsheet application. You cannot paste this data back into 
the Batch View sample list.
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Copy with Headers Copies the data in the selected rows or columns and the 
associated column headers to the Clipboard. Use this command 
to copy sample information into another text editor or 
spreadsheet application. You cannot paste this data back into the 
sample list. 

For example

Paste Pastes a single column of copied data from another text editor or 
spreadsheet application into the selected column.

Undo Last Paste Removes the last pasted item in the Batch View. 

Export to CSV File Opens the Save As dialog box where you can save the current 
sample list to a CSV file.

Edit Instrument Method Opens the Instrument Setup window where you can edit the 
parameters of the instrument method. 

• When you edit an external method, the application updates 
the method in the …\Xcalibur\methods folder. 

• When you edit an internal method, the application updates 
the method in the 
…\TraceFinderData\3.3\Projects\…\batch\Methods\method 
folder.

For detailed information about editing instrument methods, see 
“Working with Instrument Methods” on page 108.

Table 141. Batch View shortcut menu commands  (Sheet 2 of 2)

Command Description

Copy with Headers 
from TraceFinder

Paste into an Excel spreadsheet.
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Compound Active Status Pane

In the Compound Active Status pane, you can choose specific compounds to be active or 
inactive.

 To set a compound as active or inactive

1. In the sample list, select a sample.

All compounds in the selected sample are listed in the Compound Active Status pane.

The default active/inactive status is determined by the identification settings in the local 
method. For information about setting the identification parameters, see “Identification” 
on page 152.

• To display compounds alphabetically, right-click and choose Sort by Compound 
Name from the shortcut menu.

• To display compounds from shorter to longer retention times, right-click and choose 
Sort by Retention Time from the shortcut menu.

2. Select or clear the Active check box for the compound.

Compound Active/Inactive Status

You can specify which compounds are active or inactive in the Local Method View or the 
Batch View.

Figure 208. Active and inactive compounds in the Local Method View

For details about setting the status on the Identification page, see “Identification” on 
page 152.
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Figure 209. Active and inactive compounds in the Batch View

For details about setting the status in the Batch View, see “Compound Active Status Pane” on 
page 620.

Creating a New Batch

In the Batch View, you can create a new batch. 

Follow these procedures:

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To browse in raw data files

• To customize the column display

 To create a new batch

1. Choose File > New > Batch from the main menu.

The Create New Batch dialog box opens, displaying all drives that contain projects. See 
“Create New Batch Dialog Box” on page 628.
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2. Select a drive from the list.

3. Select the folder where you want to store your batch.

To create a new folder for the storage location, see “Editing Folders for Batches” on 
page 629.

4. Select Unknown Only from the Type list.

The batch list displays all batches in the selected folder. The Method list displays all 
methods for the unknown screening type.

5. Select a master method from the Master Method list. 

6. Click Create.

A new batch opens with one Unknown sample. 

The batch name in the title bar indicates that you are creating an unknown screening 
batch.

 To add samples to the list

1. To add a single sample row, right-click the sample list and choose Add Sample from the 
shortcut menu.

2. To add multiple sample rows, select the number of rows and then click the Add Sample 
icon, .

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  The application displays all configured and enabled repositories. 

Tip  To activate the Create button, you must enter a unique batch name. If the Create 
button is not activated, you have entered a batch name that is already used.
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 To insert samples into the list

Select the sample above which you will insert new, Unknown samples, and then do one of 
the following:

• To insert a single sample row, right-click and choose Insert Sample from the shortcut 
menu. 

• To insert multiple sample rows, select the number of rows and then click the Insert 
Sample icon .

The application inserts the Unknown samples above the selected sample.

 To import samples into the list

1. Choose Batch > Import Samples from the main menu, or click the Import Samples 
icon, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a CSV, an XML, or an SLD file.

2. Click Browse and select a CSV, an XML, or an SLD file that contains the samples to 
import.

3. From the Imported Samples Will Be list, select Appended to the End of the List or 
Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the sample list. 

When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following column name substitutions:

Xcalibur column TraceFinder column

Position Vial Position
Inj Vol Injection Volume
Dil Factor Conversion Factor

Inserted samples
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When you import samples from an Xcalibur sequence file (.sld), the application makes 
the following sample type substitutions:

5. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The application inserts the copy above the selected sample.

 To reinject a sample

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

 To edit sample values

1. For each sample, do one of the following:

Type a new file name over the current filename.

–or–

Double-click the Filename column and locate a raw data file to use for the sample. 

–or–

Right-click and choose Browse in Raw File from the shortcut menu, and then locate a 
raw data file to use for the sample.

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank
QC QC Std
Std Bracket Cal Std

Note  The Channel column is available only when you have activated multiplexing in 
the Configuration console. See “Multiplexing” on page 61.

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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By default, the application sets the Sample Type to Unknown.

2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or QC Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select in the 
Level list, do the following:
a. Return to the Method Development mode.
b. Open the method.
c. Click the Compounds tab.
d. Click the Calibration Levels tab.
e. Add the levels.
f. Save the method.
g. Return to the Batch View in the Analysis mode, and then click Update.

The application updates the local method with the new sample levels.

For detailed instructions about specifying calibration levels, see “Calibration Levels” on 
page 207.

4. Type a vial position in the Vial Position column for each sample. 

5. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

6. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix C, 
“Using Copy Down and Fill Down.” 

 To browse in raw data files

1. Do one of the following:

Double-click the Filename column.

–or–

Right-click and choose Browse in Raw File from the shortcut menu.

Available sample types

Matrix Blank Solvent QC Std Unknown
Cal Std

Note  When you use the scroll bar at the bottom of the sample list, the following 
columns remain fixed: Status, Filename, Sample Type, Groups, Level, Sample ID, and 
Sample Name, while the other columns scroll right and left. 
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The What Raw File Would You Like to Use dialog box opens.

2. Select a raw data file to use for the sample or use the CTRL key to select multiple files, 
and then click Open.

The application overwrites the selected, unacquired sample in the batch with the first 
“browsed in” file and adds any additional browsed in files below the selected sample.

For all browsed-in raw data files, the application sets the Status to Acquired, , and sets 
the Sample Type to Unknown. 

 To customize the column display

1. Right-click the Batch View sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens. See Modify Columns dialog box.

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select appear after the Status, Filename, Sample Type, Groups, Level, 
Sample ID, and Sample Name columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

Note  You cannot overwrite an acquired sample. When you select a sample that is 
acquired, the application adds all browsed in files below the selected sample.

Note  The following columns are fixed: Status, Filename, Sample Type, Groups, 
Level, Sample ID, and Sample Name.
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Figure 210. Modify Columns dialog box 

Table 142. Button descriptions for the Modify Columns dialog box 

Button Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

The following buttons apply to all columns, except for those that are fixed: Status, Filename, 
Sample Type, Groups, Level, Sample ID, and Sample Name.

Moves the selected column to the Available Columns pane. 

Moves all columns except those that are fixed.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. 

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. 
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Create New Batch Dialog Box

Use the Create New Batch dialog box to select a folder and method for your batch and to 
name the new batch.

 

Table 143. Create New Batch dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level folders; you must delete the lower-level 
folders first.

Or, right-click and choose Delete from the shortcut menu.

 

Rename Folder

Renames the selected folder.

Or, right-click and choose Rename from the shortcut menu.

Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.
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Editing Folders for Batches

From the Create New Batch dialog box, you can create new folders for your batches. You can 
also delete or rename folders.

Use these procedures:

• To create new project folders

• To delete project folders

• To rename project folders

 To create new project folders

1. In the Create New Batch dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names are limited to 30 characters and can contain spaces and special characters, 
except for the following special characters: \ / : + ? ” < >

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Type Type of batch to create: Quan, Screening, or Unknown Only.

Method Method used to create the new batch.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Create Creates the specified batch and opens the Batch View for the new batch.

Cancel Closes the Create New Batch dialog box without creating a batch.

Table 143. Create New Batch dialog box parameters  (Sheet 2 of 2)

Parameter Description

Note  After you add a lower-level folder, you cannot rename the parent folder.
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 To delete project folders

1. In the Create New Batch dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

 To rename project folders

1. In the Create New Batch dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Editing a Batch

In the Batch View, you can open a saved batch and edit the sample list. You can add samples, 
edit samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for reinjection. If the batch has unacquired samples when you complete your edits, 
you can save it as a “ready to acquire” batch. 

Follow these procedures:

• To open a saved batch

• To open a recent batch

• To edit samples in a batch

• To reinject a sample from a previously acquired batch

 To open a saved batch

1. Choose File > Open > Batch from the main menu.

The Open Batch dialog box opens. See Open Batch dialog box.

2. Select a project and a subproject.

3. Select Unknown Only or Any from the Type list.

The batch list displays all batches created with Unknown methods (or all methods of all 
types when you select Any).

Note  You cannot delete folders that contains lower-level folders; you must delete the 
lower-level folders first.

Note  You cannot rename folders that contain lower-level folders.
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4. Select a batch from the list. 

5. Click Open.

The selected batch opens in the Batch View. 

Figure 211. Open Batch dialog box

Table 144. Open Batch dialog box parameters 

Parameter Description

Batch Name of batches in the selected project.
Type Type of batch: Quan, Screening, or Unknown Only.
Date Changed Date the batch was last updated.
Samples Number of samples in the batch.
Method Name of the method used to create the batch.
Size Size of the batch in megabytes.
Domain TraceFinder domain in which the batch was created.
Path Path to the project in the TraceFinderData\3.3\Projects folder where the 

batch is stored.
Buttons

Type Type of batch to display in the Batch list: Quan, Screening, Unknown 
Only, or Any.

Open Opens the Batch View for the selected batch.
Cancel Closes the Open Batch dialog box without opening a batch.
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 To open a recent batch 

Choose File > Recent Files > batch from the main menu.

The selected batch opens in the Batch View.

 To edit samples in a batch

Use the commands described in “Working in the Batch View” on page 606.

You can add new samples, edit samples, or delete samples.

 To reinject a sample from a previously acquired batch

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The application creates a copy of the selected sample and appends INJ001 to the file 
name. Additional reinjections of the sample are numbered INJ002, INJ003, and so forth. 
The application copies all parameter values from the original sample.

A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit all samples in this batch, the application acquires all samples (including 
previously acquired samples).

3. To save this batch with the new samples for reinjection, choose File > Save > Batch from 
the main menu.

The batch is saved as a prepared batch that is ready to submit. You can open this batch 
from the Reinject Samples page in the Acquisition mode and submit the batch. The 
application acquires only the samples that have not been previously acquired.
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Submitting a Batch

In the Batch View, you can submit an entire batch or only selected samples in the batch. 
When you submit a batch for acquisition and processing, you can choose to create reports for 
the submitted samples. See “Submit Options dialog box” on page 635.

For a description of commands in the shortcut menu, see “ Batch View shortcut menu 
commands” on page 618.

Follow these procedures:

• To submit selected peaks for processing

• To submit samples in the batch

• To view the output files

 To submit selected peaks for processing

1. In the Peak List, select the Selected check box for the peaks that you want to process.

2. Click the Submit … for Processing icon, .

The application processes the selected peaks and updates the data in the Peak 
Identifications pane.

 To submit samples in the batch

1. Do one of the following:

• To submit all samples in the batch, click the Submit Batch icon, .

• To submit specific samples, select the samples and click the 

Submit Selected Samples icon, .

The Submit Options dialog box opens. See “Submit Options dialog box” on page 635.

2. To acquire (or reacquire) the submitted samples, select the Acquire Data check box.

• When all submitted samples have been previously acquired, this option is (by default) 
not selected. 

• When one or more samples in the batch have not been acquired, this option is (by 
default) selected.

3. To process the submitted samples, select the Process Data check box.

The application displays processing options for the Unknown Screening method.

Note  You can also submit only selected peaks for processing. See To submit selected 
peaks for processing.

Tip  You can process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when reprocessing samples.
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4. Select the check box for the unknown screening options that you want to use.

Peak Detect: Performs peak detection. You can process the data with or without 
performing peak detection. For example, you might want to turn off peak detection when 
reprocessing samples.

Identify: Performs identification. This produces the peak identification data in the 
Unknown Screening View.

With RT Alignment: Performs retention time alignment. This produces the heat map 
and group averages data in the Unknown Screening View. When you select this option, 
the application automatically selects the Peak Detect option.

5. (Optional) Select the Create Reports check box.

6. (Optional with multiplexing activated) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

7. (Optional without multiplexing activated) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

8. To specify the following optional parameters, click Show Details.

a. Select the Use check box for the device that you want to use for this acquisition.

b. Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

c. Select the Start When Ready check box, which starts all instruments together when 
they are all ready. 

When this is cleared, individual instruments can start at different times and then have 
to wait for the last instrument to be ready.

d. Select the system state after it acquires the last batch: On, Standby, or Off.

9. To start the selected processes, click OK. 

The selected processes begin, and the application shows the real-time display at the 
bottom of the current window. You can begin another batch in the Analysis mode while 
you watch the real-time display of the currently acquiring batch. 

Note  When you select Full Sequence Submission in the Configuration console, these 
options are unavailable because the current batch and the current sample are, in effect, 
the same thing. 
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Figure 212. Submit Options dialog box

IMPORTANT   After the first processing, you might see an error message stating that the 
total number of results is too large for a single batch (more than 500 000). Return to the 
Processing pages in the method (“Editing the Processing Pages” on page 311) and make 
one or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.

Table 145. Submit Options dialog box parameters  (Sheet 1 of 3)

Parameter Description 

User Name Name of the current user.
Samples Number of samples to be submitted for acquisition, processing, or 

reporting.
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Workflow Steps to Perform

Acquire Data Submits the current batch to acquisition.
• When all submitted samples have been previously acquired, this 

option is (by default) not selected. 
• When one or more samples in the batch have not been 

acquired, this option is (by default) selected.
Process Data Processes the data for the current batch using any of the following 

options:

Peak Detect: Performs peak detection for all method types. You can 
process the data with or without performing peak detection. For 
example, you might want to turn off peak detection when 
reprocessing samples.

Identify: Performs identification for unknown screening methods.

With RT Alignment: Performs retention time alignment for 
unknown screening methods. This produces the heat map and 
group averages data in the Unknown Screening View. When you 
select this option, the application automatically selects the Peak 
Detect option.
Note   You can use Unknown Screening features in conjunction 
with Quantitation or Target Screening methods.

For specifying processing data for batches that also use 
Quantitation methods, see “To submit samples in the batch” on 
page 433.

For specifying processing data for batches that also use Target 
Screening methods, see “To submit samples in the batch” on 
page 557.

Create Reports Creates reports for the current batch.

Table 145. Submit Options dialog box parameters  (Sheet 2 of 3)

Parameter Description 
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Submit as a Priority Sequence?

Priority Sequence With multiplexing activated, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing activated, specifies one of the following 
priority options to place the batch in the queue:

Next Available Batch: Places the batch immediately after the 
currently acquiring batch. 

Next Available Sample: Places the batch immediately after the 
currently acquiring sample.
Note  When you select Full Sequence Submission in the 
Configuration console, these options are unavailable because the 
current batch and the current sample are, in effect, the same 
thing. 

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument that you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then reopen 
the application. You cannot configure an instrument while the 
TraceFinder application is running.

Available only when you select the Acquire Data check box.
Use Specifies the instruments used for this acquisition.

Available only when you select the Acquire Data check box.
Start Device Specifies the instrument that initiates the communication with the 

other instruments. This is usually the autosampler.
Available only when you select the Acquire Data check box.

Start When Ready Starts the specified device when all the instruments are ready to 
acquire data. When this is cleared, individual instruments can start 
at different times and then must wait for the last instrument to be 
ready.

Post-run System State Specifies the system state after it acquires the last batch: On 
(default), Standby, or Off.

Buttons

Hide/Show Details Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.
Cancel Closes the Submit Options dialog box without submitting any 

tasks.

Table 145. Submit Options dialog box parameters  (Sheet 3 of 3)

Parameter Description 
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 To view the output files

Locate the files to view from the following directories:

The application writes saved batches to the project folder:

…\TraceFinderData\3.3\Projects\…

For each acquired sample, the application writes an RSX file to the batch Data folder:

…\TraceFinderData\3.3\Projects\…\Data

The application saves method information to the batch Methods folder:

…\TraceFinderData\3.3\Projects\…\Methods

The application writes the reports to the batch Reports folder:

…\TraceFinderData\3.3\Projects\…\batch\Reports

Saving a Batch to a New Location

You can move the current batch to a different project folder, or you can make a copy of the 
current batch and save the copy to a different project folder.

Follow these procedures:

• To save a batch to another project folder

• To move a batch to another folder

• To create new project folder

• To delete project folders

• To rename project folders

 To save a batch to another project folder

1. Choose File > Save > Save Batch As from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 640.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

If you are saving the batch to a different folder, you must give it a unique name. You 
cannot overwrite an existing batch in a folder.

5. Click Save.

When you save the batch to a different folder, the reports reflect the original project 
folders and the application does not save the calibration history.
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 To move a batch to another folder

1. Choose File > Save > Move Batch from the Batch View main menu in the Analysis 
mode.

The Save Batch As dialog box opens. See “Save Batch As Dialog Box” on page 640.

2. Select a storage location.

The default storage location is C:\TraceFinderData\3.3\Projects.

3. Select or create a project folder.

4. Type a name for the new batch.

You must give the batch a unique name in the new subproject folder. You cannot 
overwrite an existing batch.

5. Click Save.

When you move the batch, the reports reflect the original project and subproject folders 
and the application does not save the calibration history.

 To create new project folder

1. In the Save Batch As dialog box, select the folder for which you will create a new 
lower-level folder.

• You can select the main TraceFinderData\3.3\Projects folder and create a new folder 
under it.

• You can select one of the existing folders and create a lower-level folder under it. 

2. Click the Create Folder icon, .

The application adds a new lower-level folder to the selected folder. 

3. Select the new folder name and type a name for the folder.

Folder names can contain spaces and special characters, except for the following special 
characters: \ / : + ? ” < >

 To delete project folders

1. In the Save Batch As dialog box, select the folder to delete.

2. Click the Delete Folder icon, .

With no confirmation prompt, the application immediately removes the selected folder. 

Note  After you add a lower-level folder, you cannot rename the parent folder.

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.
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 To rename project folders

1. In the Save Batch As dialog box, select the folder to rename.

2. Click the Rename Folder icon, .

3. Type a new name for the folder and press ENTER.

The application saves the new folder name. 

Save Batch As Dialog Box

Use the features in the Save Batch As dialog box to save a batch to a new name or to move a 
batch to a different project folder.

Figure 213. Save Batch As dialog box

Note  This feature is not available for folders that contain lower-level project or batch 
folders; you must first delete the lower-level project or batch folders.

Table 146. Save Batch As dialog box parameters  (Sheet 1 of 2)

Parameter Description

 

Create New Folder

Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Or, right-click and choose Create Folder from the shortcut menu.

 

Delete Folder

With no confirmation prompt, immediately removes the selected folder. 

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Delete from the shortcut menu.

 

Rename Folder

Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Or, right-click and choose Rename from the shortcut menu.
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Batch table

Batch Name of batches in the selected project.

Type Type of batch: Quan, Screening, or Unknown Only.

Date Changed Date that the batch was last updated.

Samples Number of samples in the batch.

Method Name of the method used to create the batch.

Size Size of the batch in megabytes.

Domain TraceFinder domain in which the batch was created.

New batch parameters

New Batch Name of the new batch to create.

Note  If the Create button is not activated, you have entered a name that is already used or 
you have not selected a method.

Path Path to the project in the TraceFinderData\3.3\Projects folder where the batch is created.

Buttons

Save Saves the batch to the specified name and folder and opens the Batch View for the new 
batch.

Cancel Closes the Save Batch As dialog box without saving the batch.
Shortcut menu commands 

Create Folder Adds one of the following:
• When a drive is selected, adds a new project-level folder to the drive.
• When a project folder is selected, adds a subproject-level folder to the selected project.
• When a subproject folder is selected, adds a lower-level folder to the subproject. 

Delete Folder Immediately removes the selected folder. There is no prompt to confirm that you want to 
delete the selected folder.

You cannot delete a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Rename Folder Renames the selected folder.

You cannot rename a folder that contains lower-level project or batch folders; you must first 
delete the lower-level project or batch folders.

Expand Child Nodes Expands all project and subproject folders in the Project tree.

Collapse Child Nodes Collapses all project and subproject folders in the Project tree.

Table 146. Save Batch As dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Working in Data Review
The Data Review view displays the data generated by the master method. Use Data Review to 
verify the data for identified peaks before you generate reports. 

When you run samples in an experiment, you can check for peaks that are not already 
identified in either an associated target screening or quantitation method and take appropriate 
steps when the application finds these peaks and proposes whether they match one or more 
compounds using various identification sources.

Follow these procedures:

• To open the Data Review view

• To display or hide a pane on the Unknown Screening View page

• To move, dock, or float Data Review panes

• To restore the default layout

 To open the Data Review view

1. Click Analysis in the navigation pane.

The Analysis navigation pane opens.

2. Click Data Review.

The Data Review navigation pane opens. 

IMPORTANT   When unknown screening features are associated with a quantitation or 
target screening method, the unknown screening results do not include any compounds 
(other than internal standards) that were identified by the quantitation or target screening 
methods.
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 To display or hide a pane on the Unknown Screening View page

From the View menu, choose to display or hide any of the following panes.

A check mark indicates a displayed pane.

 To move, dock, or float Data Review panes

Follow the instructions in Appendix D, “Moving Data Review Panes.” 

 To restore the default layout

Choose View > Restore Default Layout.

The Unknown Screening View displays the default panes in their default locations. 

Cross Sample Peak List Pane

Use the Cross Sample Peak List pane to compare peak values across all samples in a batch.

 To use the Cross Sample Peak List pane

1. In the Peak List pane, select a peak.

The application scrolls the Cross Sample Peak List pane to the specified peak and selects 
the peak. 

2. Use the scroll bar at the bottom of the pane to scroll across the values for the selected peak 
in all samples and groups in the batch.

Displays the Peak List Pane.

Displays the TIC Chromatogram Pane.

Displays the Spectrum Pane.

Displays the Sample List Pane.

Displays the Fragments Pane.

Displays the Isotopes Pane.

Displays the Cross Sample Peak Overlay Pane.

Displays the Heat Map Pane.

Displays the Peak Identifications Pane.

Displays the Library Search Pane.

Displays the Chemical Structure Pane.

Displays the Group Averages Pane.

Displays the XIC Pane.

Displays the Cross Sample Peak List Pane.

Displays the XIC Overlay Pane.

Displays the Peak Chromatogram Pane.
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Figure 214. Cross Sample Peak List pane

 

Table 147. Cross Sample Peak List pane columns  (Sheet 1 of 2)

Column Description

Selected Identifies peaks to display when you select the Selected option in 
the XIC Overlay pane, or identifies which peaks to process when 
you click the Submit … for Processing icon, .

Do not confuse a check mark in the Selected column with the 
currently selected peak. The row for a currently selected peak is 
highlighted in blue.

Retention Time The time after injection when the compound elutes. The total 
time that the compound is retained on the column. 

M/Z Mass-to-charge ratio found in the spectra for the peak. Assumes 
that the charge is 1.

Mass The uncharged mass found in the spectra for the peak.

Monoisotopic Mass The most abundant mass in the spectra for the peak.

Maximum Fold The maximum difference of the group average response from the 
control average response.

Compound Name Displays the compound name found in the library or compound 
database. This column is displayed only when the peaks are 
aligned and you have performed a simple search. See “Editing the 
Peak Settings” on page 311.

Sample n MS Area The MS peak area for each sample.

Default Average Area The averaged response of all peak occurrences in the sample. 
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Heat Map Pane

Use the Heat Map pane to display the response of each peak occurrence in the batch. The 
Heat Map pane displays all MS Area values for all peaks in all samples in the batch that are 
above the peak threshold value specified in the method. When you select a peak in the Heat 
Map pane, the application displays the associated results for the selected peak in all panes of 
the Unknown Screening view.

The Heat Map pane is available only when you select the Alignment and Gap Filling option 
in the method (see “Editing the Peak Settings” on page 311) or select the RT Alignment 
option when you submit the batch (see “Submitting a Batch” on page 633).

Follow these procedures:

• To use the Heat Map pane

• To use the Heat Map pane with the TIC Chromatogram pane

• To use the Heat Map pane with the XIC chromatogram pane

Default % CV The coefficient of variance for each sample. 

The coefficient of variance is calculated as the standard deviation 
of the multiple samples of one level, multiplied by 100, and 
divided by the average of the multiple samples of that level. This 
calculation is based on the areas of the peaks.

Default Fold The maximum difference of the sample average response from the 
control average response.

Group n Average Area The averaged response of all peak occurrences in the group. The 
minimum value is 1, even when the peak never occurs in the 
group.

Group n % CV The coefficient of variance for each sample. 

The coefficient of variance is calculated as the standard deviation 
of the multiple samples of one level, multiplied by 100, and 
divided by the average of the multiple samples of that level. This 
calculation is based on the areas of all the peaks in the group of 
samples.

Group n Fold The maximum difference of the average response of all samples in 
a group from the control average response.

Table 147. Cross Sample Peak List pane columns  (Sheet 2 of 2)

Column Description
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 To use the Heat Map pane

1. Click the Heat Map tab to display the pane.

For detailed descriptions of all parameters in the Heat Map pane, see “Heat Map pane” 
on page 647.

2. In the Peak List pane, select a peak.

The application scrolls the Heat Map pane to the specified peak and selects the peak. 

For each found peak in the batch, the application assigns a color code indicating the 
relative MS area value from highest (orange) to lowest (green). 

 To use the Heat Map pane with the TIC Chromatogram pane

1. Click the TIC Chromatogram tab to display the pane.

The total ion current (TIC) chromatogram pane displays the relative intensity of all 
found peaks in the batch.

2. In the Heat Map pane, select a peak.

The application identifies the selected peak in the TIC Chromatogram pane and indicates 
it with a red marker.

Or, you can select a peak in the TIC Chromatogram pane, and the application scrolls the 
heat map to the selected peak.

Highest

Lowest

A red marker 
indicates the 
selected peak in 
the TIC 
Chromatogram 
pane.

Select a peak.
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 To use the Heat Map pane with the XIC chromatogram pane

1. Click the XIC tab to display the pane.

The extracted ion chromatogram (XIC) pane displays the absolute intensity of the 
selected peak. 

2. In the Heat Map pane, select a peak.

The application identifies the selected peak in the XIC, scales the chromatogram’s y axis 
to fit the peak, and indicates it with a red marker.

Or, you can select a peak in the XIC pane, and the application scales the chromatogram 
to fit the peak, indicates it with a red marker, and scrolls the heat map to the selected 
peak.

Figure 215. Heat Map pane

 

Table 148. Heat Map pane columns 

Column Description

Retention Time The time after injection when the compound elutes. The total 
time that the compound is retained on the column. 

M/Z Mass-to-charge ratio found in the spectra for the peak. Assumes 
that the charge is 1.

Mass The uncharged mass found in the spectra for the peak.

Sample n MS Area The MS peak area for each sample.

A red marker 
indicates the 
selected peak in 
the XIC pane.

Select a peak.
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Sample List Pane

Use the Sample List pane to select a sample of interest. The application displays the associated 
results for the selected sample in all panes of the Unknown Screening view. See Sample List 
pane.

 To hide or display columns in the Sample List pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Sample List pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application immediately displays or hides the column in the Sample List pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 
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Figure 216. Sample List pane

 

Table 149. Sample List pane columns 

Column Description

Batch Order The order in which the samples were acquired.

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Note   When you include unknown screening features in a 
quantitation method and you choose to process with only the 
unknown screening criteria, both the Sample View and the 
Unknown Screening View show the Status for the samples as 
acquired and processed ( ). 

Note  When you include unknown screening features in a target 
screening method and you choose to process with only the 
unknown screening criteria, both the Samples view and the 
Unknown Screening View show the Status for the samples as 
acquired and processed ( ). 

Sample Name A user-defined name that identifies a sample.

Sample Type Defines how the application processes the sample data. Each 
sample is classified as one of the following sample types: Matrix 
Blank, Solvent, Cal Std, QC Std, or Unknown

Default: Unknown
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Peak List Pane

Use the Peak List pane to select a specific peak found in the selected sample. The Peak List 
displays each peak that the application identified in the sample. See Peak List pane.

 To display information for a peak

In the Peak List, click anywhere in the peak row.

The application displays information for the selected peak in the other Data Review 
panes.

Figure 217. Peak List pane

 

Note  Do not confuse a check mark in the Selected column with the currently selected 
peak. The row for the current, selected peak is highlighted in blue. A selected check 
box in the Selected column does not indicate the current, selected peak (see Selected).

Table 150. Peak List pane columns  (Sheet 1 of 2)

Column Description

Selected Identifies peaks to display when you select the Selected option in 
the XIC Overlay pane, or identifies which peaks to process when 
you click the Submit … for Processing icon, .

Do not confuse a check mark in the Selected column with the 
currently selected peak. The row for the current, selected peak is 
highlighted in blue.
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Peak ID Identifies the peak as “peak @ retention time m/z.” 

Example: peak @ 0.80 203.05
m/z Mass-to-charge ratio found in the spectra for the peak. Assumes 

the charge is 1.
Retention Time The time after injection when the compound elutes. The total 

time (in minutes) that the compound is retained on the column. 
Area The area obtained by integrating peak intensities from the start to 

the end of the peak.
Height The distance from the peak maximum to the peak base, measured 

perpendicular to the ordinate.
Potential ID The number of returned peak IDs.
Mass The uncharged mass found in the spectra for the peak.
Monoisotopic Mass The sum of the masses of the most abundant isotope. 
Charge State The charge state of the ion (the z value in m/z). For example, a 

charge state of 2 with a negative polarity means that the 
compound has 2 more electrons than protons.

Valid range: 1 through 10
Default: 1

Filter String Filter used to identify the peak. Specified in the raw data file or the 
master method.

NIST The NIST match result name for the identified peak. If there is no 
match or if the Library search was not specified in the method, 
this shows as “N/A.” 

Library Manager The library match result name for the identified peak. If there is 
no match or if the Library Search was not specified in the method, 
this shows as “N/A.”

Elemental 
Composition

The chemical formula for the identified peak. If there is no match 
or the Elemental Composition search was not specified in the 
method, this shows as “N/A.”

Database The compound database match result name for the identified 
peak. If there is no match or the Database Search was not specified 
in the method, this shows as “N/A.”

ChemSpider The ChemSpider database match result name for the identified 
peak. If there is no match or the ChemSpider Search was not 
specified in the method, this shows as “N/A.”

Table 150. Peak List pane columns  (Sheet 2 of 2)

Column Description
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Peak Identifications Pane

Use the Peak Identifications pane to display the name and formula for identified peaks and 
the source of the identification.

Figure 218. Peak Identifications pane

 

Table 151. Peak Identifications pane columns  (Sheet 1 of 2)

Column Description

Selected Identifies peaks to display when you select the Selected option in 
the XIC Overlay pane, or identifies which peaks to process when 
you click the Submit … for Processing icon, .

Do not confuse a check mark in the Selected column with the 
currently selected peak. The row for a currently selected peak is 
highlighted in blue.

ID Source Specifies the search type used to identify the peak (Database 
Search, Library Search (NIST or LibraryManager), Elemental 
Composition, or ChemSpider Search). To specify search types in 
the method, see “To specify the search options” on page 313.

ID Source Detail Specifies the name of the library, the compound database, or the 
ChemSpider hyperlink where the peak was identified.

Match Result Name Specifies the compound name that was found in the library, in 
the compound database, or in the ChemSpider hyperlink.

Formula Specifies the chemical formula that was found in the library, in 
the compound database, in the elemental composition, or in the 
ChemSpider hyperlink.

Isotope Pattern Score % The percentage of matched isotopes in the total number of 
isotopes.

Number of Isotopes 
Matched

The number of isotopes matched in the calculated isotope 
spectra relative to the total number of isotopes used in the score 
calculation, in the format “x of y”, where

• x = the number of isotopes matching the elemental 
composition used for the Isotope Pattern Score calculation.

• y = the total number of isotopes considered in the Isotope 
Pattern Score calculation. This is the number of isotope 
peaks expected to be above the spectral noise.
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TIC Chromatogram Pane

Use the TIC Chromatogram pane to display the relative intensity of a trace along the length 
of the sample data retention window.

 To focus on a specific peak

In the TIC Chromatogram pane, click any displayed peak.

The application indicates the selected peak with a red, vertical marker and updates the 
focus in the other Data Review panes with data for that peak. 

Figure 219. TIC Chromatogram pane

Score The score from the library fit. When the application finds a 
match in the library, in the compound database, or through the 
ChemSpider hyperlink, this column displays the highest score 
associated with the Match Result Name parameter. 

Valid range: 1 through 100%

SI/Dot Product Search index method used to search the NIST library.

RSI/Rev Product (Reverse search index) A method used to search the NIST library. 
A reverse search compares a library entry to an unknown 
compound (whereas a forward search compares the mass 
spectrum of an unknown compound to a mass spectral library 
entry).

Library Probability 
Percent

The probability ranking from the NIST library. When you use a 
reverse search, this value is “N/A.”

 Fragments The number of fragments matched in the calculated spectra 
relative to the total number of expected fragments. 

Table 151. Peak Identifications pane columns  (Sheet 2 of 2)

Column Description
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XIC Pane

Use the XIC pane to display the absolute intensity of an extracted trace along the length of the 
sample data retention window.

 To focus on a specific peak

In the XIC pane, click any displayed peak.

The application indicates the selected peak with a red, vertical marker and updates the 
focus in the other Data Review panes with data for that peak. 

Figure 220. XIC pane

XIC Overlay Pane

Use the XIC Overlay pane to view specific groups of peaks. You can choose to view all peaks, 
selected peaks only, or the top twenty most intense peaks (by area). The XIC Overlay plot is a 
collection of overlaid, extracted m/z ion plots that use a different color for each peak. 

Follow these procedures:

• To display all peaks in a sample

• To display only selected peaks in a sample

• To display the top twenty peaks in a sample

• To focus on a specific peak

 To display all peaks in a sample

1. In the Sample List pane, select the sample whose peaks you want to view.

2. In the XIC Overlay pane, select the All check box.

The application displays all the peaks in the selected sample. See XIC Overlay plot 
showing all peaks.

Note  If there are more than 1000 peaks in the sample, performance might be slow.
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Figure 221. XIC Overlay plot showing all peaks

 To display only selected peaks in a sample

1. In the Sample List pane, select the sample whose peaks you want to view.

2. In the Peak List pane, select the Selected check box for each peak that you want to view.

3. In the XIC Overlay pane, select the Selected check box.

The application displays all selected peaks.

Figure 222. XIC Overlay plot showing selected peaks
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 To display the top twenty peaks in a sample

1. In the Sample List pane, select the sample whose peaks you want to view.

2. In the XIC Overlay pane, select the Top 20 check box.

The application displays the top twenty peaks in the selected sample.

Figure 223. XIC Overlay plot showing the top 20 peaks

 To focus on a specific peak

In the XIC Overlay pane, click any displayed peak.

The application indicates the selected peak with a red, vertical marker and updates the 
focus in the other Data Review panes with data for that peak.

Group Averages Pane

Use the Group Averages pane to compare the peak areas of different samples to a control 
group of samples.

The Group Averages pane is available only when you select the Alignment and Gap Filling 
option in the method (see “Editing the Peak Settings” on page 311) or select the RT 
Alignment option when you submit the batch (see “Submitting a Batch” on page 633).

The control group is displayed to the left, and other samples and groups are listed in the order 
in which they appear in the Batch View. To specify a group as the control group, see “Groups” 
on page 610.
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Each group displays a colored bar that indicates the average response of the group, as 
displayed in the Average Area column in the Cross Sample Peak List pane (“Cross Sample 
Peak List Pane” on page 643). The color of the bar matches the colors assigned to the samples 
and peaks in the Cross Sample Peak Overlay pane (“Cross Sample Peak Overlay Pane” on 
page 662).

Figure 224. Group Averages pane

 To use the Group Averages pane with the Cross Sample Peak Overlay pane

Display both the Group Averages pane and the Cross Sample Peak Overlay pane.

The color of the bars in the Group Averages pane matches the colors assigned to the 
group samples and peaks in the Cross Sample Peak Overlay pane.
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Peak Chromatogram Pane

Use the Peak Chromatogram pane to display the selected chromatogram peak. The Peak 
Chromatogram pane initially displays the apex scan for the detected peak. You can manually 
integrate the peak and use the updated peak to generate reports. See “Peak Chromatogram 
Pane” on page 660.

Follow these procedures:

• To zoom in on a peak

• To remove a peak

• To customize the labels in the display

• To display surrounding apex times

• To manually integrate a peak

• To switch between method and manual integration modes

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak.

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu.

 To remove a peak

Right-click the Peak Chromatogram pane, and choose Delete Peak from the shortcut 
menu.

The application removes the peak displayed in the Peak Chromatogram pane. All data for 
this peak are removed from the Unknown Screening View panes.

 To customize the labels in the display

1. Right-click the Peak Chromatogram pane, and choose Peak Display Settings from the 
shortcut menu.

The Peak Settings dialog box opens. For detailed descriptions of commands, see “Peak 
Settings Dialog Box” on page 661.

2. To display labels for the peak retention time (RT), mass height (MH), mass area (MA), or 
signal-to-noise (SN), select the appropriate check box.

3. Click OK in the Peak Settings dialog box.
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Figure 225. Example of displayed labels

 To display surrounding apex times

1. Right-click the Peak Chromatogram pane, and choose Peak Display Settings from the 
shortcut menu.

The Peak Settings dialog box opens. For detailed descriptions of commands, see “Peak 
Settings Dialog Box” on page 661.

2. Select the Show All Apex Times check box.

3. Click OK in the Peak Settings dialog box.

Figure 226. Example of displayed apex times

 To manually integrate a peak

1. Right-click the Peak Chromatogram pane, and choose Swipe Manual Integration from 
the shortcut menu, or click the Swipe Manual Integration icon, .

The cursor changes to indicate the manual integration mode.

2. Drag the cursor to define the beginning and ending base points for the new peak. See 
Manually integrated peak.

Note  You must drag the cursor inside the x axis and y axis.
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Figure 227. Manually integrated peak

The application updates the area of the peak to the baseline that you just added. When 
you regenerate the reports, they display the manually modified data.

3. To return to the original peak as defined by the method, right-click and choose Toggle 
Integration Settings (Method) from the shortcut menu.

 To switch between method and manual integration modes

Right-click the Peak Chromatogram pane and choose Toggle Integration Settings 
(Manual or Method) from the shortcut menu.

Initially, the method integration and manual integration settings that are stored for a 
compound and file are identical. When you switch modes, the saved result set does not 
change. However, when manual data are available, the Peak Chromatogram plots update 
and the result set updates as you switch between method and manual modes.

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

Peak Chromatogram Pane

Use the Peak Chromatogram pane to display the selected chromatogram peak. 

Figure 228. Peak Chromatogram pane

Drag the cursor across 
the peak at the base 
points for the new peak.

The application identifies the peak 
and indicates the manual 
integration in the labels.
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Peak Settings Dialog Box

Use the Peak Settings dialog box to custom the display settings.

Figure 229. Peak Settings dialog box

Table 152. Peak Chromatogram pane shortcut menu commands 

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Swipe Manual 
Integration

Switches to manual integration mode, where you can manually 
define the peak.

Also available from the icon in the upper right corner, .
Toggle Integration 
Settings (Manual or 
Method)

Switches the display between manual and method integration 
modes.

Delete Peak Removes the peak and all data for this peak from the Unknown 
Screening View panes.

Also available from the icon in the upper right corner, .
Peak Display Settings Opens the Peak Settings dialog box. See Peak Settings Dialog 

Box.

Table 153. Peak Settings dialog box parameters  (Sheet 1 of 2)

Command Description

Y-Axis Type

Relative Displays the y-axis scale from 0 through 100.
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Cross Sample Peak Overlay Pane

Use the Cross Sample Peak Overlay pane to compare instances of a selected peak across all 
samples in the batch. The application overlays all occurrences of the peak in the batch. See 
“Cross Sample Peak Overlay Pane” on page 664.

The application displays the names of all samples in the batch where the selected peak is 
found. Samples that are assigned to groups are color coded, and the peaks found in those 
samples are color coded in the plot. To assign samples to groups, see “Groups” on page 610.

The retention time window displayed in the Cross Sample Peak Overlay pane is the RT 
window that you specified in the method.

Absolute Displays the y-axis scale from 0 to the actual value of the most 
intense peak in the group.

Label in Scientific 
Notation

Displays the y-axis scale in scientific notation.

Peak Labels

RT Displays the retention time (RT) label in the peak 
chromatogram pane.

Height Displays the peak height (AH) label in the peak chromatogram 
pane.

Area Displays the peak area (AA) label in the peak chromatogram 
pane.

Signal to Noise Displays the signal-to-noise (SN) label in the peak 
chromatogram pane.

Plot Header

Sample ID Displays a user-defined, alphanumeric string that identifies a 
sample.

Threshold
m/z Displays the mass-to-charge ratio found in the spectra for the 

peak. Assumes the charge is 1.
Sample Filename Displays the name of the current, selected sample where the peak 

was found.
Compound Name Displays the compound name match in the library or compound 

database.
Filter String Displays the filter used to identify the peak. Specified in the raw 

data file or the master method.
Chromatogram

Show All Apex Times Displays all surrounding apex times in the plot.

Table 153. Peak Settings dialog box parameters  (Sheet 2 of 2)

Command Description
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Follow these procedures:

• To select the peak to display in the Cross Sample Peak Overlay pane

• To zoom in on a peak

• To use the Cross Sample Peak Overlay pane with the Group Averages pane

 To select the peak to display in the Cross Sample Peak Overlay pane

Select a peak in either the Peak List pane or the Cross Sample Peak List pane. 

See “Peak List Pane” on page 650 or “Cross Sample Peak List Pane” on page 643.

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak.

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu.

 To use the Cross Sample Peak Overlay pane with the Group Averages pane

Display both the Cross Sample Peak Overlay pane and the Group Averages pane.

The color of the bars in the Group Averages pane matches the colors assigned to the 
group samples and peaks in the Cross Sample Peak Overlay pane.
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Cross Sample Peak Overlay Pane

Use the Cross Sample Peak Overlay pane to compare instances of a selected peak across all 
samples in the batch

Figure 230. Cross Sample Peak Overlay pane

 

Library Search Pane

The Library Search pane displays the best library matches for the selected peak, with the 
highest score listed first. For detailed descriptions of the Library Search pane parameters, see 
“Library Search Pane” on page 667.

Follow these procedures:

• To view the spectrum for a library match

• To display the difference between experimental and library spectra

Table 154. Cross Sample Peak Overlay pane shortcut menu commands

Column Description

Reset Scaling Resets the original scaling after a zoom operation.

Copy to Clipboard Copies the graphic display to the Clipboard.
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 To view the spectrum for a library match 

In the Library Search pane, select a library entry.

The Experimental plot displays the measured spectra for the selected compound. Library 
matches are colored red.

The Library plot displays the expected spectra in the library. Library matches are colored 
blue.

The spectra header displays the following:

• The library match name

• The chemical formula for the peak

• The score from the library fit when the library type is Library Manager or NIST

• SI and RSI when the library type is NIST 

• Dot Prod or Rev Dot Prod when the library is HRAM

• Molecular weight when the library type is NIST

• The ID record from the library when the library type is Library Manager or NIST

• The scan number and scan filter when either is present in the library

Library matches Experimental spectrum

Library spectrum

 Library match name  Library score 

 Score ID Chemical formula
 Filter
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 To display the difference between experimental and library spectra

1. Right-click the spectrum plot and choose Show Difference Plot from the shortcut menu.

The application displays the Experimental and Library plots and a Difference plot that 
shows the difference between the experimental and library spectra. When you read a 
difference plot, the match between the experimental and library spectra is better when 
fewer peaks appear. 

Figure 231. Library Search pane showing a Difference plot

2. To specify how the difference plot displays the mass tolerance, do the following:

a. Right-click the spectrum plot and choose Set Difference Plot Mass Tolerance from 
the shortcut menu.

b. In the dialog box that opens, select either MMU or PPM as the unit of measure.

The default value is the tolerance set in the NIST library or Library Manager library.

c. Type a mass tolerance value.

d. Click OK.

Note   This command is available only when you display the difference plot.
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Library Search Pane

Use the Library Search pane to display the best library matches for the selected peak.

Figure 232. Library Search pane

Table 155. Library Search pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.

Copy to Clipboard Copies the graphic display to the Clipboard.

Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the 
Experimental and Library spectra.

When you display the Difference plot, this spectrum 
also displays the Difference spectrum.

Show/Hide Difference Plot Displays or hides the Difference spectrum plot.

Set Difference Plot Mass Tolerance Opens a dialog box where you specify the mass 
tolerance in either MMU or PPM units. Available 
only when you display the Difference Plot.
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Chemical Structure Pane

Use the Chemical Structure pane to view the chemical formula and structure for the peak that 
is currently selected in the Peak List pane.

The application displays the chemical formula (and CAS number when available) that was 
found in the search database that you specified in the method. See “Editing the Processing 
Pages” on page 311.

Figure 233. Chemical Structure pane

Fragments Pane

The Fragments pane displays the maximum number of fragments as specified in the unknown 
screening method. See “Editing the Processing Pages” on page 311. 

When a compound database search returns a match for a peak that has fragments, the 
Fragments pane displays the theoretical fragments.

When the data has an MS/MS element that is identified as belonging to the chromatographic 
peak, the Fragments pane displays the fragments found in the MS/MS scan.

The Fragments pane displays the fragments in one of two ways:

• All Fragments

• Individual Fragments
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All Fragments

The All Fragments view displays a composite of all fragments found in the peak. The 
application displays the measured peak as a solid red line; the application displays the 
expected peak as a dashed blue line.

The application displays these headers for the All Fragments view:

Figure 234. Fragments pane with overlaid spectra for all fragments

Figure 235. Fragments pane with stacked spectra for all fragments

Processing filter

File name

Minimum number 
of fragments 
specified in the 
method

Measured spectrum in redExpected spectrum in blue

Measured spectrum in redExpected spectrum in blue
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Individual Fragments

The individual fragments view displays the expected and measured peaks for a single 
fragment. 

The application displays these headers for the individual fragments view:

Figure 236. Fragments pane with overlaid spectra for a single fragment

Figure 237. Fragments pane with stacked spectra for a single fragment

Minimum number of fragments specified 
in the method

Expected m/z 
for fragment 1

Measured m/z 
for fragment 1

Delta between expected 
and measured m/z

Intensity 
threshold 
specified in the 
method

Measured spectrum in redExpected spectrum in blue

Measured spectrum in redExpected spectrum in blue
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Isotopes Pane

The isotopes pane displays isotopic pattern results for all adducts of a compound according to 
the threshold and deviation parameters defined in the unknown method. 

To identify or confirm the presence of a compound, the resulting score percentage from 
isotopic pattern matching must be higher than the specified fit threshold percentage. 

• An isotope peak is not found if its intensity, relative to the monoisotopic ion’s intensity, is 
more than the specified intensity deviation percentage away from the theoretical relative 
intensity of the isotope ion. 

• An isotope peak is found if its measured m/z is less than the specified mass deviation 
amount away from its expected m/z. 

To specify the peak threshold and deviation parameters, see “Editing the Element Settings” on 
page 327.

The Isotopes pane displays the isotopes in one of three ways:

• All Isotopes

• Multi-Isotopes

• Individual Isotopes

All isotopes panes use a shortcut menu so that you can specify how to display the data. See 
“ Isotopes pane shortcut menu commands” on page 675.

All Isotopes

The All Isotopes view displays a composite of all isotopes found in the compound. The 
application scales the window with respect to the most intense isotope. The most intense 
isotope is usually the first isotope unless you are using halogenated compounds. The 
application displays the measured peak as a solid red line; the application displays the 
expected peak as a dashed blue line.

The application displays these headers for the All Isotopes view:

Scan range for 
the isotopes

Retention time 
range for all scans

Number of averaged scans 
Processing filter

Sample file name

Percentage of total isotopes to the 
number of matched isotopes
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Figure 238. Isotopes pane with stacked spectra for all isotopes

Figure 239. Isotopes pane with overlaid spectra for all isotopes

Multi-Isotopes

The Multi-Isotopes view displays individual plots for each isotope. You can individually stack 
or overlay the plots for each isotope. 

The application displays these headers for the Multi-Isotopes view:

Measured spectrum Expected spectrumExpected m/z of the isotope

Measured spectrum in redExpected spectrum in blue

Scan range for the isotopes

Retention time 
range for all scans

Number of averaged scans 

Percentage of total isotopes to the 
number of matched isotopes
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Figure 240. Isotopes pane with overlaid spectra for multi-isotopes

Figure 241. Isotopes pane with stacked spectra for multi-isotopes

Figure 242. Isotopes pane with stacked and overlaid spectra for multi-isotopes

Expected spectrum in blue Measured spectrum in red

Measured spectrum in redExpected spectrum in blue

Measured spectrum in redExpected spectrum in blue
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Individual Isotopes

The individual isotopes view displays the expected and measured peaks for a single isotope. 

The application displays these headers for the individual isotopes view:

Figure 243. Isotopes pane with overlaid spectra for a single isotope
 

Figure 244. Isotopes pane with stacked spectra for a single isotope
 

Scan range for 
the isotopes

Retention time 
range for all 
scans

Number of averaged 
scans 

Expected m/z 
for isotope 5

Measured m/z 
for isotope 5

Delta between expected 
and measured m/z

Percentage of total isotopes to 
the number of matched isotopes 

Measured spectrum in redExpected spectrum in blue

Measured spectrum in redExpected spectrum in blue
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Spectrum Pane

When data is available, the plot width is the full mass range in the raw data file. Otherwise, 
the application scales the width to the scan range.

Figure 245. Spectrum pane

Table 156. Isotopes pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
Display Overlay Spectra
Display Stack Spectra

Overlays the two spectrum displays, or stacks the simulated 
spectrum and the peak apex spectrum.

Show/Hide Noise Label Adds a noise label to each peak. Expected isotope peaks 
(displayed in blue) do not display a noise label.

Show/Hide Resolution 
Label

Adds a resolution label to each peak. Expected isotope peaks 
(displayed in blue) do not display a resolution label.

Table 157. Spectrum pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.
Copy to Clipboard Copies the graphic display to the Clipboard.
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Working in the Report View
The Report View displays example reports for the current batch. You must have an open 
batch to use the features in the Report View.

Follow these procedures:

• To open the Report View

• To preview a report

• To generate a report as a PDF, an Excel, or a CSV file

• To print a report

• To display a generated report

• To edit a report template

• To create a new report template

 To open the Report View

Click Report View in the navigation pane.

The application opens the Report View. For detailed descriptions of all parameters, see 
“Report View” on page 680.

 To preview a report

1. In the Template pane, select a report template.

The template list shows all the report templates that you configured in the Configuration 
console. See “Specifying the Reports” on page 71. 

Figure 246. Example template list for unknown screening batches

2. Click Preview, .

The application opens the Report Designer, showing the report information for the 
current batch in the selected report template format.

For details about using the Report Designer, see Chapter 12, “Using the Report 
Designer.” 
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 To generate a report as a PDF, an Excel, or a CSV file

1. In the Template pane, select a report template.

2. Select the check box for each of the file types that you want to create: PDF, Excel, or 
CSV.

3. Click Generate, .

The application does the following:

• Displays a green progress bar as it generates the reports.

• Creates a report for the current batch as a PDF, an Excel, or a CSV file, using the 
selected report template format.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 680.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.

 To print a report 

1. In the Template pane, select a report template.

2. Select the check box for the Print file format.

3. Click Generate, .

The application does the following:

• Creates a report for the current batch using the selected report template format.

• Prints the report to your default printer.

• Adds information about the generated report to the Generated Reports pane.

For details about the Generated Reports pane, see “Report View” on page 680.

• Saves the report files to the …\TraceFinderData\3.3\Projects\batch\ReportOutput 
folder.
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 To display a generated report

In the Generated Reports pane, click View for the report that you want to see.

Figure 247. Generated Reports pane showing a PDF report

The application opens the output file.

 To edit a report template

1. In the Template pane, select a report template.

2. Click Open, .

The application opens the Report Designer showing the template in an Excel spreadsheet. 
See Report Designer showing the template for the selected report.

Figure 248. Report Designer showing the template for the selected report

3. Use the features in the Report Designer to edit the template.

See Chapter 12, “Using the Report Designer.” 

4. When you finish your changes, choose File > Save from the Report Designer menu bar.

Note   You cannot edit report templates that were provided with the TraceFinder 
application; however, you can open a TraceFinder template, make changes, and save it 
to a new template name.

Note  When user security is activated, you must have Template Editing permission to 
edit report templates created by your laboratory. If the Open button is not active, user 
security is activated and you do not have Template Editing permission. 

Opens the generated file.
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 To create a new report template

1. Click New, .

The application opens the Report Designer showing an empty template in an Excel 
spreadsheet. See Report Designer showing a new, empty template.

The Report Type is None.

In the left pane, the spreadsheet lists all samples in the current batch and all compounds 
in the method used for the batch.

Figure 249. Report Designer showing a new, empty template

2. Use the features in the Report Designer to create the report template.

See Chapter 12, “Using the Report Designer.” 

3. When you finish your changes, choose File > Save from the Report Designer menu bar.

The Save Template dialog box opens.

Figure 250. Save Template dialog box

4. Type a name for the new report template and click OK.
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Report View

Use the features in the Report View to display example reports for the current batch. 

Figure 251. Report View

Table 158. Report View parameters  (Sheet 1 of 2)

Parameter Description

Template

Displays all available unknown screening report templates.
Rules

Sheet Name Specifies each sheet in the report.
Rules Specifies the type of data used in each sheet in the selected report.

• Batch
• EachSample
• SampleType: SampleType
• CompoundType: CompoundType
• SampleCustomFormula: 

Buttons

 View Report Templates Displays the C:\TraceFinderData\3.3\Templates\ReportTemplates folder that contains 
all report templates.
Opens the selected report template in the Report Designer.

Opens a blank report template in the Report Designer.
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Opens the Report Designer showing the report information for the current batch in the 
selected report template format.

PDF Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

Excel Writes the generated report to a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

CSV Saves the generated report as a PDF file in the 
…\TraceFinderData\3.3\Projects\batch\ReportOutput folder.

When the report contains multiple sheets, the application writes each sheet as a separate 
CSV file.

Print Prints the generated report to your default printer.
Generates the selected type of reports for the current batch using the selected report 
template.

Generated Reports

Template Report template used for the report. See “Example template list for unknown screening 
batches” on page 676.

Rule Type of data used in each sheet of the report. See Rules.
Sample For sample-level reports, the name of each sample in the report.
Output Type of output specified for the report: PDF, Excel, CSV, or Print.
Generated Report File Lists the output file name for each report in the …\TraceFinderData\3.3\Projects folder.
View Displays the generated output file.

 View Generated Reports Displays the C:\TraceFinderData\3.3\Projects folder that contains all report outputs.
Clear Removes all reports from the Generated Reports display. This does not delete the reports 

from the C:\TraceFinderData\3.3\Projects folder.

Table 158. Report View parameters  (Sheet 2 of 2)

Parameter Description
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Working in the Local Method View 
A local method is a copy of a master method associated with a batch. You can edit only the 
local copy of the method, or you can edit the master method and overwrite the local copy 
with the edited master method.

In the Local Method view, you can edit the local method parameters. A local method is a copy 
of a master method associated with a batch. Local methods are named Batch_MasterMethod. 

 To open the Local Method View

1. Click Analysis in the navigation pane.

2. Click Local Method.

The Local Method view for the currently selected batch opens. See Local Method View.

You can edit many of the method parameters in a local method. Editing the local method 
does not affect parameters in the master method.

For detailed descriptions of method parameters, see “Editing a Master Method” on 
page 307.

3. Enter any local changes to the method.

4. When you have finished editing the local method, choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. 
You can use this feature to overwrite an edited local method with the original master 
method or to overwrite the local method with an updated master method.
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Figure 252. Local Method View
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12

Using the Report Designer

This chapter includes instructions about using the features of the Report Designer.

Use the features in the Report Designer to create new report templates or edit your 
laboratory’s report templates. You cannot edit report templates that were provided with the 
TraceFinder application; however, you can open a TraceFinder template, make changes, and 
save it to a new template name.

When user security is activated, you must have Template Editing permission to edit report 
templates created by your laboratory. To use the administration tools to set Reports 
permissions, refer to the instructions in the TraceFinder Administrator Console User Guide.

With the Report Designer, you can do any of the following to create or edit a report template:

• Make changes to the template as you would in an Excel application. 

• Add or remove graphics. 

• Add repeated areas of many types. 

• Format fonts and colors. 

• Add or edit formulas. 

• Edit template text and headers.

In addition to the procedures in this chapter, you can view video instructions at 
http://mytracefinder.com/plugins/reporting/.

Contents

• Editing a Template

• Toolbar Reference

• Quick Tips

Note  To edit or create a template, you must have an open batch.

http://mytracefinder.com/plugins/reporting/
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Editing a Template 
Use the Report Designer to add or remove graphics, add tables, add repeated areas, and 
format headings, data, or cells.

Follow these procedures:

• To insert graphics into a report template

• To resize an inserted graphic

• To move an inserted graphic

• To insert a table

• To remove an inserted table

• To make changes to a table

• To format header text in the spreadsheet

• To format data in the report grid

• To format cells in the report grid

• To add repeated areas

• To insert a new sheet in a report

 To insert graphics into a report template

1. Click the Insert tab.

The Insert page displays the available objects that you can insert in a quantitation, a target 
screening, or an unknown screening report template.

Figure 253. Quan Plots features for quantitation batch report templates

For a description of each graphic element, see “Insert Toolbar – Quantitation Reports” on 
page 700.

Figure 254. Screening Plots features for target screening batch report templates

For a description of each graphic element, see “Insert Toolbar – Target Screening Reports” 
on page 702.



 12 Using the Report Designer
Editing a Template

Thermo Scientific TraceFinder User Guide 687

Figure 255. Unknown Plots features for unknown screening batch report templates

For a description of each graphic element, see “Insert Toolbar – Unknown Screening 
Reports” on page 703.

2. In the template grid, drag to select cells where you want to place the item.

3. Select a sample from the list of samples in the left pane.

The application uses graphical data from the selected sample when you insert a graphical 
plot.

4. Click a graphical plot in the toolbar to insert into the selected cells. 

The application inserts the selected plot in the template grid.

Figure 256. Inserted peak chromatogram

Note  The Insert features for quantitation and target screening report templates also 
include Unknown Plots. You can insert unknown plots when your quantitation or 
target screening batch also uses unknown features.

Note  You can also select a single row, and the application inserts the upper left corner 
of the graphic at the first cell, using a minimum default size.
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 To resize an inserted graphic

1. Right-click the graphic to make it editable.

Figure 257. Editable graphic 

2. Grab a corner of the graphic and stretch it to the new size.

Figure 258. Resized graphic 

 To move an inserted graphic

1. Right-click the graphic to make it editable.

Figure 259. Editable graphic 

Note  In this example, the original graphic was too small to display all the 
chromatogram data. Stretching the graphic reveals the sample name, mass, filter, and 
labeling.

The border indicates that the 
graphic is editable.

The border indicates that the 
graphic is editable.
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2. Click the graphic (notice the cursor change), and drag it to a new location.

Figure 260. Moved graphic 

 To insert a table

1. Select a row in the report grid where you want to insert the table.

2. Click the Insert tab, and then click the Table icon, .

The New Table dialog box opens.

3. Select the type of table that you want to insert and click Select Table.

The Edit Table dialog box opens. For descriptions of all parameters, see “Edit Table 
Dialog Box” on page 697.

The dropdown list in the upper left corner displays the data type for the table you 
selected. 

Cursor for moving a graphic
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The left pane displays an alphabetical list of all available fields for the selected data type 
that you can include in the table. To display fields for a different data type, see step 4.

The right pane lists the fields that are included in the new table. 

You can select as many additional fields as you want. The table you create displays each 
selected field as a table column. By default, all available fields for the original data type are 
included in the table. The first field in the list is the leftmost column in the table. The last 
field in the list is the rightmost column in the table. To change the order of the columns, 
see step 6.

4. To add fields to the table from a different data type, do the following:

a. Click the dropdown list and select a different data type.

The left pane displays an alphabetical list of all available fields for the new data type. 

b. Select a field in the left pane and then click .

The application moves the selected field to the rightmost pane to indicate that it is 
included in the inserted table.

5. To select a field that you do not want in the table, in the rightmost pane, clear the check 
box next to the field name.
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6. To move a column up or down in the table, select the field name in the rightmost pane 
and click the Up arrow, , or Down arrow, . 

7. To edit the header for a table column, select the field in the list on the right, and then type 
new header text in the Header box in the Field Details area.

The default header name is the same as the field name.

8. To find the formula for a field, select the field.

The application displays the formula in the Formula box.

This video demonstrates how to use the Report Designer to create your own formula: 
www.Working with Formulas.

9. To create a custom column, do the following:

a. Click Custom, .

The application adds a Custom field to the fields list.

b. Select the Custom field in the list.

The application display the details for the new, custom column.

c. Enter values for the Formula and Header.

Field not selected

Field selected (blue background)

Details for the selected field 

https://www.youtube.com/watch?v=Zsy4-q2-LHo
https://www.youtube.com/watch?v=Zsy4-q2-LHo
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10. To create a pivot table, do the following:

a. Select the Pivot Table check box. 

The Pivot Table area expands to display the pivot table options.

b. Select the Use Key check box for the row label. 

c. Select the Use Key check box for the column label. 

d. Select the operation that you want to use to calculate the aggregate value: Sum, 
Count, Average, First, or Last.

11. When you have made all your table selections, click OK.

The application inserts the table into the report template. 

 To remove an inserted table

1. Select all rows and cells in the table.

2. Right-click and choose Delete – Delete Cells and Shift Cells Left from the shortcut 
menu.

The application removes the entire table from the report template.

 To make changes to a table

1. In the table that you want to edit, right-click and choose Data Table from the shortcut 
menu.

The Edit Table dialog box opens, displaying all of the available fields for the selected 
template. The Edit Table dialog box is virtually identical to the Edit Table dialog box that 
you used to create a table. 

For descriptions of all parameters, see “Edit Table Dialog Box” on page 697.

2. Edit the fields for the table and click OK.
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 To format header text in the spreadsheet

1. In the Report Designer window, select the header in the spreadsheet table.

To change all headers, select the entire header row.

To change a single header, select the specific header cell.

2. Click the Home tab.

3. Use the Font icons to change the font format.

 To format data in the report grid

1. Select the data that you want to format.

To format all rows in a column, select the header row.

To format a single cell of data, select only that cell.

2. Click the Home tab and use the toolbar icons to edit the font or cells as appropriate:

• Change the font or font size.

• Make the selected text bold.

• Make the selected text italics.

• Underline the selected text.

• Apply borders to the currently selected cells.

• Increase or decrease font size.

• Apply color to the background for selected cells.

• Change the font color.

Tip  You can also use the SHIFT key to select sequential cells or the CTRL key to 
select nonsequential cells anywhere in the grid.

Tip  You can also use the SHIFT key to select sequential cells or the CTRL key to 
select nonsequential cells anywhere in the grid.



12 Using the Report Designer
Editing a Template

694 TraceFinder User Guide Thermo Scientific

 To format cells in the report grid

1. Select the cells that you want to modify:

To change all cells in a row, select the entire row.

To change a single cell, select only that cell.

2. Click the Home tab and use the Alignment or Cells toolbar icons to edit the cells.

3. To align the cell text to the top, center, or bottom of the cell, click one of these icons:

.

4. To align the cell text to the left, center, or right of the cell, click one of these icons:

.

5. To make all contents visible within a cell, click Wrap Text.

6. To join selected cells into one cell, click Merge Cells.

7. To insert cells, rows, or columns into the template, click Insert.

8. To delete rows or columns from the template, click Delete.

9. To change the row height or column width, organize sheets, or protect or hide cells, click 
Format.

10. To highlight or emphasize useful cells based on specific criteria, click Conditional 
Formatting to use data bars, color scales, or icon sets.

11. To show formulas for selected cells instead of the resulting value, click Show Formulas.

 To add repeated areas

1. To define a repeat area, select the cells that you want to repeat.

You can repeat only one area per worksheet, but you can repeat it many times. You cannot 
insert data tables beneath a repeated area. See “Example of repeated areas” on page 696.

Tip  You can also use the SHIFT key to select sequential cells or the CTRL key to 
select nonsequential cells.
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2. Click the Insert tab and then click Repeat.

The Repeat Area Definition dialog box opens.

3. To filter the repeat area according to the filter criteria, type the string syntax in the Filter 
String box.

4. Select to repeat for each sample, for each compound, or for both. 

5. Define whether the repeat area repeats first for samples or first for compounds:

• To have the repeat area repeat first for samples and then for compounds, clear the 
Compound Centric check box.

• To have the repeat area repeat first for compounds and then for samples, select the 
Compound Centric check box.

6. To define the number of times to repeat horizontally before wrapping to the next row, 
type a number in the Max Horizontal Repeats box.

7. To define the number of times to repeat vertically before inserting an auto-page break, 
type a number in the Max Vertical Repeats Per Page box.

8. To define the maximum suggested number of repeats, type a number in the Repeats in 
Design Mode box.

This maximum number of repeats is intended to limit the size of the report while you are 
editing the report in the Report Designer. When generating an actual report, the 
application does not enforce this limit.
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In this example, the repeated area (outlined in red) displays the peak chromatogram, target 
peak, total area, peak area, retention time, theoretical amount, actual amount, and reported 
flags, if any, for each compound.

Figure 261. Example of repeated areas

 To insert a new sheet in a report

1. Click the Home tab.

2. In the Cells area, choose Insert Sheet from the Insert menu.

The application adds a new sheet to the report. 
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Edit Table Dialog Box

Use the options in the Edit Table dialog box to edit the fields in a table.

Figure 262. Edit Table dialog box

Table 159. Edit Table dialog box parameters  (Sheet 1 of 2)

Parameter Description

Dropdown List Specifies the type of table you are editing.
Field List Lists all available table fields.
Table Displays the selected table type and the fields included in the table.
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Field Details

Formula Specifies the functions and arguments used to define the field.
Preview Specifies the name of the raw data file used for the report.
Header Specifies the header name for the column in the spreadsheet.
Description Specifies the type of field.
Table Filter

Table Filter Specifies the filter used for the sample compounds.
Preview –
Sort By Sorts the data by ascending or descending values.
Pivot Table

Pivot Table Enables the Pivot Table features.
Row Label –
Row Key –
Column Label –
Column Key –
Value –
Operation Specifies the operation used to calculate the aggregate value. 

Valid values: Sum, Count, Average, First, Last
Box Format –
Additional Values –

Delete Deletes the selected table from the template.

Table 159. Edit Table dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Toolbar Reference
The Report Designer includes the following toolbars.

• Home Toolbar

• Insert Toolbar – Quantitation Reports

• Insert Toolbar – Target Screening Reports

• Insert Toolbar – Unknown Screening Reports

• Page Layout Toolbar

Home Toolbar

Use the options in the Home toolbar to modify fonts, align cell data, and format cells.

Table 160. Home toolbar options  (Sheet 1 of 2)

Parameter Description

Clipboard

Paste Paste the contents of the Clipboard. You can also paste only formating or only a 
formula.

Copy Copy text or graphics to use in another place.

Font

Font and size lists Use the dropdown lists to change the font or font size.

Bold Make the selected text bold.

Italic Make the selected text italics.

Underline Underline the selected text.

Border Apply borders to the currently selected cells.

Font size Increase or decrease the font size.

Fill color Apply color to the background for selected cells.

Font color Change the font color.

Alignment

Align the cell text to the top, center, or bottom of the cell.

Align the cell text to the left, center, or right of the cell.
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Insert Toolbar – Quantitation Reports

Use the options in the Insert toolbar to add graphics, plots, and other objects to a template or 
report. You can also set up repeating objects and define functions.

Wrap text Make all contents visible within a cell.

Merge cells Join selected cells into one cell.

Cells

Insert Insert cells, rows, columns, or sheets into a template.

Delete Delete rows or columns from a template.

Format Change the row height or column width, organize sheets, or protect or hide cells.

Conditional Formatting Based on specific criteria, highlight or emphasize useful cells using data bars, color 
scales, and icon sets.

Show Formulas Show formulas for selected cells instead of the resulting value.

Table 160. Home toolbar options  (Sheet 2 of 2)

Parameter Description

Table 161. Insert toolbar options  (Sheet 1 of 2)

Parameter Description

Table

Table Create a table to manage and analyze data.
Field Edit the formula for a field by choosing functions and editing arguments.
Repeat

Repeat Repeat text, cell, or graphic elements.
Refresh Update the view to reflect recent changes.
Plots

 Add a sample TIC. 

For information about sample TIC data in the Data Review results, see “Peaks Pane” on 
page 478.

 Add a peak chromatogram. 

For information about peak chromatogram data in the Data Review results, see “Quan Peak” 
on page 499.
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 Add an ion overlay. 

For information about ion overlay data in the Data Review results, see “Ion Overlay” on 
page 512.

 Add a spectral plot.

For information about spectral plot data in the Data Review results, see “Spectra” on 
page 515.
Add a comparative spectral plot.

For information about comparative spectral data in the Data Review results, see “Spectra” on 
page 515.
Add a calibration curve plot.

For information about calibration curve data in the Data Review results, see “Calibration 
Curve” on page 510.
Add an isotope plot to display the number of isotopes found, the score, a pass/fail flag, and a 
plot of the isotopes. 

For information about isotope plot data in the Data Review results, see “Isotope” on 
page 516.
Add a fragment plot.

For information about fragment plot data in the Data Review results, see “Fragments” on 
page 517.
Add a library plot.

For information about library plot data in the Data Review results, see “Library Match” on 
page 515.
Add plots for unknown screening when your quantitation batch includes unknown screening 
features. See Insert Toolbar – Unknown Screening Reports.

Charts

Add a custom chart. To define the chart, double-click the inserted blank chart.

Illustrations

Insert a picture from a file.

Table 161. Insert toolbar options  (Sheet 2 of 2)

Parameter Description
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Insert Toolbar – Target Screening Reports

Use the options in the Insert toolbar to add graphics, plots, and other objects to a template or 
report. You can also set up repeating objects and define functions.

Table 162. Insert toolbar options  (Sheet 1 of 2)

Parameter Description

Table

Table Create a table to manage and analyze data.
Field Edit the formula for a field by choosing functions and editing arguments.
Repeat

Repeat Repeat text, cell, or graphic elements.
Refresh Update the view to reflect recent changes.
Plots

 Add a sample TIC. 

 Add a peak chromatogram. 

For information about peak chromatogram data in the Data Review results, see 
“Chromatogram Pane” on page 583.

 Add an ion overlay. 

 Add a spectral plot.

For information about spectral plot data in the Data Review results, see “Spectrum” on 
page 584.
Add an isotope plot to display the number of isotopes found, the score, a pass/fail flag, and a 
plot of the isotopes. 

For information about isotope plot data in the Data Review results, see “Isotopes” on 
page 585.
Add a fragment plot.

For information about fragment plot data in the Data Review results, see “Fragments” on 
page 591.
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Insert Toolbar – Unknown Screening Reports

Use the options in the Insert toolbar to add graphics, plots, and other objects to a template or 
report. You can also set up repeating objects and define functions.

Add a library plot.

For information about library plot data in the Data Review results, see “Library” on 
page 594.
Add plots for unknown screening when your target screening batch includes unknown 
screening features. See Insert Toolbar – Unknown Screening Reports.

Charts

Add a custom chart. To define the chart, double-click the inserted blank chart.

Illustrations

Insert a picture from a file.

Table 162. Insert toolbar options  (Sheet 2 of 2)

Parameter Description

Table 163. Insert toolbar options  (Sheet 1 of 2)

Parameter Description

Table

Table Create a table to manage and analyze data.
Field Edit the formula for a field by choosing functions and editing arguments.
Repeat

Repeat Repeat text, cell, or graphic elements.
Refresh Update the view to reflect recent changes.
Plots

 Add a peak chromatogram. 

For information about peak chromatogram data in the Data Review results, see “Peak 
Chromatogram Pane” on page 658.
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Add a TIC chromatogram.

For information about TIC chromatogram data in the Data Review results, see “TIC 
Chromatogram Pane” on page 653.

 Add a spectral plot.

For information about spectral plot data in the Data Review results, see “Spectrum Pane” on 
page 675.
Add an XIC overlay plot.

For information about XIC overlay data in the Data Review results, see “XIC Overlay Pane” 
on page 654.
Add a library plot.

For information about library plot data in the Data Review results, see “Library Search Pane” 
on page 664.
Add an XIC plot.

For information about XIC plot data in the Data Review results, see “XIC Pane” on 
page 654.
Add a cross-sample peak overlay plot.

For information about cross-sample peak overlay data in the Data Review results, see “Cross 
Sample Peak Overlay Pane” on page 662.
Add a fragments plot.

For information about fragments plot data in the Data Review results, see “Fragments Pane” 
on page 668.
Add an isotopes plot.

For information about isotopes plot data in the Data Review results, see “Isotopes Pane” on 
page 671.
Add a chemical structure plot.

For information about chemical structure plot data in the Data Review results, see “Chemical 
Structure Pane” on page 668.

Charts

Add a custom chart. To define the chart, double-click the inserted blank chart.

Illustrations

Insert a picture from a file.

Table 163. Insert toolbar options  (Sheet 2 of 2)

Parameter Description
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Page Layout Toolbar

Use the options in the Page Layout toolbar to adjust margins, orientation, paper size, and page 
breaks. To see your changes, click Print Preview.

Table 164. Page Layout toolbar options

Command Description

 View the report before printing it.

 Define page details.

Select page margins for the current view or the entire document.

 Switch the pages from portrait to landscape view.

 Choose a page size for the current view or the entire document.

 Specify where a new page begins in the printed copy.

Template Properties Open the Template Properties dialog box where you can specify 
the expected batch type for the report template.

The Template Properties dialog box also displays the Used Range 
so that you can identify when there is empty white space in the 
report template. Extra white space to the right or left of the 
report content can cause unwanted page breaks.
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Quick Tips
Follow these tips to make the most of the Report Designer features.

 To move a report to the Archive folder

1. With a report open for editing, choose File > Archive from the Report Designer main 
menu.

2. At the confirmation prompt, click Yes.

The application deletes the report from the …batch\ReportOutput folder.

 To insert items in the Report Designer

• Insert a data table when the selected cell is above or below any other table, but not in the 
same row as a field. You cannot insert tables in repeat areas.

• Insert a data field when the selected cell is not in the same row as a table.

• Use these shortcut keys:

 To format cells and group headers

Because the first row of a data table retains formatting information, edit the formatting of 
the first row.

The application copies the formatting to all other rows.

For group header items, the application copies the formatting of the first group header to 
the remaining group headers.

 To sort fields 

Select a field, and then click A-Z to sort the data in ascending or descending order.

CTRL+T Insert a table.

CTRL+T Edit a table when the selected cell is inside a table.

CTRL+SHIFT+T Insert or edit a field.

CTRL+R Insert or edit a repeating area.
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13

Using the Audit Viewer

This chapter includes instructions about using the features of the Audit Viewer. For detailed 
descriptions of parameters in the Audit Viewer, see “Audit Viewer” on page 716.

The TraceFinder application records all user access, including logging in, logging out, data 
creation and editing (batches, methods, and templates), and manual integration. You can use 
the Audit Viewer to view the resulting log files to track modifications to the data. When an 
event requires confirmation (as specified in the Administrator Console), the Audit Viewer 
records who confirmed each change to a batch, method, or template. When no confirmation 
is required, then the Audit Viewer records the user who was logged in when the change 
occurred. 

In the Administration Console, a user with Auditing permissions can configure the auditing 
service by specifying which events are logged, which events require confirmation, a list of 
default reasons for a specific event, and whether a user can submit a custom reason. To use the 
auditing administration tools, refer to the instructions in the TraceFinder Administrator 
Console User Guide.

Audit Trail Log Files
The application creates the following audit trail log files:

• Application: Records all user access, such as starting and stopping the application, logging 
in, logging out, or accessing or saving data in batches and methods. The application saves 
the data in the following log file: C:\Thermo\TraceFinder\3.3\Logs\AuditLog.adb.

• Master Method: Records all user interactions with master methods, such as creating, 
opening, or editing a master method. The application saves the data in the following log 
file: C:\TraceFinderData\3.3\Methods\MasterMethodName\AuditLog.adb.

Contents

• Audit Trail Log Files

• Audit Log File Functions

• Audit Viewer
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• Batch Template: Records all user interactions with batch templates, such as creating, 
opening, or editing a batch template. The application saves the data in the following log 
file: C:\TraceFinderData\3.3\Templates\Batches\BatchTemplateName\AuditLog.adb.

• Batch: Records all user interactions with batches, such as creating, opening, editing, 
acquiring, processing, or generating reports for a batch. The application saves the data in 
the following log file: 
C:\TraceFinderData\3.3\Projects\SubFolder\BatchName\AuditLog.adb.

Audit Log File Functions
The Audit Viewer displays all saved audit log files, and you can filter and sort the audit data.

Follow these procedures:

• To access the Audit Viewer

• To select an audit log

• To view only application, method, batch, or batch template events

• To create a filter for audit log events

• To view audit event details

• To create a filter for an audit log history

• To display the history for an event

 To access the Audit Viewer 

Choose Tools > Audit Trail from the TraceFinder main menu or click the Audit Viewer 
icon, .

The Audit Viewer opens. For detailed descriptions of parameters in the Audit Viewer, see 
“Audit Viewer” on page 716.

Note   The Tools > Audit Trail menu command always opens to application log files, 
whereas the Audit Viewer icon is context sensitive and opens to the appropriate type 
of log files (application, method, batch, or batch template).
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 To select an audit log 

1. Click the Open Audit Log icon, . 

The application opens the Audit Log Selection dialog box.

2. Expand a log folder to select an application, batch, method, or batch template audit log 
file, and click OK.

The Audit Viewer displays the contents of the selected audit log file, as in this example for 
a method.

 To view only application, method, batch, or batch template events

1. In the Active Log list, select an Active Log file.

• Application logs include application and security events.

• Method logs include application and method events.

• Batch logs include application, method, and batch events.

• Batch template logs include application and batch template events.

The Audit Viewer displays icons for each of the event types included in the log file.

2. Click an icon to turn the display on or off.

In this example, the Events pane displays Batch and Method events and hides Application 
events.

Note  There is no icon for security events in an application log file. You cannot hide 
the display of security events.
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 To create a filter for audit log events

1. In the Events pane, click the Create New Filter icon, .

The Filter Editor dialog box opens.

2. In the View box, type a name for the new filter.

You can also leave the View box empty when you enter your filter criteria. When you 
finish adding conditions and click OK (step 8), the application filters the current events 
list based on the filter criteria you specify, but the filter is not saved. The Filter list in the 
viewer identifies this filter as (Custom).

3. Click the Add icon, .

The application adds a new, undefined condition to the Condition list.

4. In the Field list, select one of the following field types.

5. In the Operator list, select one of the available operators.

The available operators depend on the field type that you selected.
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6. In the Value box, type a value or select a value from the list.

• For the Date/Time field, type a numerical value in the Value box.

• For the User, Reason, Context, or Details field, type the appropriate text in the Value 
box. This value is case sensitive.

• For the Type of Event field, select one of the following values.

The Filter at the bottom of the dialog box displays the complete definition for the filter.

7. Repeat step 3 (on page 710) through step 6 (on this page) for each condition that you 
want to include in your filter.

8. When you have added all your conditions, click OK.

The application creates the new filter with the specified conditions. 

Note   You can also click the Tokens icon, , and select a token for the Value. 
Tokens are predefined values, such as dates and sample or compound identifiers. 
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 To view audit event details

In the Events pane, select an event.

The Details pane displays key values based on the type of log you select.

 To create a filter for an audit log history

1. In the History pane, click the Create New Filter icon, .

The Filter Editor dialog box opens.

2. In the View box, type a name for the new filter.

You can also leave the View box empty when you enter your filter criteria. When you 
finish adding conditions and click OK (step 8), the application filters the current history 
list based on the criteria you specify, but the filter is not saved. The Filter list in the viewer 
identifies this filter as (Custom).

3. Click the Add icon, .

The application adds a new, undefined condition to the Conditions list.

Details for batch log files include the name of the batch.

Details for method log files include the name of the method and 
the method type.

Details for batch template log files include the name of the batch 
template, the location of the data repository, and the subproject 
folder where the template was created.

Details for Application log files include whether the events are for a 
batch or method, the location of the data repository, and, for a 
batch, the subproject folder where the batch was created.

Details for Security log files include the authentication method 
used (Windows Active Directory or local machine) and the 
location of the administrator repository.
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4. In the Field list, select one of the following field types.

5. In the Operator list, select from equals, less than/greater than, or contains.

The available operators depend on the field type that you selected.

6. In the Value list, type or select a value from the list.

• For the Name, Context, or Details field, type the appropriate text in the Value box. 
This value is case sensitive.

• For the OldValue or NewValue field, type a numerical value in the Value box.

• For the ChangeType field, select one of the following values.
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• When the selected Field is ItemType, select one of the following values.

The Filter at the bottom of the dialog box displays the complete definition for the filter.

7. Repeat steps 3 through 6 for each condition that you want to include in your filter.

8. When you have added all your conditions, click OK.

The applications created the new filter with the specified conditions. 

 To display the history for an event

1. In the Events pane, select an event that has a selected check box in the History column.

Note   You can also click the Tokens icon, , and select a token for the Value. 
Tokens are predefined values, such as dates and sample or compound identifiers. 

Select an event that has the 
History check box selected.
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The History pane displays all unsaved (queued) actions for the selected event.

2. To limit the actions in the history list, select a filter from the Filter list.

See “To create a filter for an audit log history” on page 712.

Figure 263. Example History filter

When you select this filter,

the History pane displays only these actions for the selected event:
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Audit Viewer
Use the Audit Viewer to view the audit log files to track user access and modifications to the 
data. See Audit Viewer parameters.

Figure 264. Application log in the Audit Viewer

Figure 265. Batch log in the Audit Viewer
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Table 165. Audit Viewer parameters  (Sheet 1 of 2)

Parameter Description

Active Log Name of the current audit log file.

Opens the Audit Log Selection dialog box where you can open a different audit log file. 
You can select from these audit log files: application, batch, method, or batch template.

Refreshes the current audit log file in the viewer.

Show Select to display only specific types of events in the Events list. The selected log file can 
contain batch, method, and application events. 

Events

Filter Select a filter view to use for displaying the event log entries. 

 Opens the Filter Editor dialog box where you can create a filter view.

 Opens the Filter Editor dialog box where you can edit the current filter view.

 Deletes the current event filter view.

Log
 Indicates an event that occurred at the main application level, such as 
logging in or opening a batch.

 Indicates an event that occurred in the Administration Console.

 Indicates an event that occurred in a method template.

 Indicates an event that occurred in a method.

 Indicates an event that occurred in a batch.

Date/Time Time stamp of the event.

User When an event requires confirmation (as specified in the Administrator Console), User is 
the user who confirmed each change to a batch, method, or template. 

When no confirmation is required, User is the user who was logged in when the change 
occurred. 

Computer Name Name of the computer on which the application recorded the event. 

Event Type Specific event that triggered the log file entry. For a complete list of event types, refer to 
the TraceFinder Administration Console User Guide.

Context Name of the sample, batch, method, or application version where the event occurred.
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History Indicates that there is a history log of queued actions for the event.

Reason Default or custom reason that the user entered for the event.

Details
Key/Value

Identifying parameters and their values for the selected auditing event. These key 
parameters are different for each type of auditing event. 

History

Filter Select a filter view to use for displaying the change history. 

 Opens the Filter Editor dialog box where you can create a filter view.

 Opens the Filter Editor dialog box where you can edit the current filter view.

 Deletes the current history filter view.

Order The sequence of actions that occurred.

Change Type One of the predefined ChangeType values. See ChangeType.

Context Name of the specific value on which the action occurred.

Item Type One of the predefined ItemType values. See ItemType.

Item Name A user-defined name for the filter. 

Old Value/New Value Original parameter value and the changed value.

Details 
Key/Value

Identifying parameters and values for the selected history event.

Table 165. Audit Viewer parameters  (Sheet 2 of 2)

Parameter Description
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A

Using Quick Acquisition

Use the quick acquisition feature to quickly submit samples from any mode in the 
application.

 To run a quick acquisition

1. Choose Tools > Quick Acquire Sample from the main menu or click the Quick Acquire 
Sample icon, .

The TraceFinder Quick Acquisition window opens.

2. To create the sequence of samples that you want to acquire, do any of the following:

• Use the Sequence buttons in the toolbar to open and save Xcalibur sequence files.

Note  The Quick Acquisition feature is available only when you activate it in the 
Configuration console. See “Quick Acquisition” on page 57.

Button Description

Replaces the current sequence with a new sequence that contains one 
Unknown sample.

Opens the Open dialog box where you can open a saved SLD file.

Saves the current sequence as an SLD file in the 
C:\TraceFinderData\Sequences folder.

Opens the Save As dialog box where you can save the current 
sequence to a new file name or location.
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• Use the Samples buttons in the toolbar to create a sequence of samples.

• (Optional) Use the Tools buttons in the toolbar to open a qualitative browser or the 
NIST library browser.

3. (Optional) When using multiplexing, select a channel for each imported sample.

To disable a configured channel, clear the check box for the channel in the Multiplexing 
Channels area at the bottom of the page.

By default, all configured channels are selected. The configured channels are determined 
by the multiplexing settings in the Configuration console. See “Multiplexing” on page 61. 

4. When you have completed your sequence of samples, click either of the Acquire buttons.

The application submits the samples for acquisition, processing, and report generation. 
See “Acquisition Page” on page 389.

Button Description

Adds the specified number of new, empty samples to the end 
of the sample list. 

Inserts a new, empty sample or samples above the selected 
sample. 

Removes the selected samples from the sample list. 

Button Description

Opens the qualitative explorer that you configured as your 
default qualitative explorer in the Configuration console. See 
“Launching a Qualitative Explorer” on page 18.

Opens the NIST library browser. See “Launching the NIST 
Library Browser” on page 17.

Button Description

Submits only the selected samples for acquisition, processing, or 
report generation. 
Submits the sequence for acquisition, processing, or report 
generation. 
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B

Isotopic Pattern Details

The TraceFinder application calculates an isotopic pattern score based on the settings in the 
method. The application displays this score in the Data Review view. This appendix describes 
the isotopic distribution concepts and provides calculation details with examples for the 
isotopic pattern score.

Isotopic Distribution in Exact Mass Spectra
To determine the elemental compositions, the TraceFinder application uses an isotopic 
pattern matching algorithm that considers the isotope accurate mass and intensity ratios. 
Using a single exact mass, usually the monoisotopic mass of a measured isotope pattern, the 
application calculates all possible elemental compositions that lie within a mass tolerance 
window. You can filter this list of possible elemental compositions and narrow the results by 
using the natural isotopic distribution of elements. 

Natural Isotopic Distribution

The following table lists the natural isotopic distribution of the most common elements.

Contents

• Isotopic Distribution in Exact Mass Spectra

• Isotopic Pattern Score Calculations

Table 166. Natural isotopic distribution (Sheet 1 of 2)

Element Isotope Isotope 
order Exact mass Mass difference Abundance (%)

Hydrogen 1H A0 1.0078 99.9985
2H A1 2.014102 +1.006302 0.015

Carbon 12C A0 12.0 98.890
13C A1 13.003355 +1.003355 1.110

Nitrogen 14N A0 14.003074 99.634
15N A1 15.00109 +0.998016 0.366
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where:

• A0 represents the monoisotopic peak, which is the most abundant and usually the isotope 
with the lowest mass. 

For example: 1H, 12C, 14N, 16O, 19F, 31P, and 32S

• A1 represents the isotope where one atom in the molecule is statistically replaced by 
another atom approximately 1 amu heavier. 

For example: 2H, 13C, 15N, 17O, and 33S

• A2 represents the isotope where:

Two atoms in the molecule are statistically replaced by two other atoms, each 
approximately 1 amu heavier.

–or–

One atom is replaced by another atom approximately 2 amu heavier. 

For example: 18O and 34S

• A3 represents the isotope where:

Three atoms in the molecule are statistically replaced by three other atoms, each 
approximately 1 amu heavier.

–or–

One atom is replaced by another atom approximately 1 amu heavier and one atom is 
replaced by another atom approximately 2 amu heavier. 

–or–

One atom is replaced by another atom approximately 3 amu heavier. 

Oxygen 16O A0 15.994915 99.762
17O A1 16.999132 +1.004217 0.038
18O A2 17.999161 +2.004246 0.200

Fluorine 19F A0 18.99840 100

Phosphorus 31P A0 30.971459 100

Sulfur 32S A0 31.972071 95.020
33S A1 32.971459 +0.999388 0.750
34S A2 33.967867 +1.995796 4.210
36S A4 35.967081 +3.995010 0.020

Table 166. Natural isotopic distribution (Sheet 2 of 2)

Element Isotope Isotope 
order Exact mass Mass difference Abundance (%)
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• A4 represents the isotope where: 

Four atoms in the molecule are statistically replaced by four other atoms, each 
approximately 1 amu heavier.

–or–

Two atoms are replaced by two other atoms, each approximately 1 amu heavier, and one 
atom is replaced by another atom approximately 2 amu heavier. 

–or–

Each atom of the two atoms is replaced by another atom approximately 2 amu heavier. 

–or–

One atom is replaced by another atom approximately 1 amu heavier, and one atom is 
replaced by another atom approximately 3 amu heavier. 

–or–

One atom is replaced by another atom approximately 4 amu heavier. 

For example: 36S

• Mass difference is the difference in mass between the A0 isotope and another isotope (A1, 
A2, A3, A4, and so on) of the same element.

• Abundance is the percentage of occurrence of each isotope normally in nature.

In the following figure, the x axis shows the mass difference of A1 relative to the monoisotopic 
peak (A0) of the 13C, 15N, and 33S isotopes. The y axis shows relative abundance in intensity.

Figure 266. Mass difference and abundance of A1 relative to A0
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In the following figure, the x axis shows the mass difference of A2 relative to the monoisotopic 
peak (A0) of the 18O, 34S, and 13C2 isotopes. The y axis shows relative abundance in 
intensity. 

Figure 267. Mass difference and abundance of A2 relative to A0

Note  For a particular isotopic spectrum, the mass difference is always the same between 
the A0 isotope and the other isotopes (A1, A2, and so on) of each specific element, but the 
intensity varies according to the composition of the molecule—that is, the number of each 
element in the molecule.



 B Isotopic Pattern Details
Isotopic Pattern Score Calculations

Thermo Scientific TraceFinder User Guide 725

Isotopic Pattern Score Calculations
The TraceFinder application follows the same isotopic distribution logic as described in 
“Isotopic Distribution in Exact Mass Spectra” on page 721, but in a different order and with 
numerical limits and scores to optimize automatic processing. After the TraceFinder 
application determines the possible elemental compositions for a particular compound of 
interest, it calculates a expected isotope pattern for each elemental composition candidate and 
an isotopic pattern score to represent the fit between the expected and measured isotope 
patterns. 

The following data set example describes the isotopic pattern score data and provides the score 
calculation details for one specific data set. 

Data Set Example

This example uses the Metribuzin target compound in an Apple_PosHCD__40_5_01 
sample.

For this compound, note that the Isotopic Pattern Score column shows 90% and the Num 
Isotopes Matched column shows “2 of 3” in the Compounds pane in the Data Review. The 
compound’s formula is C8H14N4OS and its adduct is H, so the modeled isotopic pattern is 
C8H15N4OS.

Figure 268. Isotopic data for Metribuzin

In the Spectrum pane, click the Isotopes tab and zoom in to view the expected isotopic 
pattern spectrum compared to the acquired, measured spectrum. The resulting isotopic 
pattern score should correlate to a visual inspection of the difference between the expected 
isotope display and the measured display for the target compound.

Figure 269. Isotopic pattern spectra (stacked)

Expected 
spectrum

Measured 
spectrum
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For this example, the processing method used to process the data contains the following 
isotopic pattern settings for target screening:

• Fit threshold = 90%

• Allowed Mass Deviation = 5 ppm

• Allowed Intensity Deviation = 10%

• Use Internal Mass Calibration = Cleared

The data for the Metribuzin compound is as follows:

Because the measured and the expected spectra have different intensities, the spectral noise 
threshold must proportionally apply to the expected spectrum to decide which peaks are 
expected in the measured data.

Noise threshold (expected) = Noise of A0 (measured)  Intensity of A0 (expected)  
Intensity of A0 (measured)

Following the previous formula, the expected noise threshold is 1482 8.55E5  4.75E4 = 
2.6676E4.

The expected ions in the measured spectrum are those whose intensities are above the 
expected noise threshold. The following table lists the ions in the expected spectrum. A “” in 
the Above Threshold column indicates the expected ions. 

Measured Expected

A0 m/z = 215.09602 A0 m/z = 215.09611

A0 Noise = 1482 –

A0 intensity = 4.75E4 A0 intensity = 8.55E5

Table 167. Ions in expected spectrum

Isotope 
order

m/z 
(expected)

Intensity 
(expected) Above threshold Present in measured 

spectrum

A0 215.09611 8.55E5  Yes

A1 216.09945 7.50E4  Yes

A2 217.09191 3.86E4  Yes

A3 218.09521 3.39E3 No
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Calculating Mass and Intensity Deviations

The expected number of ions is 3, as shown by those ions with a “” in the Above Threshold 
column of the Ions in expected spectrum table. These are the ions you focus on for the 
scoring calculations. This number “3” shows as the value of y in the Num Isotopes Matched 
column of the Compounds pane in the Data Review. It indicates the number of expected 
isotopic pattern peaks based on the Fourier transform (FT) noise in the spectrum. 

In this case, you expect to see the three most intense expected peaks in the measured 
spectrum. The masses of those peaks are (in order of intensity from high to low): 215.09611, 
216.09945, and 217.09191. When the measured spectrum is more intense or the noise level is 
lower, you find more peaks passing the noise threshold and expected in the measured 
spectrum, eventually including other isotopic peaks.

The following table shows the mass deviation (delta m/z) data for each of the expected ions.

where:

Delta m/z (ppm) = 1 000 000  ([m/z (measured) – m/z (expected)]  m/z (expected))

For example: 

1 000 000  ([216.09879 – 216.09945]  216.09945)] = –3.05 ppm

If the absolute value of the Delta m/z is less than 5 ppm (the Allowed Mass Deviation value set 
in the processing method), the TraceFinder application determines that this ion is 
found—that is, the ion is present in the measured spectrum. For this data set example, the 
application finds only the A0 and A1 ions, so “2” shows as the value of x in the Num Isotopes 
Matched column of the Compounds pane in the Data Review. The application does not find 
the A2 expected ion because the absolute value of its Delta m/z of 24 ppm is much higher 
than 5 ppm.

Table 168. Mass deviation data for the expected ions

Isotope order m/z (expected) m/z (measured) Delta m/z (ppm)

A0 215.09611 215.09602 –0.42

A1 216.09945 216.09879 –3.05

A2 217.09191 217.09712 24

Tip   You can see the expected, measured, and delta m/z values on the Isotopes page of the 
Spectrum pane. The MS page (see “Isotopic pattern spectra (stacked)” on page 725) 
displays the profile measured m/z values, whereas the Isotopes page displays the centroid 
measured m/z values, which might be different.

If you want more precision, you can see extra decimal digits for the A0 m/z values in an 
exported data file. 
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The following table lists the intensity deviation (delta intensity) data for each of the expected 
ions, relative to the A0 ion’s expected intensity of 8.55E5 and measured intensity of 4.75E4.

where:

• Relative intensity (expected and measured) values are derived from the isotopic pattern 
spectra (see “Isotopic pattern spectra (stacked)” on page 725). Each value is a percentage 
of the isotope’s intensity relative to the A0 ion’s intensity.

For example: 7.50E4 8.55E5 = 8.77%

• Delta intensity = Relative intensity (measured) – Relative intensity (expected)

For example: 18.42 – 8.77 = 9.65

In this example, the absolute values of the Delta m/z for the A0 and A1 ions (see “ Mass 
deviation data for the expected ions” on page 727) are both less than the Allowed Mass 
Deviation of 5 ppm; therefore, the application considers that these two ions are present in the 
measured spectrum. The delta intensity of the A1 isotope ion is close to the Allowed Intensity 
Deviation of 10% and the delta intensity of the A2 isotope ion is much higher (see “ Intensity 
deviation data for the expected ions” on page 728). 

The TraceFinder application determines the isotopic pattern score value from a combination 
of the mass and intensity deviations between the expected and the measured spectra. In this 
case, the application reduces the isotopic pattern score value down to 90 from 100 to reflect 
the marginal quality of the intensities of the A1 and A2 isotopes and to penalize for not 
finding the A2 isotope.

Note  You can see from zooming in on the isotopic pattern spectra (see “Isotopic pattern 
spectra (stacked)” on page 725) that there are measured peaks in the measured spectrum 
closely corresponding to the first two expected ions, but there is not a measured peak 
closely corresponding to the 217.09191 expected ion. 

Table 169. Intensity deviation data for the expected ions

Isotope 
order m/z (expected) Intensity 

(expected)
Relative intensity 
(expected, %)

Intensity 
(measured)

Relative intensity 
(measured, %)

Delta 
intensity 

A0 215.09611 8.55E5 100 4.75E4 100 0

A1 216.09945 7.50E4 8.77 8.75E3 18.42 9.65

A2 217.09191 3.86E4 4.51 3.47E4 73.05 68.54
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Calculating Isotopic Pattern Score

To score the fit for an isotopic pattern, the TraceFinder application calculates each expected 
ion’s fit and then combines the individual fit scores, weighted by their expected intensities.

For each expected ion peak, the application measures the m/z and intensity differences 
between the expected and the measured patterns. It then normalizes those differences 
(normalized deviation values) to the maximum allowed mass and intensity deviation values set 
in the processing method. The application then sums the normalized differences by vector 
addition (see Vector sum of intensity (I) and mass (M) deviations).

Figure 270. Measured and expected patterns

Figure 271. Vector sum of intensity (I) and mass (M) deviations

This example starts first with the intensity deviations. The Allowed Intensity Deviation value 
set in the processing method is 10, so this is the normalization value. As shown in “ Intensity 
deviation data for the expected ions” on page 728, the delta intensity value for the A1 isotope 
is close to 10%, resulting in a normalized intensity deviation close to 1.0.

Measured spectrum in greenExpected spectrum in blue

Vector sum

Measured spectrum in greenExpected spectrum in blue
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Normalized Intensity Deviation

The following table lists the normalized intensity deviation data for each of the expected ions.

Next are the mass deviations. For mass deviations, you can control two settings in the 
processing method:

• The first setting is the Allowed Mass Deviation that functions as an outer limit in the 
same way as the Allowed Intensity Deviation functions as a limit for the intensity. 

• The second setting is the Use Internal Mass Calibration check box. If you do not select 
this check box in the method, then the application considers any mass value within 
2 ppm of the expected m/z as a perfect match (no deviation). If you select this check box, 
then the application considers only a mass value within 1 ppm of the expected m/z as a 
perfect match.

In this example, the Allowed Mass Deviation value set in the processing method is 5 ppm and 
the Use Internal Mass Calibration check box is cleared. The mass normalization is a bit more 
complex than the intensity normalization because mass values < 2 ppm (Use Internal Mass 
Calibration setting) from the expected m/z are considered to have no deviation from theory; 
however, for values between 2 and 5 ppm (Allowed Mass Deviation value) from the expected 
m/z, the normalized deviation varies from 0 through 1.

The calculated normalized mass deviation value is as follows:

• 0 if absolute value (Delta m/z) < 2 ppm

where 2 ppm is the value from the Use Internal Mass Calibration setting.

• [absolute value (Delta m/z) – 2 ppm] (5 ppm – 2 ppm) if 
absolute value (Delta m/z) 2 ppm

where 2 ppm is the value from the Use Internal Mass Calibration setting and 5 ppm is the 
Allowed Mass Deviation value.

In this case, the absolute value of the mass deviation for the A0 ion is less than 2 ppm; 
therefore, its normalized mass deviation value is 0.

Table 170. Normalized intensity deviation data for the expected ions

Isotope 
order m/z (expected) Delta 

intensity

Allowed 
intensity 
deviation (%)

Normalized intensity 
deviation

A0 215.09611 0 10 0  10 = 0.0 

A1 216.09945 9.65 10 9.65  10 = 0.965

A2 217.09191 68.54 10 68.54  10 = 6.854
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Normalized Mass Deviation

The following table lists the normalized mass deviation data for each of the expected ions.

For example: [(24 – 2)] (5 – 2) = 7.33

To calculate the combined deviations, the application uses the Pythagorean theorem to 
calculate the vector sum of the normalized deviations. The calculation for the vector sum is as 
follows:

Vector sum = Square root [(Normalized intensity deviation)2 + (Normalized mass deviation)2]. 

However, if the vector sum > 1, then set it to 1.

Calculated Vector Sum

The following table lists the vector sum data for each of the expected ions.

To calculate the final score, you must weigh the vector sum values and then express the result 
as a percentage value. Each ion’s weighting contribution to the final isotopic pattern score is 
proportional to its intensity. 

Table 171. Normalized mass deviation for each of the expected ions

Isotope 
order

m/z 
(expected)

m/z 
(measured) Delta m/z (ppm) Internal 

calibration (ppm)
Allowed mass 
deviation (ppm)

Normalized mass 
deviation

A0 215.09611 306.10356 –0.42 2 5 0

A1 216.09945 307.10691 –3.05 2 5 0.35

A2 217.09191 308.11324 24 2 5 7.33

Table 172. Calculated vector sum

Isotope 
order m/z (expected) Normalized intensity 

deviation
Normalized mass 
deviation Vector sum

A0 215.09611 0 0 0

A1 216.09945 0.965 0.35 1

A2 217.09191 6.854 7.33 1
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Weighting Factor Calculations

The following table lists the weighting factor of each of the three expected ions.

The weighting factor of each individual ion = Intensity of each ion  Sum of intensities of all 
expected ions

For example: 8.55E5 9.686E5 = 0.8827

When not all of the expected ions are present in the measured spectrum, the application 
applies a penalty value (1, 2, or 4) to the weighted deviation of each missing ion, lowering the 
final isotopic pattern score even further. The penalty value depends on how strong the ion 
signal is expected to be in the measured spectrum. For the A2 ion that is not found, the 
application sets its penalty to a value of 1, causing its vector sum value of 1 (in Table 172 on 
page 731) to be replaced with the penalty value of 1 (in Table 174). In this case, it is the same 
number, but for other cases, the penalty value might be different from the vector sum value.

Calculated Isotopic Pattern Score

The following table lists the calculated isotopic pattern score using the weighting factors. 

where:

• Weighted deviation of each individual ion = Deviation  Weighting factor

For example: 1  0.0774 = 0.0774

• Isotopic pattern score = 100% (1.0 – Sum of all weighted deviation values)

For this example, the calculated isotopic pattern score of 100% (1.0 – 0.12) is 88, 
which is close to the 90 score displayed in the application.

Table 173. Weighting factor calculations

Isotope order m/z (expected) Intensity (expected) Weighting factor for final score

A0 215.09611 8.55E5 0.8827

A1 216.09945 7.50E4 0.0774

A2 217.09191 3.86E4 0.0399

Sum = 9.686E5 Sum = 1.000

Table 174. Calculated isotopic pattern score

Isotope 
order

m/z 
(expected)

Deviation (vector 
sum or penalty) Weighting factor Weighted deviation

A0 215.09611 0 (vector sum) 0.8827 0

A1 216.09945 1 (vector sum) 0.0774 0.0774

A2 217.09191 1 (penalty) 0.0399 0.0399

Sum = 0.12
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Finding the Noise Value

On the Isotopes page of the Spectrum pane, you can view the averaged noise value (N) for a 
peak in the measured spectrum.

 To find the noise value associated with a mass spectral peak

1. Right-click the spectrum plot area and choose Display Stack Spectra from the shortcut 
menu.

2. Zoom in to the peak of interest.

As an example, see “Isotopic pattern spectra (stacked)” on page 725 for the compound 
Metribuzin. 

3. Right-click the measured spectrum plot area and choose Show Noise Label from the 
shortcut menu.

In this example, the averaged noise value for the peak is 1579.

Note  Use these calculations to approximate the score displayed in the application. The 
calculated score might not match exactly the score in the application because some 
internal calculation details are not listed here or there is a discrepancy due to decimal digit 
rounding.

In certain cases, closely matching isotopes exist because heavier isotopes contribute to the 
isotopic pattern observed in the mass spectra. For example, the isotopes 206.0941 and 
206.1006 result from the contribution of one heavier isotope of carbon and one heavier 
isotope of nitrogen, respectively, together making up the split A1 isotopic peak. When the 
application performs isotopic pattern scoring, this situation appears as a main isotopic 
peak with a smaller peak to the side whose m/z is included in the calculations.

Noise

Measured spectrum in redExpected spectrum in blue
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C

Using Copy Down and Fill Down

This appendix describes the Copy Down and Fill Down commands that you can use to make 
entering column values easier.

• Use the Fill Down command for the Filename, Sample Name, Sample ID, and Vial 
Position columns.

• Use the Copy Down command for the Sample Type, Vial Position, Injection Volume, 
Conv Factor, Level, Comment, and other columns.

Follow these procedures:

• To automatically copy column values

• To automatically enter sequential column values

• To use Copy Down or Fill Down for a range of samples

 To automatically copy column values

1. Select the cell whose value you want to copy to all cells below it.

Observe the difference between a selected and nonselected cell. 

2. Right-click and choose Copy Down from the shortcut menu.

The value is copied to all rows below the selected row. 

 To automatically enter sequential column values

1. Enter a value for the first row of the fill down sequence.

This does not have to be the first sample row. You can begin the fill down procedure from 
any row in the sequence.

Selected 

Not selected 
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2. Select the cell whose value is the first in the fill down sequence.

Observe the difference between a selected and nonselected cell. 

3. Right-click and choose Fill Down from the shortcut menu.

The application enters sequential column values starting with the value in the selected 
row and ending with the last row in the column. 

You can repeatedly use the Fill Down command to create multiple sequences.

When you use the Fill Down command for the Vial Position column with an autosampler 
configured, the application knows the number of vial positions configured in your 
autosampler and numbers the positions accordingly. 

Selected 

Not selected 
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 To use Copy Down or Fill Down for a range of samples

1. To select a range of sample values, do one of the following:

Drag your cursor to select a contiguous group of sample values.

–or–

Hold down the SHIFT key to select a contiguous group of sample values.

2. Right-click and choose the appropriate command from the shortcut menu.

The column values are copied or entered sequentially starting with the value in the first 
selected row and ending with the last selected row. 
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D

Moving Data Review Panes

This appendix describes the procedures you can use to move, dock, or float panes in all Data 
Review views. The procedures have accompanying animations.

Follow these procedures:

• To move a docked pane

• To make a pane floating or dockable

• To change a pane from a docked pane to a tabbed pane

 To move a docked pane

1. Grab the title bar of the pane and begin dragging the pane. 

The application displays docking arrows.

2. Drag the pane over one of the arrows.

As you hold the cursor over a docking arrow, the application displays a blue region 
indicating where this arrow will place the pane.

3. Drop the pane onto one of the arrows. 

This animation shows the various ways that you can use the docking mechanism to move a 
pane. To view the animation, click the filmstrip, and then right-click and choose Full Screen 
Multimedia. To stop the animation, press ESC.
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 To make a pane floating or dockable 

Do one of the following:

• To make a dockable pane floating, right-click the title bar of the pane and choose 
Floating.

While a pane is set as floating, you cannot use the docking arrows to dock it or make 
it a tabbed pane.

• To make a floating pane dockable, right-click the title bar of the pane and choose 
Dockable.

This animation shows how to switch a pane from docked to floating and back to docked. To 
view the animation, click the filmstrip, and then right-click and choose Full Screen 
Multimedia. To stop the animation, press ESC.

 To change a pane from a docked pane to a tabbed pane

1. Grab the title bar of the pane and begin dragging the pane. 

The application displays docking arrows.

2. Hold the cursor over the center of the docking arrows to display a blue region indicating 
the location of the tabbed pane.

3. Drop the pane over the center of the docking arrows.

This animation shows how to change a pane from a docked pane to a tabbed pane and back to 
a docked pane. To view the animation, click the filmstrip, and then right-click and choose 
Full Screen Multimedia. To stop the animation, press ESC.

Note  To change a floating pane to a tabbed pane, you must first make the pane a dockable 
pane, and then you can make it a tabbed pane.

Drop the pane on the center location to create a tabbed pane.
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Symbols
.cdb, defined  2
.csv, defined  2
.db, defined  2
.meth, defined  2
.pmd, defined  2
.raw, defined  2
.xml, defined  2
# Background Scans parameter

configuration  45
quantitation  179
target screening  289
unknown screening  337

% Test parameter  210
%CV parameter  490
%Diff parameter  490
%RSD parameter  490

A
Acquire a New Raw Data File parameter  126
Acquisition command  32
Acquisition page

editing  137, 307
Injection Volume parameter

Batch View
quantitation  416
target screening  540
unknown screening  616

method development
quantitation  140
target screening  263
unknown screening  310

Instrument Method parameter
quantitation  141
target screening  264
unknown screening  310

Ion Range Calc Method parameter  141
Mass Precision parameter

quantitation  141
target screening  264
unknown screening  310

Active parameter
Data Review sample list  490
Identification page  153

Actual RT parameter  491
Add Compound command  84
Add Compound from Compound Database command  151
Add Group command  227
Add Sample command

acquisition  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

Add This Mass as New Confirming Ion command  195
Add This Mass to Existing Quan Mass Ranges command  195
Adduct parameter  491
Allowed Intensity Deviation parameter  199, 276
Allowed Mass Deviation parameter  198, 276
Amount parameter  206
Amplifier parameter  271
Analysis command  32
Area Noise Factor parameter

configuration  47
quantitation  181
target screening  291
unknown screening  339

Area parameter  491
Area Scan Window parameter

Detect page  182
ICIS peak detection  48, 292, 340

Area Tail Extension parameter
Detect page  182
ICIS peak detection  48, 292, 340

Area Threshold, event type
configuration  51
quantitation  185
target screening  295
unknown screening  343

Assay Type parameter
quantitation method  140
screening method  263
unknown screening method  310

Index
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Index: B

Associate a Raw Data File dialog box  129
Auto TSRM Update parameter  387
Autocalc Initial Events parameter, Avalon  184
automated background subtraction options  142
Automatically Create the Master Method parameter  125
Avalon detection algorithm  39
Avalon Event List dialog box  50, 184, 294, 342

B
background subtraction options  142
Background Subtraction Range Option parameter  147
Barcode Actual parameter

acquisition  376
quantitation  417
target screening  541
unknown screening  617

Barcode Expected parameter
quantitation  417
target screening  541
unknown screening  617

Baseline Window parameter
Detect page  181
ICIS peak detection

configuration  47
target screening  291
unknown screening  339

batches
Acquisition mode  348
calibration  380

Best Match Method parameter  149, 250
Blank Subtraction parameter  540
Browse in Raw File command

quantitation  418
target screening  541
unknown screening  618

Bunch Factor, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

C
cal1-caln parameter  208
Calculated Amt parameter  491
Calculation Type parameter

quantitation  417
target screening  540
unknown screening  617

Calibration Curve Type command  511
Calibration Levels page, Method View  207

Calibration Method parameter  250
Calibration page

Compounds page  204
QAQC page  219

Calibration parameter  387
calibration standard (Cal Std) sample type, defined  404
Carryover Limit parameter  218
CAS No parameter, Identification page  153
caution flags  454, 464
Channel parameter

Batch View
quantitation  417
target screening  541
unknown screening  617

Data Review  491
Chk Std page, Method View  220
Chromatogram View Width parameter  272
color codes, Sample Definition view  371
commands

Acquisition  32
Add Compound  84
Add Compound from Compound Database  151
Add Group  227
Add Sample

acquisition  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

Add This Mass as New Confirming Ion  195
Add This Mass to Existing Quan Mass Ranges  195
Analysis  32
Apply to All Peaks in Compound

Avalon  184
Genesis  179
ICIS  182

Apply to All Peaks in Method
Avalon  184
Genesis  179
ICIS  182

Apply to All Peaks with Like Sensitivity Settings
Avalon  184
Genesis  179
ICIS  182

Browse in Raw File
quantitation  418
target screening  541
unknown screening  618

Calibration Curve Type  511
Confirming Ion List  503
Copy Down  735, 739
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Index: C

Copy with Headers
Acquisition mode  372
Batch View sample list

acquisition  376
quantitation  419
target screening  542
unknown screening  619

Export Mass List  253
Export to CSV File

Acquisition mode  372
Batch View sample list

acquisition  376
quantitation  419
target screening  542
unknown screening  619

Fill Down  735
Import Compounds  76
Import Samples

acquisition  372
quantitation  418
target screening  541
unknown screening  618

Insert Copy Sample
Acquisition mode  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

Insert Sample
Acquisition mode  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

Log Off  13
Manual Integration Settings  503
Map Raw Files to Samples

quantitation  418
target screening  541
unknown screening  618

Method Integration Settings  503
Methods  32
Modify Columns, Batch View sample list

acquisition  370, 373
quantitation  408, 413
target screening  532, 537
unknown screening  608, 612

Pause Queue  398
Peak Detection Settings  504, 508
Peak Labels  503
Reactivate All  398
Real Time Status  13

Reinject Selected Samples
Acquisition mode  371
Batch view sample list

quantitation  418
target screening  541
unknown screening  618

Remove Pending Batch  400
Remove Pending Batches  398
Remove Pending Samples  400
Remove Selected Samples

Acquisition mode  372
Batch view sample list

quantitation  418
target screening  541
unknown screening  618

Send RT to Method  503
Set This Mass as a New Quan Peak  195
Set This Mass as Quan Mass  195
Show Peak Info  504
Stop Active Batch  398
Stop All Batches  398
Stop Batch  400
Turn Device Off  381
Turn Device On  380
Turn Device Standby  380
Update Confirming Ion Ratios with This Spectrum  

195
comma-separated values, defined  2
Comment parameter

Batch View
quantitation  417
target screening  541
unknown screening  617

Data Review  450
Compound parameter

Calibration page  219
Compound Database  97
QC levels page  210

Compound Type parameter
Calibration  206
Identification page  153

compound types
internal standards

Detection page  155
Identification page  152

quan
Detection page  155
Identification page  152

target
Detection page  155
Identification page  152

Compounds page, Method View  150
compounds, importing to compound database  76
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Index: D

Confirming Ion List command  503
Constrain Peak Width parameter

Genesis
Detect page  178
peak detection  44, 288, 336

ICIS
Detect page  181
ICIS peak detection  291, 339
peak detection  47

contacting us  xiii
Conversion Factor parameter

quantitation  417
target screening  540
unknown screening  617

Copy Down command  735, 739
Copy with Headers command

Acquisition mode  372
Batch View sample list

acquisition  376
quantitation  419
target screening  542
unknown screening  619

Create PDF parameter
quantitation method  237
unknown screening method  346

Curve Type parameter
Calibration page  206
Method Template Editor  250

CV Test (%) parameter
Calibration page  219
Chk Std page  220
ISTD page  222

D
Decimal Places to be Reported parameter  240
Detection Algorithm parameter

Avalon  49, 293, 341
Genesis  43, 287, 335
ICIS  46, 290, 338

Detection Method parameter
Avalon

Detect page  183
peak detection  49, 293, 341

Genesis
Detect page  177
peak detection  43, 287, 335

ICIS
Detect page  180
peak detection  46, 290, 338

Detection page, Method View  154
Detection Type parameter, Times page  167
Detector parameter, Signal page  175

Device Name parameter
Acquisition mode  385
quantitation  437
target screening  560
unknown screening  637

Dilution Factor parameter
quantitation  417
target screening  540
unknown screening  617

Disable Cluster Off, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Disable Cluster On, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Display Compounds Above Set Limit parameter  240

E
Enable parameter, Ratios page  203
Enable Peak Threshold parameter  148, 250
Enable Valley Detection parameter

Genesis peak detection  44, 288, 336
method development  178

End RT parameter, Times page  168
End Threshold, event type

configuration  51
quantitation  185
target screening  295
unknown screening  343

Estimation Method parameter  207
Event parameter

configuration  50
quantitation  185
target screening  294
unknown screening  342

Event types  51, 185, 295, 343
Exclude Matching Quan Peaks parameter  148, 251
Excluded parameter  496
Exclusion Window parameter  148, 251
Expected RT parameter  491
Expected RT parameter, Times page  167
Expected Width parameter

Genesis peak detection  44, 288, 336
method development  178

Export Mass List command  253
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Index: F

Export to CSV File command
Acquisition mode  372
Batch View sample list

acquisition  376
quantitation  419
target screening  542
unknown screening  619

Extracted Ion Chromatogram  103

F
features summary  3
file types, supported  2
Filename parameter, Batch View

acquisition  376
quantitation  416, 491
target screening  539
unknown screening  616

Fill Down command  735
Filter parameter

Detection  175
Signal page  174

Final Units parameter
Batch View

quantitation  417
target screening  540
unknown screening  617

Data Review  491
Fit Threshold parameter  198, 275
Flag Values Above Carryover parameter  241
Flag Values Above LOR parameter  241
Flag Values Above ULOL parameter  241
Flag Values Below LOD parameter  241
Flag Values Below LOQ parameter  241
Flag Values Between LOD and LOQ parameter  241
Flags parameter

Compound Results pane  452
Compounds pane  459
Sample Results pane  461, 492
Samples pane  450, 477

Force Cluster Off, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Force Cluster On, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Fragment Ions parameter  274

G
Genesis detection algorithm  39
Groups page, Method View  226
Groups parameter, Batch View

quantitation  416
target screening  540
unknown screening  616

H
Height parameter  492

I
ICIS detection algorithm  39
Identification page, Method View  152
Ignore if Not Defined parameter  274
Import an Xcalibur Method dialog box  127
Import Compounds command  76
Import Samples command

acquisition  372
quantitation  418
target screening  541
unknown screening  618

Include Compound Peak Spectrum as Reference Spectrum 
parameter  250

Include Confirming Ions parameter  250
Include Data Dependent Filters parameter  148
Injection Amount parameter  126
Injection Volume parameter

Batch View
quantitation  416
target screening  540
unknown screening  616

method development
quantitation  140
target screening  263
unknown screening  310

Insert Copy Sample command
Acquisition mode  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

Insert Sample command
Acquisition mode  371
Batch View sample list

quantitation  418
target screening  541
unknown screening  618

installing NIST and QED libraries  14
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Index: L

Instrument Method parameter
Acquisition page

quantitation  141
target screening  264
unknown screening  310

Batch View
quantitation  417
target screening  540
unknown screening  617

Method Forge  126
instrument status indicators  381
Integration Mode parameter  492
intensity ratios  721
Intensity Threshold parameter  201, 275
Ion Coelution parameter

common peak detection  42
Ratios page  203

Ion Range Calc Method parameter  141
isotope accurate mass  721
isotopic distribution  721
Isotopic Pattern parameter  275
isotopic pattern, score calculations  725
ISTD Amt parameter  493
ISTD Matching parameter  148, 251
ISTD page, Method View  222
ISTD parameter  206
ISTD Resp parameter  493

L
Lab Name parameter  140, 263, 309
Level parameter

Batch View
quantitation  416
target screening  540
unknown screening  616

QC Levels page  210
Library Search parameter  276
license, transfer  xii
licenses, types of  xi
Limit Library Hits parameter  149, 250
Limit the Retention Time Range parameter  250
Limits page, Method View  218
Linked Compound parameter  206
LOD (Detection Limit) parameter  218
Log Off command  13
Login parameter  13
LOQ (Quantitation Limit) parameter  218
LOR (Reporting limit) parameter  218

M
m/z (Apex) parameter  494, 580
m/z (Delta) parameter  495, 580
m/z (Expected) parameter  495, 580
Manual Injection parameter  126
Manual Integration Settings command  503
Map Raw Files to Samples command

quantitation  418
target screening  541
unknown screening  618

Mass Precision parameter
quantitation  141
target screening  264
unknown screening  310

Mass Tolerance parameter  148
Matrix Blank page, Method View  221
Matrix Blank sample type, defined  404
Max Amt Diff (%) parameter  219
Max Conc parameter  221
Max Recovery (%) parameter, ISTD page  222
Max RF Diff (%) parameter  220
Max RSD (%) parameter, Calibration page  219
Max RT (+min) parameter, ISTD page  222
Method Integration Settings command  503
Method parameter

Matrix Blank page  221
Solvent Blank page  223

Method Template Editor  249
Method View

Calibration Levels page  207
Calibration page

Compounds page  204
QAQC page  219

Chk Std page  220
Compounds page  150
Detection page  154
Groups page  226
Identification page  152
ISTD page  222
Limits page  218
Matrix Blank page  221
Processing page  141, 311
QAQC page  217
QC Check page  220
QC Levels page  208
Ratios page  202
Real Time Viewer page  211
Reports page  236
Solvent Blank page  223
Spectrum page  190
Suitability page  187
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Index: N

methods
importing Xcalibur  127
Method Template Editor  249
update TSQ method  379

Methods command  32
Min Peak Height (S/N) parameter

Genesis  179
ICIS  181

Min Peak Width parameter
Detect page  182
ICIS peak detection  48, 292, 340

Min recovery (%) parameter, ISTD page  222
Min RF parameter  220
Min RT (–min) parameter  222
Min. # of Fragments parameter  201, 275
modes, choosing  32
Modify Columns command, Batch View sample list

acquisition  370, 373
quantitation  408, 413
target screening  532, 537
unknown screening  608, 612

Multiplet Resolution parameter
Detect page  182
ICIS peak detection  48, 292, 340

Multiplexing Channels parameter  371

N
Name the Master Method parameter  125
Negative Peaks, event type

configuration  51
quantitation  186
target screening  295
unknown screening  343

NIST library, installing  14
Noise Method parameter

Detect page  182
ICIS peak detection  48, 292, 340

noise value  733
Number of Confirming Ions parameter  250
Number of Scans to Subtract parameter  148

O
Only Select Top Peaks parameter  148, 250
Open Chromatograph Reference Sample dialog box  368, 
445, 514

Origin parameter
Calibration  206
Method Template Editor  251

P
parameters

# Background Scans
configuration  45
quantitation  179
target screening  289
unknown screening  337

% Test  210
%CV  490
%Diff  490
%RSD  490
Acquire a New Raw Data File  126
Active

Data Review sample list  490
Identification page  153

Actual RT  491
Adduct  491
Allowed Intensity Deviation  199, 276
Allowed Mass Deviation  198, 276
Amount  206
Amplifier  271
Area  491
Area Noise Factor

configuration  47
quantitation  181
target screening  291
unknown screening  339

Area Scan Window
Detect page  182
ICIS peak detection  48, 292, 340

Area Tail Extension
Detect page  182
ICIS peak detection  48, 292, 340

Assay Type
quantitation method  140
screening method  263
unknown screening method  310

Auto TSRM Update  387
Autocalc Initial Events, Avalon  184
Automatically Create the Master Method  125
Background Subtraction Range Option  147
Barcode Actual

acquisition  376
quantitation  417
target screening  541
unknown screening  617

Barcode Expected
quantitation  417
target screening  541
unknown screening  617
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Baseline Window
Detect page  181
ICIS peak detection

configuration  47
target screening  291
unknown screening  339

Best Match Method  149, 250
Blank Subtraction  540
cal1-caln  208
Calculated Amt  491
Calculation Type

quantitation  417
target screening  540
unknown screening  617

Calibration  387
Calibration Method  250
Carryover Limit  218
CAS No, Identification page  153
Channel

Batch View
quantitation  417
target screening  541
unknown screening  617

Data Review  491
Chromatogram View Width  272
Comment

Batch View
quantitation  417
target screening  541
unknown screening  617

Data Review  450
Compound

Calibration page  219
Compound Database  97
QC levels page  210

Compound Type
Calibration  206
Identification page  153

Constrain Peak Width
Genesis

Detect page  178
peak detection  44, 288, 336

ICIS
Detect page  181
ICIS peak detection  291, 339
peak detection  47

Conversion Factor
quantitation  417
target screening  540
unknown screening  617

Create PDF  237
unknown screening method  346

Curve Type
Calibration page  206
Method Template Editor  250

CV Test (%)
Calibration page  219
Chk Std page  220
ISTD page  222

Decimal Places to be Reported  240
Detection Algorithm

Avalon  49, 293, 341
Genesis  43, 287, 335
ICIS  46, 290, 338

Detection Method
Avalon

Detect page  183
peak detection  49, 293, 341

Genesis
Detect page  177
peak detection  43, 287, 335

ICIS
Detect page  180
peak detection  46, 290, 338

Detection Type, Times page  167
Detector  175
Device Name

Acquisition mode  385
quantitation  437
target screening  560
unknown screening  637

Dilution Factor
quantitation  417
target screening  540
unknown screening  617

Display Compounds Above Set Limit  240
Enable Peak Threshold  148, 250
Enable Valley Detection

Genesis peak detection  44, 288, 336
method development  178

Enable, Ratios page  203
End RT, Times page  168
Estimation Method  207
Event

configuration  50
quantitation  185
target screening  294
unknown screening  342

Exclude Matching Quan Peaks  148, 251
Excluded  496
Exclusion Window  148, 251
Expected RT  491
Expected RT, Times page  167
Expected Width

Genesis peak detection  44, 288, 336
method development  178

Filename, Batch View
acquisition  376
quantitation  416, 491
target screening  539
unknown screening  616
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Filter  174
Filter, Detection  175
Final Units

Batch View
quantitation  417
target screening  540
unknown screening  617

Data Review  491
Fit Threshold  198, 275
Flag Values Above Carryover  241
Flag Values Above LOR  241
Flag Values Above ULOL  241
Flag Values Below LOD  241
Flag Values Below LOQ  241
Flag Values Between LOD and LOQ  241
Flags

Compound Results pane  452
Compounds pane  459
Sample Results pane  461, 492
Samples pane  450, 477

Fragment Ions  274
Groups, Batch View

quantitation  416
target screening  540
unknown screening  616

Height  492
Ignore if Not Defined  274
Include Compound Peak Spectrum as Reference 

Spectrum  250
Include Confirming Ions  250
Include Data Dependent Filters  148
Injection Amount  126
Injection Volume

Batch View
quantitation  416
target screening  540
unknown screening  616

method development
quantitation  140
target screening  263
unknown screening  310

Instrument Method
Acquisition page

quantitation  141
target screening  264
unknown screening  310

Batch View
quantitation  417
target screening  540
unknown screening  617

Method Forge  126
Integration Mode  492
Intensity Threshold  201, 275

Ion Coelution
common peak detection  42
Ratios page  203

Ion Range Calc Method  141
Isotopic Pattern  275
ISTD  206
ISTD Amt  493
ISTD Matching  148, 251
ISTD Resp  493
Lab Name  140, 263, 309
Level

Batch View
quantitation  416
target screening  540
unknown screening  616

QC levels page  210
Library Search  276
Limit Library Hits  149, 250
Limit the Retention Time Range  250
Linked Compound  206
LOD (Detection Limit)  218
Login  13
LOQ (Quantitation Limit)  218
LOR (Reporting limit)  218
m/z (Apex)  494, 580
m/z (Delta)  495, 580
m/z (Expected)  495, 580
Manual Injection  126
Mass Precision

quantitation  141
target screening  264
unknown screening  310

Mass Tolerance  148
Max Amt Diff (%)  219
Max Conc  221
Max Recovery (%), ISTD page  222
Max RF Diff (%)  220
Max RSD (%), Calibration page  219
Max RT (+min), ISTD page  222
Method

Matrix Blank page  221
Solvent Blank page  223

Min Peak Height (S/N)
Genesis  179
ICIS  181

Min Peak Width
Detect page  182
ICIS peak detection  48, 292, 340

Min recovery (%), ISTD page  222
Min RF  220
Min RT (–min)  222
Min. # of Fragments  201, 275
Multiplet Resolution

Detect page  182
ICIS peak detection  48, 292, 340
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Multiplexing Channels  371
Name the Master Method  125
Noise Method

Detect page  182
ICIS peak detection  48, 292, 340

Number of Confirming Ions  250
Number of Scans to Subtract  148
Only Select Top Peaks  148, 250
Origin

Calibration  206
Method Template Editor  251

Password, login screen  13
Path  126
Peak Height (%)

Genesis
Detect page  178
peak detection  44, 288, 336

ICIS
method development  181
peak detection  47, 291, 339

Peak Noise Factor
ICIS peak detection  47, 291, 339
method development  181

Peak S/N Cutoff
Detect page  179
Genesis peak detection  45, 289, 337

Percentage  221
Post-run System State

acquisition  386
quantitation  438
target screening  561
unknown screening  637

Priority Sequence
acquisition  385
quantitation  437
target screening  560
unknown screening  637

QC1-QCn  210
Qual Processing  416
Quan - Blank Method  129
Quan by Importing an Xcalibur Processing Method  

127
Quan by Selecting Compounds from CDB  133
Quan Using Method Forge  118, 121
R^2 Threshold  219
Ranges, compound detection  176
Raw Filename  126
Reference Compound, Identification page  153
Report Concentration  240
Report Name  237, 298, 346
Report Noise As

Detect page  179
Genesis peak detection  45, 289, 337

Response Ratio  495

Response Via
Calibration  206
Method Template Editor  251

RMS
Detect page  182
ICIS peak detection  48, 292, 340

RT
Calibration  206
Calibration levels  208
Calibration page  219
Chk Std page  220
Identification page  153
ISTD page  222
Limits page  218
Matrix Blank page  221
QC levels page  210
Solvent Blank page  223

S/N Ratio Threshold  274
S/N Threshold

Genesis peak detection  44, 288, 336
method development  178

Sample Amt  496
Sample Comment  126
Sample ID

acquisition  376
quantitation  416
target screening  540
unknown screening  616

Sample Name
acquisition  376
Batch View

quantitation  416
target screening  540
unknown screening  616

Data Review  462
Sample Type

Batch View
quantitation  416
target screening  539
unknown screening  616

Data Review  450, 462
Sample Volume

quantitation  417
target screening  540
unknown screening  617

Sample Weight
quantitation  417
target screening  540
unknown screening  617

Sensitivity
Avalon  183
Genesis  177
ICIS  180
Method Template Editor  250

Separate Ion Overlay Display  241
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Set Ion Ratio to All Confirming Peaks in Compound  
203

Set Ion Ratio to All Confirming Peaks in Method  203
Set Peak Windows Settings to All Peaks in Compound  

168
Set Peak Windows Settings to All Peaks in Method  

168
Shade Row when Sample is Outside of Evaluation 

Criteria  240
Show Chromatogram on Quantitation Report  240
Show Quan Peaks Only  211
Smoothing

Avalon
Detect page  183
peak detection  49, 293, 341

Genesis
Detect page  178
peak detection  44, 288, 335

ICIS
Detect page  181
peak detection  47, 290, 338

Specify Default Ion Ratio Ranges  250
Standard type  206
Start Device

acquisition  386
quantitation  437
target screening  561
unknown screening  637

Start RT, Times page  168
Start When Ready

acquisition  386
quantitation  438
target screening  561
unknown screening  637

Status, Batch View
Reference Sample  376
sample list  539

Stepoff Value  148
System Shutdown Method  387
System Startup Method  387
System Status  387
Tailing Factor

Genesis
method development  178
peak detection  45, 289, 336

ICIS
method development  181
peak detection  47, 291, 339

Target Ratio  203
Theoretical Amt  496
Threshold Override  274
Time

configuration  50
quantitation  185
target screening  294
unknown screening  342

Time/Event/Value, Avalon peak detection  49, 293, 341
Trace, Detection  175
ULOL (Linearity Limit)  218
Units  206
Upper Limit  223
Use Alternate Calibration Report Format  241
Use an Existing Raw Data File  126
Use as RT Reference, Identification page  153
Use Autosampler  126
Use Data Dependent Scans  148, 252
Use Genesis Algorithm for Qual Processing  148, 251
Use Internal Mass Calibration  199, 276
Use Matrix Blank  271
Use RT Limits  271, 315
Use Source CID Scans  272
Use These Libraries  250
Valley Rise (%)

Detect page  179
Genesis peak detection  45, 289, 337

Valley S/N
Genesis peak detection  45, 289, 337
method development  179

Value
configuration  50
quantitation  185
target screening  294
unknown screening  342

Vial Position
Batch View

acquisition  376
quantitation  416
target screening  540
unknown screening  616

Method Forge  126
View Width

peak detection  42
Times page  168

Weighting
Calibration  206
Method Template Editor  251

Window
ion ratio  42
Ratios page  203
retention time  42
Times page  167

Window Override  274
Window Type

peak detection  42
Ratios page  203

XIC  174
Password parameter, login screen  13
Path parameter  126
Pause Queue command  398
Peak Detection Settings command  504, 508
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Peak Height (%) parameter
Genesis

Detect page  178
peak detection  44, 288, 336

ICIS
method development  181
peak detection  47, 291, 339

Peak Labels command  503
Peak Noise Factor parameter

ICIS peak detection  47, 291, 339
method development  181

Peak S/N Cutoff parameter
Detect page  179
Genesis peak detection  45, 289, 337

Percentage parameter  221
Post-run System State parameter

acquisition  386
quantitation  438
target screening  561
unknown screening  637

P-P Threshold, event type
configuration  51
quantitation  186
target screening  295
unknown screening  343

Priority Sequence parameter
acquisition  385
quantitation  437
target screening  560
unknown screening  637

procedures
Access the Audit Viewer  708
acquisition mode

access real-time display  388
add samples to the sample list  361
assign a specific channel to a sample  367
create a batch template  359
create a quantitation batch template  357–358
import samples into the sample list  365
insert samples into the sample list  363
pause all batches in a queue  396
re-inject a sample from  366
remove a batch from a queue  399
remove a pending batch from a queue  400
remove a pending sample from a queued batch  399
remove a single batch from a queue  397
remove all batches in a queue  397
remove all pending batches in a queue  397
remove pending samples from a queued batch  399
remove samples from the sample list  366
save a to-be-run batch  381
select a previously acquired batch  356
select a ready-to-acquire batch  355
select a reference sample  368

specify a calibration batch  380
specify device states  380
specify startup or shutdown methods  379
start a new batch  352–354
start an acquisition  381
update TSRM data  379
view output files  386

analysis mode
access the Analysis mode

quantitation  405
target screening  529
unknown screening  605

add an auto sample type  443
add samples to the samples list

quantitation  422
target screening  545
unknown screening  622

browse in raw data files
quantitation  426
target screening  549
unknown screening  625

calculate the conversion factor for a liquid sample
quantitation  412
target screening  536
unknown screening  611

calculate the conversion factor for a solid sample
quantitation  412
target  536
unknown screening  612

change the displayed information for detected peaks
qualitative peak  486
quantitative peak

Data Review  501
method development  155

change the library entry for a selected peak  488
change the peak panes display  499
copy a sample in the samples list

quantitation  424
target screening  547
unknown screening  624

create a group
quantitation  410
target screening  534
unknown screening  610

create a new batch
quantitation  421
target screening  544
unknown screening  621

create a new project folder
quantitation  440
target screening  563
unknown screening  639

create a new quantitation method and update the 
compound database  574
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create a new quantitation method with the selected 
compounds  573

create a new report template
quantitation  523
target screening  598
unknown screening  679

create new project folders
quantitation  430
target screening  553
unknown screening  629

customize the column display
quantitation  408
target screening  532
unknown screening  608

customize the column display, Batch View
quantitation  426
target screening  549
unknown screening  626

delete project folders
quantitation  430, 440
target screening  553, 563
unknown screening  630, 639

display a generated report
quantitation  522
target screening  597
unknown screening  678

display or hide a pane on the Target Screening page  
566

display peaks for a specific compound, qualitative 
view  478

display the features for calculating sample weight
quantitation  411
target screening  536
unknown screening  611

edit a report template
quantitation  522
target screening  598
unknown screening  678

edit sample values
quantitation  425
target screening  548
unknown screening  624

edit samples in a batch
quantitation  432
target screening  555
unknown screening  632

exclude a calibration point  497
export compounds to a compound database

target screening  572
export compounds to a CSV file

quantitation  519
target screening  571

export compounds to an Excel spreadsheet
quantitation  518
target screening  570

generate a report as a PDF, an Excel, or a CSV file
quantitation  521
target screening  597
unknown screening  677

import samples into the list
quantitation  423
target screening  546
unknown screening  623

insert samples in the samples list
quantitation  423
target screening  546
unknown screening  623

make a compound active or inactive  497
manually add a peak

chromatogram pane  482
qualitative peak pane  485
quantitation peak  500

manually exclude a calibration point  511
manually integrate a quantitative peak  500
manually specify the conversion factor for a sample

quantitation  412
target screening  537
unknown screening  612

modify the peak detection settings  502
move a batch to another project folder

quantitation  439
target screening  562
unknown screening  639

open a recent batch
quantitation  432
target screening  555
unknown screening  632

open a saved batch
quantitation  431
target screening  554
unknown screening  630

open the Batch View
quantitation  406
target screening  530
unknown screening  606

open the Data Review view
quantitation  447
target screening  566
unknown screening  642

open the Local Method View
quantitation  526
target screening  602
unknown screening  682

open the Report View
quantitation  520
target screening  596
unknown screening  676

preview a report
quantitation  520
target screening  596
unknown screening  676
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print a report
quantitation  521
target screening  597
unknown screening  677

reinject a sample
quantitation  424
target screening  547
unknown screening  624

reinject a sample from a previously acquired batch
quantitation  432
target screening  556
unknown screening  632

remove a manually created peak  500
remove a peak from the peak list  480
remove a peak from the qualitative peak pane  485
remove samples from the samples list

quantitation  424
target screening  547
unknown screening  624

rename project folders
quantitation  430, 440
target screening  553, 563
unknown screening  630, 640

save a batch to another project folder
quantitation  439
target screening  562
unknown screening  638

scroll the samples list
acquisition  373
quantitation  408
target screening  532
unknown screening  607

set a compound as active or inactive
quantitation  420
target screening  543
unknown screening  620

specify a chromatogram reference sample  445
specify a threshold sample  446
specify instrument methods for samples

quantitation  413
target screening  537
unknown screening  612

submit all samples in the batch
quantitation  433
target screening  557
unknown screening  633

submit selected peaks for processing
quantitation  433
target screening  556
unknown screening  633

switch between method and manual integration
qual mode  485
quan mode  501

use the Cross Sample Peak List pane  643

use the Cross Sample Peak Overlay pane with the 
Group Averages pane  663

use the Group Averages pane with the Cross Sample 
Peak Overlay pane  657

use the Heat Map pane  646
use the Heat Map pane with the TIC 

Chromatogram pane  646
use the Heat Map pane with the XIC pane  647
view output files

quantitation  438
target screening  561
unknown screening  638

zoom in on a peak
chromatogram navigation  482
qual peak  484
quantitation peak  499
spectra pane  487

audit viewer
access the Audit Viewer  708
create an audit log events filter  710
create an audit log history filter  712
select an audit log  709
view audit event details  712
view only application, method, batch, or batch 

template events  709
Configuration console

add a quantitation peak to a compound  86
import compounds  76
open the Defaults view  37
remove a compound  85
specify common detection parameters  39
specify default laboratory and instrument names  37
specify default mass precision and intensity scale  38

getting started
choose a node  32
display a log of instrument errors  33
install the NIST library  14
install the QED library  14
log in to the TraceFinder application  11
monitor the instrument status  33
start the TraceFinder application  11

method development mode
add a compound to the database  84
add a mass as a new compound  160
add a mass as a new confirming ion peak  163
add a mass to the existing quan mass ranges  160
add a quan peak  160
add a quan peak to an existing compound  193
add compounds to the method  156
add confirming ions to an existing compound  194
add ions to get an accumulated signal  193
automatically select compounds to create a new 

method  118
calibrate the compounds  246
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change the compound reference spectrum  159
change the quantitation mass used for a quan peak  

191
create a blank method  129
create a group  226
create a new instrument method  109
create a new multiplexing instrument method  110
create a target screening method  259, 305
export mass list data to an XML file  253
filter the displayed compounds  152, 155
identify the peaks  245
import an Xcalibur method  127
manually select compounds to create a new method  

121
open a quantitation method  115
open a target screening method  257
open an instrument method  111
open an unknown screening method  303
open the Instrument View  108
replace a confirming ion peak  163
replace a quantitation mass  159
replace a quantitative peak with a confirming ion 

peak  162
save the method template  248
save the new method  164
select compounds from the compound database  133
set a confirming ion peak as an additional 

quantitative peak  162
set automated background subtraction options  142
specify an internal standard for a compound  204–

205
specify general information for a master method  138, 

307
specify ion ratio criteria  197, 202
specify mass tolerance  143
specify peak criteria  244
specify QC levels and concentrations  209
specify qualitative peak processing  247
specify quantitation flag options  239
specify quantitation limits  238
specify ranges of ions for detection and integration  

168
specify report types and output formats  236, 297, 

345
specify the maximum concentration as a percentage  

221
specify user interface options  239
update confirming ion ratios  191
zoom in the chromatogram or spectrum displays  194

Report View
format cells in the report grid  694
format data in the report grid  693
format header text in the spreadsheet  693
insert a table  689

insert graphics into a report template  686
make changes to a table  692

select an audit log  709
specify calibration levels and concentrations  207

Processing page
Background Subtraction Range Option  147
editing  141, 311
Include Data Dependent Filters parameter  148
Mass Tolerance parameter  148
Method View  141, 311
Number of Scans to Subtract parameter  148
Stepoff Value parameter  148

Q
QAQC page, Method View  217
QC Check page, Method View  220
QC Levels page, Method View  208
QC1-QCn parameter  210
QED library, installing  14
Qual Processing parameter  416
quality check standard (QC Std) sample type, defined  404
Quan - Blank Method parameter  129
Quan by Importing an Xcalibur Processing Method 
parameter  127

Quan by Selecting Compounds from CDB parameter  133
quan report settings, specifying  238, 346
Quan Using Method Forge parameter  118, 121

R
R^2 Threshold parameter  219
Ranges parameter, compound detection  176
Ratios page, Method View  202
Raw Filename parameter  126
Reactivate All command  398
Real Time Status command  13
Real Time Viewer page, Method View  211
Reference Compound parameter, Identification page  153
reference spectra  487
Reinject Selected Samples command

Acquisition mode  371
Batch view sample list

quantitation  418
target screening  541
unknown screening  618

Remove Pending Batch command  400
Remove Pending Batches command  398
Remove Pending Samples command  400
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Remove Selected Samples command
Acquisition mode  372
Batch view sample list

quantitation  418
target screening  541
unknown screening  618

Report Concentration parameter  240
report formats, specifying  236
Report Name parameter  237, 298, 346
Report Noise As parameter

Detect page  179
Genesis peak detection  45, 289, 337

reports
Acquisition mode  377
listed  6

Reports page, Method View  236
Response Ratio parameter  495
Response Via parameter

Calibration  206
Method Template Editor  251

RMS parameter
Detect page  182
ICIS peak detection  48, 292, 340

RT parameter
Calibration  206
Calibration levels  208
Calibration page  219
Chk Std page  220
Identification page  153
ISTD page  222
Limits page  218
Matrix Blank page  221
QC levels page  210
Solvent Blank page  223

S
S/N Ratio Threshold parameter  274
S/N Threshold parameter

Genesis peak detection  44, 288, 336
method development  178

Sample Amt parameter  496
Sample Comment parameter  126
Sample ID parameter

acquisition  376
quantitation  416
target screening  540
unknown screening  616

Sample Name parameter
acquisition  376
Batch View

quantitation  416
target screening  540
unknown screening  616

Data Review  462
Sample Type parameter

Batch View
quantitation  416
target screening  539
unknown screening  616

Data Review  450, 462
sample types, defined  404
Sample Volume parameter

quantitation  417
target screening  540
unknown screening  617

Sample Weight parameter
quantitation  417
target screening  540
unknown screening  617

score, isotopic pattern  721
Select Compounds from Database dialog box  151
Select Compounds to Add dialog box  133
Selected Reaction Monitoring  101
Send RT to Method command  503
Sensitivity parameter

Avalon  183
Genesis  177
ICIS  180
Method Template Editor  250

Separate Ion Overlay Display parameter  241
Set Ion Ratio to All Confirming Peaks in Compound 
parameter  203

Set Ion Ratio to All Confirming Peaks in Method parameter  
203

Set Peak Windows Settings to All Peaks in Compound 
parameter  168

Set Peak Windows Settings to All Peaks in Method parameter  
168

Set This Mass as a New Quan Peak command  195
Set This Mass as Quan Mass command  195
Shade Row when Sample is Outside of Evaluation Criteria 
parameter  240

Shoulders Off, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Shoulders On, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Show Chromatogram on Quantitation Report parameter  240
Show Peak Info command  504
Show Quan Peaks Only parameter  211
Single Ion Monitoring  102



Thermo Scientific TraceFinder User Guide 757

Index: T

Smoothing parameter
Avalon

Detect page  183
peak detection  49, 293, 341

Genesis
Detect page  178
peak detection  44, 288, 335

ICIS
Detect page  181
peak detection  47, 290, 338

Solvent Blank page, Method View  223
Solvent sample type, defined  404
Specify Default Ion Ratio Ranges parameter  250
spectral noise threshold  726
Spectrum page, Method View  190
SRM experiment type  101
Standard type parameter  206
Start Device parameter

acquisition  386
quantitation  437
target screening  561
unknown screening  637

Start RT parameter, Times page  168
Start Threshold, event type

configuration  51
quantitation  185
target screening  295
unknown screening  343

Start When Ready parameter
acquisition  386
quantitation  438
target screening  561
unknown screening  637

status color codes, Sample Definition view  371
Status parameter, Batch View

Reference Sample  376
sample list  539

Stepoff Value parameter  148
Stop Active Batch command  398
Stop All Batches command  398
Stop Batch command  400
Suitability page, Method View  187
supported file types, defined  2
System Shutdown Method parameter  387
System Startup Method parameter  387
System Status parameter  387

T
Tailing Factor parameter

Genesis
method development  178
peak detection  45, 289, 336

ICIS
method development  181
peak detection  47, 291, 339

Tangent Skim, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Target Ratio parameter  203
templates

batch  357, 359
method  243

Tension, event type
configuration  52
quantitation  186
target screening  296
unknown screening  344

Theoretical Amt parameter  496
Thermo Instrument Setup window  262, 308
Thermo Xcalibur Instrument Setup window  138
Threshold Override parameter  274
Time parameter

configuration  50
quantitation  185
target screening  294
unknown screening  342

Time/Event/Value parameter, Avalon peak detection  49, 
293, 341

Trace parameter, Detection  175
Turn Device Off command  381
Turn Device On command  380
Turn Device Standby command  380

U
ULOL (Linearity Limit) parameter  218
Units parameter  206
Unknown sample type, defined  404
Update Confirming Ion Ratios with This Spectrum 
command  195

Upper Limit parameter  223
Use Alternate Calibration Report Format parameter  241
Use an Existing Raw Data File parameter  126
Use as RT Reference parameter, Identification page  153
Use Autosampler parameter  126
Use Data Dependent Scans parameter  148, 252
Use Genesis Algorithm for Qual Processing parameter  148, 
251

Use Internal Mass Calibration parameter  199, 276
Use Matrix Blank parameter  271
Use RT Limits parameter  271, 315
Use Source CID Scans parameter  272
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Use These Libraries parameter  250
user security, activating  57

V
Valley Rise (%) parameter

Detect page  179
Genesis peak detection  45, 289, 337

Valley S/N parameter
Genesis peak detection  45, 289, 337
method development  179

Value parameter
configuration  50
quantitation  185
target screening  294
unknown screening  342

vector addition  729, 731
Vial Position parameter

Batch View
acquisition  376
quantitation  416
target screening  540
unknown screening  616

Method Forge  126
View Width parameter

peak detection  42
Times page  168

W
weighting factor  732
Weighting parameter

Calibration  206
Method Template Editor  251

Window Override parameter  274
Window parameter

ion ratio  42
Ratios page  203
retention time  42
Times page  167

Window Type parameter
peak detection  42
Ratios page  203

workflow  5

X
XIC parameter, Signal page  174
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